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Preface

Welcome to the Oracle TeleService Implementation Guide, Release 11i.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle TeleService.

If you have never used Oracle TeleService, Oracle suggests you attend one or 
more of the Oracle Applications training classes available through Oracle 
University.

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.
xv



How To Use This Guide
The Oracle TeleService Implementation Guide contains the information you need to 
understand and use Oracle TeleService. This guide contains four chapters:

■ Chapter 1 describes the steps required to implement service request 
functionality.

■ Chapter 2 provides instructions for setting up automatic service request and 
task assignment.

■ Chapter 3 describes how to automate task generation for service requests.

■ Chapter 4 provides the steps for implementing the Customer Care module 
which encompasses the Contact Center and Relationship Plans.

■ Chapter 5 provides the steps for implementing the Charges module.

■ Chapter 6 explains how you can automate the submission of Oracle Field 
Service charges.

■ Appendix A includes information useful for integrating relationship plans in 
other Oracle E-Business Suite applications.

■ Appendix B answers some frequently asked questions about relationship plans.

■ Appendix C lists the seeded relationship plan data.

■ Appendix D lists lookup codes used by the application.

■ Appendix E lists seeded data you can use for setting up function and data 
security.

■ Appendix F lists the system profiles for the Service Request and Customer Care 
modules of Oracle TeleService.
xvi



Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor 
makes any representations regarding the accessibility of these Web sites. 
xvii



Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle TeleService.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ PDF Documentation - See the Documentation CD provided with each release 
for current PDF documentation for your product. This Documentation CD is 
also available on OracleMetaLink and is updated frequently.

■ Online Help - Oracle TeleService provides the Oracle TeleService User Guide and 
sections of this guide as online help. Only those sections relating to specific 
setup windows and HTML pages are included. Online help patches are 
available on MetaLink.

■ 11i Release Content Document - Refer to the Release Content Document for 
new features listed release. The Release Content Document is available on 
OracleMetaLink.

■ About document - Refer to the About document for information about new and 
changed features in this release. This document also provides information about 
new documentation or documentation patches that you can download. The 
new About document is available on OracleMetaLink.

Related Guides
Oracle TeleService shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other guides when you 
set up and use Oracle TeleService.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.
xviii



Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Guides Related to This Product

About Oracle TeleService
This online document describes new features and changes to Oracle TeleService 
since the last major release. It is available on OracleMetaLink.

Oracle Common Application Components User’s Guide
This guide explains how to use Assignment Manager and Resource Manager and 
other common application components.

Oracle Common Application Components Implementation Guide
This guide explains how to implement Assignment Manager and Resource 
Manager and other common application components including notes and tasks.

Oracle Universal Work Queue Implementation Guide
This guide explains how to implement the work queue agents use to get their work 
and telephony integration for Oracle TeleService.

Oracle Knowledge Management Implementation Guide
This guide explains how to implement the knowledge base both agents can use to 
resolve customer problems.

Oracle Territory Manager User Guide
This guide explains how to set up territories using the Oracle Territory Manager 
module.

Oracle Territory Manager Implementation Guide
This guide explains how to implement the Oracle Territory Manager module.
xix



Oracle Contracts Core Implementation Guide
This guide explains in more detail how to set up events which are used by Oracle 
TeleService relationship plans. 

Oracle Install Base Implementation Guide
This guide describes how to setup the installed base for tracking customer products.

Oracle iSupport Implementation Guide
This guide describes how to implement the Web-portal customers can use to create 
service requests and monitor their status.

Oracle Field Service Implementation Guide
This describes steps to implement Oracle Field Service.

Oracle Scheduler Implementation Guide
This guide helps you implement the Oracle Advanced Scheduler agents can use to 
schedule field-service tasks.

Oracle Scripting Implementation Guide 11i
This guide describes how to implement Oracle Scripting components and test the 
implementation appropriately.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications 
and the Oracle technology stack by automating many of the required steps. This 
guide contains instructions for using Oracle Rapid Install and lists the tasks you 
xx



need to perform to finish your installation. You should use this guide in conjunction 
with individual product user guides and implementation guides.

Oracle Applications Implementation Wizard User Guide
If you are implementing more than one Oracle product, you can use the Oracle 
Applications Implementation Wizard to coordinate your setup activities. This guide 
describes how to use the wizard.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

About Document
For information about implementation and user documentation, instructions for 
applying patches, new and changed setup steps, and descriptions of software 
updates, refer to the About Document for your product. About documents are 
available on OracleMetaLink for most products starting with Release 11.5.8.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.
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Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff and describes the Oracle Application Object Library components 
that are needed to implement the Oracle Applications user interface described in 
the Oracle Applications User Interface Standards for Forms-Based Products. This manual 
also provides information to help you build your custom Oracle Forms Developer 
forms so that the forms integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Applications Product Update Notes

Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.

Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.
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Oracle Workflow API Reference
This guide describes the APIs provided for developers and administrators to access 
Oracle Workflow.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle TeleService implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This guide also provides 
information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetalink

Oracle Applications Message Manual

This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle TeleService and reach full productivity quickly. These courses are organized 
into functional learning paths, so you take only those courses appropriate to your 
job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.
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Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle TeleService working for 
you. This team includes your technical representative, account manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle server, and your hardware and software 
environment.
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Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Your Feedback
Thank you for using Oracle TeleService and this user guide.

Oracle values your comments and feedback. In this guide is a reader’s comment 
form that you can use to explain what you like or dislike about Oracle TeleService 
or this user guide. Mail your comments to the following address or call us directly 
at (650) 506-7200. 

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Or, send electronic mail to appsdoc_us@oracle.com.
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Implementing Service Requests

This chapter describes steps required to successfully implement 
service-request-related functionality in Oracle TeleService.

It covers:

■ About Configuring Service Requests to Model Business Processes on page 1-2

■ Configuring Service Requests to Model Business Processes on page 1-6

■ Creating and Updating Status Groups on page 1-10

■ Setting Up Service Request Types on page 1-15

■ Restricting Access to Service Request Information on page 1-19

■ Setting Up Service Request Severities on page 1-29

■ Setting Up Service Request Urgencies on page 1-31

■ Defining Service Request Problem Codes on page 1-32

■ Setting Up Message Action Codes on page 1-66

■ Setting Up Task Types and Priorities for Service Request Usage on page 1-67

■ Setting Up the Display of Oracle Install Base Items on page 1-67

■ Setting Up HTML Applications for Service Requests on page 1-67

■ Setting Up Service Request Profile Options on page 1-68

■ Indexing Note and Summary Text for Searches on page 1-69

■ Creating Owners and Supervisors on page 1-69

■ Setting Up Service Request Linking Through Relationships on page 1-71

■ Setting Up Notifications on page 1-79
uests 1-1



About Configuring Service Requests to Model Business Processes
■ Implementing Oracle eMail Center and E-Mail Templates on page 1-90

■ Setting Up the List of Values for the Language Field on page 1-95

■ Setting Up Default Response and Resolution Times on page 1-96

■ Automating the Closure of Service Requests on page 1-97

■ Setting Up Custom Tabs on the Service Request Window on page 1-100

■ Integrating with Oracle Enterprise Asset Management on page 1-105

■ Enabling Oracle Complex Maintenance, Repair, and Overhaul on page 1-105

1.1 About Configuring Service Requests to Model Business Processes
This group of topics provides a conceptual overview of the service request setups 
you can perform to model the different ways your organization handles customer 
problems. It covers the following related features:

■ Service Request Statuses

■ Status Groups and Status Transitions

■ Service Request Types

The last section, Summary of Setup Outcomes, explains how these features can 
work together.

Service Request Statuses
Service request statuses provide a classification system which makes it possible for 
your organization to track the stage of a response to a customer problem from the 
initial customer contact to resolution. 

The statuses seeded in Oracle TeleService are:

■ Waiting

■ Clear

■ Closed

■ Open

■ Cancelled by User

You can set up different statuses for different types of customer problems. For 
example, you may wish to include the status of “Invoice Corrected” for service 
requests about billing problems, but for equipment exchanges you may wish to 
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About Configuring Service Requests to Model Business Processes
include “Received”, “Fixed”, and “Shipped Back to Customer”. In Oracle 
TeleService you specify all of the possible statuses first and then specify their uses 
later by grouping them in Status Groups.

You can specify what kinds of changes users can make to a service request with a 
specific status. For example, if your organization calculates the amount a customer 
is to be billed only after work has been completed, then you will want to permit 
agents working on service requests with the status of “Open” to update the 
information about the customer problem but not to update charges the customer 
has incurred. When the work has been completed and the service request has the 
status of “Closed”, then you may want to bar agents from updating the problem 
information but permit them to modify the charges.

Service Request Status Groups and Status Transitions
For each Service Request Type, you can specify which of the service request statuses 
you have created make sense for that particular type of customer problem. The list 
of permissible statuses is called a Status Group. 

For example, “Invoice Corrected” makes sense as a status of a service request for a 
billing question and “Repaired” as a status for inhouse equipment repairs, but not 
vice versa. 

Status groups make it possible for you to group your statuses according to use and 
to determine the initial status for a service request and the permissible status 
transition rules for each status in the group. The initial status is the default status of 
the service request when agents or customers create it. The transition rules make it 
possible for you to determine what statuses agents or customers can choose for a 
service request of a given status.

For example, you may want all new service requests to get the status of New, but 
you will not want to permit agents to set it back to New after it has already been 
worked on. Or you may not want to permit agents to turn a “Closed” service 
request back to “Open” or “New” because work has already been completed. 

Note: The status transition rules only govern what statuses users 
can select, they do not determine whether the information in the 
service request can be updated or not. You determine whether users 
can modify information when you set up the statuses themselves. 
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Service Request Types
Agents use Service Request Types to categorize service requests based on the type 
of question or problem. If you have implemented Oracle iSupport, then customers 
can also use Service Request Types to categorize their problems when they create a 
service request on the Web. 

Examples of Service Request Types include:

■ Request for Information

■ Customer Complaint

■ Billing Issue

■ Installation Request

■ Preventive Maintenance Visit

■ Return

■ Depot Repair

You can set up Service Request Types to:

■ Channel different types of customer problems and inquiries to different groups 
in your organization

This is accomplished by associating Service Request Types with different 
Responsibilities. For example, you may wish to restrict only accountants to 
viewing and updating Billing Issue type service requests and you may wish to 
restrict access to Installation Requests to the field service organization.

■ Provide data security

The Responsibility to Service Request Type mappings provide data security not 
just for the service request information itself, but also for all related information 
including service request tasks, notes, and interaction history.

Agents that are barred from using a Service Request Type cannot view or 
modify any service-request-related information.

■ Restrict agents to using appropriate problem and resolution codes

Problem codes and resolution codes provide agents with a quick and consistent 
way of classifying customer problems and resolutions. You can specify which 
codes map service request types to problem codes and resolution codes to 
restrict selection to those appropriate to the problem.

■ Automatically create tasks when a service request is created
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You can use Service Request Types along with Problem Codes, Items, and Item 
Categories to generate tasks that need to be performed to resolve the customer 
problem. You can then have agents or dispatchers assign these tasks to the 
engineers who will do the work. 

■ Capture additional information about a customer problem

You can set up Service Request Types to capture additional information you 
may need to resolve the customer problem. This is beneficial mostly to 
organizations handling problems reported by individuals who are not the 
owners of the item to be serviced. These include government agencies that must 
fix broken streetlights, repair roads, or tow away abandoned vehicles. For 
example, a government agency receiving a call about an abandoned vehicle 
must capture the make, model, color, and the license plate number so the 
towing service knows which vehicle to tow away and what tow truck to send to 
do the job. 

Based on the information entered, the application can automatically create 
different tasks and check if the new service request is a duplicate.

■ Launch Oracle Workflow processes

Each Service Request Type can be linked to an Oracle Workflow process that 
can be automatically launched when agents create or update a service request 
of this type. 

Summary of Setup Outcomes
This topic provides a summary of outcomes of different Service Request Types, 
Status Groups, and Status transition setups:

■ If you map a Service Request Type to a Status Group with transition rules, then 
agents can only change the Status of service requests of this type to Statuses 
permitted by the transition rules. 

■ If you map a Service Request Type to a Status Group that does not have any 
transition rules, then agents can set service requests to any status listed in that 
Status Group.

■ If you do not map a Service Request Type to a Status Group, then agents can set 
service requests of that type to any status.
Implementing Service Requests 1-5



Configuring Service Requests to Model Business Processes
1.2 Configuring Service Requests to Model Business Processes
Use this general procedure as a guideline for setting up service request Statuses, 
Status Groups, and Service Request Types to model your business processes. 

To set up service requests to model your business processes:
1. Set up service request Statuses for all types of service requests. See Setting Up 

Service Request Statuses on page 1-6.

2. Group the Statuses into the groups that will be used by different Service 
Request Types and create permissible status transitions for each group. See 
Creating and Updating Status Groups on page 1-10.

3. Set up Service Request Types and specify what Status Groups they use. Indicate 
any workflows to be launched when different types of requests are created or 
updated. See Setting Up Service Request Types on page 1-15.

4. If you wish to limit access to Service Request Types by Responsibility, then 
follow the procedure for setting up service request data security described in 
Granting Access to Service Request Types by Responsibility on page 1-19.

1.3 Setting Up Service Request Statuses
Use this procedure to set up service request Statuses. The Status of a service request 
tracks the status of a customer problem from the initial customer contact to 
resolution and controls what kind of information in the service request can be 
updated. 

You can also set up Statuses to: 

■ Indicate the service request has been responded to or resolved and 
automatically fill in the date and time in the Responded On or Resolved On 
fields.

■ Indicate a service request is on hold. This makes the application ignore the 
service request when assessing the priority of work for agents.

To set up a service request Status:
1. Navigate to Setup > Service Requests > Service Request Status.

The Service Request Statuses window appears.
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2. Enter a name in the Status field. The text you enter here is what is displayed in 
the Status List of Values (LOV) in the Service Request window.

3. By selecting the Responded check box, you can set a status to automatically fill 
in the date and time in the Responded On field of the service request. The date 
and time reflect the time the agent sets the service request to this Status. 

4. By selecting the Resolved check box, you can set a status to automatically fill in 
the date and time in the Resolved On field of the service request. The date and 
time reflect the time the agent sets the service request to this status. 

5. Select the Final check box if you want the application to: 

■ Enter the date in the Closed field of a service request set to this status. 

The Closed field appears in the Service Request window header.

■ Disable autoassignment of service request ownership for service requests 
set to this status.

Autoassignment ignores all service requests set to a status flagged as Final. 
(For information on automatic service request ownership assignment, see 
Chapter 2, "Implementing Service Request and Task Assignment".)

■ Terminate any instances of the workflow you have associated with the 
service request of that type in the Service Request Type window. 
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You can set up a service request to automatically launch a workflow 
whenever an agent creates or updates it. Because each update launches a 
new instance of the workflow, each service request can have multiple 
instances of the workflow running at the same time. (See Setting Up Service 
Request Types on page 1-15 for details about associating workflows to 
Service Request Types.)

If a workflow is running and an agent sets the service request to a status 
you flag as Final, then the application takes one of two possible actions:

* Warns the agent with a message that an instance of the workflow is 
running and permits the agent to terminate the workflow by clicking a 
button in the message text. 

* Aborts any instances of the workflow automatically without warning 
the agent. 

If you wish to abort the workflows automatically without the warning 
messages, then you must select the Abort Workflow on Final Status without 
Warning check box in the Service Request Type window. If you leave this 
check box unselected, then agents always receive a warning.

6. If you wish to use the status you are creating as the initial status of any type of 
service request, then select the Initial check box. You may wish different service 
requests types to have a different initial statuses. For example, you may wish to 
designate a service request created by a customer using Oracle iSupport as 
“Opened by customer” and one opened by service agent in the Service Request 
window as “New”.

7. If you are using the Next Work functionality to deliver the next service requests 
to an agent, then you may wish to designate a status as on hold by selecting the 
On Hold check box. An on-hold status indicates that work on the service 
request is temporarily suspended because an agent is waiting for more 
information from the customer or for spare parts to become available, for 
example. 

Automated assignment permits agents to request the next most urgent piece of 
work from the Universal Work Queue by clicking the Next Work button.

Note: You must designate a status as initial here, if you want to 
use it as the initial status of service requests for a Status Group.
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Placing a service request on hold excludes the service request from the pool of 
work evaluated by the application when the agent requests the next highest 
priority work item. 

Without an on-hold status, the application will deliver the same service request 
over and over again if it happens to be the item with the highest priority.

See the Implementing Service Request and Task Assignment chapter of this 
guide for more information.

8. The Classification field is reserved for future functionality. It will be used for 
grouping service request statuses in management reports. 

9. Optionally, enter Start and End dates for the status if you wish to restrict status 
use. By specifying a future start date you can delay the use of a new status. You 
can inactivate a status by setting an end date. 

10. A check mark in the Predefined check box indicates the status was seeded by 
Oracle. You cannot delete a predefined status, but you can modify its wording 
or remove it from use by entering an end date. 

Oracle includes the following predefined statuses:

■ Waiting

■ Clear

■ Closed

■ Open

11. If you wish to assign a color to the text the support agent sees in the Status field 
of the Service Request window, then select the color using the Text Color field.

12. If you wish to restrict users from updating certain types of information, then 
select one or more of the Service Request Status Restriction check boxes:

■ Disallow Request Update: Prevents users from updating the service request.

■ Disallow Task Update: Prevents users from updating tasks related to the 
service request in the Service Request window. (Tasks can still be modified 
from within the Oracle Task user interface, however.)

■ Disallow Charge Update: Prevents users from updating charges.

■ Disallow Owner Update: Prevents users from updating service request 
ownership.

■ Disallow Product Update: Prevents users from updating product 
information.
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■ Disallow Charge: Prevents users from entering charges information.

13. Save your changes.

14. Repeat the above procedure for all the statuses you need for all of your Service 
Request Types.

You are now ready to group the statuses you have created into Status Groups 
specific to each Service Request Type according to the procedure outlined in 
Creating and Updating Status Groups on page 1-10.

1.4 Creating and Updating Status Groups
Use Status Groups to create lists of statuses to be used with different Service 
Request Types. Status Groups also make it possible for you to determine the initial 
status for a service request and the permissible status transition rules for each status 
in the group. This topic covers:

■ Viewing and Updating Status Groups

■ Creating New Status Groups

■ Adding a Status to a Status Group

■ Creating Transition Rules for Statuses in a Status Group

For more information about Status Groups and how they relate to service request 
statuses and types see About Configuring Service Requests to Model Business 
Processes on page 1-2.

1.4.1 Viewing and Updating Status Groups
Use this procedure to view existing Status Groups on the Status Group Summary 
window. This window provides the launching point for updating, copying, and 
creating new Status Groups.

To view and update Status Groups:
1. Navigate to Setup > Service Requests >Status Groups and Transitions.

The application displays the Status Group Summary page in a new browser 
window. The page lists the existing Status Groups.
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2. If you wish to sort the existing Status Groups by name, description, start, and 
end dates, then click on the appropriate column heading.

3. If you wish to edit an existing Status Group, then click Update (the pencil icon).

4. If you wish to make a copy of an existing Status Group so you can use it as a 
template for other Status Groups, then click Duplicate (the icon with the two 
sheets of paper.)

5. If you wish to create a new Status Group, then click Create New Group and 
follow the procedure outlined in Creating New Status Groups on page 1-11.

1.4.2 Creating a New Status Group
Use this procedure to create a new Status Group.

Prerequisites
You must create statuses first following the procedure outlined in Setting Up 
Service Request Statuses on page 1-6.
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To create a new Status Group:
1. Navigate to Setup > Service Requests > Status Groups and Transitions.

2. Click Create New Group in the Status Group Summary page.

The Status Group Definition page appears.

3. Enter a name for the group in the Name field.

4. Enter an optional description.

5. Enter start and end dates if you wish to restrict the availability of this Status 
Group.

6. Using the Add Another Row button, add the statuses for this group. (See 
Adding a Status to a Status Group on page 1-13 for details.)

The Initial and Final flags and the rest of the status information is read only. It 
can only be updated while editing the statuses themselves. 

7. After you have completed adding all of the statuses for your group click Apply 
to save.

8. Scroll down to the Default Initial Status region and select the default status for 
new service requests for this Status Group. You are limited to selecting statuses 
with the Initial flag set to Y. 

9. Click Apply.
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1.4.3 Adding a Status to a Status Group
Use this procedure to add a status to a Status Group you are creating or editing in 
the Status Group page.

Prerequisites
You must be in the process of creating or editing a Status Group in the Status Group 
page.

To add a status to a Status Group you are editing or creating:
1. Click Add Another Status.

2. Click Search for Status (flashlight icon) to the right of the Status field.

The Search and Select Status page appears. 

3. Click Go to display all statuses or enter a partial name first for a short list 
matching your search criteria.

4. Select the radio button corresponding to the status you wish to add.

5. Click Select.

The status you selected appears in the Status Group page.

Note: You can only add one status at a time.
Implementing Service Requests 1-13



Creating and Updating Status Groups
1.4.4 Creating Transition Rules for Statuses in a Status Group
Use this procedure to create status transitions for a Status Group you are editing or 
creating. 

Prerequisites
■ You must be in the process of creating or editing a Status Group in the Status 

Group page.

■ You must add a status to the group before you can create a transition rule for it.

To add a transition rule for a Status Group you are editing:
1. Scroll down to the Transitions region of the Status Group page.

2. Click Add Another Row.

3. A new row opens.

4. To enter the status to transition from, click the flashlight icon to the right of the 
Status From field.

5. The Search and Select From page appears.

6. Click Go to display all statuses or enter a partial name first for a short list 
matching your search criteria.

7. Select the radio button corresponding to the status you wish to add.

Note: If you wish to use the automatic status update feature 
offered by service request relationships, then the Status Group must 
include the seeded statuses of “Waiting”, “Cleared”, and “Closed”.

If you are setting up transition rules, then the Status Group must 
also permit all transitions to the status of “Closed”. This is because 
an agent can indicate one service request is a duplicate of a second 
service request, an action that automatically sets the first service 
request to the status of “Closed.” A transition rule you enter here 
takes precedence and can prevent this automatic resetting of 
statuses. See Setting Up Service Request Linking Through 
Relationships on page 1-71 for more information.

Note: You can only add one status at a time.
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8. Click Select.

The status you selected appears in the Status From field in the Status Group 
page.

9. Enter the status you wish to transition to in the Status To field. You can do this 
by clicking on the flashlight icon to the right of the Status To field. The 
procedure is the same as for the Status From field.

10. Click Apply.

11. If you wish to delete a rule, then click Delete (the trash can icon) and click 
Apply.

1.5 Setting Up Service Request Types
Use this procedure to set up Service Request Types which your agents will use to 
categorize customer problems. You can set up Service Request Types to:

■ Channel service requests to different groups in your organization by associating 
Service Request Types with responsibilities.

■ Trigger a workflow whenever a service request of that type is created. 

■ Limit agents to using a subset of service request statuses by linking a Service 
Request Type to a Status Group.

■ Enable contractual discounts by mapping a Service Request Type to a business 
process.

■ Specify Service Request Types to be used for customers to log service requests 
on the Web using Oracle iSupport.

Prerequisites:
You must create the object you wish to link to the Service Request Type first. For 
example, if you wish to link a Service Request Type to a Status Group, then you 
must create the Status Group first. 

To set up Service Request Types:
1. Navigate to Setup > Service Requests > Request Types.

The application displays the Service Request Types window.
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2. For each Service Request Type you wish to create:

a. Enter a name of the Service Request Type in the Type field. This is the text 
agents see in the Type list of values in the Service Request window.

b. If you have implemented Oracle Contracts, then select a business process 
from the Business Process list of values. Selecting the business processes 
links Charges to Oracle Contracts to determine the type of coverage and 
discounts for any billable work performed on behalf of the customer.

c. Optionally, enter Start and End dates to control the use of Service Request 
Types. By specifying a future start date you can delay the use of a new 
Service Request Type. You can inactivate a type by setting an end date. 

d. Enter a description for the Service Request Type.

e. If you have set up a Status Group suitable for this Service Request Type, 
then select it using the Status Group Name LOV. You can reuse the same 
Status Group for multiple Service Request Types. If you leave this field 
blank, then users will be able to use all statuses you have defined.
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f. If you wish to enable this Service Request Type for use with Oracle 
Enterprise Asset Management then select the Asset Maintenance check box. 

g. If you wish to enable it for Oracle Complex Maintenance, Repair, and 
Overhaul, then select the Complex Maintenance check box.

h. If this Service Request Type is being used in Oracle iSupport, then you can 
display an image to help customers select the correct type during request 
creation. For example, a computer hardware company may present users 
with an icon of a printer for the Printer Trouble and an icon of a monitor for 
Monitor Trouble. To display the image, upload the image to APPL_TOP in 
the OA_MEDIA directory and enter the name in the Image File Name field.

i. Optionally, you can associate a workflow with a Service Request Type by 
selecting a workflow using the Workflow LOV.

Oracle TeleService includes three seeded workflows which are a part of the 
SRVEREQ item type and appear in the LOV:

* Call Support Process

Use this workflow only under special circumstances described below.

* Customer Support Event Process 

Do not use this workflow. It is used by Oracle TeleService internally.

* Duplicate Check and Autotask Create for iSupport and Email Center 
Created SR

Use this workflow to check for potential duplicate service requests for 
service requests created in Oracle iSupport and Oracle eMail Center.

These three workflows are described in detail below:

* Call Support Process: This workflow notifies the individual service 
request owner each and every time a service request of this type is 
created or updated. The owner can set the status of the service request 
to closed by clicking the Resolved button on the notification.

Note: If you are restricting the use of Service Request Types by 
Responsibility, then you can specify different Status Groups for 
every Responsibility that can use a particular type. This mapping, 
done in a separate setup, supersedes any mapping you make here. 
See Restricting Access to Service Request Information on page 1-19.
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In this release, this workflow has been superseded by a more flexible 
notifications process which implementers can use to selectively notify 
both service request owners and customer contacts of service related 
events. (See Setting Up Notifications on page 1-79). You will want to 
associate this workflow to a type only if the resolution functionality is 
important to you. 

If you associate this workflow with a Service Request Type and also use 
the new notifications feature, owners may receive two notices for the 
same event.

* Customer Support Event Process: This process notifies service request 
owners and contacts of different events related to service requests and 
is used by the notifications feature of Oracle TeleService. See Setting Up 
Notifications on page 1-79.

* Duplicate Check and Autotask Create for iSupport and Email Center 
Created SR: Use this workflow to check for potential duplicate service 
requests for service requests created in Oracle iSupport and Oracle 
eMail Center.

This workflow process checks for potential duplicate service requests 
when customers create service requests using Oracle iSupport or agents 
create service requests from within Oracle Email Center. If the work-
flow finds a potential duplicate, it notifies the service request owner. 
When customers create a service request of a type set up with extended 
attributes, the program instead alerts the individual you specify in the 
Alert Recipient field of the Service Request Attributes Configuration 
window. You must be sure to select the autolaunch check box to enable 
this process.

j. If you have associated a workflow, then select one or both of the related 
check boxes:

* Auto Launch Workflow: Launches workflow automatically when a 
service request is created and updated.

* Abort Workflow on Final Status without Warning: Selecting this check 
box aborts without warning any instances of the workflow you have 
associated with this Service Request Type whenever an agent sets that 
service request’s status to a status that is flagged as Final in the Service 
Request Statuses window. (See Setting Up Service Request Statuses on 
page 1-6.)
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If you do not select this check box, then the agent always receives a 
warning if a workflow is about to be terminated and has a chance to 
cancel the abort.

k. If you wish to make this Service Request Type available to customers who 
are creating service requests on the Web using Oracle iSupport, then select 
the Web Entry check box.

3. When you have completed creating your Service Request Types, then click Save 
on the toolbar.

4. If you have selected the Auto Launch Workflow check box for any Service 
Request Type, then you must set the service system profile option Service: Auto 
Launch Workflow to Yes.

1.6 Restricting Access to Service Request Information
This group of topics explains how you can restrict user access to service request 
data.

■ About Service Request Security on page 1-19 provides an overview.

■ Setting Up Service Request Data Security on page 1-22 outlines the major steps.

■ Creating Your Own Custom Security on page 1-27 provides guidelines for 
organizations wishing to set up their own custom security.

The rest of the topics provide detailed procedures:

■ Mapping Responsibilities to Service Request Types on page 1-22

■ Turning Security On or Off on page 1-26

1.6.1 About Service Request Security
The standard service data security provided with your application, makes it 
possible for you to restrict by Responsibility which users can create and access what 
types of service requests and related information. 

To set it up, you need to map responsibilities to Service Request Types and turn the 
standard security on.

The mappings prevent users from creating, viewing, and modifying all service 
request data related to the Service Request Types not mapped to their 
Responsibility. This includes service request tasks, notes, and interaction history. It 
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even prevents users from viewing relationships of a service request to other service 
requests of types they cannot access. 

Users without access to a Service Request Type are also excluded from the lists of 
resources other agents use to assign service request ownership and tasks for that 
Service Request Type.

The standard service data security is turned off by default. When you set up the 
Responsibility mappings and turn it on, it secures service request data not just in 
Oracle TeleService, but in all applications that use service requests. (See How 
Turning on Standard Service Security Impacts Other Applications on page 1-20.)

Turning service security on or off does not affect objects such as tasks and notes that 
are not attached to service requests.

Service data security is built using standard Oracle applications data security. This 
means you can create your own custom security by following the procedures 
outlined in the Managing Oracle Applications Security chapter of the Oracle 
Applications System Administrator’s Guide. 

1.6.1.1 How Turning on Standard Service Security Affects Other Applications
Turning on security affects all applications and Oracle application foundation 
modules that use service requests to different degrees:

■ Oracle iSupport

Customers creating service requests on the Web are subject to Oracle iSupport’s 
own security which is based on the customer: customer contacts have access 
only to service requests for their organization. 

You can create Responsibility to Service Request Type mappings to prevent 
customer contacts from creating service requests of types not mapped to their 
Responsibility. However, this restriction is for creation only. Those contacts are 
not restricted from viewing or updating any service request permitted by 
Oracle iSupport security.

When agents work with the customer-created service requests in Oracle 
TeleService, however, they are subject to full standard security restrictions (the 
same as for any other service request.)

■ Tasks

Tasks enforces standard service security only partially. Task standalone forms 
display all service request tasks regardless of the Service Request Type. 
However, agents are prevented from making updates in all Task windows. 
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■ Assignment Manager

The Assignment Manger enforces standard service security fully. This means 
this module assigns only resources that have access to the Service Request Type.

■ Oracle Inbound

If you have set up an Interactive Voice Recognition (IVR) system to route calls 
based on customer entering service request numbers, then these calls are routed 
only to agents who have access to service requests of this type.

Agents transferring calls regarding service requests to other agents are 
restricted to transferring the calls only to agents with access to the Service 
Request Type.

All telephony implementations must map at least one agent in the call center to 
each Service Request Type coming through the call center.

■ Universal Work Queue

The UWQ enforces standard security fully. This means:

* Work queues of each agent display only those service requests of types 
the agent can access. 

* The number of service requests displayed in each node sums up only 
information agents can access. 

* The tasks nodes display all tasks, including all service request tasks. 
However, the agent cannot view the details of service request tasks they 
cannot access.

* The Next Work and Request Work buttons assign only work the user 
can access. 

■ Oracle Depot Repair

Oracle Depot Repair enforces service security fully.

■ Oracle Enterprise Asset Management

Users associating work orders to service requests can only see and select those 
service requests of types they can access.

■ Oracle Install Base

Oracle Install Base usually permits users to view all the service requests logged 
for a customer’s product. Turning the standard security restricts that view to 
those service requests of types mapped to the Responsibility.
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■ Oracle Daily Business Intelligence

With standard security on, this application prevents users form seeing 
information on Service Request Types not tied to their Responsibility.

1.6.2 Setting Up Service Request Data Security
Use this high-level procedure to guide your implementation of the service request 
security. 

To set up data security for service request data:
1. If you wish to use the standard security provided with your application, then:

a. Navigate to Setup > Service Requests > Type-Responsibility Mapping and 
map each Responsibility to the Service Request Types you wish users to 
access. Unmapped responsibilities cannot view or modify any service 
requests or related objects. For detailed procedures, see Mapping 
Responsibilities to Service Request Types on page 1-22.

b. Navigate to Setup > Service Requests > Service System Parameters and turn 
standard security on. For details, see Turning Security On or Off on 
page 1-26.

2. If you do not wish to implement standard security, and instead wish to 
implement custom data security of your own, then:

a. Create custom security according to procedures described in the Managing 
Oracle Applications Security chapter of the Oracle Applications System 
Administrator’s Guide. See Creating Your Own Custom Security on page 1-27 
for guidelines.

b. Navigate to Setup > Service Requests > Service System Parameters and turn 
the custom security on by selecting Custom Security from the Service 
Request Security drop-down list. For details, see Turning Security On or Off 
on page 1-26.

1.6.3 Mapping Responsibilities to Service Request Types
This group of procedures describes how to create the mappings between 
responsibilities and Service Request Types:

■ Displaying Existing Responsibility Mappings on page 1-23

■ Creating a New Responsibility Mapping on page 1-24
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■ Updating a Responsibility Mapping on page 1-25

1.6.3.1 Displaying Existing Responsibility Mappings
Use this procedure to view existing Responsibility mappings. 

To display existing mappings:
1. Navigate to Setup > Service Requests > Type-Responsibility Mapping.

The Service Responsibility Setup page appears in a browser window listing any 
existing mappings.

2. By default, the page displays only active mappings. You can change the view by 
making an alternate selection from the View drop-down box:

■ All: Includes active, inactive, and planned mappings.

■ Planned: Limits the display to mappings that are not yet in effect.

■ Active: (the default) Displays only mappings that are currently in effect.

3. From this page you can:

■ Create a new Responsibility mapping by clicking Add Responsibility. See 
Creating a New Responsibility Mapping on page 1-24 for details.

■ Update an existing mapping by clicking Update. See Updating a 
Responsibility Mapping on page 1-25.

■ Delete a mapping by clicking Remove. 
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1.6.3.2 Creating a New Responsibility Mapping
Use this procedure to create a new Responsibility mapping. 

To map a Responsibility:
1. Navigate to Setup > Service Requests > Type-Responsibility Mapping.

The Service Responsibility Setup page appears in a browser window.

2. Click Add Responsibility.

The Step 1 Add Service Responsibility page appears.

3. Select the Responsibility you wish to map using the Responsibility List of 
Values.

4. Use the Classification drop-down list to specify if the mapping is intended for 
agent-facing service applications (Service Provider) or for Oracle iSupport (Self 
Service User).

If you select Self Service User, you are restricted to mapping only those Service 
Request Types that have been set up in the Service Request Types window with 
the Web Entry check box selected. See Setting Up Service Request Types on 
page 1-15 for details.

5. Select the type of mapping you wish to create using the Access drop-down box:

■ If you wish to grant this Responsibility access to all Service Request Types, 
then select All Request Types. If you have selected Self Service User in the 
last step, then you are mapping the Responsibility only to those Service 
Request Types that are specified for web entry.
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■ If you wish to enable access for this Responsibility to one or more Service 
Request Types, then select Select Service Request Type.

6. Click Continue.

Step 2 Map Responsibility to Service Request Types page appears.

7. If you selected All Request Types, the page lists all of the Service Request Types. 
If you wish to limit any of the Service Request Types to using a specific a Status 
Group, then: 

a. Select the Status Group. 

The selection you make here overrides for users of this Responsibility any 
mapping you have made in the Service Request Statuses window. If you do 
not make a mapping here, the application automatically uses any mappings 
you have entered in the Service Request Types window.

b. Click Finish.

8. If you selected Select Request Type, then select the types:

a. Click Add Another Row.

b. Select a Service Request Type.

c. If you wish to limit this Responsibility to using a specific a Status Group, 
then select it using the Status Group drop-down list. The selection you 
make here overrides for users of this Responsibility any mapping you have 
made in the Service Request Statuses window. If you do not make a 
mapping here, the application automatically uses any mappings you have 
entered in the Service Request Types window.

d. Optionally, enter dates in the Start Date and End Date fields if you to 
restrict the availability of this mapping.

e. Click Add Another Row to add the next type or Finish to save your entries 
and return to the Service Responsibility Setup page.

1.6.3.3 Updating a Responsibility Mapping
Use this procedure to update a Responsibility to Service Request Types mapping.

Note: Granting All Request Types access provides access not only 
to all existing Service Request Types, but also all of those created in 
the future.
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To update a Responsibility mapping:
1. Navigate to Setup > Service Requests > Type-Responsibility Mapping.

The Service Responsibility Setup page appears in a browser window.

2. If you wish to change the Classification or Access type for this mapping, then:

a. Click Update Responsibility.

The Update Responsibility Setup window appears.

b. Here you can select a different access type, and classification.

c. Click Apply. 

You are returned to the Mapping of Responsibility to Service Request Types 
window.

3. Click Update next to the mapping you wish to update.

The Mapping of Responsibility to Service Request Types page appears.

On this page you can:

■ Remove a Service Request Type from the mapping, by entering an end date.

■ Specify a service request Status Group.

■ Map additional types using the Add Another Row button.

1.6.4 Turning Security On or Off
Use this procedure to turn on or off service request security.

Prerequisites:
You must map Service Request Types to responsibilities or create your own custom 
security framework before turning security on as a second step. Turning security on 
as a first step prevents all users from accessing service requests, tasks, and other 
related business objects.

To turn on security:
1. Navigate to Setup > Service Requests > Service System Parameters.

The application displays the Service System Parameters page in a new browser 
window.
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2. Using the Service Request Security drop-down box, select one of the following:

■ No Security, if you wish to turn off security and make all service requests 
and related tasks available to users.

■ Standard Security, if you wish to enable security supplied with the 
application.

■ Custom Security, if you wish to disable the seeded security and turn on 
your own custom security.

3. Click Apply.

1.6.5 Creating Your Own Custom Security
Your organization can create its own custom security framework according to the 
concepts and procedures described in the Managing Oracle Applications Security 
chapter of the Oracle Applications System Administrator’s Guide.

For example, you may wish to:

Note: Only the Security region relates to security. The second Self 
Service region, is for restricting customer access to Service Request 
Types during service request creation in Oracle iSupport. See 
Enabling Responsibility Mappings for Oracle iSupport on 
page 1-28.
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■ Restrict the ability of users to view service requests by status.

Limiting users to only viewing service requests with the status of Open, for 
example. You can do so, by inserting a where clause in the SQL statement of the 
object instance set predicate.

■ Restrict access to service requests, tasks, and other business objects to specific 
responsibilities or individuals

You can accomplish this by selecting a more restricted grantee such as a 
Responsibility or a resource. By default, all seeded grantees are Global.

The custom security you create replaces the standard security provided with your 
application. 

You can use the seed data for standard security as a guide for creating custom 
security. See Standard Service Security Seed Data on page E-9 lists standard security 
seed data you can use as a guide.

1.7 Enabling Responsibility Mappings for Oracle iSupport
You can restrict customer contacts from creating service requests by Service Request 
Type. To do so, you create the same Responsibility to Service Request Type 
mappings used in standard service security and then turn on the mappings using 
the procedure below.

Prerequisites
You must map Oracle iSupport responsibilities to Service Request Types that have 
been specified as Web Enabled. (See Mapping Responsibilities to Service Request 
Types on page 1-22.)

To use mappings to restrict request creation in Oracle iSupport:
1. Navigate to Setup > Service Requests > Service System Parameters.

The application displays the Service System Parameters page in a new browser 
window.

2. To restrict Oracle iSupport users to creating service requests of types mapped to 
their Responsibility, select the Only Service Request Types Mapped to User’s 
Responsibility radio button. This restricts only the creation of service requests; 
not the ability to access existing requests. 
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3. Selecting All Web Enabled Service Request Types permits users to create 
service request of any type specified as Web Entry enabled. Any mappings you 
have created are disabled.

4. Click Apply.

1.8 Setting Up Service Request Severities
You define service request severities to assist in setting service request priority. The 
service request severity reflects the support agent’s perception of the reported 
service request. Service request severity is a mandatory field in the service request.

Following are some examples of service request severities:

■ High

■ Medium

■ Low

To set up a service request severity:
1. Navigate to Setup > Service Requests > Request Severities. 

The Service Request Severities window appears.

Note: You can use the mappings for this purpose even when 
standard security is turned off. 
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2. Enter a severity name in the Severity field in the header of the Service Request 
window.

3. Enter a numerical value in the Importance Level field. The importance level 
indicates the importance of this particular severity with respect to other defined 
severities. 

If you are implementing automatic workload balancing for automatic work 
assignment, then you must group the severities into four categories: 1 through 
4, where 1 are the severities of the highest priority and 4 are those with the least 
priority. See the Implementing Service Request and Task Assignment chapter of 
this guide for more information.

4. Enter an optional description of the severity.

5. If you are enabling the pull version of autoassignment where agents assign 
work to themselves in the Universal Work Queue using the Get Work and Next 
Work buttons, then you must use the Priority Code LOV to select one of the 
four priorities: critical, high, medium, or low.

The application uses the priority you enter here together with the service 
request due date to calculate the most urgent work item to assign to agents 
when they click the Get Work and Next Work buttons.

The Priority Code maps onto the Global Priority Levels in the Universal Work 
Queue. 

For more information on autoassignment topics, see the Implementing Service 
Request and Task Assignment chapter of this guide.

6. Optionally, enter Start and End dates to control the use of severities. By 
specifying a future start date you can delay the use of a new severity. You can 
inactivate a severity by setting an end date.

7. Optionally, select a text color in the Text Color field. The severity will be shown 
in this color on the service request window.

8. If a descriptive flexfield has been enabled for this form, select the appropriate 
values.

9. Save your service request severity.
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1.9 Setting Up Service Request Urgencies
You define service request urgencies to provide an indicator of the customer’s 
perception of the urgency of the service request. Urgency is an optional field in 
service requests.

Following are some examples of service request urgencies:

■ Inoperable

■ Partially Operable

■ Not Urgent

To set up service request urgencies:
1. Navigate to Setup > Service Requests > Request Urgencies.

The Service Request Urgencies window appears.

2. Enter an urgency name in the Urgency field. The urgency name appears in the 
Urgency list of values in the Service Request Workbench tab.

3. Enter a numerical value in the Importance Level field. The importance level 
indicates the importance of this particular urgency with respect to other defined 
urgencies and must contain a unique value.

4. Enter a description of the urgency.
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5. Optionally, enter Start and End dates to control the use of urgencies. By 
specifying a future start date you can delay the use of a new urgency. You can 
inactivate an urgency by setting an end date.

6. Select a text color in the Text Color field. The urgency will be shown in this 
color on the service request window.

7. If a descriptive flexfield has been enabled for this form, select the appropriate 
values.

8. Save your service request urgency.

1.10 Defining Service Request Problem Codes
Service request problem codes provide service agents with a standard way to 
classify customer requests. 

For example:

■ Hardware Problem

■ Software Problem

■ Shipping Damage

Agents can enter one problem code per service request using the Problem Code list 
of values. Entry is optional by default.

Problem codes are implemented using the standard Oracle Applications lookup 
code of type REQUEST_PROBLEM_CODE. The associated lookup codes are user 
definable. 

Prerequisites
If you plan to use a large number of problem codes in your organization, you can 
restrict agents to seeing only those problem codes that are relevant to the customer 
problem they are resolving. This is accomplished by mapping problem codes to 
Service Request Types, items, and item categories. If you plan to create the 
mappings, you should plan them out before creating the problem codes. See 
Restricting the Use of Problem Codes on page 1-34.

To set up service request problem codes:
1. Navigate to Setup > Service Requests > Problem Codes.

The Oracle Service: Service Request Problem Codes Lookups window appears. 
displaying all problem codes.
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2. Enter a problem code in the Code field.

3. Enter a meaning. A meaning is a brief description of the code.

4. Optionally, enter a full description of the code in the Description field.

5. Optionally, enter Start and End dates to control the use of problem codes. By 
specifying a future start date you can delay the use of a new problem code. You 
can inactivate a problem code by setting an end date.

6. The Tag field is not used for problem codes.

7. Select the Enabled check box to make the code is available for use.

8. Optionally, enter the descriptive flexfield, if defined.

9. Save your problem code.

10. After you complete entering your problem codes, you may wish to restrict their 
use by mapping them to Service Request Types, inventory items, and item 
categories. See Restricting the Use of Problem Codes on page 1-34.
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1.11 Restricting the Use of Problem Codes
This group of topics explains how you can make it easier for agents to select the 
correct problem code for a customer problem by restricting their use. It covers:

■ About Mapping Problem Codes on page 1-34

■ Displaying Problem Code Mappings on page 1-35

■ Viewing Unmapped Problem Codes on page 1-37

■ Creating a New Problem Mapping on page 1-38

■ Updating the List of Problem Codes for a Mapping on page 1-39

■ Removing Unwanted Mappings From Use on page 1-40

1.11.1 About Mapping Problem Codes
Problem codes permit agents to accurately classify customer problems. Because the 
list of all problem codes can be large, you can use the procedures in this section to 
narrow an agent’s choice to only those problem codes appropriate to each customer 
problem. You can do this by mapping problem codes to Service Request Types, 
inventory items (individual items or categories), or a combination of the two.

For example, if you have customers calling in with billing questions or computer 
hardware problems, then you may wish to map the available problem codes to the 
two Service Request Types to prevent an agent from accidentally making the wrong 
problem code entry. You do not want an agent to enter “Incorrect labor rate” in a 
service request about a faulty hard drive, for example, or “Replacement needed” for 
a billing question.

You may wish to restrict the use of problem codes further by inventory item 
category to prevent an agent from using the wrong problem code for a particular 
product, for example, using “New battery required” for a service request that 
involves the replacement of the hard drive. 

If you do not create a mapping for a problem code, agents can use it in any service 
request. 

You can map problem codes to the following valid permutations:

■ A Service Request Type alone

■ An inventory item alone

■ An inventory item category alone
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■ A Service Request Type and an inventory item

■ A Service Request Type and an inventory item category

Example
Suppose you create eight problem codes, A through H, and two mappings: 

■ Mapping 1: Problem codes A, B, and C to Service Request Type T1

■ Mapping 2: Problem codes D and E to T1 and inventory item P1

You leave problem codes F, G, and H unmapped.

Here are the available problem codes for an agent creating a service request: 

■ If an agent does not enter either Service Request Type T1 or product P1, then 
the available problem codes are limited to the unmapped problem codes F, G, 
and H.

■ Agents entering item P1 with different Service Request Types are also limited to 
the unmapped problem codes.

There is no mapping defined for item P1 alone, so entering the item without the 
Service Request Type T1 does not make any difference.

■ If the agent selects Service Request Type T1 but does not enter the item P1, then 
the available problem codes are: A, B, and C as well as the unmapped problem 
codes F, G, and H.

■ If the agent selects type T1 and item P1, then the available problem codes are: 
A,B,C, D, and E as well as the unmapped problem codes F, G, and H.

A, B, and C are valid for Service Request Type T1 and all inventory items.

D and E are valid for the T1 and P1 combination. 

1.11.2 Displaying Problem Code Mappings
Use this procedure to view the existing problem code mapping setup.

To display problem code mappings:
1. Navigate to Setup > Service Requests > Problem Code Mapping.

The Problem Code Mapping page displays in a browser window listing any 
existing problem code mappings.
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2. Select a view from the View drop-down list:

■ Active: to view all mappings in effect.

■ All: to view all current, planned, and end-dated mappings.

■ Planned: to view only mappings that have a future start date. 

3. If you wish to create a new mapping, you can view a list of unmapped problem 
codes first and select those you wish to map by clicking Unmapped Problem 
Codes. Or, if you know which codes you want to map, you can skip this step 
and create the mapping directly by clicking Create Problem Code Mapping. 
See Creating a New Problem Code Mapping on page 1-38 for details.

4. If you wish to update the list of problem codes for an existing mapping, then 
click the Update Problem Code Mapping (the pencil icon) next to the item you 
wish to update. You cannot update the mapped objects, only the list of codes. 
See Updating the List of Problem Codes for a Mapping on page 1-39.

5. If you wish to disable a particular mapping or make it available only at a future 
time, then enter a date in the End Date or Start Date fields and click Apply. 
End-dating a mapping is useful if you have made an error in your setup as it 
frees up mapped problem codes for reuse.
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1.11.3 Viewing Unmapped Problem Codes
Use this procedure to view all of the unmapped problem codes and select a group 
of them for mapping.

Prerequisites
Display existing mappings by navigating to Setup > Service Requests > Problem 
Code Mapping

To view unmapped problem codes:
1. Click Unmapped Problem Codes in the Problem Code Mapping page.

The Unmapped Problem Codes page appears listing the codes available for 
mapping.

2. If you wish to create a mapping, then:

a. Select the codes you wish to map using the check boxes.

b. Click Create Code Mapping.

The Create Problem Mapping Page appears. There you can select the 
Service Request Type and item or item category combination for your 
mapping. See Creating a New Problem Code Mapping on page 1-38 for 
details. 
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1.11.4 Creating a New Problem Code Mapping
Use this procedure to create a new problem code mapping.

Prerequisites
■ You must first set up Service Request Types, problem codes, and inventory 

items, and item categories.

■ Display existing mappings by navigating to Setup > Service Requests > 
Problem Code Mapping.

To create a new problem code mapping:
1. There are two ways to create a problem code mapping from the Problem Code 

Mapping page:

■ You can view a list of problem codes that are not already mapped by 
clicking Unmapped Problem Codes and select those you wish to map. This 
method is preferable if you have many codes to map or are not sure which 
are available for mapping. See Viewing Unmapped Problem Codes on 
page 1-37.

■ If you know which problem codes you wish to map, then click Create 
Problem Code Mapping.

The Create Problem Mapping page appears.
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2. Select the object or combination of objects you wish to map. You can map 
problem codes to a Service Request Type alone or in combination with either an 
item or an item category: 

■ If you wish to map problem codes to a Service Request Type, then select the 
type using the Request Type list of values (the flashlight icon).

■ If you wish to map to an inventory item or an item category, then select 
either the Item or the Item Category radio button and use the list of values 
to make your selection.

3. If you wish to limit the availability of this mapping, then enter dates in the Start 
Date and End Date fields.

4. Enter any additional problem codes you wish to map. For each code:

a. Click Add Another Row.

b. Select the problem code using the Problem Code drop-down list.

5. If you wish to remove any mapped code, you can do so by clicking Remove. 
You can remove codes only before you save the mapping.

6. Click Apply when you are done.

1.11.5 Updating the List of Problem Codes for a Mapping
Use this procedure to update the list of problem codes for a mapping. You cannot 
modify the objects mapped to the codes, only add or remove problem codes from 
the list.

Prerequisites
Display existing mappings by navigating to Setup > Service Requests > Problem 
Code Mapping

To update the list of problem codes in a mapping:
1. Click Update Problem Code Mapping in the Problem Code Mapping page.

The Update Problem Mapping page appears listing existing mappings.

Note: The drop-down list lists all problem codes, including those 
already mapped. If you select a mapped code by accident, you will 
receive an error when saving this mapping.
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2. If you wish to remove an existing problem code, then enter an end date.

3. If you wish to add a problem code to the list, then:

a. Click Add Problem Codes.

Add Problem Codes page appears.

b. Click Add Another Row. 

c. Select the code you wish to add using the Problem Code drop-down list.

d. Repeat the above two steps for all of the codes you wish to add.

e. If you wish to remove any of the items you have added, you can do so by 
clicking Remove (the pencil with eraser and paper icon).

f. Click Apply when you are done.

4. Click Apply.

1.11.6 Removing Unwanted Mappings From Use
While you cannot delete mappings after you save them, you can remove mappings 
from use by entering a recent date in the End Date field on the Problem Code 
Mapping page.

To remove unwanted problem code mappings from use:
1. Navigate to Setup > Service Requests > Problem Code Mapping.

The Problem Code Mapping page displays in a browser window listing any 
existing problem code mappings.
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2. Enter a recent date in the End Date field of the mapping you wish to disable.

3. Click Update.

1.12 Setting Up Service Request Resolution Codes
Resolution codes provide a uniform way for agents to specify how a service request 
is resolved. For example:

■ Unit Replaced

■ Patch Sent

■ Documentation Sent 

Agents can enter one resolution code per service request using the Resolution Code 
list of values. Entry is optional by default.

Resolution codes are implemented using the standard Oracle Applications lookup 
code of type REQUEST_RESOLUTION_CODE. The associated lookup codes are 
user definable. 

Prerequisites
If you plan to use a large number of resolution codes in your organization, you can 
restrict agents to seeing only those that are relevant to the customer problem. This is 
accomplished by mapping resolution codes to problem codes, Service Request 
Types, items, and item categories. For information about mapping resolution codes, 
see Specifying the Use of Resolution Codes on page 1-42.

To set up service request resolution codes:
1. Navigate to Setup > Service Requests > Resolution Codes.

The Service Request Resolution Codes window appears displaying any existing 
resolution codes.
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2. Enter the resolution codes:

a. Click New in the toolbar.

b. Enter a single word as the code in the Code field. This is for internal use by 
the application.

c. Enter the wording you wish agents to see in the list of values in the 
Meaning field.

d. Optionally, enter a description in the Description field.

e. If you wish to restrict the availability of the code, then start or end dates. By 
specifying a future start date you can delay the use of a new resolution 
code. You can inactivate a resolution code by setting an end date.

f. The Tag field is not used for resolution codes.

g. Select the Enabled check box to make the code available for use.

h. Optionally, you can enter a descriptive flexfield if one has been set up for 
this purpose.

3. Save your resolution codes by clicking Save in the toolbar.

1.13 Specifying the Use of Resolution Codes
Resolution codes provide agents with a standard way of specifying in a service 
request the action taken to resolve a customer problem. The topics in this section 
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explain how you can reduce agent error and improve efficiency by specifying which 
resolution codes can be used with which Service Request Types. These are:

■ About Mapping Resolution Codes on page 1-43

■ Displaying Resolution Code Mappings on page 1-44

■ Viewing Unmapped Resolution Codes on page 1-45

■ Creating a New Resolution Code Mapping on page 1-46

■ Updating the List of Resolution Codes for a Mapping on page 1-48

■ Removing Unwanted Mappings From Use on page 1-49

1.13.1 About Mapping Resolution Codes
You can specify which resolution codes are relevant to which service requests by 
mapping resolution codes to problem codes, Service Request Types, inventory items 
(individual items or categories), or a combination of the three.

You can map resolution codes to the following valid permutations:

■ A Service Request Type alone

■ An inventory item alone

■ An inventory item category alone

■ A problem code alone

■ A Service Request Type and an inventory item

■ A Service Request Type and an inventory item category

■ A Service Request Type and a problem code

■ An inventory item and a problem code

■ An inventory item category and a problem code

■ A Service Request Type, an inventory item, and a problem code

■ A Service Request Type, an inventory item category, and a problem code

For example, if customers calling about their computer hard drives failing have 
drives from different manufacturers that are mutually incompatible, you may wish 
to create separate resolution codes for each manufacturer. Then, by creating a 
mapping for each problem code and drive manufacturer, you can ensure agents 
select the correct resolution code.
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Suppose you have three brands of hard drives Toshiba HD, IBM HD, and Seagate 
HD. You may wish to create three resolution code mappings:

This mapping ensures that agents select the correct resolution code for each hard 
drive make. 

Agents can use unmapped resolution codes in all service requests.

1.13.2 Displaying Resolution Code Mappings
Use this procedure to view the existing resolution code mapping setup.

To display resolution code mappings:
1. Navigate to Setup > Service Requests > Resolution Code Mapping.

The Resolution Code Mapping page displays in a browser window listing any 
existing resolution code mappings.

Mapping Problem Code Item Category
Mapped Resolution 
Codes

Mapping 1 Hard Drive Failed Toshiba HD ■ Replaced Drive T

■ Repaired Drive T

■ Reformatted Drive T

Mapping 2 Hard Drive Failed IBM HD ■ Replaced Drive IBM

■ Repaired Drive IBM

■ Reformatted Drive 
IBM

Mapping 3 Hard Drive Failed Seagate HD ■ Replaced Drive S

■ Repaired Drive S

■ Reformatted Drive S
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2. Select a view from the View drop-down list:

■ Active: to view all mappings in effect.

■ All: to view all current, planned, and end-dated mappings.

■ Planned: to view only mappings that have a future start date. 

3. If you wish to create a new mapping, you can view a list of unmapped 
resolution codes and select those you wish to map by clicking Unmapped 
Resolution Codes. Or, if you know which codes you want to map, you can skip 
this step and create the mapping directly by clicking Create Resolution Code 
Mapping. See Creating a New Resolution Code Mapping on page 1-46 for 
details.

4. If you wish to update the list of resolution codes for an existing mapping, then 
click the Update Resolution Code Mapping (the pencil icon) next to the item 
you wish to update. You cannot update the mapped objects, only the list of 
codes. See Updating the List of Resolution Codes for a Mapping on page 1-48.

5. If you wish to disable a particular mapping or make it available only at a future 
time, then enter a date in the End Date or Start Date fields and click Apply. 
End-dating a mapping is useful if you have made an error in your setup as it 
frees up mapped codes for reuse.

1.13.3 Viewing Unmapped Resolution Codes
Use this procedure to view all of the unmapped resolution codes and select a group 
of them for mapping.

Prerequisites
Display existing mappings by navigating to Setup > Service Requests > Resolution 
Code Mapping
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To view unmapped resolution codes:
1. Click Unmapped Resolution Codes in the Resolution Code Mapping page.

The Unmapped Resolution Codes page appears listing the codes available for 
mapping.

2. If you wish to create a mapping, then:

a. Select the codes you wish to map using the check boxes.

b. Click Create Resolution Code Mapping.

The Create Resolution Mapping Page appears. Complete your mapping by 
following the procedure Creating a New Resolution Code Mapping on 
page 1-38. 

1.13.4 Creating a New Resolution Code Mapping
Use this procedure to create a new resolution code mapping.

Prerequisites
■ You must first set up Service Request Types, problem codes, resolution codes, 

inventory items, and item categories.

■ Display existing mappings by navigating to Setup > Service Requests > 
Resolution Code Mapping

To create a new resolution code mapping:
1. There are two ways to create a mapping from the Resolution Code Mapping 

page:
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■ You can view a list of unmapped resolution codes by clicking Unmapped 
Resolution Codes and select those you wish to map. This method is 
preferable if you have many codes to map or are not sure which are 
available for mapping. See Viewing Unmapped Resolution Codes on 
page 1-37.

■ If you know which resolution codes you wish to map, then click Create 
Resolution Code Mapping.

The Create Resolution Code Mapping page appears.

2. Select the object or combination of objects you wish to map: 

■ If you wish to map resolution codes to a Service Request Type, then select 
the type using the Request Type list of values (the flashlight icon).

■ If you wish to map an inventory item or an item category, then select either 
the Item or the Item Category radio button and use the list of values to 
make your selection. 

■ If you wish to map a problem code, then select a problem code.

3. If you wish to limit the availability of this mapping, then enter dates in the Start 
Date and End Date fields.

4. Enter any additional resolution codes you wish to map. For each code:

a. Click Add Another Row.
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b. Select the code using the Resolution Code drop-down list.

5. If you wish to remove any mapped code, you can do so by clicking Remove. 
You can remove codes only before you save the mapping.

6. Click Apply when you are done.

1.13.5 Updating the List of Resolution Codes for a Mapping
Use this procedure to update the list of resolution codes in a mapping. You cannot 
modify the objects mapped to the codes, only add or remove resolution codes from 
the list.

Prerequisites
Display existing mappings by navigating to Setup > Service Requests > Resolution 
Code Mapping

To update the list of resolution codes in a mapping:
1. Click Update Resolution Code Mapping in the Resolution Code Mapping 

page.

The Update Resolution Code Mapping page appears listing existing mappings.

2. If you wish to remove a mapped resolution code, then enter an end date.

3. If you wish to add a resolution code to the mapping, then:

a. Click Add Resolution Codes.

Add Resolution Codes page appears.

b. Click Add Another Row. 

c. Select the code you wish to add using the Resolution Code drop-down list.

d. Repeat the above two steps for all of the codes you wish to add.

e. If you wish to remove any of the items you have added, you can do so by 
clicking Remove (the pencil with eraser and paper icon).

f. Click Apply when you are done.

Note: The drop-down list lists all resolution codes, including 
those already mapped. If you select a mapped code by accident, 
you will receive an error when saving this mapping.
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4. Click Apply.

1.13.6 Removing Unwanted Mappings From Use
While you cannot delete mappings after you save them, you can remove mappings 
from use by entering a recent date in the End Date field on the Resolution Code 
Mapping page. 

To remove unwanted resolution code mappings from use:
1. Navigate to Setup > Service Requests > Resolution Code Mapping.

The Resolution Code Mapping page displays in a browser window listing any 
existing resolution code mappings.

2. Enter a recent date in the End Date field of the mapping you wish to disable.

3. Click Update.

1.14 Capturing Additional Service Request Attributes 
This group of topics explains how to set up the capture of additional service request 
information (attributes) in a structured question and answer format at the time of 
service request creation. You can use the information for automatic duplicate 
checking and task creation. 

For a general explanation of attributes see About Additional Attributes on 
page 1-49.

For an overview of the setup steps see Overview of Attribute Setup on page 1-51.

The remaining topics explain individual setup steps:

■ Creating Prompts and Questions on page 1-51

■ Creating Lists of Value for the Answers on page 1-52

■ Setting Up Attributes for a Service Request Type on page 1-53

■ Enabling Attribute Capture in Oracle iSupport on page 1-56

1.14.1 About Additional Attributes
You can require agents or customers creating a service request to enter additional 
information in response to a set of prompts or questions. Obtaining additional 
information in this structured format is especially important for reporting problems 
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that do not involve inventory or installed base items and permits the application to 
take action based on the information provided.

For example, a government agency receiving a call about an abandoned vehicle 
must capture the make, model, color, and the license plate number so the towing 
service knows which vehicle to tow away and what tow truck to send to do the job. 

Based on the information entered, the application can:

■ Automatically create different tasks

For example, you can set up the application to create a task to send a different 
type of tow truck depending on whether the abandoned vehicle is a passenger 
car or a bus. 

■ Automatically check if the new service request is a duplicate

You can have the application automatically check past service requests for 
potential duplicates. Has anyone else called about an abandoned car with the 
same make, model, and color within the last ten days? 

You can capture the additional attributes for service requests created by agents in 
the Service Request tab of the Contact Center or by customers in Oracle iSupport. 

Note 1: The capture of additional attributes is not available for 
service requests created in the Service Request window or in other 
applications, including Oracle Depot Repair and Oracle eMail 
Center. Agents creating service requests in these modules may still 
see the same Service Request Types in the list of values, but they 
cannot enter the additional attributes.

Note 2: Some elements of the user interface in the setup windows 
refer to the Oracle Citizen Interaction Center or CIC rather than to 
Oracle TeleService. This is because the additional attribute 
functionality was developed by the Oracle Citizen Interaction 
Center which has become an integrated part of Oracle TeleService 
in this release. Not all of the terminology has been changed in setup 
windows.
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1.14.2 Overview of Attribute Setup
This overview summarizes setups for the capture of additional attributes. Follow 
the references in each step for detailed procedures. 

To set up the capture of additional service request attributes:
1. Set up the prompts or questions agents will see and lists of values they will use 

to select the answers:

a. Enter the prompts or questions in the REQUEST_RESOLUTION_CODE 
lookup. For example: “Is the vehicle blocking traffic?” or “License Plate 
Number.” See Creating Prompts and Questions on page 1-51.

b. Agents can either enter an attribute by typing it in or by making a selection 
from a list of values. 

If you wish to have agents make their entries using the list of values, then 
create a new lookup for each list of answers. See Creating Lists of Values for 
the Answers on page 1-52.

A list of values ensures consistency of entries and improves duplicate 
checking. Although the application can check for duplicates based on 
free-text answers, the matches must be exact, including capitalization and 
spacing. 

2. Navigate to Extended Attribute Configuration > Service Request Type 
Attributes and specify which questions and answers you wish to use for each 
Service Request Type. See Setting Up Attributes for a Service Request Type on 
page 1-53.

3. If you wish to have customers to fill in the same information when they create 
service requests using Oracle iSupport, then follow the steps described in 
Enabling Attribute Capture in Oracle iSupport on page 1-56.

1.14.3 Creating Prompts and Questions
Use this procedure to create the prompts or questions agents must answer for 
attribute capture.

To create the questions or prompts for capturing attributes:
1. Under the Application Developer Responsibility, navigate to Lookups > 

Application Object Library.

The Application Object Library Lookups window appears.
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2. In the Type field, use the Query Enter / Query Run method to display the 
lookup CUG_SR_TYPE_ATTRIBUTES.

3. Set up each question or prompt on a separate row (you can create additional 
rows by clicking New in the toolbar):

a. In the Code field, enter a unique code. This code is for internal use only and 
does not get displayed to agents or users.

b. Enter the text of the question or prompt in both the Meaning field and 
Description field.

The wording you enter in the Description field is what agents see. 

The Meaning field is displayed in the list of values you use to link the 
answers to the questions. For this reason you may wish to make the entries 
identical.

4. Click Save in the toolbar.

1.14.4 Creating the Lists of Values for the Answers
Use this procedure to create lookups with the lists of answers for questions you 
have defined. 

To define the list of answers:
1. Under the Application Developer Responsibility, navigate to Lookups > 

Application Object Library.

The Application Object Library Lookups window appears.

2. In the Type field, enter a name for the list of answers. This is the name that will 
appear in the list of values when you link the list to the prompt or question.

3. In the User Name field, enter a user-friendly name for the value list. 

4. Use the Application field LOV to select Oracle Citizen Interaction Center.

5. Optionally enter a description for this group of answers.

6. Set up the list of values in the table below the control region. You can create 
additional rows by clicking New in the toolbar as needed. For each value:

a. In the Code field, enter a unique code. This code is for internal use only and 
does not get displayed to agents or users.

b. Enter the wording in the Meaning and in the Description fields.
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The wording you enter in the Description field is what agents see in the list 
of values. 

7. Click Save in the toolbar.

1.14.5 Setting Up Attributes for a Service Request Type
Use this procedure to specify which attributes are to be captured for a Service 
Request Type. 

Prerequisites
Service Request Types must be defined and you must have completed the setup of 
both the prompts and of the lists of values agents will use to make their entries. 

To specify which attributes to capture for a Service Request Type:
1. Navigate to Extended Attribute Configuration > Service Request Type 

Attributes.

The Service Request Attribute Configuration window appears.

2. Use the Type LOV to select the Service Request Type you wish to set up. The 
description of the Service Request Type appears in the Description field.
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3. If you wish to validate the address by a user hook you have created, then select 
the Validate Address check box. The user hook can be read by a third party 
application that may have specific address format requirements. See 
Implementing the Validate Address User Hook on page 1-55.

4. Select the Address Mandatory check box if you wish to require agents to enter 
the incident address.

5. In the Service Request Attributes region, set up each attribute:

a. In the name field, select the prompt or question you defined in the CUG_
SR_TYPE_ATTRIBUTES lookup type. 

b. If agents must use the list of values for their entries, then use the List Name 
LOV to select the lookup where you defined the valid values. 

If you do not select a lookup here, agents will be permitted to make entries 
as free text.

c. If you have not selected a lookup in the previous step, then, optionally, 
enter a default value for this field. The default value is prefilled 
automatically in the attribute capture window and is saved if agents do not 
modify it.

d. Enter an integer in the Sequence field corresponding to the order you wish 
to present the prompt. The prompts are displayed in descending order. 

Entry in this field is optional. If you do not enter a sequence, the application 
displays the prompts in alphabetical order. 

If you specify an order, then the application displays those prompts with 
sequence first followed by any without a sequence in alphabetical order.

e. If you wish to make entry optional, then deselect the Mandatory check box. 
This check box is selected by default requiring agents to enter a value 
before saving the service request.

f. The Displayed check box must be selected to display the attribute to agents. 
This check box is selected by default.

6. Save your work.

Note: The agents see the text displayed in the Attribute 
Description, not the name.
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7. If you wish to set up duplicate checking based on the attributes you have 
defined, then follow the instruction described in Setting Up Automatic 
Duplicate Checking for Service Requests on page 1-58.

8. If you wish to have customers fill in the same attribute information when they 
create service requests using Oracle iSupport, then follow the steps described in 
Enabling Attribute Capture in Oracle iSupport on page 1-56.

1.14.5.1 Implementing the Validate Address User Hook
You must use a Global Information System application such as Oracle Spatial, for 
the storage, retrieval, and manipulation of spatial data. Oracle TeleService provides 
the user hook for the address validation against this data.

The following provides guidelines to implement the validate address user hook:

To implement the validate user address hook for Runtime Form
Upon commit, CUG_VALIDATE_ADDRESS_TYPE.Validate_Incident_Address_
Type (CUGVADTS.pls and CUGVADTB.pls) is called to validate address and 
jurisdiction; which then calls CUG_Validate_Address_Pkg.Validate_Incident_
Address (CUGVADIS.pls) for address validation, and CUG_Validate_Type_
Pkg.Validate_Incident_Type (CUGVTPIS.pls) for jurisdiction validation. 

■ You can customize or create the package body to implement address and 
jurisdiction validation logic in CUG_Validate_Address_Pkg.Validate_Incident_
Address and CUG_Validate_Type_Pkg.Validate_Incident_Type package. 

To implement the validate user address hook for Oracle iSupport
Citizen Interaction Center (CIC) has CugValidateAddressIF.java, 
CugValidateTypeIF.java, interface located under oracle.apps.cug.cm. This interface 
is the container of abstract methods that might be required to conduct address 
validation and jurisdiction check on a given incident address and incident type. 

■ You must set the following profiles to determine the customer implementation 
class for performing jurisdiction and address validation: 

■   CUG_ADDRESS_VALIDATION_CLASS 

■   CUG_TYPE_VALIDATION_CLASS 

Note: The previously mentioned pls files can be found at $CUG_
TOP/patch/115/sql. 
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The architecture (PL/SQL and java) is executed only if the Validate Address flag is 
selected for the service request type in the Service Request Attribute Configuration 
window of the CIC setup.

See Setting Up Attributes for a Service Request Type  on page 1-53.

1.14.6 Enabling Attribute Capture in Oracle iSupport
Use this procedure to make service request attribute capture available for use in 
Oracle iSupport. The procedure involves running two concurrent programs to map 
the attribute setup to iSupport templates. By doing so, customers entering service 
requests are asked to submit the same information as agents in Oracle TeleService. 

Prerequisites
■ Be familiar with running concurrent programs.

■ Set up attribute capture for Service Request Types first.

To enable attribute capture in Oracle iSupport:
1. Navigate to Sync SR Type to iSupport Template.

The Parameters and the CIC SR Type Attributes to iSupport Template Interface 
windows appear.

Note: CugValidateTypeAndAddress is a public java class which 
instantiates the interface implementation classes entered in the 
CUG_ADDRESS_VALIDATION_CLASS and CUG_TYPE_
VALIDATION_CLASS profiles. 
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2. Enter the start date. All attribute setups created on or since this date will be 
mapped to Oracle iSupport templates.

3. Click Submit and follow the standard procedures for running concurrent 
programs.

4. You must run a separate concurrent program to map each of the lookups (lists 
of values) that are used by your attribute setups. For each lookup:

a. Navigate to Sync SR Attribute Listname to iSupport.

The Parameters and the CIC SR Attribute Listname to iSupport Choice 
Interface windows appear.
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b. Enter the name of the lookup in the List Name field.

c. Click OK.

d. Submit the concurrent program following the standard procedure for 
running concurrent programs.

1.15 Setting Up Automatic Duplicate Checking for Service Requests
This group of topics explains how you can set up the application to automatically 
check for potential duplicates of the service request an agent or customer is creating. 

For an explanation of the different ways of checking for duplicates, see Duplicate 
Checking Overview on page 1-59.

For the general setup procedure see Setting Up Duplicate Checking on page 1-61.

The remaining topics provide the details for the setup of each method:

■ Setting Up Duplicate Checking by Customer and Item Details on page 1-62.

■ Setting Up Duplicate Checking by Service Request Attributes on page 1-63.

■ Setting Up Duplicate Checking by Item Instance or Serial Number  on 
page 1-64.
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1.15.1 Duplicate Checking Overview
The application flags existing service requests as potential duplicates if they are 
similar and were created within the time frame you specify. The application 
determines if the service requests are similar based on one or both of the following 
two types of information:

■ The customer and item

■ Incident address and the information captured through service request 
attributes

The two methods of checking for duplicates meet different business needs. If your 
organization services items owned by your customers, then you are likely to restrict 
the checking to the customer and item combination. If you are a government agency 
responding to reports of power outages or broken water mains, then you are likely 
to implement duplicate checking on the extended attributes and the incident 
address.

1.15.1.1 Duplicate Checking Based on Customer and Item
Suppose, for example, that an agent at a printer manufacturer receives a call from a 
customer contact reporting that a departmental printer is broken. The agent records 
the details about the problem and asks the caller for the printer’s serial number.

If the agent enters the serial number or instance number for the printer, the 
application performs the duplication check immediately and displays a list of any 
service requests that have been created for that printer within the period you 
specify.

Because the printer is shared by many people in the department, chances are that 
others have already called in about the same problem. If they have, the agent can 
abort the service request creation, or, if the problem is new, continue creating the 
service request. (See Setting Up Duplicate Checking by Item Instance or Serial 
Number  on page 1-64)

If the caller does not know the serial or instance number, the application checks for 
duplicates based on a combination of the customer and item and displays a listing 
of potential duplicates at the time the agent saves the service request. The agent can 
either create a new service request, or create a service request that is linked to the 
original service request as a duplicate.

Creating a service request as a duplicate for customers calling about the same 
problem makes it possible for the organization to better track the number of service 
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requests agents handle and to add the customer contact to the list of people who are 
notified when the issue is resolved.

Customers going online to report the same problem on their Oracle iSupport portal, 
do not receive any warnings. The application permits the customer to create the 
service request and, if it finds duplicates, notifies the owner of the service request 
(an agent that has been assigned to handle the service request) that the customer 
has created a potential duplicate.

1.15.1.2 Duplicate Checking Based on Capture of Extended Attributes
A government agency receives a call from a resident of 915 Oxford Street that a 
truck has been parked in front of the house for the past week. 

The agent selects “Abandoned Vehicle” as the Service Request Type and enters the 
address the caller is reporting as the incident address. The application presents the 
agent with a list of questions that you have set up for this Service Request Type: 
What is the make of the vehicle?, the model?, the color?, the license plate number? 
(See Capturing Additional Service Request Attributes on page 1-49.)

When the agent saves the service request, the application performs the duplicate 
check based on any of the information you specify using the procedures in this 
section and displays a list of any potential duplicates.

Just as with the previous duplicate check method, the agent can create a new service 
request, or create a service request that is linked to the original service request as a 
duplicate.

If the customer goes online to report the problem, the application permits the 
creation of the service request and notifies an agent you specify in the setup that a 
potential duplicate service request has been created.

Note: Only agents creating service requests in either the Service 
Request tab of the Contact Center or the Service Request window 
receive immediate notification of potential duplicates through 
pop-up windows. Duplication checking for agents creating service 
requests in Oracle eMail Center is limited to e-mail or workflow 
notification only.
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1.15.2 Setting Up Duplicate Checking
Use this procedure to set up duplicate checking upon saving a service request.

To set up duplicate checking:
1. Turn on duplicate checking by setting the system profile option Services: Check 

for Duplicate Service Requests to Yes.

By default this profile option is set to No. This profile option takes precedence 
over all other duplicate checking setups. If it is set to No, duplicate checking is 
turned off.

2. Select the type of duplicate check you wish to use by setting the profile option 
Services: Service Request Duplicate Criteria as follows:

a. If you wish to enable duplicate checking by customer and item alone, then 
select one of the following:

* Instance or (Customer, Item, and Serial Number)

Select this setting if your organization uses serial numbers when log-
ging service requests against items. 

The application checks duplicates on either the instance or the combina-
tion of customer, item, and serial number. 

* Instance or (Customer and Item)

Select this option if you do not use serial numbers for logging service 
requests against items. The application checks for duplicates on either 
instance or a combination of customer and item. 

Note: The application notifies different individuals depending on 
which duplicate checking process you specify. For customer and 
item-based checking, the process notifies whoever is designated as 
the service request owner. For attribute-based checking you specify 
a single individual to be notified for each Service Request Type.
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b. If you wish to enable duplicate checking based on extended attributes and 
the incident address alone, then select Extended Attributes and Incident 
Address.

c. If you wish to enable duplicate checking using both types of check, then 
select one of the two following options:

* All with Serial Number

Performs both type of duplicate checks with the serial number.

* All without Serial Number

Performs both type of duplicate checks without the serial number.

3. If you have selected to use duplicate checking by customer and item, then set 
up the time duration system profile and notifications as outlined in Setting Up 
Duplicate Checking by Customer and Item Details on page 1-62.

4. If you have selected to use the attribute method of duplicate checking, then 
select the attributes and time frame for the check in the Service Request 
Attribute Configuration window. See Setting Up Duplicate Checking by Service 
Request Attributes on page 1-63.

1.15.2.1 Setting Up Duplicate Checking by Customer and Item Details
In addition to procedure outlined in Setting Up Duplicate Checking  on page 1-61, 
use this procedure to enable duplicate checking by customer and item.

Prerequisites
You must first set up the system profile options to enable duplicate checking by 
customer and item described in Setting Up Duplicate Checking on page 1-61.

To set up duplicate checking by customer and item:
1. Set up the time frame for the duplicate checking:

Note: This profile takes precedence over setups you make in the 
Service Request Attribute Configuration window. If you select to 
check for duplicates using item and customer alone using one of 
these two settings, the application does not perform a check based 
on attributes even if you select to do so while setting up attributes 
in the Service Request Attribute Configuration window.
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a. Set the system profile option Service: Service Request Duplicate Time Frame 
UOM to the unit of time you wish to use. This profile option is set to Day by 
default.

b. Set the system profile option Service: Service Request Duplicate Time Frame 
to the time duration. This profile option is set to 30 by default.

2. If you wish the owner of the service request to be notified when the application 
finds duplicates, then set up notifications as described in Setting Up 
Notifications on page 1-79. 

Notifications provide the only way to alert agents when service requests are 
created in Oracle iSupport or Oracle eMail Center. In the Service Request tab of 
the Contact Center and in the Service Request window, agents receive 
automatic alerts via pop-up windows.

1.15.2.2 Setting Up Duplicate Checking by Service Request Attributes
In addition to procedure outlined in Setting Up Duplicate Checking  on page 1-61, 
use this procedure to set up duplicate checking by service request attributes. 

Prerequisites
You must first:

■ Set up service request attributes according to procedures described in 
Capturing Additional Service Request Attributes on page 1-49.

■ Complete setting the system profile options to enable duplicate checking by 
attribute described in Setting Up Duplicate Checking on page 1-61.

To set up duplicate checking by service request attributes:
1. Navigate to Extended Attribute Configuration > Service Request Type 

Attributes.

The Service Request Attribute Configuration window appears.
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2. Select the Service Request Type you wish to set up using the Type list of values.

The window displays the attributes you have created. 

3. In the Duplicate Check region:

a. Select the Check Required check box.

b. Enter the time frame as an integer in the Time Frame field.

c. Select the unit of measure using the Increment Type list of values.

For example, if you wish the duplicate check to check all service requests 
created in the past two hours, then you enter 2 in the Time Frame field and 
select Hour as the increment.

4. Select the Incident Address check box, if you wish to use the incident address in 
duplicate checking.

5. For each attribute you wish to use for the duplicate check, select the Duplicate 
check box. 

1.15.3 Setting Up Duplicate Checking by Item Instance or Serial Number
You can also check for potential duplicate service requests based on an item 
instance or a serial number. 
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Upon entering either an item instance or a serial number you will see a pop up 
window listing potential duplicate service requests that were created with a 
defined time frame.

To set up duplicate checking by item instance or serial number

1. Set up the time frame for the duplicate checking:

a. Set the system profile option Service: Service Request Duplicate Time Frame 
UOM to the unit of time you wish to use. This profile option is set to Day by 
default.

b. Set the system profile option Service: Service Request Duplicate Time Frame 
to the time duration. This profile option is set to 30 by default.

2. Set the system profile Services: Check for Similar Service Requests to Yes. (A 
setting of No disables this functionality).

Note: This check occurs when you select the item instance or 
serial number and not when you save the service request.
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1.16 Setting Up Message Action Codes
If your organization is using Oracle Workflow-based messaging feature of service 
requests, you can use message action codes to specify an action you want a message 
recipient to take. 

Agents can send messages regarding a service request from the Service Request 
window by selecting Select Messages from the Tools menu.

To setup a message action code:
1. Navigate to the Setup > Service Requests > Action Requests.

The Oracle Service: Service Request Action Request Type Lookups window 
appears. The type field and description display MESSAGE_ACTION_
REQUEST and action request types used when sending messages.

2. Enter a message action code in the Code field. 

3. Enter a brief description of the code in the Meaning field.

4. Enter a full description of the code in the Description field.

5. Enter the effective dates in the From and To fields.

6. Select the Enabled check box to make the code available for use.

7. Save the message action request code.
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1.17 Setting Up Task Types and Priorities for Service Request Usage
This step is required to use task types and task priorities in the Service Request 
window’s Task tab.

To set up task types and priorities:
1. Navigate to the Task Type Setup window.

Setup > Task Management > Task Types

2. All existing task types are displayed. For each task types which you want 
displayed in the Service request task tab, Click Map Types.

3. Associate the source Service Request to the task type.

4. Save your work.

5. Navigate to the Task Priority Setup window.

Setup > Task Management > Task Priority

6. All existing task priorities are displayed. For each task priority which you want 
to display in the Service Request Task tab, click Map Priority.

7. Associate the source Service Request to the task priority.

8. Save your work.

1.18 Setting Up the Display of Oracle Install Base Items
This step is required to display Oracle Install Base items in the Service Request 
window.

To set up the display of Oracle Install Base items:
1. Navigate to the Customer Product Statuses setup window.

Setup > Installed Base > Instance Status

2. Check the Request Allowed check box for the customer product statuses that 
you want to be displayed in the Service Request window.

1.19 Setting Up HTML Applications for Service Requests
This step is required to enable HTML applications from the Service Request. HTML 
applications include Oracle Knowledge Management and Oracle Install Base.
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To enable Oracle Knowledge Management:
1. Login as SYSADMIN to the JTF URL for the relevant environment.

2. Open the Users tab.

3. Click on "Users" on the "User Management" menu list.

4. Search for the required user, for example, "SUPPORT"

5. Click on the User Name, "SUPPORT" on the search result to view the user 
details.

6. Click Roles to display the Available and Assigned roles for the user.

7. Assign the role "CS_SYSTEM_ADMIN" to the user.

8. Click Update.

To enable Oracle Install Base:
1. Perform steps 1 through 6 as described for Oracle Knowledge Management 

above.

2. Assign the role "CS_NORMAL_USER" to the user.

1.20 Setting Up Service Request Profile Options
System profile settings determine several default values that appear for service 
requests, control functionality and assist in the management of unique business 
processes. Profiles can be set at User, Responsibility, Application, and Site levels. 

Site-level profile settings apply to all users at an installation site. Application-level 
profile settings apply to all the users of the specified application and override those 
set at the site level. Responsibility-level profile settings apply to all users who use 
the Responsibility to sign on to the application and override those set at site and 
application level. User-level profile options apply to individual users identified by 
their application user names and override all other profile options.

For a detailed explanation of system profile options and the procedures for setting 
them up, please refer to Oracle Applications System Administrator’s Guide.

To set up the service request profile options:
1. If you are using a Customer Support Responsibility, the navigation path to 

update Profile Options is Other > System Profile Values.
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2. You can also update system profiles under the System Administrator 
responsibility by navigating to Profiles > System. 

3. Search for a specific profile and set the profile value at site, application, 
Responsibility, or user levels. Most Support related profile options begin with 
the word Service, so you can query on Service% for these.

1.21 Indexing Note and Summary Text for Searches
You can run the Service Request Synchronize Index concurrent program to make it 
possible for agents to search for text in the summary and note fields using the 
Service Request find window. By running this concurrent program on a periodic 
basis you can retrieve results that include recently-created service requests.

This concurrent program is set up by the system administrator and can be run every 
15 minutes or 30 minutes, for example.

To run the Service Request Synchronize Index concurrent program:
1. Using System Administrator Responsibility, navigate to:

Security > Responsibility > Request

2. Query on the called Group "Support Reports".

3. Add the Service Request Synchronize Index concurrent program to the               
list.

4. Save your work.

1.22 Creating Owners and Supervisors
Follow these steps to create Owners and Supervisors.

1. Log-in as Sysadmin.

2. Select Responsibility: Human Resources.

3. From the Enter and Maintain form, and create two new Employees.

4. Make one of the Employees the Supervisor of the other, from the same form.

This can be done using the Assignment button on the same form.

5. Switch Responsibility to System Administrator.

6. Create two new users from the form: Security >Users >Define.
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7. Associate these users to the two new employees by using the LOV for the field 
People on the Define Users form.

8. Switch Responsibility to Customer Support, Vision Enterprises.

9. Go to Resource Management >Maintain Resources >Import Resources.

10. Import the two new employees just created as resources, and save the resources.

11. Verify, from the Owner LOV on the Service Request form, that the two new 
resources exist.
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1.23 Setting Up Service Request Linking Through Relationships
Agents can link service requests to other service requests and to other E-Business 
Suite objects by creating a relationship on the Related Objects tab of the Service 
Request window. This topic explains this functionality and the permitted 
modifications. It covers:

■ Overview on page 1-71

■ Permitted Modifications on page 1-75

■ Changing Relationship Wording or Removing a Relationship Type from Use on 
page 1-75

■ Adding Reference Relationships to Objects Other Than Service Requests on 
page 1-76

■ Turning Off Automatic Service Request Status Updates Rules on page 1-78

1.23.0.1 Overview
By creating a relationship link to another service request or to another object, such 
as a maintenance plan for a piece of equipment, agents can make information 
available with the click of a mouse. 

Relationships indicate, for example, that one service request is a duplicate of the 
other, that one is the cause of another, or that it contains relevant information for the 
resolution of another. An individual service request can be linked to multiple other 
objects.

Some types of the relationships are merely informational. Others propagate the 
change of status in one service request to the other service requests linked to it. For 
example, if agents specify that service requests A and B are caused by service 
request C, then closing C closes A and B as well. 

The breakdown of a major system can sometimes cause multiple customer contacts 
to report the same problem. The status propagation permits the service organization 
to deal with all the duplicate service requests all at the same time.

Users have six available relationship types for linking service requests to other 
service requests: 

Note 1: Status propagation is available only for linked service 
requests, not to other E-Business Suite objects.
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■ Caused by

■ Root cause of

■ Duplicate of

■ Original for

■ Reference for

■ Refers to

Only the last two relationship types can be used to link service requests to other 
objects you set up:

■ Reference for

■ Refers to

Because relationships between two objects are bidirectional, they come in pairs. If a 
user specifies a relationship in one direction, the application automatically specifies 
a relationship in the other direction:

■ Caused by /Root cause of

■ Duplicate of /Original for

■ Reference for / Refers to

The following two relationship pairs also propagate status changes between the 
linked service requests:

■ Caused by/Root cause of

■ Duplicate of/Original for

The following table explains the three most frequently used relationship types. The 
Action column of this table indicates both the status changes and reciprocal links 
created automatically by the application.
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Relationship Action Example 

Caused by Linking service request A to service 
request B using a “Caused by” 
relationship indicates that A is caused 
by B. 

The application:

■ Sets the status of A to “Waiting”.

■ Creates the reciprocal link “Root 
Cause of” for B.

When B is set to the status of 
“Closed”, then the status of A is 
automatically set to “Clear”.

If multiple service requests are 
“Caused by” B, then all are set to 
“Clear”.

Problem:

A customer contact calls to say his e-mail is not 
working. The support agent discovers that the system 
administrator has already logged a service request to 
track this problem. The contact's e-mail is not working 
because the e-mail server is down. 

Resolution:

The agent creates a “Caused by” link between the 
contact’s service request and the service request 
already logged for the e-mail server problem. The 
application automatically sets the status of the 
contact’s service request to “Waiting”.

When the system administrator resolves the e-mail 
server failure and closes the server problem service 
request, then the application automatically updates the 
contact’s service request status to “Clear”. 

Duplicate of Linking service request A to service 
request B with the “Duplicate of” 
relationship indicates that A is a 
duplicate of B.

The application automatically:

■ Creates an “Original for” link 
from B to A.

■ Changes the status of A to 
”Closed” with the resolution 
code “Closed as Duplicate”.

All call center agents have been notified of the e-mail 
outage. Subsequently, an employee logs a ticket to 
report the e-mail outage. 

The agent who is assigned to work on the service 
request identifies it as a duplicate and enters the 
“Duplicate of” link.

The application automatically closes the employee’s 
service request with the resolution code of “Closed as 
Duplicate” and a reference to the service request 
already logged for the e-mail outage.
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Refers to If service request A “Refers to” 
service request or document B, this 
means that B has information relevant 
to A.

The application automatically creates 
the reciprocal “Reference for” 
relationship from B to A provided 
both documents are service requests. 

Agents can use this type of 
relationship for linking a service 
request to another object, such as a 
maintenance plan. See Adding 
Reference Links to Objects Other 
Than Service Requests on page 1-76 
for more details.

An agent working on a service request remembers that 
he created a similar service request for another 
customer. By creating a link to that old service request, 
he makes it possible for others to refer to it. 

Note 1: Agents are permitted to indicate service request A is a 
duplicate of service request B only if service request A has no 
existing relationship links of type Duplicate of, Original for, Root 
Cause of, and Caused by. The service request can have existing 
relationship links of type Reference for and Refers to. If A does 
contain links, and agents wish to indicate A is a duplicate of B, they 
must first remove the links from A. 

Agents are restricted in this way for logical reasons:

■ A service request can be a duplicate of only one original.

■ Service requests that are originals for others cannot be chained.

■ Service requests that are the cause of or caused by others will 
cause logical errors in the status propagation.

Note 2: If you are implementing status transitions as described in 
Status Groups and Status Transitions on page 1-3, then you must 
make sure that you permit the status transitions required by the 
automatic service request status update rules. The rules must allow 
the application to be able to update the status of duplicate service 
requests to “Closed”, for example. 

Relationship Action Example 
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1.23.1 Permitted Modifications to Service Request Relationships
While you are not permitted to add new relationship types, you can:

■ Change relationship wording or remove a relationship type from use. (See 
Changing the Wording of a Relationship Type or Removing It from Use on 
page 1-75.)

■ Add reference type links to objects other than service requests. (See Setting Up 
Reference Links to Objects Other Than Service Requests on page 1-76.)

■ Turn off automatic service request status update rules. (See Turning Off 
Automatic Service Request Status Updates Rules on page 1-78.)

1.23.2 Changing the Wording of a Relationship Type or Removing It from Use
Use this procedure to change the wording users see in the Relationship Type list of 
values or to remove a link type from use.

To change the wording for a relationship type or remove it from use:
1. From the Navigator, navigate to Setup > Service Requests > Relationships and 

Valid Objects.

The Define Relationships page appears in your browser window.

2. If you wish to modify the wording of a relationship agents see in the LOV, then 
make the modifications in the Relationship Name field.

3. If you wish to restrict the availability of a relationship, then enter a start date, an 
end date, or both. Entering a start date in the future postpones the use of that 
relationship type until that date. Entering an end date ends the availability of 
the relationship type at midnight of the date specified.

Note 3: The application automatically sends an Oracle Workflow 
notification to the service request owner if the automatic status 
update fails. If you wish, you can modify the text of the Oracle 
Workflow message “Notify: Service Request Update Failed 
Message. The item type for this message is Service Request 
(Internal Name: SERVEREQ).
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4. Click Apply to save your work.

5. If you wish to permit users to link service requests to objects other than service 
requests using the “Reference for” and “Refers to” link pair, then click Update 
Valid Objects (the pencil icon) in the Reference for row and follow the 
procedure outlined in Adding Reference Links to Objects Other Than Service 
Requests on page 1-76.

1.23.3 Setting Up Reference Links to Objects Other Than Service Requests
Use this procedure to make it possible for users to link service requests to objects 
using the “Refers to” relationship link. The system automatically creates the 
reciprocal “Reference for” relationship. By default, this relationship type is already 
set up for service requests.

Prerequisites
You must set up the objects you wish to link to service requests using the Task 
Setup: Object Types window which is available by navigating to Task and 
Escalation Manager > Setup > Objects Meta-data under the CRM Administrator 
Responsibility.

See Setting Up Metadata Objects in Oracle Common Application Components 
Implementation Guide for details.

To set up reference links to objects other than service requests:
1. From the Navigator, navigate to Setup > Service Requests > Relationships and 

Valid Objects.

The Define Relationships page appears in a browser window.

Note: Because the relationships are reciprocal and come in pairs, 
restricting the availability of one relationship type automatically 
restricts the availability of its reciprocal.
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2. Click Update Valid Objects (the pencil icon) in the “Reference for” row.

The Valid Objects page appears.

3. Click Add Another Row.
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4. From Relationship Type drop-down list, select Refers to.

5. Click Search for Related Object Type (the searchlight icon in the Related Object 
Type column.)

Search and Select: Related Object Type page appears.

6. Click Go to display all of the objects you have defined.

7. Select the radio button next to the name of the object.

8. Click Select.

The object you selected appears in the Valid Objects: Reference for and Refers to 
Relationships page.

9. Click Apply to save your work. 

1.23.4 Turning Off Automatic Service Request Status Updates Rules
Use this procedure to turn off any of the seeded automatic service request status 
update rules. You cannot add rules or modify them.

To turn off automatic service request status update rules:
1. From the Navigator, navigate to Setup > Service Requests > View Status Update 

Rules.

The View Automatic Status Update Rules page appears in a browser window.

2. Click View Event Details (the glasses icon) to the right of the rule type you 
wish to disable.

The View Event Details page appears. The page displays different details 
depending on the rule type you have chosen.
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3. Enter an end date for any rule you wish to disable.

4. Click Apply.

1.24 Setting Up Notifications
This group of topics explain how to set up rules to trigger automatic notifications to 
agents and customers of different service-request-related events. These include:

■ Overview of Notifications on page 1-79

■ Notification Post-Install Steps on page 1-81

■ Restrictions for the Notification Process on page 1-82

■ Modifying the Notification Mode on page 1-82

■ Modifying and Creating Notification Message Templates on page 1-82

■ Displaying Existing Notification Rules on page 1-85

■ Creating a New Notification Rule on page 1-86

■ Updating Existing Notification Rules on page 1-88

1.24.1 Overview of Notifications
You can set up the application to automatically notify the service request owner and 
customer contacts associated with the service request whenever a certain event 
occurs, for example, whenever a service request is created, closed, or reassigned. 
Notifications can be sent via Oracle Workflow notifications or by e-mail.
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Oracle TeleService includes a notification workflow and notification templates 
suitable for different types of events, but implementers must set up the rules that 
trigger the workflow. 

The rules make it possible to selectively notify users only about events of interest to 
the organization. This notification functionality enhances and replaces notifications 
through the Call Support Process workflow which can be associated with Service 
Request Types. The Call Support Process notifies users each and every time a 
service request is updated.

This release includes one seeded notification rule: If service request status changes 
to closed, then notify the primary contacts of related service requests.

The following table describes the events that can trigger a notification message to be 
sent and the scope of the rule you can create. 

Event Description Who you can Notify Explanation

Contact Added 
to Service 
Request

An agent or customer 
adds a contact to a 
service request. A 
contact can be either a 
customer contact or an 
employee.

■ All contacts 
associated with the 
service request

■ The new contact

■ The service request 
owner

■ The primary 
contact

The application sends out notifications 
when an agent or a customer adds a contact 
to the service request.

Published 
Solution 
Added to 
Service Request

An agent or a 
customer has linked a 
published knowledge 
management solution 
to the service request.

■ All contacts

■ Only the primary 
contact

The application sends out notifications 
whenever an agent or customer links a 
knowledge management solution to a 
service request. You may wish to use this 
message to e-mail suggested fixes to 
customer problems.

Service Request 
Status Changed

An agent or a 
customer changes the 
service request status.

■ All contacts

■ The service request 
owner

■ Owners of all 
related service 
requests. 

■ Notify the primary 
contacts of all 
related service 
requests

The application sends out notifications 
whenever a service request is changed from 
one status to another. You must specify the 
status transition that triggers the 
notification. For example, if you wish to 
notify all contacts whenever a service 
request is closed, then you could trigger a 
message whenever the status changes from 
“Working” to “Closed”.
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1.24.2 Notification Post-Install Steps
This procedure explains how to remove unnecessary lines in the body of e-mail 
notification messages.

By default all e-mail notification templates contain the following two unnecessary 
lines in the body of the message:

Service Request 
Created

An agent creates a 
service request.

■ All contacts

■ Only the primary 
contact

The application sends out a notification 
whenever an agent creates a service 
request.

Service Request 
Owner 
Changed

An agent or concurrent 
program has assigned 
a new owner or 
removed an old owner. 

■ Old owner of the 
service request

■ New owner of the 
service request

You can notify new owner that a service 
request has been assigned to them and that 
the old owner is no longer assigned.

Relationship 
Created

An agent creates a 
relationship between a 
service request and 
other related service 
requests, maintenance 
plans, or other 
E-Business Suite 
objects.

■ Service request 
owner

Agents can specify different relationships 
between a service request and other service 
requests or E-Business Suite objects. For 
example, they can specify service request A 
is a duplicate of service request B or caused 
by the problem described in the service 
request B.

You can specify which relationship will 
trigger a notification to be sent to the 
service request owner. See Setting up 
Service Request Relationships on page 1-71 
for more details.

Relationship 
Removed

An agent removes a 
relationship in a 
service request.

■ Service request 
owner

You can notify the owner of the service 
request if another agent has removed a 
previously established relationship between 
the service request and another service 
request or object. You must specify the 
relationship you wish to trigger the 
notification.

Service Request 
Updated

An agent or customer 
updates the service 
request.

■ Service request 
owner

You can notify the owner whenever 
someone else updates the service request.

Event Description Who you can Notify Explanation
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■ Oracle Workflow Notification (FYI)

■ From

To remove unnecessary e-mail notification lines:
1. Open the "System: Mailer" item type 

2. Open the "Workflow Open FYI Mail" (internal name:OPEN_MAIL_FYI) 
message 

3. Select the Body tab. 

4. Delete the first two lines and save the message.

1.24.3 Restrictions for the Notification Process
The following restrictions apply:

■ You can only notify individual service request owners (not group owners).

■ Service request owners are not notified if they themselves have taken the action 
that triggered the notification. For example, a service request owner who is 
being notified every time a service request is being updated receives 
notifications only when others update the service request. 

■ For e-mail notifications, the customer contact record must contain an e-mail 
address for the notifications to be sent.

1.24.4 Modifying the Notification Mode
You can send notifications via e-mail or Oracle Workflow notifications.

By default:

■ Service request owners receive notifications via Oracle Workflow.

■ All service request contacts, employee and customer, receive notifications by 
e-mail.

To change the notification modes, you can modify the Notification Mailer setup in 
Oracle Workflow as described in the Oracle Workflow Guide.

1.24.5 Modifying and Creating Notification Message Templates
The subject and text of the message users receive is stored in a Oracle Workflow 
message template. You can create your own notification message templates or you 
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can modify those provided with Oracle TeleService by following the procedures in 
the Setting Up Oracle Workflow section of the Oracle Workflow Guide. 

This table lists the templates provided with Oracle TeleService:

Message Name Description

Notify Contact: Service Request 
Created Message

Notifies a contact that they have been listed as a contact 
in a service request.

Notify Contact: Service Request 
Status Updated Message

Notifies recipient that a service request status has been 
updated.

Notify New Owner: Service 
Request Reassigned Message

Notifies an agent that they have been assigned as the 
new owner of a service request.

Notify Old Owner: Service 
Request Reassigned Message

Notifies an agent that ownership of the service request 
has been reassigned to someone else.

Notify Owner: Service Request 
Created Message

Notifies an agent that a service request was created with 
them as the owner.

Notify Owner: Service Request 
Status Updated Message

Notifies the recipient that the service request status was 
updated.

Notify Primary Contact: Service 
Request Created Message

Notifies the recipient that a service request has been 
created with them listed as a primary contact.

Notify: Published Solution 
Added to Service Request 
Message

Notifies recipient that a knowledge base solution has 
been added to the service request.

Notify: Related Service Request 
Created Message

Notifies recipient that an agent has created a 
relationship with another service request. For example, 
if an agent has indicated another service request is a 
duplicate of the service request.

Notify: Related Service Request 
Removed Message

Notifies recipient that a relationship between a service 
request and a second service request or object has been 
removed. For example, if an agent removes the link 
indicating a duplicate service request. 

Notify: Related Service Request 
Updated Message

Notifies recipient that a linked service request has been 
updated.

Notify: Service Request Contact 
Added Message

Notifies recipient that a new contact has been added to 
the service request.

Notify: Service Request Updated 
Message

Notifies recipient that a service request has been 
updated.
Implementing Service Requests 1-83



Setting Up Notifications
Here are the message requirements:

■ All seeded messages are defined in the Oracle Workflow item type Service 
Request (Internal Name: SERVEREQ)

■ The internal name for all new messages you create must start with: CS_SR_EVT

■ The message definition can be up to 1376 characters in length.

■ Although Oracle has seeded only text messages, you can set up HTML 
messages instead.

■ You can automatically display service request details in your message by 
entering different tokens. Here is the list of available tokens:

Notify: Contacts of Related 
Service Requests

Notifies contacts of related service request that the status 
of the primary service request has been updated.

Display Name Internal Name

Created By CREATED_BY

Customer Product ID CUSTOMER_PRODUCT_ID

Expected Resolution 
Date

EXPECTED_RESOLUTION_DATE

Initiator Role INITIATOR_ROLE

Inventory Item ID INVENTORY_ITEM_ID

Old Request Status REQUEST_STATUS_OLD

Owner ID OWNER_ID

Owner Name OWNER_NAME

Owner Role OWNER_ROLE

Previous Owner ID PREV_OWNER_ID

Previous Owner Name PREV_OWNER_NAME

Previous Owner Role PREV_OWNER_ROLE

Problem Code PROBLEM_CODE

Problem Description PROBLEM_DESCRIPTION

Product Description PRODUCT_DESCRIPTION

Message Name Description
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The SERVEREQ item type includes additional tokens which are specific to internal 
application workflows.

1.24.6 Displaying Existing Notification Rules
Use this procedure to display existing notification rules.

To display existing notification rules:
1. Navigate to Setup > Service Request > View Notification Rules.

The View Notification Rules page appears listing any rules you have created 
previously. 

Request Customer REQUEST_CUSTOMER

Request Date REQUEST_DATE

Request ID REQUEST_ID

Request Number REQUEST_NUMBER

Request Severity REQUEST_SEVERITY

Request Status REQUEST_STATUS

Request Summary REQUEST_SUMMARY

Request Type REQUEST_TYPE

Request Urgency REQUEST_URGENCY

Resp Appl ID RESP_APPL_ID

Resp ID RESP_ID

Response Deadline RESPONSE_DEADLINE

Response Time RESPONSE_TIME

Solution Summary SOLUTION_SUMMARY

Updated By UPDATED_BY

User ID USER_ID

Workflow Administrator 
Role

WF_ADMINISTRATOR

Display Name Internal Name
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You can:

■ Delete a rule by clicking Delete (the trash can icon).

■ Update a rule by clicking Update (the pencil icon). See Updating Existing 
Notification Rules on page 1-88.

■ Create a new rule by clicking Define Notification Rules. See Creating a 
New Notification Rule on page 1-86.

1.24.7 Creating a New Notification Rule
Use this procedure to create a new notification rule.

To create a new notification rule:
1. Navigate to Setup > Service Request > Define Notification Rules.

2. Click Define Notification Rules.

The Define Notification Rule page appears.
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3. Select the event for the rule using the Event drop-down box.

4. Click Go.

The page displays any rules already created for this event.

5. Click Add Row.

6. In the new row, select the condition(s) you wish to use as the trigger the 
notification. The conditions are different for each type of event.

For example, if you wish to send out a notification each time a service request 
changes a status, then select:

■ The status to trigger the notification.

■ The condition 

Whether you want to send the notification each time a service request 
changes to the target status or changes from that status. 

■ Whom you want to notify

You have three choices: you can notify all contacts on the service request, 
the service request owner, or all the owners of service requests that have 
been linked to the service request via a relationship.

7. Click Update Action Details.

The Notification Details page appears.

8. Click Search for Notification Template (the searchlight icon).

The Search and Select: Notification Template page appears.
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9. If you wish to restrict your search, then enter a complete or partial name of a 
template in the Search by field.

10. Click Go.

The page displays the available templates in the Results region.

11. Select the radio button next to the template you wish to use.

12. Click Select.

The template name displays in the Notification Details page.

13. Click Apply.

14. If you wish to create or update another rule, then select the View Notifications 
Rule link at the top left of the page.

1.24.8 Updating Existing Notification Rules
Use this procedure to update existing notification rules. You can delete rules or 
update existing rule conditions and attach different notification message templates.

To update an existing notification rule:
1. Display the existing notification rules by navigating to Setup > Service Request 

> View Notification Rules.

The Define Notification Rule page appears.

2. Click Update (the pencil icon) for the rule you wish to update.

The Define Notification Rule page appears displaying the rules already 
associated with this event.

3. If you wish to delete a rule, then click Delete (the trash can icon).

4. If you wish to modify the conditions for this rule, then make your 
modifications.

The conditions are different for each type of event. For example, if you wish to 
modify a rule which sends out a notification each time a service request changes 
to the status of “Closed” then you can modify:

■ The status you wish to trigger the notification.

■ The condition: whether you want to send the notification each time a 
service request changes to the status or changes from that status. 
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■ Who you want to notify. For status changes, you have three choices: you 
can notify all contacts on the service request, the service request owner, or 
all the owners of service requests that have been linked to the service 
request via a relationship.

5. If you wish to select a different notification message template for this rule, then 
click Update Action Details.

The Notification Details page appears.

6. Click Search for Notification Template (the searchlight icon).

The Search and Select: Notification Template page appears.

7. If you wish to restrict your search, then enter a complete or partial name of a 
template in the Search by field.

8. Click Go.

The page displays the available templates in the Results region.

9. Select the radio button next to the template you wish to use.

10. Click Select.

The template name displays in the Notification Details page.

11. Click Apply.

12. If you wish to update another rule, then select the View Notifications Rule link 
at the top left of the page.
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1.25 Implementing Oracle eMail Center and E-Mail Templates
Integration with Oracle eMail Center makes it possible for agents to communicate 
with customers via e-mails from both the Contact Center and the Service Request 
windows.

When Oracle eMail Center is implemented, agents can:

■ Compose e-mails to customers and customer contacts by clicking on an icon. 
Agents can use e-mail templates which supply the contextual information about 
the customer.

■ View the text of e-mails sent via Interaction History.

1.25.0.1 Guidelines for Setting Up the Oracle eMail Center
Follow these general steps when implementing the Oracle eMail Center:

1. Set up Oracle eMail Center as described in the Oracle eMail Center 
Implementation Guide.

2. Set up e-mail templates for use with the Contact Center and Service Request 
forms. You can use the mail-merge fields listed in Customer and Contact Mail 
Merge Fields on page 1-91 and Service Request Mail Merge Fields on page 1-93.

3. To enable e-mail from the Contact Center:

a. Set the following system profile options:

■ Customer Care: Enable Outbound E-mail From the Contact Center

This profile option sets enables the e-mail buttons on the application’s tool 
bar. A setting of Yes, the default, enables the icons and permits users to use 
the icons to send e-mails. A setting of No disables the icons and 
functionality.

■ Customer Care: Default Template for Outbound from Contact Center

Set this profile to the e-mail template you wish agents to use as a default for 
creating e-mails. There is no seeded template available, so you must create 
your own.

■ Customer Care: Default Category for Outbound E-mail from Contact 
Center

If you wish to restrict the use of eMail Center templates by Oracle 
Marketing Encyclopedia System (MES) product categories, then set this 
profile to any of the existing categories.
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b. You can specify which responsibilities can create e-mails within the Contact 
Center by mapping the function CSCSFECW according to the procedures 
described in Oracle Applications System Administrator’s Guide. This function 
controls access to the Open Email Compose Window icon in the Toolbar 
and the corresponding menu selection. The seeded Customer Support 
Responsibility includes this mapping.

4. To enable e-mail from the Service Request window, set the following system 
profile options:

■ Service: Enable Defaulting CC field in Email Header While Sending An 
Email In Service Request Form

Setting this profile option to Yes automatically defaults in the CC address 
line the e-mail addresses of all the service request contacts. If an agent is 
sending an e-mail to the customer e-mail address, then all of the service 
request contacts are copied on the e-mail. If the agent is e-mailing one of the 
contacts all of the remaining contacts are copied. The application defaults 
the e-mail addresses only when agents launch the compose window from 
the Service Request window. 

Setting this profile to No leaves the CC address line blank.

■ Service: Subject Prefix for Outbound Email in Service Request

Setting this profile to Yes causes the application to populate the Subject line 
of the e-mail with the problem summary from the service request. The 
application defaults the subject line only when agents launch the compose 
window from the Service Request window.

Setting this profile to No leaves the subject line blank.

■ Service: Default Email Template

Set this profile to a default e-mail template you have created.

1.25.0.2 Customer and Contact Mail Merge Fields
For setting up e-mail templates for use with the Contact Center, you can use the 
following customer, contact, and interaction parameters:

Customer Parameter Description

CUSTOMER_NAME Customer’s name

CP_FIRST_NAME Customer’s first name
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CP_LAST_NAME Customer’s last name

CP_PARTY_NUMBER Party Number 

CP_PRIMARY_PHONE Identifying phone number

CP_PRIMARY_EMAIL Identifying email

CUST_URL Identifying URL

CP_ADDRESS Identifying address (the address displayed on Contact Center 
header)

CP_CITY City for the identifying address

CP_STATE State for the identifying address

CP_POSTAL_CODE Postal Code for the identifying address

CP_COUNTRY Country for the identifying address

ACCOUNT_NUMBER Account number displayed on the header

Contact Parameter Description

CONTACT_NAME Party name

CON_FIRST_NAME First name

CON_LAST_NAME Last name

CON_PARTY_NUMBER Party number

CON_PRIMARY_
PHONE

Primary phone

CON_PRIMARY_EMAIL Primary email

CONT_URL Primary URL

CON_ADDRESS Identifying Address displayed on the contact center header

CON_CITY City

CON_STATE State

CON_POSTAL_CODE Postal Code

CON_COUNTRY Country

RELATION Relationship displayed on Contact Center header.

Customer Parameter Description
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1.25.0.3 Service Request Mail Merge Fields
You can use the following service request mail merge fields in the templates for 
e-mails sent from the Service Request window:

CRITICAL_FLAG Critical Customer Flag

TIMEZONE Contacts Time Zone

Interaction Parameter Description

INTERACTION_ID Interaction Id

DEFAULT_OUTCOME_
FOR_INTERACTION

Default outcome for an interaction

DEFAULT_RESULT_
FOR_INTERACTION

Default result for an interaction

DEFAULT_REASON_
FOR_INTERACTION

Default reason for an interaction

DEFAULT_OUTCOME_
FOR_ACTIVITY

Default outcome for an activity

DEFAULT_RESULT_
FOR_ACTIVITY

Default result for an activity

DEFAULT_REASON_
FOR_ACTIVITY

Default reason for an activity

Service Request 
Parameter Description

SR_CUSTOMER_NAME Customer name

SR_CONTACT_NAME Contact name

SR_ACCOUNT_
NUMBER

Account number

SR_NUMBER Service request number

SR_STATUS Service request status

SR_TYPE Service Request Type

SR_SEVERITY Service request severity

Contact Parameter Description
Implementing Service Requests 1-93



Implementing Oracle eMail Center and E-Mail Templates
SR_URGENCY Service request urgency

SR_REPORTED_DATE Service request incident date

SR_GROUP_OWNER Service request group owner

SR_INDIVIDUAL_
OWNER

Service request individual owner

SR_ITEM Item

SR_ITEM_DESC Item Description

SR_INSTANCE Instance

SR_SERIAL_NUMBER Serial number

SR_REVISION Revision

SR_TAG Tag

SR_SYSTEM System

SR_CONTRACT Contract

SR_CONTRACT_LINE Contract Line

SR_COMPONENT Component

SR_ COMPONENT _
DESC

Component description

SR_ COMPONENT _
REV

Component revision

SR_SUBCOMPONENT Subcomponent

SR_ SUBCOMPONENT _
DESC

Subcomponent description

SR_ SUBCOMPONENT _
REV

Subcomponent revision

SR_SUMMARY Service request summary

SR_RESOLUTION_
SUMMARY

Resolution summary

SR_RESOLUTION_BY Service request resolution by date

SR_RESPOND_BY Service request respond by date

SR_SUPPORT_SITE Support site

Service Request 
Parameter Description
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1.26 Setting Up the List of Values for the Language Field
Use this procedure to set up the list of values for the Language field in the Service 
Request window header. Agents can use this field to indicate a customer’s preferred 
language for a specific service request.

To set up the list of values for preferred languages:
1. Navigate to Setup > Service Requests > Preferred Language

The Oracle Service: Service Request Preferred Language window appears.

2. Use the Language Code LOV to select the languages you wish to add to the list 
of values in the Language field.

SR_ ESCALATION _
LEVEL

Escalation level

Note: The language preference agents enter using this LOV 
remain specific only to individual service requests. The preference 
is not stored in the customer record itself. This means that selecting 
a language preference in a service request does not modify the 
customer’s overall language preference which is entered in the 
Preferred Language field in the Party Information tab of the 
Contact Center. 

Service Request 
Parameter Description
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The language name the agent will see in the LOV appears in the Description 
field.

3. Optionally, enter dates if you wish to limit the availability of your entry.

4. Click Save.

1.27 Setting Up Default Response and Resolution Times
Use this procedure to set up default service request response and resolution times 
by business process and service request severity.

When agents create a service request not covered by a contract, the application uses 
these times to calculate the deadlines for responding and resolving the service 
request and automatically defaults the Respond By and Resolve By fields. 

The application calculates the deadlines based on the date and time displayed in the 
Reported field of the Service Request (INCIDENT_DATE). 

If agents later change the Service Request Type or severity, the defaults change 
accordingly.

If an agent later selects a contract for the service request or enters an installed base 
item covered by a contract, these default times get overwritten by those specified in 
the contract.

To set up default response and resolution times:
1. Set up an Oracle Service Contract coverage template with the reaction times 

and resolution times for each business process and service request severity as 
described in the Oracle Service Contracts User Guide.

2. Navigate to Others > Profile System Values and set the system profile option 
Service: Default Coverage for SLA to the name of the template you have 
created.

Note: The template you create is for defaulting reaction times and 
resolution times only. It cannot be used to default pricing 
information such as discounts and labor rates.
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1.28 Automating the Closure of Service Requests
These two topics explain how you can automate the closure of service requests and 
related tasks. The first explains closure. The second provides the procedure for 
setting it up.

■ Understanding Closure Automation on page 1-97

■ Setting Up Automatic Closure for Service Requests on page 1-99

1.28.1 Understanding Closure Automation
Service requests can have multiple associated tasks that have a completion status 
independent if the service request itself. If you do not implement closure 
automation, the closure of each task is independent of the closure of the service 
request. This means that agents must remember to close all tasks when they close a 
service request and remember to close the service request after all tasks are 
completed. 

You can automate closure by one or both of the following methods:

■ Downward Propagation

■ Upward Propagation

1.28.1.1 Downward Propagation
If an agent wishes to close the service request, you can have the application check if 
the service request is ready to be closed and then automatically close all of the 
service request tasks.

The application prevents agents from closing the service request for any of the 
following reasons:

■ If any tasks with the Restrict Closure check box selected are not closed

Agents can select this check box when they create a task to prevent closure of 
the service request when the task is not in a closed status.

■ If the service request has associated non-field service tasks that are still being 
worked on

The application determines a task is still being worked if the task start date is 
equal or earlier than the system date and if there is no end date. The application 
checks both the scheduled and actual start date. This is because an engineer 
may start a task without having yet had the chance to record the actual start 
date.
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This rule does not check Oracle Field Service tasks as this application has its 
own rules for preventing closure.

■ If the service request has field service tasks that are scheduled or in progress

See Oracle Field Service documentation for details.

■ If the service request includes charges that have not yet been successfully 
submitted

The application only checks charge lines of type Actual with the OM Interface 
check box selected.

The application does not check for open Oracle Enterprise Asset Management work 
orders, Oracle Depot Repair repair orders, and maintenance requirements. This 
means that the service request and associated tasks can be closed even with work 
orders or repair orders in progress.

You can enable downward propagation in this release by setting the system profile 
Service: Validate and Auto Close on Service Request Closure to Yes. The system 
profile Service: Task Auto Close Status determines the status of the closed tasks.

Oracle Complex Maintenance Repair, and Overhaul closes its own maintenance 
requirements.

The closure of associated tasks is immediate. As soon as the agent closes the 
request, all of the tasks are closed as well. If any of the rules are violated, the 
application warns the agent with an error message.

1.28.1.2 Upward Propagation
If all service request tasks have been closed or all charges have been submitted, you 
can have the application check if the service request is ready to be closed and then 
close it.

The application prevents the service request from being closed if:

■ Not all tasks are closed

The application prevents the service request from being closed if any associated 
task is in a status that does not have the Closed check box selected.

■ If any debriefed tasks have encountered errors when being converted to charges

■ If there are any charges that have not been submitted to Oracle Order 
Management
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■ If there are any Oracle Depot Repair repair orders, Oracle Enterprise Asset 
Management work orders, or Oracle Complex Maintenance Repair, and 
Overhaul maintenance requirements.

Closure is prevented if any of these are associated with the service request, 
regardless of status.

You can turn upward propagation on by setting the system profile Service: Auto 
Closure of Service Request to Yes. You specify the status you wish to apply to the 
service request in Service: Service Request Auto Close Status.

The speed with which the service request is closed depends on your 
implementation of the Oracle Workflow Event Manager.

This module has seeded event subscriptions for the following two business events: 

1. oracle.apps.jtf.cac.task.updateTask: This event is raised whenever a task is 
updated. 

2. oracle.apps.cs.chg.Charges.submitted: This event is raised whenever a charge 
line is submitted to Order Management. 

For information on business events and the manager, see the Oracle Workflow 
Developer’s Guide.

1.28.1.3 Which Method to Choose
Your organization can take advantage of either or both of these methods of 
automating closure. Most organizations will want to turn on at least the downward 
propagation because it prevents agents from accidentally closing service requests 
that have tasks still being worked on.

If your organization delivers field service, you will also benefit from enabling 
upward closure. If your organization does not perform manual wrap-up of service 
requests after the engineers enter debrief information in the field, you can have the 
service requests set to a final status.

Or you can have all service requests set to a special wrap-up status that tells agents 
which service requests need to be wrapped up.

1.28.2 Setting Up Automatic Closure for Service Requests
Use this procedure to set up automatic closure of service requests and associated 
tasks.
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To set up automatic closure for service requests and tasks:
1. Navigate to Setup > Others > Profile System Values. 

2. If you wish to turn on downward propagation, then set the following two 
system profile options:

■ Set Service: Validate and Auto Close on Service Request Closure to Yes at 
the site level to turn on downward propagation. By default this profile is set 
to No.

■ Set Service: Task Auto Close Status to the status you wish to use for all tasks 
closed automatically. By default, this profile option is not set to any status.

3. If you wish to turn on upward propagation, then set the following two system 
profile options:

■ Set Service: Auto Closure of Service Request to Yes at the site level to turn 
on upward propagation. By default this profile is set to No.

■ Set Service: Service Request Auto Close Status to the status you wish to use 
for a service request that has been closed automatically. By default, this 
profile option is not set to any status.

1.29 Setting Up Custom Tabs on the Service Request Window
Implementers can create two custom tabs in the Service Request window by 
modifying the code for the Service Request form and the associated library. 

The customization must be made on a view or a table that has a reference to or 
intersection with CS_INCIDENTS_ALL_B. The application passes the INCIDENT_
ID to the control block of the form and this can be used to retrieve or save to and 
from the custom tabs.

This topic covers:

■ Basic Information on page 1-100

■ Guidelines for Setting Up Custom Tabs on page 1-101

■ Parameters Passed from the Service Request Header on page 1-103

■ Function Name for Custom Tabs on page 1-104

1.29.1 Basic Information
This section describes basic information for the application developer about both 
tabs.
1-100 Oracle TeleService Implementation Guide 



Setting Up Custom Tabs on the Service Request Window
1.29.1.1 Custom1 Tab
Form name: CSXSRCT1.fmb 

Library name: CSSRCT1.pld

Tab page name: CSXCUST1

Canvas name: CSXSRCT1

Data block name: CSXCUST1_BLK

Control block name:CSXCUST1_CTRL_BLK

Window Name: FOLDER_INCIDENT_TRACKING

1.29.1.2 Custom2 Tab
Form name: CSXSRCT2.fmb 

Library name: CSSRCT2.pld

Tab page name: CSXCUST2

Canvas name: CSXSRCT2

Data block name: CSXCUST2_BLK

Control block name: CSXCUST2_CTRL_BLK

Window name: FOLDER_INCIDENT_TRACKING

1.29.2 Guidelines for Setting Up Custom Tabs
These steps provide guidelines to help you with custom tab implementation.

Prerequisites
Knowledge of Oracle Forms development procedures and an understanding of 
Oracle TeleService code.

To set up the two custom tabs:
1. Customize the form using the following guidelines:

■ In the form CSXSRCT1.fmb and/or CSXSRCT2.fmb, create a data block 
with all the fields you wish to display in the custom tab. 

■ Code an On Insert trigger for the data block to insert data into the tables.

■ Code an On Update trigger for the data block to update data in the tables.
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■ Code an On Delete trigger for the data block to delete data from the tables.

■ The fields in the data block must be placed on the tabbed canvas CC_MAIN_
CSXCUST1.CSXSRCT1 and/or CSXCUST2.CSXSRCT2

■ Any record groups and LOVs must be coded. 

■ In order to integrate this with the Service Request window, you must add 
the data block, record groups, and LOVs for CSXSRCT1.fmb to the 
CSXSRCT1_OBJ_GRP object group. Those for CSXSRCT2.fmb must be 
added to the CSXSRCT2_OBJ_GRP object group.

2. Modify the library using the following guidelines:

■ You can use any of the following event handlers:

Procedure Name Description

WHEN-NEW-FORM-INSTANCE This procedure calls WHEN-NEW-FORM-INSTANCE 
of the custom form. Code is added to this library 
based on the requirements of the custom form. 
This trigger is called from the 
WHEN-NEW-FORM-INSTANCE of the main form.

KEY-CLRFRM This procedure calls CLEAR_CTRL_FIELDS, a 
procedure that clears the control field values 
populated by values from the header region. This 
is called from the KEY_CLRFRM of the main form

POPULATE_CTRL_FIELDS This procedure populates the control fields from 
the main form. This is called by the 
WHEN-NEW-FORM-INSTANCE, RESTART, and 
WHEN-TAB-PAGE-CHANGED triggers.

SHOW_TAB_VIEW This procedure can be used to show the stacked 
canvases used in the custom tab, if any. This is 
called in the WHEN-TAB-PAGE-CHANGED trigger of 
the main form.

HIDE_TAB_VIEW This procedure can be used to hide the stacked 
canvases used in the custom tab, if any. This is 
called in the WHEN-TAB-PAGE-CHANGED trigger 
of the main form.

WHEN_TAB_PAGE_CHANGED This procedure populates the control block fields 
and can be coded to customize any other functions. 
This is called in the WHEN-TAB-PAGE-CHANGED 
trigger of the main form.
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■ All the code to handle API calls can be put in the library CSSRCT1.pld 
and/or CSSRCT2.pld. 

3. Integrate the forms with the Service Request form:

a. Copy the forms CSXSRCT1.fmb and/or CSXSRCT2.fmb to the $AU_ 
TOP/forms/US directory in the patched environment.

b. Compile the corresponding library and copy CSSRCT1.pll and/or 
CSSRCT2.pll to the $AU_TOP/resource directory in the patched 
environment.

c. Run the adadmin utility to compile CS forms and libraries so that the 
changes made to the custom form and library are reflected in the Service 
Request form.

1.29.3 Parameters Passed from the Service Request Header
The following parameters are passed from the Service Request form to the 
CSXSRCT1 and CSXSRCT2 forms:

ALLOW_ACCESS This can be coded to enable the custom tabs. This 
is called in the WHEN-NEW-FORM-INSTANCE 
trigger of the main form.

DENY_ACCESS This can be coded to disable the custom tabs. This 
is called in the WHEN-NEW-FORM-INSTANCE 
trigger of the main form.

CLEAR_CTRL_FIELDS This procedure clears the control fields. This is 
called from the Key_Clrfrm Procedure of the 
custom library.

RESTART This procedure can be used to populate the control 
fields. This is called from the RESTART trigger of 
the main form.

Parameter Description

 CSXCUST1_CTRL_BLK. 
INCIDENT_ID

Identification number for the Service Request 

CSXCUST1_CTRL_BLK.INCIDENT_
TYPE_ID

Identification number for the Service Request type

Procedure Name Description
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These parameters are populated by the POPULATE_CTRL_FIELDS procedure, 
which is called by the WHEN-NEW-FORM-INSTANCE trigger, the 
WHEN-TAB-PAGE-CHANGED trigger, and the RESTART trigger.

1.29.4 Function Name for Custom Tabs
The function name for CSXSRCT1 is CS_HA_AXS_CUSTOM1_TAB. For CSXSRCT2 it 
is CS_HA_AXS_CUSTOM2_TAB. You can add these functions to the CS_HA_
SERVICE_REQ_FUNCTIONS to show the custom tabs.

By default, the tabs are hidden, so you must enable the function in the menu CS_
HA_SERVICE_REQ_FUNCTIONS.

Either of the custom tabs can also be set as default tabs.

CSXCUST1_CTRL_BLK.INCIDENT_
STATUS_ID

Identification number for the Service Request 
Status

CSXCUST1_CTRL_BLK.INCIDENT_
SEVERITY_ID

Identification for the Service Request Severity

CSXCUST1_CTRL_BLK.INCIDENT_
OWNER_ID

Identification number for the Service Request 
Owner

CSXCUST1_CTRL_BLK.OWNER_
GROUP_ID

Identification number for the Service Request 
Owner Group

CSXCUST1_CTRL_BLK.INCIDENT_
NUMBER

Service Request Number

CSXCUST1_CTRL_BLK. INCIDENT_
DATE

Service Request Date 

Note: Please back up your custom forms and libraries before 
applying any future CS patches for these files so they are not 
over-written in $AU_TOP/forms/US and $AU_TOP/. After the 
patch is applied successfully, you must copy the customized files 
back to these directories and run adadmin to generate CS forms 
and libraries. 

If Oracle supplies a bug fix in the future for the custom forms and 
libraries you modify, then you must copy your modifications from 
the backup to the newer version of the files.

Parameter Description
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1.30 Integrating with Oracle Enterprise Asset Management
To make it possible for agents to view and create work orders, you must set up 
Oracle Enterprise Asset Management according to the procedures described in the 
Oracle Enterprise Asset Management User’s Guide and set up Service Request Types 
with the Asset Maintenance check box selected. See Setting Up Service Request 
Types on page 1-15. This is the only implementation step within Oracle TeleService.

1.31 Enabling Oracle Complex Maintenance, Repair, and Overhaul
To make it possible for agents to access Oracle Complex Maintenance, Repair, and 
Overhaul maintenance requirements, you must implement Oracle Complex 
Maintenance, Repair, and Overhaul according to that application’s documentation 
and create Service Request Types with the Complex Maintenance check box 
selected. See Setting Up Service Request Types on page 1-15. This is the only 
implementation step within Oracle TeleService.
Implementing Service Requests 1-105



Enabling Oracle Complex Maintenance, Repair, and Overhaul
1-106 Oracle TeleService Implementation Guide 



Implementing Service Request and Task Assign
2

Implementing Service Request and Task

Assignment

Agents use the Universal Work Queue to obtain their work assignments which can 
consist of service requests and tasks. This chapter explains how to automate the 
assignment of service requests and tasks to group and individual work queues. It 
covers:

■ Types of Assignment on page 2-1

■ Process of Assigning Ownership Outlined on page 2-5

■ Assignment Setup Variations  on page 2-9

■ Setting Up Automated Assignment on page 2-16

■ Setting Up Service Territories on page 2-21

■ Setting Up the Load Balancing Formula on page 2-24

■ Specifying the Numerical Equivalents for Skill Levels on page 2-27

2.1 Types of Assignment
This topic explains the different modes of service request and task assignment. It 
covers:

■ Overview  on page 2-2

■ Pull Method Explained on page 2-3

■ Push Method Explained on page 2-4
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Types of Assignment
2.1.1 Overview
This topic explains the differences between manual work assignment and the two 
modes of automated assignment.

2.1.1.1 Manual Assignment
Agents can take ownership of any task or service request in the Universal Work 
Queue or assign ownership of that item to a different individual provided they can 
access the work queue. 

Manual work assignment:

■ Does not take into account the priority of the item the agent chooses to work on.

■ Does not prevent multiple agents from choosing to work on the same item.

2.1.1.2 Semi-automated Work Assignment
Agents can also use the Assignment Manger to help them assign work. This 
application foundation module can be invoked by clicking the button beside the 
Owner fields in the Service Request window and the Service Request tab of the 
Contact Center.

Agents can use the Assignment Manager in the assisted mode, in which case the 
Assignment Manger preselects a list of resources based on service territories and 
preferred resources in Oracle Service Contracts. In the manual mode, agents select a 
resource using a list of values of all available resources.

See the Assignment Manager Section of the Oracle Common Application Components 
User's Guide and Oracle Common Application Components Implementation Guide.

2.1.1.3 Automated Work Assignment
To overcome these problems, Oracle TeleService provides service organizations two 
ways of automating the assignment of work to agents:

■ Push Method

The application assigns service request and task ownership to groups and 
individuals based on contracts, installed base, and service territories. 

When assigning service requests to individuals, the application also takes into 
account qualifications, availability, and the workload of your resources.

■ Pull Method
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The application assigns service requests and tasks to groups, but leaves the 
individual agents within those groups to request ownership of those items 
through the Universal Work Queue.

The process for assignment of tasks and service requests is similar, but separate. 
This means that your organization can use one method to assign tasks and the 
second for service requests. However, if you use the pull method for both service 
requests and task, then service requests must be assigned to an owner before the 
application can automatically assign its tasks. 

You can have the application assign a service request in two ways:

■ Every time a service request is created or updated either manually or 
automatically.

■ In batches by periodically running a concurrent program.

Tasks can be assigned automatically when the task is created or must be assigned 
manually by the agent.

The application assigns a task or a service request only if the agent does not assign 
ownership manually and then only to agents that have the right security 
permissions. Agents can override any automatic assignment by making an entry in 
the owner fields using the lists of values.

2.1.2 Pull Method Explained
The pull method assigns work to the group work queue and permits agents to 
request work either by clicking the Request Work or Next Work buttons. 

■ Request Work

The Request Work button looks at all of the unassigned work and assigns the 
next highest priority item to the agent. 

This button is available only in the Universal Work Queue window toolbar.

Note: If you are having the application generate tasks 
automatically based on service requests types and extended 
attributes, then tasks are assigned to the individual you have 
specified in that setup, not through automatic assignment. See 
Generating Tasks Based on Service Request Type and Extended 
Attribute Values on page 3-11.
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■ Next Work

The Next Work button looks both in the unassigned and agent’s queues and 
opens the next highest priority work item. If the item is unassigned the 
application automatically assigns it to the agent. 

This button is available in both the Universal Work Queue and Service Request 
window toolbars.

The Universal Work Queue presents agents with the next most urgent service 
request or task to work on. The application determines which item is the most 
urgent based on the priority, due date, and time.

■ For service requests:

The priority is based on a classification of the severity of the service request. 
This is set in the Service Request Severities window using the Priority Code 
LOV. 

The due date is either the Respond By date (if the organization has not yet 
responded) or the Resolved By date.

■ For tasks:

The priority is based on the Task Priority.

The due date is the task’s Planned End Date.

Agents can specify that a particular task or service request is on hold by selecting a 
task or service request status that has been specified as being on hold. This prevents 
the application from displaying the same high priority item over and over again 
when an agent clicks the button. 

2.1.3 Push Method Explained
The push method automatically assigns work to the work queues of individual 
agents or groups. Agents can over-ride the automatic assignment by selecting a 
different owner.

Note: Although it is called the pull method, this work assignment 
method does automatically assign the service request or task to the 
group work queue. Its name is based on the fact that agents must 
assign the work item to themselves either by selecting it from the 
group work queue or by using the Next Work or Request Work 
buttons. 
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Service Request Assignment
The application assigns service request ownership to individual agents or work 
groups and places the service request in their work queues. 

Service request owners coordinate the resolution of a customer service request and 
monitor the completion of the various tasks different individuals within the 
organization must perform in order to resolve it. 

If an agent manually enters a Group Owner for a service request and leaves the 
individual owner field blank, then the assignment engine chooses the best qualified 
resource from the group provided.

The autoassignment operates only on active service requests, those that have not 
been set to a status specified as final. 

Task Assignment
The application assigns ownership of a task, an individual unit of work that must 
be performed to resolve the service request, to either an individual or group owner.

A task owner is responsible for the completion of the task and its entry is 
mandatory. Each task can also have one or more assignees who are actually 
responsible for completing the work. 

Assignees are optional and not assigned by the application. For many types of 
tasks, the owner and assignee can be one and the same person. For field service 
tasks, the task owner is usually the dispatcher and the assignee is the field service 
engineer performing the work at the customer site.

2.2 Process of Assigning Ownership Outlined
This topic explains:

■ How the Application Assigns Ownership of Service Requests on page 2-5

■ How the Application Assigns Ownership of Tasks on page 2-8

2.2.1 How the Application Assigns Ownership of Service Requests
For both the pull and push assignment, the automated assignment process first 
assigns group owners for service requests.

If you are implementing push assignment to individuals, then the application 
assigns ownership to individual resources as a second step:
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■ If an agent has assigned group ownership manually on the Service Request 
window, then the process performs only the second step, assigning ownership 
to individuals within the selected group.

■ If an agent assigns an individual owner, then the application does not assign a 
group owner. 

2.2.1.1 How the Application Assigns Group Ownership for Service Requests
To determine which group queue is assigned ownership the autoassignment 
process:

1. Searches contracts for preferred group resources. Oracle Installed Base does not 
support groups for preferred resources.

You can have the process check either Oracle Service Contracts, Oracle Install 
Base or both by setting the profile option JTFAM: Resource Search Order. If 
multiple preferred groups exist, it assigns ownership to the first group it finds.

If the process finds a group owner in this step, it terminates. It multiple groups 
are found, then ownership is assigned to the first group found.

2. Searches for qualified resources using service territories

If the contract does not specify group ownership, then autoassignment searches 
for group owners using the service territories set up with Oracle Territory 
Manager.

If multiple groups qualify as potential owners, then the process assigns 
ownership to the first group on the list. If no groups qualify, then the user 
receives an error message.

3. If you are using the pull model of autoassignment, the application determines 
the most urgent service request to assign based on the priority, due date, and 
time.

Note: In this release, there is no optimization between multiple 
groups. This means that the first group is always assigned 
ownership, regardless whether the resources belonging to other 
groups may be more qualified or available to handle the service 
request. Workload and skills optimization works only for resources 
within the winning group.
2-6 Oracle TeleService Implementation Guide 



Process of Assigning Ownership Outlined
The due date is either the Respond By date (if the organization has not yet 
responded) or the Resolved By date.

The priority is based on the classification of the severity of the service request 
you enter in the Priority Code field. It can have one of four values: critical, high, 
medium, or low.

If you wish to have the application assign ownership to groups only, then set the 
system profile Service: Service Request Auto Assignment Level to Group.

2.2.1.2 How the Application Assigns Service Request Ownership to Individuals
Only the push model assigns work to individual resources automatically. In this 
case, you must set the system profile Service: Service Request Auto Assignment 
Level to Individual.

The process:

1. Searches customer contracts and the installed base for preferred individual 
resources

The autoassignment process first checks to see if there are any preferred 
individual resources listed in the contracts or the installed base for the specific 
item. You can have the process check either contracts or the installed base or 
both by setting the profile option JTFAM: Resource Search Order. All resources 
found are included in the list of potential owners. If the process finds preferred 
resources here it adds them to the list of possible owners, it does not check the 
service territories in the next step.

2. Searches for qualified individuals using service territories

If neither the contract nor the installed base include preferred resources, then 
the autoassignment process checks to see if the service request attributes can be 
matched against any of the service territories set up with Oracle Territory 
Manager. If the service request can be assigned to a territory, then the individual 
resources listed in the territory become the potential owners.

3. Eliminates resources who are not members of the group assigned group 
ownership

The autoassignment process eliminates from the list of potential owners all the 
individual resources that are not members of the group selected as the group 
owner.

4. Eliminates unavailable resources
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The autoassignment eliminates from the list of possible owners any resources 
who have indicated that they are not available. Agents can indicate they are 
unavailable in Oracle TeleService by deselecting the Available check box in the 
Resource Availability window (Tools1 > Web Availability). 

5. Picks the best resource using an optimizer formula.

The formula calculates a score for each resource and selects the one with the 
highest score.

The calculation balances the level of skill for a resource (the sum of skill levels 
for the product, platform, product category, and the problem code) with the 
backlog of service requests of different severities (Severity 1 through Severity 4) 
and the difference in time zones between the customer and the agent. 

You must assign weights for each of the factors in the formula for each Service 
Request Type and severity using the Load Balancing Weights window (Setup > 
Service Requests > Load Balancing Weights). You can set up different weights 
for each Service Request Type and service request severity. See Setting Up the 
Load Balancing Formula on page 2-24.

2.2.2 How the Application Assigns Ownership of Tasks
This topic explains how the automated assignment process assigns ownership of 
service request tasks.

Unlike service requests that can have both a group and individual owners, tasks can 
have either an individual or a group owner. 

You must decide which type of owner you wish to assign by setting the system 
profile: Service: Service Request Task Auto Assignment Level:

■ For the push model, you set this system profile to Individual.

■ For pull, you set it to Group.

The process for assigning tasks is similar to the two-step process used to assign 
group ownership of service requests with a few minor differences.

The application:

1. Searches contracts and installed base for preferred group or individual 
resources

You can have the process check either Oracle Service Contracts, Oracle Install 
Base or both by setting the profile option JTFAM: Resource Search Order.
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If multiple preferred resources exist, the process assigns ownership to the first it 
finds.

If the process finds an owner in this step, it terminates. 

2. Searches for qualified resources using service territories

If neither the contract or installed base specify ownership, then autoassignment 
searches for group or individual owners using the service territories set up with 
Oracle Territory Manager. 

For the push model, you must assign an individual resource to each territory. 
For the pull model, you must assign a group. The territories must be of the 
Service Request and Task transaction type.

If multiple groups or individuals qualify as potential owners, then the process 
assigns ownership to the first resource on the list. If no resource qualifies, then 
the user receives an error message.

3. If you are using the pull model of automated assignment, the application 
determines the most urgent task to assign based on the priority, due date, and 
time.

The priority is based on the Task Priority. It can have one of four values: critical, 
high, medium, or low. The due date is based on the Planned End Date.

The process does not use the work load balancing formula for assigning tasks to 
individuals.

2.3 Assignment Setup Variations
Because you can set up the assignment of service requests and tasks independently 
multiple setup variations are possible:

■ Push for service requests only (See description on page 2-10.) 

■ Pull for service requests only (See description on page 2-11.) 

■ Push for both service requests and tasks (See description on page 2-12.) 

■ Push for service requests and pull for tasks (See description on page 2-13.) 

■ Pull for both service requests and tasks (See description on page 2-14.) 

■ Pull for service requests and push for tasks (See description on page 2-15.) 

You can implement these variations through different setups of:

■ Service territories set up with Territory Manager
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■ The following system profile options:

Explanations of the different scenarios and the relevant profile settings and territory 
setups for each are given below:

2.3.1 Push for Service Requests Only
Automatically assigns service request ownership to individuals or groups. Use this 
setup if your organization uses only service requests to assign work. 

Territory Management Setups
If you are assigning service requests to groups only, then you need to create only 
one service territory hierarchy using group resource qualifiers.

System Profile Name
Possible 
Values

Default 
Setting Description

Service: Enable Service 
Request-UWQ Workitem 
Integration

Yes or No No Setting the profile to Yes makes it possible for agents 
to use the Request Work and Next Work buttons for 
service requests and service request tasks.

This system profile must be set to Yes for the pull 
method.

Service: Service Request Task 
Owner Field Optional 

Yes or No No A setting of Yes makes the Task Owner field optional. 
When an agent does not make an entry, this 
automatically triggers the task assignment 
functionality (both pull and push models) at the time 
the task is saved. The application automatically 
assigns the owner.

Service: Service Request Owner 
Auto Assignment Level

Group or 
Individua
l

Individ
ual

This profile determines the level of autoassignment 
for service requests. A setting of Individual assigns 
ownership to a group and to an individual. A setting 
of Group assigns ownership to a group only. 

This system profile must be set to Group for the Pull 
Method.

Service: Service Request Task 
Owner Auto Assignment Level

Group or 
Individua
l

Individ
ual

This profile determines the type of owner assigned to 
a service request task. A setting of Individual assigns 
ownership to an individual resource. A setting of 
Group assigns ownership to a group.

This system profile must be set to Group for the Pull 
Method.
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If you are assigning service requests to individuals, then you must set up two sets of 
territories: one using group resources and the second with the individual resources.

Select Service Request as the Territory Transaction Type for each territory.

System Profile Settings
The following table outlines the settings of key profiles for this scenario:

2.3.2 Pull for Service Requests Only
Automatically assigns service request ownership to groups and let the individuals 
request ownership on their own.Use this setup if your organization uses only 
service requests to assign work. 

Territory Management Setups
As you are assigning service requests to groups only, you need to create only one 
service territory hierarchy and assign group resources to each territory.

Select Service Request as the Territory Transaction Type for each territory.

System Profile Settings
The following table outlines the settings of key profiles for this scenario:

System Profile Name Valid Setting Comments

Service: Enable Service Request-UWQ 
Workitem Integration

Yes or No Setting the profile to Yes enables the Request Work 
and Next Work buttons.

Service: Service Request Owner Auto 
Assignment Level

Individual or 
Group

Individual or Group, depending on whether you wish 
to assign ownership to individual agents (more likely) 
or groups (less likely). The preferred setting for the 
push method is Individual.

System Profile Name Valid Setting Comments

Service: Enable Service Request-UWQ 
Workitem Integration

Yes Setting the profile to Yes to enable the Request Work 
and Next Work buttons. This ensures that agents are 
receiving the highest priority work item from among 
all of the assigned and unassigned items.

Service: Service Request Owner Auto 
Assignment Level

Group Set to Group. The pull model requires the application 
to assign the service request to the agent’s group. 
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2.3.3 Push for Both Service Requests and Tasks
Use this setup if you wish to automatically assign the ownership of both service 
requests and tasks to individual agents or dispatchers. This setup is appropriate for 
organizations where service request owners are different individuals from task 
owners. 

Territory Management Setups
You must create three territory hierarchies: 

1. For assigning service requests to groups. You must assign a group resource to 
each territory and select Service Request as the Territory Transaction Type.

2. For assigning service requests to individuals. You must assign an individual 
resource to each territory and select Service Request as the Territory Transaction 
Type.

3. For assigning tasks to groups, you must assign a group resource to each 
territory and select Service Request and Task as the Territory Transaction Type.

4. For assigning tasks to individuals, you must assign an individual resource to 
each territory and select Service Request and Task as the Territory Transaction 
Type. 

System Profile Settings
The following table outlines the settings of key profiles for this scenario:

IEU: Distribute: Service Request Task: 
Work Source 

Yes This profile enables the Universal Work Queue for 
pull assignment by activating tasks.

IEU: Distribute: Service Request: Work 
Source

No This profile enables the Universal Work Queue for 
pull assignment by activating service requests.

System Profile Name Valid Setting Comments

Service: Enable Service Request-UWQ 
Workitem Integration

Yes or No Setting the profile to Yes enables the Request Work 
and Next Work buttons. 

Service: Service Request Task Owner 
Field Optional 

Yes Turns on automatic task assignment and makes task 
owner optional.

System Profile Name Valid Setting Comments
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2.3.4 Push for Service Requests and Pull for Tasks
This setup is appropriate for organizations that wish to assign service request 
ownership, but want to leave it up to agent or dispatcher to request task ownership. 

Territory Management Setups
You must create three territory hierarchies: 

1. For assigning service requests to groups. You must assign a group resource to 
each territory and select Service Request as the Territory Transaction Type.

2. For assigning service requests to individuals, you must assign an individual 
resource to each territory and select Service Request as the Territory Transaction 
Type.

3. For assigning tasks to groups, you must assign a group resource to each 
territory and select Service Request and Task as the Territory Transaction Type.

System Profile Settings
The following table outlines the settings of key profiles for this scenario:

Service: Service Request Owner Auto 
Assignment Level

Individual or 
Group

Individual or Group, depending on whether you wish 
to assign ownership to individual agents (more likely) 
or groups (less likely). The preferred setting for the 
push method is Individual.

Service: Service Request Task Owner 
Auto Assignment Level

Individual or 
Group

Individual or Group, depending on whether you wish 
to assign ownership to individual agents (more likely) 
or groups (less likely). The preferred setting for the 
push method is Individual.

IEU: Distribute: Service Request Task: 
Work Source 

No This profile enables the Universal Work Queue for 
pull assignment by activating tasks. 

IEU: Distribute: Service Request: Work 
Source

No This profile enables the Universal Work Queue for 
pull assignment by activating service requests. 

System Profile Name Valid Setting Comments

Service: Enable Service Request-UWQ 
Workitem Integration

Yes Setting the profile to Yes to enable the Request Work 
and Next Work buttons.

System Profile Name Valid Setting Comments
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2.3.5 Pull for Both Service Requests and Tasks
The application assigns ownership of service requests and tasks to the group work 
queue but leaves the agents to request the assignment when they are available.

This setup is appropriate for organizations that wish to let agents and dispatchers 
request work rather than assigning it to them. The group queues do not display any 
of the tasks for service requests that do not yet have an individual owner. This is 
because an individual service request owner is required for automatic assignment.

Territory Management Setups
You must create two territory hierarchies: 

1. For assigning service requests to groups. You must assign a group resource to 
each territory and select Service Request as the Territory Transaction Type.

2. For assigning tasks to groups, you must assign a group resource to each 
territory and select Service Request and Task as the Territory Transaction Type.

System Profile Settings
The following table outlines the settings of key profiles for this scenario:

Service: Service Request Task Owner 
Field Optional 

Yes Yes turns autoassignment on. To implement pull for 
tasks, you must create your service territories with 
group resources rather than individual resources.

Service: Service Request Owner Auto 
Assignment Level

Individual or 
Group

Individual or Group, depending on whether you wish 
to assign ownership to individual agents (more likely) 
or groups (less likely).

Service: Service Request Task Owner 
Auto Assignment Level

Individual or 
Group

Individual or Group, depending on whether you wish 
to assign ownership to individual agents (more likely) 
or groups (less likely). The preferred setting for the 
push method is Individual.

IEU: Distribute: Service Request Task: 
Work Source 

Yes This profile enables the Universal Work Queue for 
pull assignment by activating tasks. 

IEU: Distribute: Service Request: Work 
Source

Yes This profile enables the Universal Work Queue for 
pull assignment by activating service requests. 

System Profile Name Valid Setting Comments
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2.3.6 Pull for Service Requests and Push for Tasks
This is a very unlikely scenario that is useful only for organizations that wish to 
assign tasks ahead of service requests, perhaps to give individuals a head start on 
tasks with long lead times.

Territory Management Setups
You must create three territory hierarchies: 

1. For assigning service requests to groups. You must assign a group resource to 
each territory and select Service Request as the Territory Transaction Type.

2. For assigning tasks to groups. You must assign a group resource to each 
territory and select Task as the Territory Transaction Type.

3. For assigning tasks to individuals. You must assign an individual resource to 
each territory and select Service Request and Task as the Territory Transaction 
Type.

System Profile Settings
The following table outlines the settings of key profiles for this scenario:

System Profile Name Valid Setting Comments

Service: Enable Service Request-UWQ 
Workitem Integration

Yes Setting the profile to Yes to enable the Request Work 
and Next Work buttons.

Service: Service Request Task Owner 
Field Optional 

Yes Yes turns autoassignment on. To implement pull for 
tasks, you must create your service territories with 
group resources rather than individual resources.

Service: Service Request Owner Auto 
Assignment Level

Group Set to Group. The pull model requires the application 
to assign the service request to the agent’s group. 

Service: Service Request Task Owner 
Auto Assignment Level

Group Set to Group. The pull model requires the application 
to assign the service request to the agent’s group. 

IEU: Distribute: Service Request Task: 
Work Source 

Yes This profile enables the Universal Work Queue for 
pull assignment by activating tasks. 

IEU: Distribute: Service Request: Work 
Source

Yes This profile enables the Universal Work Queue for 
pull assignment by activating service requests. 
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2.4 Setting Up Automated Assignment
Use this procedure to set up the automatic assignment of service requests.

Prerequisites
The skills-selection and load balancing portion of the autoassignment process takes 
into account the following skills: 

■ Product Category

■ Product 

■ Problem Code

■ Platform

If you wish to take advantage of skills based assignment and autobalancing, then:

■ You must rate the resources on these skills for them to be included in the 
selection process

■ The service requests to be assigned must include at least one of these three 
factors.

System Profile Name Valid Setting Comments

Service: Enable Service Request-UWQ 
Workitem Integration

Yes Setting the profile to Yes to enable the Request Work 
and Next Work buttons.

Service: Service Request Task Tab 
Owner Field Optional 

Yes Yes turns autoassignment on. To implement push for 
tasks, you must create your service territories with 
individual resources rather than group resources.

Service: Service Request Owner Auto 
Assignment Level

Group Set to Group. The pull model requires the application 
to assign the service request to the agent’s group. 

Service: Service Request Task Owner 
Auto Assignment Level

Group or 
Individual

Set to Group. The pull model requires the application 
to assign the service request to the agent’s group. The 
preferred setting for the push method is individual.

IEU: Distribute: Service Request Task: 
Work Source 

Yes This profile enables the Universal Work Queue for 
pull assignment by activating tasks. 

IEU: Distribute: Service Request: Work 
Source

No This profile enables the Universal Work Queue for 
pull assignment by activating service requests. 
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To set up automated assignment:
1. Specify whether you wish autoassignment to check for preferred resources in 

contracts, the installed base, or both by setting the profile option JTFAM: 
Resource Search Order. 

The available settings are:

■ Both Contracts and Install Base (this is the default value)

Autoassignment returns all preferred resources found in contracts and 
installed base as possible owners.

■ Contracts Preferred Resource

Autoassignment uses only preferred resources found in contracts. If none 
are found, then and only then it searches the installed base.

■ Installed Base Preferred Resource. 

Autoassignment uses only preferred resources found in the installed base. If 
none are found, then and only then it searches contracts.

2. If you use Oracle Service Contracts and your contracts specify preferred 
resources, then you can restrict which resources are picked by business process 
by setting one or both of the following two system profile options:

■ Service: Use Business Process ID in Service Request Auto Assignment

A setting of Yes limits the search for preferred resources to the business 
process associated with the service request type

A setting of No returns all preferred resources as possible service request 
owners.

■ Service: Use Business Process ID in Service Request Task Auto Assignment

A setting of Yes restricts the search for preferred resources to the business 
process associated with the task type.

A setting of No returns all preferred resources as possible task owners.

Restricting the search for preferred resources using this two system profiles, 
may be required because Oracle Service Contracts can specify different 
resources for different business processes. For example, for field service, a 
contract may specify an expert engineer dedicated to fixing a particular piece of 
equipment for a customer. You may not wish to assign service request or task 
ownership to this individual.

3. If you are using pull assignment for service requests, then: 
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a. Set up service request statuses that can be used by agents to designate work 
on a service request has been suspended. You can designate a status as 
suspended by selecting the On Hold check box in the Service Request 
Statuses window.

Pull assignment permits agents to request the next most urgent piece of 
work from the Universal Work Queue by clicking the Next Work button.

Placing a service request on hold excludes the service request from the pool 
of work evaluated by the application when the agent requests the next 
highest priority work item. 

Without an on-hold status, the application will distribute the inactive 
service request over and over again if it happens to be the item with the 
highest priority.

See Setting Up Service Request Statuses on page 1-6 for details on status 
setup.

b. Navigate to Setup > Service Requests > Request Severities and specify the 
priority for each service request severity in the Service Request Severities 
window. 

The Next Work button in the Universal Work Queue presents agents with 
the most urgent service request to work on. The application determines 
which item to display based on the due date and time and priority.

The due date is either the Respond By date (if the organization has not yet 
responded) or the Resolved By date.

The priority is based on the classification of the severity of the service 
request you enter in the Priority Code field. It can have one of four values: 
critical, high, medium, or low.

4. Determine whether you want to enable automated assignment (both push and 
pull) each time a service agent creates a request using Oracle TeleService, by 
setting the system profile Service: FORMS - Automatic Assignment of Owner.

The available options are:

■ Yes

Use this setting if you want to trigger automated assignment each time a 
service request is created or updated in Oracle TeleService (both the 
Customer Care and Service Request modules).

■ No (the default setting)
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Use this setting if you want to let the concurrent program Automatic 
Assignment of Resource for Service Request take care of the assignment 
instead. If you wish to assign ownership with the concurrent program, then 
you must set up the concurrent program to run periodically.

5. If you have implemented Oracle iSupport, then specify whether or not you 
wish to enable automated assignment each time a customer creates a service 
request on the web. This is accomplished by setting the profile option Service: 
HTML - Automatic Assignment of Owner.

The available options are:

■ Yes

Use this setting if you want automatic assignment each time a service 
request is created in Oracle iSupport.

■ No (the default setting)

Use this setting if you want to let the concurrent program Automatic 
Assignment of Resource for Service Request take care of the assignment 
instead. If you wish to assign ownership with the concurrent program, then 
you must set up the concurrent program to run periodically.

6. Select one of the assignment scenarios you wish to implement from those listed 
in Assignment Variations on page 2-9 and set up service territories and the 
profile options accordingly. 

For territory setup, follow the procedures described in Oracle CRM Application 
Foundation User Guide and Oracle Territory Manager User Guide and the 
guidelines listed in Setting Up Service Territories on page 2-21.

For instructions on how to create preferred resources see Oracle Service Contracts 
Implementation Guide and Oracle Install Base Implementation Guide.

7. If you are automatically assigning service requests to individual resources, then:

a. Set up the numerical values you wish to use for each skill level as this will 
greatly influence assignment. See Specifying the Numerical Equivalents for 
Skill Levels on page 2-27.

b. Navigate to Setup > Service Requests > Load Balancing Weights and set up 
the formula the application uses to optimize assignment according to the 
procedure described in Setting Up the Load Balancing Formula on 
page 2-24.
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8. If you wish to assign service requests via the concurrent program, then set up 
the concurrent program Automatic Assignment of Resource for Service Request 
to run periodically:

■ If you wish to assignment all Service Request Types of all severities and all 
group owners, then do not enter any parameters.

■ You can restrict running the program by entering parameters for up to five 
Service Request Types, severities, and group owners. 

2.4.1 Post Installation Steps to Enable Service Request Automatic Assignment 
(Pull-Model)

Use this post installation procedure to enable Pull Assignment.

To enable Pull Assignment:
You must complete the following post installation steps to enable Pull Assignment:

1. Set profile the Service: Enable Service Request-UWQ Workitem Integration to 
Yes.

2. Run the concurrent program Service: Synchronize Service Requests and Work 
Items

This concurrent program synchronizes the Service Request schema with the 
UWQ metaphor schema. There are no mandatory parameters required to run 
this program. The program derives a default value for Priority Code attribute of 
Service Request Severity, if it is not yet set, based on the severity's importance 
level.

A work item will be created in UWQ for every open Service request. If there is 
already an existing work item in UWQ, and if any of the following service 
attributes have changed, the program will update the work item accordingly:

■ On-hold and Close flag (from Status)

■ Priority Code (from Severity)

■ Due Date

■ Owner Group Type

■ Group ID

■ Owner Type

■ Owner ID
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■ Summary

■ Customer ID

This concurrent program can be used to synchronize service requests work items 
whenever any of the Status and Severity attributes changed, such as Status On-hold 
or Close flags, and Severity Priority Code.

3. Run the concurrent program Service: Synchronize Service Request Task Work 
Items.

This program synchronizes task work items with the migrated service request 
work items. The work items need to be updated to indicate their new object 
code SR-TASKS, and implement any of the distribute dependencies defined for 
them. For example, SR-TASKS cannot be distributed unless the parent Service 
Request has been distributed. In this scenario, the SR-TASK work item is put 
on-hold until the parent service request has been distributed. 

2.5 Setting Up Service Territories
Use the information below as a guideline for setting up service territories according 
to the procedures described in Oracle CRM Application Foundation User Guide and 
Oracle Territory Manager User Guide. 

Oracle recommends that you set up different service territory hierarchies for 
assigning tasks and service requests and different territory hierarchies for assigning 
group and individual resources. 

For assigning tasks set up one of the following:

■ Territories for group resources if you are using the Pull Model

■ Territories for individual resources for the Push Model.

For assigning service requests, set up:

■ Territories for group resources if you are using either the Push or Pull Models

■ Territories for individual resources for the Push Model

Note: This concurrent program should not be run before running 
the concurrent program which synchronizes the service requests 
and the work items.
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When setting up territories for assigning service requests, you must select 
Service Request as the Transaction Type. 

For task territories, you must select Service Request and Task as the Transaction 
Type.

The following table lists the transaction qualifiers for both service requests and 
tasks in the order they appear in the list of values and explains their source.

You cannot use some of the qualifiers in the current release as indicated below.

Note: If you do not set up territories and the autoassignment 
process does not find any preferred resources in contracts or the 
installed base, then autoassignment generates a user error message.

Territory Transaction 
Qualifier

Available 
for Use UI Source / Comments

Account Code No Reserved for future use.

Area Code Yes Area code for a customer’s phone number from the 
Phone field in the Customer region of the Service 
Request window.

City Yes City of incident address entered in the Service Request 
header. 

Contact Preference Yes Customer contact preference entered in the 
Communication Preference field in the Service Request 
window.

Country Yes Country of incident address. 

County No Reserved for future use.

Customer Name Yes Customer name entered in the Name field in the 
Customer region of the Service Request window.

Customer Name 
Range

No Reserved for future use.

Customer Site No Reserved for future use.

Group Owner Yes Group Owner field in the Service Request window.

Inventory Item No Do not use. Instead, use the Product qualifier for 
inventory items.
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The following additional three qualifiers are available for tasks only:

Platform Yes Platform field on the Subject tab of the Service Request 
window.

Postal Code Yes Postal Code field of incident address. 

Problem Code Yes Problem Code field on the Workbench tab of the 
Service Request window.

Product Yes Item field in the Service Request window header.

Product Category Yes Category field on the header of Service Request 
window.

Province Yes Province of incident address. 

Request Creation 
Channel

Yes Channel field on the header of the Service Request 
Window.

Request Severity Yes Severity field on the header of the Service Request 
Window.

Request Status Yes Status field on the header of the Service Request 
Window.

Request Type Yes Type field on the header of the Service Request 
Window.

Request Urgency Yes Urgency field on the Workbench tab of the Service 
Request window.

Service Contract 
Coverage

Yes Coverage field on the header of the Service Request 
Window.

Service Item Yes The Service field on the header of the Service Request 
window

Service Request 
Language

Yes Language field in the header.

State Yes State field of incident address.

Support Site No Reserved for future use.

VIP Customers No Reserved for future use.

Territory Transaction 
Qualifier

Available 
for Use UI Source / Comments
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Although the Territory Management program makes it possible for you to 
create your territories based on product skills, Oracle recommends that you set 
them up on the basis of geography, or such factors as urgency and the service 
level agreement SLAs. The autoassignment process takes resource skills into 
consideration later during load balancing.

2.6 Setting Up the Load Balancing Formula
The optimizer load balancing formula picks the optimal individual for service 
request ownership within a group by balancing the level of skill for a resource (the 
sum of skill levels for the product, platform, product category, and the problem 
code) with the backlog of service requests of different severities and the difference 
in time zones between the customer and the agent. Use this procedure to customize 
the formula by setting up the weights for each factor. The weights determine how 
much importance each factor is given in the calculation.

You must set up separate weights for each Service Request Type and severity 
combination.

Prerequisites
You must set up the numerical values you wish to use for each skill level as this will 
greatly influence assignment. See Specifying the Numerical Equivalents for Skill 
Levels on page 2-27.

To set up the load balancing formula:
1. Navigate to Setup > Service Requests > Load Balancing Weights.

Territory Transaction 
Qualifier

Available 
for Use UI Source / Comments

Task Type Yes Task Type field.

Task Status Yes Task Status field.

Task Priority Yes Task Priority field.

Note: Territory setup forces you to hardwire all possible resources 
into each territory by entering them on the Resources tab of the 
Territory Manager. This means that if you do choose to use 
territories for autoassignment, you must update the list of resources 
in your territories as employees are hired or change their skill sets.
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The Load Balancing Weights window appears.

2. For each Service Request Type and severity combination enter the weights to be 
used by the formula:

a. Enter the Service Request Type and severity you wish to set up using the 
LOVs.

b. Enter the weights:

The optimizer formula calculates the score for each resource as a sum of the 
factors multiplied by the weights you enter in this window. The resource 
with the highest score becomes the owner.

Score for Each Potential Owner = Category Skill(weight 1) + Product 
Skill(weight 2) + Platform Skill (weight 3) + Problem Code Skill(weight 
4) + Time Since Last Assignment(weight 5) + Severity One Count(weight 6) 
+ Severity Two Count(weight 7) + Severity Three Count (weight 8) + 
Severity Four Count (weight 9) + Time Zone Difference (weight 10)

The table below explains each factor:

No. Factor Name Description

1 Category Skill Product category skill level of the resource entered in the 
Resource Manager. The formula uses the numeric value 
assigned to the proficiency level the employee.

2 Product Skill Product skill level of the resource entered in the Resource 
Manager. The formula uses the numeric value assigned to 
the proficiency level the employee.
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■ Enter positive weights for the skill levels (factors 1 through 4). 

■ Enter negative weights for the backlog of service requests of different 
severities (factors 6 through 9), the Last Login Time (factor 5), and the Time 
Zone Difference (factor 10). 

■ There is no restriction on the numerical value of the weights. 

■ If you wish to remove a particular factor from the formula, you can assign it 
a weight of 0.

3 Platform Skill Product platform skill level of the resource entered in the 
Resource Manager. The formula uses the numeric value 
assigned to the proficiency level the employee.

4 Problem Code 
Skill

Product code skill level of the resource entered in the 
Resource Manager. The formula uses the numeric value 
assigned to the proficiency level the employee.

5 Time Since 
Last 
Assignment

The time in minutes since the agent received the last 
service request assignment.

6 Severity One 
Count

The number of backlogged service requests of the highest 
severities. These include all of the severities that you 
have set with importance = 1. See Setting Up Service 
Request Severities  on page 1-29. 

7 Severity Two 
Count

The number of backlogged service requests of high 
severities. These include all of the severities that you 
have set with importance = 2. 

8 Severity Three 
Count

The number of backlogged service requests of medium 
severities. These include all of the severities that you 
have set with importance = 3. 

9 Severity Four 
Count

The number of backlogged service requests of low 
severities. These include all of the severities that you 
have set with importance = 4. 

10 Time Zone 
Difference

This factor which is based on the difference between the 
time zone of the contact and the support site, is 
calculated based on the practices of Oracle’s own support 
organization. Time Zone Difference = [Round (2.77 - 
Absolute Value (contact time zone - support site time 
zone in hours/4)].

No. Factor Name Description
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2.7 Specifying the Numerical Equivalents for Skill Levels
Use this procedure to specify a numerical value for each of the six default skill 
levels. The numerical skill level is one of the factors used by the work-load 
balancing formula to calculate the optimal resource to assign as the service request 
owner. This means that you must enter the smallest number to the Basic Skill level 
and the highest number to Expert. The formula assigns ownership to the resource 
with the highest skill level. The higher the number you enter here, the more 
important skill will be as a factor in the formula.

To specify the numerical equivalents for skill levels:
1. Log into HTML applications under the Resource Self Service Administrator 

Responsibility.

2. Select the Administration tab and Skill Levels subtab.

The Define Skill Levels page appears.

3. If you wish, you can modify the wording for the skill level.

4. Enter a numeric value for each of the skill levels.

5. Click Update.
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3

Automatic Task Generation for Service

Requests

This chapter describes how to implement the automatic generation of tasks for 
service requests. It covers:

■ Understanding Automatic Task Generation on page 3-1

■ Generating Tasks on Request Types, Items and Problem Codes on page 3-5

■ Generating Tasks on Request Types and Attribute Values on page 3-11.

■ Customizing Automatic Task Generation on page 3-13

3.1 Understanding Automatic Task Generation
This group of topics explains the concepts behind automatic task generation. It 
provides: 

■ An overview on page 3-2

■ A description of the two methods for generating tasks:

■ Method 1: Using Service Request Types, Item or Item Categories, and 
Problem Codes  on page 3-2

■ Method 2: Using Service Request Types and Information Entered in 
Additional Service Request Attributes on page 3-4

■ Implementation guidelines for applications other than Oracle TeleService. See 
Automatic Task Generation and Other E-Business Suite Applications on 
page 3-4
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3.1.1 Overview
When an agent creates a service request, the application can automatically generate 
tasks that will be used in the resolution of the customer problem. This makes it 
possible for an agent to schedule a repair on the first call rather than having the 
dispatcher to call the customer back, for instance.

Automatic task generation is most useful for known problems that have standard 
resolutions. If agents need to research the problem, by using the knowledge base 
and other methods, then the tasks required to resolve the problem will vary.

The generated tasks appear in the Task tab of the service request and must be 
assigned and scheduled by the agent handling the service request or through 
automatic assignment.

Using the procedures described in this topic group, you can automatically generate 
tasks based on one of the following two types of criteria:

■ A combination of the Service Request Type, the item or item category, and 
problem code

For example, a manufacturer of laboratory equipment can automatically set up 
tasks to send different diagnostic equipment to a customer’s site depending on 
what equipment type and model the customer owns.

■ Service Request Type and information entered in additional service request 
attributes you have set up

For example, a city’s solid waste department can automatically create tasks to 
send a different truck depending on the size of the item to be picked up. 

You must choose between the two methods, which are mutually exclusive at the 
site, application, or responsibility level, by setting the profile Service: Auto Generate 
Tasks on SR Create.

3.1.2 Method 1: Using Request Types, Item Information, and Problem Codes
To automatically generate one or more tasks based on Service Request Types, Item 
or Item Categories, and Problem Codes, you: 

1. Set up templates for task generation using the Task common application 
module. The templates are called Task Group Templates because they can be 
used to generate one or more tasks.

2. Map the task group templates to the conditions that will trigger task creation.
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You can map a task group template to one or more of the following:

■ A Service Request Type

■ A problem code

■ An item or item category

For any service request, the application creates tasks from only one task group 
template. 

Because mappings you create can overlap, however, you must set up a set of rules 
for the application to determine which mapping to choose in case they do.

For example, for customers reporting blurred images on their X-ray machines, a 
medical diagnostic equipment company may wish to send a technician to asses the 
nature of the problem first if the caller doesn’t know the make or the model of the 
machine they own. But if a customer calls in with the details, the company may 
send a repair crew with the correct parts right away.

In this case, the company creates two mappings:

Mapping 1

The mapped task template group creates a task to send a technician to 
investigate the nature of the problem.

Mapping 2

The mapped task template group creates a task to send a repair crew with the 
correct parts.

Mapping Object Value

Service Request Type Image Problems

Item Category X-ray machines

Mapping Object Value

Service Request Type Image Problems

Item Acme X-ray Model #1
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If an agent creates a service request for a problem with the Acme X-ray machine 
Model #1, both mappings are valid.

To handle the overlapping case, the company sets up a rule that in case both 
mappings apply, the application chooses the most specific mapping. 

3.1.3 Method 2: Using Request Types and Additional Attributes
If you have set up your Service Request Types to capture additional information, 
(see Capturing Additional Service Request Attributes on page 1-49), you can 
generate tasks based on a combination of the Service Request Type and the 
information agents or customers enter. 

Suppose, for example, that a government agency sets up the Abandoned Vehicle 
Service Request Type to capture additional information required to deal with the 
problem.

Whenever agents create a service request of type “Abandoned Vehicle”, the 
application presents them with a list of questions: What is the make of the vehicle?, 
the model?, The color?, The license plate number?, Does it carry hazardous 
materials? 

You can set up the application to automatically create a task based on the values an 
agent enters in any attribute. For example, if the agent specifies that the vehicle is a 
bus, the application creates a task to send a large tow truck. If the vehicle is a 
passenger car, the task will be for a small tow truck. If the vehicle carries hazardous 
materials, the application creates an additional task to alert the hazardous materials 
team.

Optionally, you can set up the task to launch an Oracle Workflow process and pass 
to it parameters you specify. 

3.1.4 Automatic Task Generation and Other E-Business Suite Applications
If you are implementing other Oracle E-Business Suite Applications that use service 
requests, here are a few considerations for implementing automatic task generation:

■ Oracle iSupport

Customers creating service requests in Oracle iSupport only see the tasks if you 
set them to the status of Public.

■ Oracle Knowledge Management
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Oracle Knowledge Management makes it possible for solutions to include task 
templates agents can use these to generate tasks manually. If you are using this 
feature, you may wish to restrict automatic task creation to Service Request 
Types that do not require knowledge management searches to prevent the 
accidental creation of duplicate tasks.

■ Oracle Enterprise Asset Management and Oracle Complex Maintenance, 
Repair, and Overhaul 

These two applications do not use tasks for assigning work, so you do not want 
to set up automatic task generation for the Service Request Types for these 
applications.

3.2 Generating Tasks on Request Types, Items, and Problem Codes
This group of topics explains how to implement the automatic generation of tasks 
based on Service Request Types, item or item categories, and problem codes. 

The general procedure for the setup is covered in Setup Procedure Overview on 
page 3-5.

The other topics provide details for:

■ Viewing Task Template Mappings on page 3-6

■ Specifying Conditions for Task Generation on page 3-7

■ Updating a Task Template Group Mapping  on page 3-8

■ Setting Up Rules for Handling Multiple Valid Mappings on page 3-9

3.2.1 Setup Procedure Overview
This procedure outlines the steps for implementing automatic task generation based 
on Service Request Types, item or item categories, and problem codes.

To set up automatic task creation:
1. Set the system profile option Service: Auto Generate Tasks on SR Create to Task 

Template Mapping.

2. Create task group templates according to the procedures described in Oracle 
Common Application Components Implementation Guide. Each task group template 
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can generate multiple tasks. When creating task templates, select Service 
Request as the document type.

3. Specify the factor or combination of factors that will trigger the task or tasks to 
be generated. See Specifying Conditions for Task Generation by Creating Task 
Template Mappings on page 3-7.

4. Create the set of rules that determine which tasks get generated should a 
service request match more than one mapping. See Setting Up Rules for 
Handling Multiple Valid Mappings on page 3-9.

3.2.2 Viewing Existing Task Template Mappings
Use this procedure to display existing task template mappings. 

To display task template mappings:
1. Navigate to Setup > Service Requests > Task Template Mapping.

The Task Template Mapping page appears in a browser window displaying 
existing mappings.

From this page you can:
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■ Create a mapping by clicking Create Task Template Mapping and 
following the procedure outlined in Specifying Conditions for Task 
Generation by Creating Task Template Mappings on page 3-7. 

■ Specify which tasks get generated should a service request match more than 
one mapping by clicking Task Template Search Rules and defining the 
rules as described in Setting Up Rules for Handling Multiple Valid 
Mappings on page 3-9. 

■ Update a mapping by selecting a different template or remove a mapping 
from use by specifying an end date.

3.2.3 Specifying Conditions for Task Generation
Use this procedure to specify the conditions that trigger tasks to be automatically 
generated at service request creation. This is called a task template mapping.

Prerequisites
You must create task group templates before you can map them.

To create a task template mapping:
1. Navigate to Setup > Service Requests > Task Template Mapping.

The Task Template Mapping page appears.

2. Click Create Task Template Mapping.

3. The Create Task Template Mapping page appears.
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4. Select the object or combination of objects you wish to map: 

■ For Service Request Types, use the Request Type list of values (the flashlight 
icon) to make your selection.

■ If you wish to map to an inventory item or an item category, then select 
either the Item or the Item Category radio button and use the list of values 
to make your selection.

■ For problem codes, use the Problem Code list of values.

5. If you wish to limit the availability of this mapping, then enter dates in the Start 
Date and End Date fields.

6. Select the task template group using the Task Group Template list of values.

7. Click Apply to save your mapping.

The new mapping appears in the Task Template Mapping page.

3.2.4 Updating a Task Template Group Mapping
You cannot specify a different set of objects in a mapping after you have saved it. 
However, you update a mapping by:

■ Selecting a different task template group so that different tasks get generated.

■ Removing a mapping from use by end-dating it.
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To update a task template group mapping:
1. Navigate to Setup > Service Requests > Task Template Mapping.

The Task Template Mapping page appears.

2. If you wish to map a different task template, then use the Task Template list of 
values to select it.

3. If you wish to remove a particular mapping from use, then enter a past date in 
the End Date field.

4. Click Apply.

3.2.5 Setting Up Rules for Handling Multiple Valid Mappings
Use this procedure to set up rules that determine which task group template the 
application uses to generate tasks when a service request satisfies the criteria for 
more than one mapping.

To set up rules to choose among multiple valid mappings:
1. Navigate to Setup > Service Requests > Task Template Mapping.

The Task Template Mapping page appears.

2. Click Task Template Search Rules.

The Task Template Search Rules page appears displaying all of the existing 
search rules.
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3. Select the task template search order you wish to use using the Active check 
boxes.

4. Click Reorder Sequence to determine the sequence in which the application 
picks the templates.

The Reorder Sequence page appears listing the active templates.
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5. Move the templates in the list to the order you desire using the arrow controls 
on the right.

6. Save the sequence by clicking Apply.

3.3 Generating Tasks on Request Type and Attribute Values
Using this procedure you can set up the automatic generation of tasks based on the 
values of additional attributes you have set up for a Service Request Type. 

Prerequisites
You must set up the attributes for the Service Request Type first. See Capturing 
Additional Service Request Attributes on page 1-49. 

If you wish to modify task types or create additional ones, then follow the 
procedures in Customizing Automatic Task Generation on page 3-13.

To generate tasks based on extended attribute values:
1. Set the system profile Service: Auto Generate Tasks on SR Create to Task Type 

Attribute Configuration. To set it:

a. Navigate to Others > Profile System Values.

The Find System Profile Values window appears.
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b. Make sure Site and Profiles with no values check boxes are selected.

c. Enter %Auto Generate% as the search term in the Profile field.

The System Profiles window displays the profile option.

d. Make your selection and save.

2. Navigate to Extended Attribute Configuration > Service Request Task Attribute 
Details.

The Service Request Types search window appears.

3. Select the Service Request Type you wish to set up.

4. The Service Request Task Type Configuration window appears.

5. Set up the rules for creating tasks based on attribute values in the Service 
Request Attributes region. For each rule:

a. If required, create a new entry line by clicking New.

b. Use the Task Type list of values (LOV) to select the task type for the task to 
be generated.

c. Using the Name LOV, select the attribute.
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d. Select the = operator. This is the only operator supported in this release.

e. In the Value field enter the value to trigger the task generation. If you have 
set up the attribute with a list of values, then you must select the value. If 
you have not, then you must enter the value as text. 

f. On the Mandatory tab, enter the details of the task, such a description, its 
default status, priority, publish flag, private flag. The application uses the 
information for creating tasks.

Select the Publish flag if you wish the task to display in Oracle iSupport 
where it can be viewed by customers.

6. If you wish to trigger a workflow for this task when it is created, then you must 
associate the workflow with the task type in the Task Types window. (See 
Defining Task Types on page 3-15).

7. If you have set up a workflow for this task and wish to pass it additional task 
attributes, then select the Optional tab and select the values for the attributes 
there. See Customizing Automatic Task Generation on page 3-13.

3.4 Customizing Automatic Task Generation
This group of topics provides guidelines and procedures for customizing the 
automatic task generation process.

■ For an overview see About Customizing Automatic Task Generation on 
page 3-14.

■ For a high-level overview of a customization, see Customizing Task Generation 
Using Oracle Workflow and Additional Task Attributes on page 3-14. 

■ For an example of such a customization see Sample E-mail Notification 
Workflow Customization on page 3-22.

The rest of the topics provide detailed procedures for specific tasks. For information 
on how to perform generic task setups, see:

■ Defining Task Types on page 3-15

Note: You must enter a task owner, the individual responsible for 
the completion of the task. This means that you cannot 
automatically assign tasks created in this way via automatic 
assignment. 
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■ Defining Task Status on page 3-17

■ Defining Task Priority on page 3-19

For details on Oracle TeleService task attribute setups, see:

■ Defining Additional Attributes for Tasks on page 3-20

■ Mapping Additional Attributes to a Task Type on page 3-20

3.4.1 About Customizing Automatic Task Generation
There are multiple ways you can customize the automatic task generation process. 
Some customizations involve modifying the standard task setups performed in the 
Tasks module. For example, you can create additional task types, statuses, and 
priorities. 

You can also set up a task to automatically launch an Oracle Workflow process, by 
associating the process with a task type. (This is done in the same Task Type 
window where you set up task types. See Defining Task Types on page 3-15.)

These standard setups are described in the topics below and in the Task Manager 
section of the Oracle Common Application Components Implementation Guide.

Oracle TeleService provides you with additional functionality that makes it possible 
for you to create task attributes you can use to pass additional information into an 
Oracle Workflow process.

Suppose, for example, that a government department handling hazardous material 
spills needs to notify different individuals via e-mail depending on the type of the 
material involved in a spill. 

To do this, the department creates an Oracle Workflow process which automatically 
sends the e-mail notification and maps it to the task type. The department sets up 
additional task attributes to pass the text of the e-mail, the e-mail address of the 
individual to be notified, and other information.

This way the workflow can send different e-mails to different individuals 
depending on whether the spill involves acid or radioactive material, for example.

3.4.2 Customizing Using Oracle Workflow and Additional Task Attributes
This topic outlines the steps for customizing automatic task generation using Oracle 
TeleService’s task attribute feature. Oracle provides a sample e-mail notification 
workflow customization. (See Sample E-mail Notification Workflow Customization 
on page 3-22.)
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To customize task generation with a workflow using task attributes:
1. Create the Oracle Workflow process with the attributes you wish to capture and 

upload it into the Service Request item type.

2. Create a task type and associate it with the workflow. See Defining Task Types  
on page 3-15 for details.

3. Create the additional attributes you wish to pass to the Workflow process 
according to the procedure described in Defining Additional Attributes for 
Tasks on page 3-20.

4. Map the attributes to the Task Type and enter the values to be passed into the 
task attributes. See Mapping Additional Attributes to a Task Type on page 3-20.

3.4.3 Defining Task Types
Use this procedure to set up and modify task types. While the primary function of 
task types is to classify tasks, you can use task types to specify the types of 
resources that can be assigned, determine whether the tasks are schedulable for 
Oracle Field Service, and to automatically launch workflows when tasks of this type 
are created. For further information see the tasks section of the Oracle Common 
Application Components Implementation Guide.

To define task types:
1. Navigate to Setup > Task Management > Task Types.

The Task Types window appears.
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2. If you are creating a new task type, click New in the toolbar to insert a new row 
for entering task type.

3. In the Type field, enter a name for the task type. This is the name of the task 
type agents see in the list of values.

4. If you wish to launch a workflow each time with this task type then:

a. For Item Type, select JTFTASK. This is the only selection available.

b. Use the Process LOV to select the workflow. The Task Workflow and 
Description fields towards the bottom of the window display information 
about the workflow.

5. If you are planning to use this type for Oracle Field Service, then select Field 
Service using the Rule field LOV.

6. Make entries in the Effective Dates From and Effective Dates To fields if you 
wish to limit the availability of this type.

7. If you wish to specify the amount of time this task should take, then:

a. In the UOM field, select the unit of measure for quantifying the effort for 
the task type.
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b. In the Duration field, enter the default amount of time this task type would 
take to complete.

8. Select the Notification check box if you wish to notify the task owner that a task 
has been created through the Oracle Workflow notifications page.

9. Select the Schedulable check box if you wish to have the task scheduled through 
Oracle Advanced Scheduler.

10. The seeded check box indicates seeded task types.

11. If you want to specify the type of resources that can be assigned to complete the 
task, then:

a. Click Resource Requirements.

The Resource Requirements window appears. 

b. Using the Name LOV, select the resource type to be used with this task 
type.

c. In the Required Units field, enter the estimated number of units of the 
selected resource type that would be required to perform this task type.

d. Select the Enabled Flag check box to activate the resource type assignment 
for the task type. 

e. Select OK to save your assignments and return to the Task Types window.

12. Save your work.

3.4.4 Defining Task Status
You can limit the user’s choices of task status by defining the list of status options 
and determining the employee type that has access to each status type. When you 
provide a list of values for the Task Status field, task creators choose from a 
pre-defined template of status options. Use this procedure to define types of task 
status for your users.

You can also define a group of tasks that must be performed and impose a sequence 
of statuses to the tasks. A status transition is the imposed sequence of statuses. For 
example, one status transition may dictate the following status sequence:

■ Open

Note: The Private check box is reserved for future use.
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■ Assigned

■ Working

■ Closed

As each status in the sequence is completed, the subsequent status appears on the 
agent’s list. 

In addition, you can define rules for each status transition. A status transition rule 
defines access and read-write privileges for the status transition. Rules can be 
associated to responsibilities, so that a manager may have more privileges than an 
agent.

To define task status:
1. Navigate to the Task and Escalation Status window.

2. Define a type name and enter it in the Status field.

3. Enter a brief description of the status type in the Description field.

4. Enter the effective dates in the From and To fields.

5. Select the appropriate task status check boxes. The following check boxes are 
available:

■ Task Status

■ Assignment Status

■ Assigned

■ Working

■ Schedulable

■ Accepted

■ Rejected

■  Onhold

■ Approved

■ Completed

■ Cancelled

■ Delete Allowed

■ Closed
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■ Seeded

6. Optionally, define transition values that determine the user privilege for each 
status type.

Use this procedure to define transition values.

a. Click Define Transition.

The Status Transition window opens.

b. In the Rules tab, enter a name for the user privilege relationship in the Rule 
Name field.

c. Enter an initial and final status type for the user.

Use the initial and final status values to determine the user’s range for 
selecting task status.

d. In the Responsibility tab, enter the pre-determined rule name.

e. Enter a user type in Responsibility Name field and click OK.

A transition value stipulating user status privilege now exists.

f. Save your task status type.

The new task status and corresponding privileges register as lists of values 
for their fields in the application.

3.4.5 Defining Task Priority
Determine task priority by choosing terms for varying levels of priority and setting 
an importance rating that corresponds with each term. 

To define task priority:
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Setup to expand the node.

3. Select Task Priority and click OK.

The Task Priority window opens.

4. Define a name and enter it in the Priority field.

5. Enter a numerical value in the Importance field.

Choose an importance value from a larger defined scale of priority.
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6. Enter a brief description of the priority value.

7. Enter the effective dates in the From and To fields.

8. Select Seeded to restrict the edit of task priority from future users.

9. Save your task type.

The new task priority registers as a lists of value for the Priority field in the 
application.

3.4.6 Defining Additional Attributes for Tasks
You can define additional attributes in the lookup CUG_TASK_TYPE_
ATTRIBUTES. 

To define additional task type attributes:
1. Under the Application Developer Responsibility, navigate to Lookups > 

Application Object Library.

The Application Object Library Lookups window appears.

2. In the Type field, use the Query Enter / Query Run method to display the 
lookup CUG_TASK_TYPE_ATTRIBUTES.

3. Set up each question or prompt on a separate row (you can create additional 
rows by clicking New in the toolbar):

a. In the Code field, enter a unique code. This code is for internal use only and 
does not get displayed to agents or users.

b. Enter the attribute name in both the Meaning field and Description field.

4. Click Save in the toolbar.

3.4.7 Mapping Additional Attributes to a Task Type
Use this procedure to map additional task attributes to a task type. Doing so makes 
it possible for you to pass values of these attributes to an Oracle Workflow process 
you have created.

Prerequisites:
■ Create the task types

■ Create the attributes in the CUG_TASK_TYPE_ATTRIBUTES lookup.
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■ If you wish to use a list of values to pass values to an attribute, then you must 
create the lookups with the values first. 

To map additional attributes to a task type:
1. Navigate to Extended Attribute Configuration > Task Type Attributes.

The Task Type Attribute Configuration window appears.

2. Use the Name list of values (LOV) to select the task type you wish to set up.

3. In the Task Type Attributes region, enter the attributes you wish to map:

a. Using the Name LOV, select the attribute from those you have defined in 
the CUG_TASK_TYPE_ATTRIBUTES lookup. 

b. If you are going to be using a list of values to select values for the attributes, 
then use the List Name LOV to select the lookup where you defined the 
valid values. 

If you do not select a lookup here, you can enter text instead. 

c. If you have not selected a lookup in the previous step, then, optionally, 
enter a default value for this field. 

d. Enter an integer in the Sequence field corresponding to the order you wish 
to present the prompt. The prompts are displayed in descending order.
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e. If you wish to make entry optional, then deselect the Mandatory check box. 
This check box is selected by default.

f. The Displayed check box must be selected to display the attribute. This 
check box is selected by default.

4. Save your work.

3.4.8 Sample E-mail Notification Workflow Customization
To illustrate how you can customize automatic task generation, Oracle includes a 
sample customization that sends an e-mail when a task of type Email Notification is 
created with content you specify in the additional attributes.

The sample customization includes:

■ The Email Follow-up task type set up with additional task attributes

■ The Email Generic Notification Process, an Oracle Workflow process that sends 
an e-mail via the workflow mailer.

If you wish to use this sample e-mail customization, then follow the steps described 
in Enabling Sample E-Mail Workflow Process on page 3-24.

3.4.8.1 E-mail Follow-up Task Type
The following table lists the sample Email Follow-up task type attributes which 
pass information to the Email Generic Notification workflow process. The second 
column of the table explains what entries you can make for each attribute.

Attribute What You Enter

Approver A user name of a user with an e-mail address. The 
approver is the message recipient.

Subject Text that appears as the subject of the e-mail message.

Message Body Text of the message.

Requester A user name of a user with an e-mail address. The 
requester is the person who is listed as the sender

Message Header Text which appears as the header of the message.

Message Footer Text which appears as the footer of the message.

Email Reminder Counter The number of reminders you wish to send to the 
requester.
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3.4.8.2 Email Notification Generic Process
The following diagram illustrates the sample workflow process Oracle Workflow 
Process Email Notification Generic (CUG_EMAIL_NOTIFICATION)

1. The process initiates when a task of type Email Follow-up is created.

2. The process gets the task attribute details (requester, approver, subject, etc.) 
from the values you enter on the Optional tab of the Task Type: Attribute 
Configuration window.

3. The process sets a due date for the approver to acknowledge the e-mail 
notification. The due date is set based on the service request creation date and 
the number of days you enter in the Offset for Due Date attribute.

4. The process sends an e-mail to the Approver with the text you entered in the 
Subject, Message Header, Message Body, and Message Footer attribute.

UOM for Due Date Unit of measure for the due date: DAY, WEEK, MONTH

Offset for Due Date The number of days, weeks, or months. 

Notes: For the Approver and Requester task type attribute you 
must enter an Oracle Application user name. This is defined in the 
Users window under the System Administrator Responsibility. The 
Email Notification workflow uses the e-mail address entered for the 
user in the same window.

Note: You must make sure that the workflow is mapped to the 
task type in the Task Type window.

Attribute What You Enter
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5. If the approver does not acknowledge the message by the end of the due date, 
the process sends a reminder notification. The process sends the number of 
reminders you specify in the Email Remainder Counter attribute. If the 
approver acknowledges any of the notifications (the original or a reminder), the 
workflow terminates.

6. If the approver does not respond, the workflow sends the maximum number of 
reminders. The work flow then fails and terminates.

7. When the process completes successfully, the workflow updates the task status 
to Completed. If the processing fails, the process sets the task status to 
Cancelled. You can modify these statuses by setting the following system 
profiles:

■ CUG_TASK_FAILED_STATUS

■ CUG_TASK_SUCCESS_STATUS

3.4.8.3 Enabling Sample E-mail Workflow Process
Use this procedure to enable the sample Email Workflow.

To enable the sample e-mail workflow process:
1. Navigate to Setup > Task Management > Task Type.

2. For the Email Follow-up task type:

a. Enter CUGTASKS in the Item Type field.

b. In the process field, enter CUG_EMAIL_NOTIFICATION.

3. Save.

4. Make sure that the notification mailer is set up. See Setting Up Notification 
Mailers in the Oracle Workflow Administrator’s Guide.
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Implementing Customer Care

This chapter presents a detailed description of the setup and implementation steps 
required to successfully implement the Customer Care module of Oracle 
TeleService.

This following topics are covered:

■ Setting Up Customer Profiles on page 4-2

■ Setting Up Relationship Plans on page 4-28

■ Setting Up Critical Customers on page 4-51

■ Setting Up Quick Menu on page 4-51

■ Setting Up Wrap-up on page 4-53

■ Setting Up Party and Account Numbering on page 4-54

■ Specify Global Address Formatting and Address Validation on page 4-54

■ Setting Up Custom Tabs on the Contact Center on page 4-59

■ Enabling E-Mail for the Contact Center on page 4-61

■ Setting Up Search Preferences on page 4-62

■ Modifying the Behavior of Contact Center Tabs on page 4-65

■ Modifying the Behavior of the Contact Center Header on page 4-81

Note: Please use the Customer Support Responsibility for 
performing the setup procedures detailed in this chapter unless 
indicated.
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■ Enabling Telephony on page 4-84

■ Enabling Oracle Knowledge Management on page 4-85

■ Enabling Oracle Scripting on page 4-85

■ Specifying the Defaults for Overriding Customer Criticality on page 4-86

4.1 Setting Up Customer Profiles
Customer profiles make it possible for you to provide agents with summaries of key 
customer information, such as the number of open service requests or expiring 
contracts.

Agents can view the summarized customer information in two places:

■ The Dashboard tab 

Available in the Contact Center (Oracle TeleService) and E-Business Center 
(Oracle TeleSales).

■ The Profile window

Available in the Service Request and Override Customer Criticality windows in 
Oracle TeleService and the Repair Order window in Oracle Depot Repair.

Setting up customer profiles is also a prerequisite for implementing relationship 
plans. While the information on the Dashboard tabs and Customer Profile windows 
summarizes key information about customers, they require agents to check that 
information periodically. Relationship plans, described in a separate section of this 
guide, automatically display an alert message or a script when a customer meets 
certain conditions based on your customer profile setup.

For a brief overview of customer profile concepts, see About Customer Profiles on 
page 4-3.

For an overview listing the major steps of the setup procedure, see Overview of 
Customer Profile Setup on page 4-6.

Details of individual steps are covered in the following topics:

■ Defining Profile Ratings on page 4-7

Note: Customer profiles are not the same as system profile 
options.
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■ Associating Ratings with Colors on page 4-9

■ Defining Profile Check Categories on page 4-10

■ Defining Profile Check Variables on page 4-11

■ Defining Profile Checks on page 4-17

■ Defining Drill-Downs for a Profile Check on page 4-13

■ Grouping Profile Checks for Display in Customer Profile Windows on page 4-22 

■ Grouping Profile Checks for Display in Dashboard Tabs on page 4-24

■ Determining Access by Module and Responsibility on page 4-26

■ Running the Customer Profile Engine on page 4-28

4.1.1 About Customer Profiles
Customer profiles make it possible for you to provide agents with: 

■ Summaries of key customer information in a graphical format

■ The ability to drill down to the details of the information the profiles highlight 

You can specify access to customer profiles by application and by Responsibility, so 
that agents working on different types of customer problems receive different 
customer views.

4.1.1.1 Summaries of Key Customer Information
Customer profiles make it possible for you to create summaries of key customer 
information, called profile checks. Profile checks can summarize information by 
customer, by account, or by customer contact. 

Profile checks can be of two types:

■ Variable 

■ Yes and No (Boolean)

Variable 
The variable profile checks tell agents the level of a particular customer, account, or 
contact attribute, such as the number of open service requests or the number of 
booked orders. Each profile check displays a number (the number of open service 
requests or expiring contracts, for example), a rating (high, medium, low) and a 
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color (green, yellow, and red, for example). The rating and color together comprise a 
rating label. 

Yes and No (Boolean)
Boolean profiles compare the level of a profile check variable against a constant or 
an expression with one or more variables and returns either a Yes or No. For 
example: "Does the customer, account, or contact have more than one open 
escalation?", "Does the customer have a credit hold?".

Summaries Displayed in a Graphical Format
Agents can view the customer information summarized by the profile checks in two 
places:

■ The Dashboard tab 

The Dashboard tab displays the summarized customer information organized 
in distinct regions called dashboard groups. These regions are separated by 
headings called categories.

■ The Profile window

The Profile window displays a list of select profile checks in the order you 
determine. Profile windows do not use category headings.

Here is a sample Dashboard on the Contact Center showing key customer 
information organized in three dashboard categories: Service, Tasks, and Contracts.

Agents can filter their views of profile checks by account, customer, or contact by 
making a selection from View Details For drop-down list on the header. 
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Profile windows display only select individual profile checks. Here is a sample 
Profile window:

4.1.1.2 The Ability to Drill Down to Details
You can set up customer profiles to make it possible for agents to drill down from a 
variable profile check in a Dashboard tab or customer Profile window to a detailed 
list of all the items in the Drill-Down List window. This is called a first-level 
drill-down. 

During implementation you can select which fields agents see in this window. 
Boolean (Yes or No) profile checks do not permit drill-downs.

Here is a sample first-level drill-down window:
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Agents can drill down to the individual item in this window by clicking on one of 
the displayed fields. 

The item displays in an application window. This is called the second-level 
drill-down.

4.1.2  Overview of Customer Profile Setup
Use this overview of major setup steps to guide you through the customer profile 
setup.

To set up customer profiles:
1. Set up the rating labels (the wording and colors) you will use with your profile 

checks and the categories you wish to use to organize the profile checks on the 
Dashboard tab: 

a. Navigate to Setup > Customer Care Lookups.

b. Define the general labels you wish to use to classify customer information 
for agents. For example, you may wish to classify customers into three 
categories, Low, Medium, and High. See Defining Profile Ratings on 
page 4-7 details.

c. Navigate to Setup > Customer Management > Customer Profiles.

d. On the Preferences tab, associate the profile ratings you have defined with 
color codes to create rating labels. For example, you may wish to display 
red next to the word High. See Associating Ratings with Colors on page 4-9.

e. On the same tab, define the headings (categories) which organize the profile 
checks on the Dashboard. See Defining Profile Check Categories on 
page 4-10.

2. Navigate to Setup > Customer Management > Customer Profiles.

3. On the Profile Variable tab, define the variables you wish to use in your profile 
checks. This is where you enter the SQL queries that retrieve and summarize 
your customer data. You can use the same variable in multiple profile checks. 

For details see Defining Profile Check Variables on page 4-11.

4. On the Profile Checks tab, define all of the profile checks you want to use to 
summarize customer information in the Profile windows and Dashboard tabs. 
You get to select which agents see them in a subsequent step. See Defining 
Profile Checks on page 4-17. 
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5. On the Drilldown tab, set up the two levels of drill-downs your agents will use 
to view the details of the customer information summarized by the profile 
check. The first level provides a window with a list of individual records; the 
second level displays the individual record itself. See Defining Drill-Downs for 
a Profile Check on page 4-13.

6. On the Profile Groups tab, define the groupings of profile checks for display in 
the customer Profile window. By matching these profile groups to application 
modules and responsibilities in a later step, you can create different customer 
overviews for different groups within your organization. See Grouping Profile 
Checks for Display in Customer Profile Windows on page 4-22.

7. On the Dashboard Groups tab, define the groupings of profile checks for 
display in the Dashboard tabs of the Contact Center and E-Business Center 
windows. By matching these profile groups to application modules and 
responsibilities in a later step, you can create different customer overviews for 
different groups within your organization. See Grouping Profile Checks for 
Display in Dashboard Tabs on page 4-24.

8. On the Preferences tab, specify which application modules and which 
application responsibilities can view the profile groups and dashboard groups 
you have created. See Determining Access by Module and Responsibility on 
page 4-26.

9. Set up the concurrent program that will automatically refresh the Dashboard 
tab and Profile views of customer information. See Running the Customer 
Profile Engine on page 4-28.

10. You can have the application refresh the customer information on the 
dashboard each time an agent displays a customer by setting the profile 
Customer Care: To Allow Auto Refresh Facility for Dashboard to Yes. A setting 
of No requires the agent to click the Refresh button to update the display. See 
Setting Automatic Refresh of Profiles on the on page 4-29 Dashboard for more 
details.

4.1.3  Defining Profile Ratings
Use this procedure to modify or create the labels used to describe the ranges of 
values of your profile checks. The application provides three seeded values: High, 
Medium or Low. These labels are called profile ratings.

Profile ratings are implemented in Customer Care using standard Oracle 
Applications lookup codes. Profile rating codes are implemented with the User 
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access level. This means that you can create new labels and modify the seeded 
values.

Prerequisites
None

To define profile ratings:
1. Navigate to Setup > Customer Care Lookups.

The Customer Care Lookups window appears.

2. In the Type field perform a search using the Query by Example method on 
CSC_PROF_RATINGS. 

The window displays the three predefined ratings, High, Medium, and Low, 
and any others your organization has defined.

3. To create a new rating code:

a. Place your cursor in a row and click New in the toolbar.

b. Enter a name in the Code field. You will be associating this name while 
building the profile checks.

c. Enter a name in the Meaning field. This is the wording agents will see on 
the Dashboard tab and Customer Profile window.

d. Optionally, enter a description in the Description field.
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The Tag field is not used.

e. If you wish to control the dates this rating code is to be effective, then enter 
dates in the Effective Date fields.

4. Verify that the Enabled check box is selected.

5. Save your work.

 

4.1.4 Associating Ratings with Colors
Use this procedure to associate colors with the ratings you defined to create a rating 
label. It is here that you specify, for example, that the label High will always display 
in the Dashboard and Customer Profile windows together with the color red. 

Prerequisites
You must define profile ratings before you can associate them with a color.

To associate ratings with colors:
1. Navigate to Setup > Customer Management > Customer Profiles.

2. Select the Preferences tab.
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3. In the Rating Labels region, select the rating you wish to associate with a color 
from the Rating list of values. The Rating field displays the Code value from the 
lookup, not the value users will see.

4. Select a color to associate to the rating from the Color list of values.

5. Save your work.

 

4.1.5 Defining Profile Check Categories
Use this procedure to define the categories used in the Dashboard tab to group 
profile checks. For example, open, escalated, and accepted tasks can all be grouped 
under the Tasks category.

Prerequisites
None

To define categories:
1. Navigate to Setup > Customer Management > Customer Profiles. 

2. Select the Preferences tab.

3. In the Categories region of the tab, for each category you wish to define:

a. Enter a name for the category in the Category field. This internal name will 
not display on the Dashboard tab.

b. Enter the wording that will display on the Dashboard tab in the Meaning 
field. 

c. Optionally enter a description for the category in the Description field.

4. Save your work.

4.1.6 Defining Profile Check Variables
Use this procedure to define the variables you wish to use in your profile checks. 
The variables contain the SQL statement that is executed to retrieve the customer 
profile check value. You can use the same variables in multiple profile checks.

Your SQL statements can contain two bind variables:

■ :party_id - Use this variable if the SQL statement refers to a party
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■ :cust_account_id - Use this variable if the SQL statement refers to a customer 
account

No other bind variables are supported.

Your SQL statement must be constructed so that only a single row is returned by the 
query.

For a detailed description of the database objects you can include in your SQL 
statement, please refer to the Electronic Technical Reference Manual (eTRM) for 
Customer Care that is available from http://metalink.oracle.com. Navigate to Top 
Tech Docs and use the link titled Applications Electronic Technical Reference 
Manuals. Customer Care database objects are stored in the folder named CSC.

Prerequisites
None

To define a profile check variable:
1. Navigate to Setup > Customer Management > Customer Profiles.

The Customer Profile Setup window appears.

2. Select the Profile Variables tab.

3. Click New on the toolbar.
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4. Enter a name in the Name field.

5. Enter a unique name in the Code field.

6. If you are displaying the information from this variable in the Dashboard tab, 
then using the Level drop-down list, select the appropriate view where the 
information is to appear. Available views are: Customer, Account, and Contact. 
Agents use these views to filter the information in the Dashboard tab.

7. If you wish to restrict the use of this variable, then enter dates in the Active: 
From and Active: To fields.

8. Optionally enter a description of the profile variable in the Description field.

9. Enter the appropriate components of the SQL statement in the following fields:

■ Select (mandatory field).

■ Currency (optional field).

■ From (mandatory field).

■ Where (mandatory field).

■ Other (optional, used for including clauses such as Group By).

10. To validate the SQL statement, click Validate.

11. Save the variable by clicking Save in the toolbar. 

Your SQL statement is validated automatically when you save. You cannot save 
an invalid SQL statement.

 

4.1.7 Defining Drill-Downs for a Profile Check
Use this procedure to define the drill-down windows for a profile check. There are 
two levels of drill-down windows. The first level lists the items summarized by the 
profile check. The second-level drill-down window is the application window 
which displays the details of an individual record. An agent displays an item in the 
application window by double clicking on one of the fields in the summary list. 

Prerequisites
You must create the variables for the profile check before you can define drill-down 
windows.
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To define drill-down windows:
1. Navigate to Setup > Customer Management > Customer Profiles.

The Customer Profiles window opens.

2. Select the Drilldown tab.

3. From the Variable field, select the profile variable for which you want to define 
the drill-down. 

The Description field as well as the Tables and Views region display 
information about the selected profile variable.

4. Using the Drilldown Module list of values, select the application module you 
wish to use for the second-level drill down. If the module you wish to use is not 
listed, then you can add it to the list by following the steps outlined in Enabling 
Application Windows for Drill-Down on page 4-15.

5. Select up to 20 columns you wish to display in the first-level drill-down list:

a. Select one of the tables in the Table and Views region.

The Columns region displays the available columns for that table.
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b. Select the Show check box for the columns that you wish to display in the 
first-level drill-down.

c. For the columns you wish to display, enter a user-friendly name in the 
Display Name field. The text you enter here is what agents see in the 
first-level drill-down window. 

6. Select one of the columns in the first-level drill-down as the column that agents 
will use to drill-down to the application window (the second-level drill-down). 
For example, if you select the service request number, an agent can view the 
details of the service request in the Service Request window by double-clicking 
on the service request number in the summary list. 

a.  Select the table in the Table and Views region.

The Columns region displays the available columns for that table.

b. Select the ID radio button for the column that you wish use for the 
drill-down.

c. Click Save in the toolbar.

The column name of the ID you have selected, displays in the Drilldown 
Column field at the top of the tab.

7. Optionally, click Build to generate and display the SQL for the drill-down.

The SQL statement is validated when you save. You cannot save an invalid SQL 
statement.

 

4.1.8 Enabling Application Windows for Drill-Down
Use this procedure to enable application windows for drill-down.

Note: Only columns from registered tables and views are 
displayed. Column names are retrieved from FND_COLUMNS and 
FND_VIEWS. If the columns you wish to use are not visible, check 
to see if the table or view is registered.

Note:  You can select only one ID column for a profile variable.
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Prerequisites
You must define the form object first in the Form Functions window. You can access 
this window by logging in under the Systems Administrator Responsibility and 
navigating to Application > Function. 

To enable application windows for drill-down:
1. Navigate to Setup > Customer Management > Customer Profiles.

The Customer Profiles window opens.

2. Select the Drilldown tab.

3. Click New.

The Task Setup: Object Types window opens.

4. Enter a name for the drill-down module object type you are creating in this 
procedure in the Name field.

5. Enter a description for the drill-down module in the Description field.

Note: The name you enter here is for your reference only. It does 
not display in the Drilldown Module list of values.
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6. Enter a value in the Object Code field that begins with CSC_PROF, for example: 
CSC_PROF_OKSAUDET. 

7. You must know both the function name and the window name displayed for 
the user. The function name, for example, OKS_OKSAUDET, is what you enter 
in the Function Name field in this window. You need to know the associated 
User Function Name: Author Service Contracts because this is what gets 
displayed in the Drilldown Module list of values on the Drilldown tab. Use the 
following procedure to find either name:

a. Switch Responsibility to Systems Administrator.

b. Navigate to Application > Function.

The Forms Functions window appears.

c. Using the Query by Example method, display the function either using the 
Function or User Function Name fields. 

d. Note down the names of both fields. 

8. Enter the function name in the Function Name field. For example, OKS_
OKSAUDET.

The Drill Down Module list of values displays the User Function Name 
associated with this form function name. 

9. Enter the parameters.

10. Select Customer Care from the Application Name list of values.

11. Entry in the Usage region is optional. You can select CUSTOMER_CARE from 
the list of values, which also populates the Object User field. The Seeded check 
box indicates whether the module is predefined.

12. Save your changes.

13. Close the form to return to the Drilldown tab.

The new application window is available in the Drilldown Module field list of 
values.

 

4.1.9 Defining Profile Checks
Use this procedure to define profile checks. 
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You can use the predefined profile checks as a guide. See Predefined Profile Checks 
on page 4-21.

Prerequisites
You must define profile variables, ratings, and rating labels first. 

To define profile checks:
1. Navigate to Setup > Customer Management > Customer Profiles Setup.

The Customer Profile Setup window appears.

2. Select the Profile Checks tab.

3. Enter a name for the profile check in the Name field. This is the wording the 
agents see in the Dashboard tab or Profile window.

4. The Code field defaults to the name you enter in the Name field. You can 
substitute the value in the Code field with another unique value.

5. Select the level for the profile check depending on what type of information the 
profile check summarizes. The options are: Customer, Account, or Contact.

6. Enter a description for the profile check in the Description field.

7. Enter the date when the profile check is to be in force by specifying the Active 
From and Active To fields.
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8. If you wish to create a variable profile check, then select Variable from the Type 
drop-down list and follow the steps described in Defining Variable Profile 
Checks on page 4-19.

9. If you wish to create a Boolean (Yes or No) profile check, then select Yes or No 
from the Type drop-down list and follow the steps described in Defining 
Boolean Profile Checks on page 4-20.

10. Save your work.

4.1.9.1 Defining Variable Profile Checks
Perform these steps to create a variable profile check after you have completed the 
basic steps described earlier:

1. In the Variable field, select the variable on which the profile check is to be 
based. This is one of the variables you have defined in the Profile Variables tab.

2. In the Data Type field, enter the data type for the variable you have selected. 
The valid choices are Number, Char, and Date. 

3. If appropriate, enter a format mask in the Format Mask field.

4. In the Ratings region, define value ranges and their labels. For each range:

a. Enter a Lower and Upper number. The range you enter here cannot overlap 
another range.

b. Select an appropriate label. This is one of the rating labels you have created 
which combine the rating and color code.

Enter the low value for the first range and the high value for the last range as 
shown in the example below. In the example, leaving the Upper Value for the 
High range blank ensures that your profile check displays for customers of any 
high value above 20. 

5. If you wish, you can turn the display of the profile on only when the number is 
below or above a threshold. 

Lower Value Upper Value Label

0 10 Low

11 20 Medium

21 Leave blank High
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For example, you may wish call center agents to see information on the number 
of open service requests for a customer regardless if the number is low or high. 
But managers may care only about customers with high numbers. By specifying 
the upper number in the Medium range as your trigger, you can display only 
the high range to the group of your choice. To define a threshold for a profile 
check:

a.  Select either the Upper or Lower radio button depending on whether you 
wish to use the lower or higher number for the range as the threshold.

b. Using the Label list of values, select the range below or above which you 
wish the display to be triggered. 

Using the above example, if you wish to display the profile check only 
when the value is High, then you would select the Upper radio button and 
select Medium from the Label list of values. 

c. For the threshold to affect the display of information you must select the 
Display on Threshold check box when you define profile groups and 
dashboard groups. See Grouping Profile Checks for Display in Customer 
Profile Windows on page 4-22 and Grouping Profile Checks for Display in 
Dashboard on page 4-24 Tabs for more information.

4.1.9.2 Defining Boolean Profile Checks
Perform these steps in addition to the basic steps described earlier to create a 
Boolean profile check:

1. Using the Type drop-down list, select Yes or No.

2. In the Rules region, build a logical expression (rule) comparing an existing 
profile variable with a constant or an expression.

For example, the seeded Critical Customers profile check evaluates the 
expression Open Service Requests > 5.

3. Save the profile check you have defined. 

 

4.1.10 Predefined Profile Checks
Oracle TeleService provides the following 28 predefined profile checks you can use 
as a guide to define your own. All but Critical Customer are variable profile checks:
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■ Accepted Tasks

■ Active Contracts

■ Approved Tasks

■ Booked Orders

■ Cancelled Contracts

■ Cancelled Orders

■ Cancelled Tasks

■ Critical Customer

■ Customer Opportunities

■ Entered Contracts

■ Escalated Defects

■ Escalated Service Requests 

■ Expired Contracts

■ Expiring Contracts

■ Installed Base Size (11.5.6)

■ Loyalty

■ On-Hold Contracts

■ On-Hold Tasks

■ Open Defects

■ Open Orders

■ Open Service Requests

■ Open Tasks

■ Profitability

■ Rejected Tasks

■ Revenue

Note:  Do not modify seed data. If you want to make 
modifications, please make a copy and modify your copy. 
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■ Satisfaction

■ Terminated Contracts

 

4.1.11 Grouping Profile Checks for Display in Customer Profile Windows
Use this procedure to group profile checks for display in the customer Profile 
window. By associating the groups you create here with application modules and 
responsibilities you can provide different groups of agents with different customer 
views in the Profile window. 

Prerequisites
You must define profile checks before you can define Profile Groups.

To define profile groups:
1. Navigate to Setup > Customer Management > Customer Profiles.

The Customer Profile Setup window appears.

2. Select the Profile Groups tab.

3. In the Name field, enter a name for the profile group. 

All the profile checks you have defined are displayed in the Checks region.
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4. The Code field defaults based on the value you entered in the Name field.

5. In the Description field, optionally enter a description for the profile group you 
are defining. 

6. In the Customer Type field, select the customer type you want to associate with 
the profile group. 

Selecting All, the default, displays the profile group you are creating for both 
persons (consumers) and Organizations.

If you wish to restrict this profile group for display when agents are handling a 
specific customer type, then select either Person or Organization.

7. You can enter dates in the Active From and Active To fields to limit the 
availability of this profile group.

8. In the Checks region:

a. Select the appropriate profile check from the Profile Checks column and 
move it to the Group Checks column. Use the right and left arrow buttons 
to move the profile checks between the columns. Use the up arrow and 
down arrow buttons to move the selected group check up or down in the 
list.

b. Leave the Display on Threshold check box unselected, unless:

* You have set up your profile check with a threshold.

* You wish this profile check to display only when this threshold is 
crossed.

For an explanation of using thresholds, please see Defining Variable Profile 
Checks on page 4-19 for additional information.

9. Save the Profile group.

4.1.12 Grouping Profile Checks for Display in Dashboard Tabs
Use this procedure to group profile checks to create different Dashboard tab views 
for agents by application module and by Responsibility. 

You can use this procedure to create different views for customers, individual 
accounts, and for customer contacts.
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Prerequisites
You must define profile checks and categories before you define dashboard groups. 

To define dashboard groups:
1. Navigate to Setup > Customer Management > Customer Profiles 

The Customer Profile Setup window appears.

2. Select the Dashboard Groups tab. 

3. Enter a name for the Dashboard Group in the Group field.

4. The Code field defaults based on the value you entered in the Group field.

5. Enter a description for the Dashboard Group in the Description field.

6. From the Customer Type drop-down list, select the customer type for this 
dashboard group. 

The default is All, but you can restrict the usage of groups to either 
Organizations or Persons. Restricting a Dashboard group to a customer type 
means that the information will display only for customers of that type. 

7. Select the level at which you wish to display this group using the Level 
drop-down list. You can display information on the Dashboard for customers, 
accounts, and customer contacts.
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Each level requires that you to set up different profile checks, so the selection 
you make here restricts the profile checks you can select for the group. 

You can use the dashboard group definitions to determine the display of any 
one level (such as customers) or for all three levels (such as customers, accounts, 
and customer contacts). Remember that the categories you set are for the entire 
dashboard group and are not defined for a specific level. However, the profile 
checks that display are applicable for the specific level that you choose.

8. If you wish to restrict the use of this dashboard group for a specific time period, 
then enter dates in the Active From and Active To fields.

9. Select the categories that will organize the information on the Dashboard tab:

a. In the Categories region, move the categories from the Categories column to 
the Dashboard Categories column using the right and left arrow buttons. 

b. Order the categories in the order you wish them to display in the 
Dashboard. Use the up-arrow and down-arrow buttons to move a category 
up or down in the list. 

10. Save your changes so your categories are available in the next step.

11. In the Checks region, specify which profile checks you wish to display under 
each category:

a. Select the dashboard category you wish to set up from the Category list of 
values.

b. Select the profile checks you wish to use by moving them from the Profile 
Checks column to the Group Checks column. Use the right and left arrow 
buttons to move the profile checks between the columns. 

c. Determine the display order of the profile checks by ordering those you 
have selected (the Group Checks column). Use the up-arrow and 
down-arrow buttons to move the selected profile check up or down in the 
list. 

12. If you have set up a particular profile check with a threshold and wish to 
restrict the display using that threshold, then select the Display on Threshold 
check box to the right of the Group Checks column.

13. Save your dashboard group. 

. 
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4.1.13 Determining Access by Application Module and Responsibility
Use this procedure to determine which application module, customer type, and 
Responsibility displays the profile groups and dashboard groups you have created. 

Prerequisites
You must create the profile and dashboard groups first.

To determine access by modules, customer types, and responsibilities:
1. Navigate to Setup > Customer Management > Customer Profiles.

2. Select the Preferences tab.

3. Select an application module from the Module list of values. Although all 
application modules from all E-Business Suite applications appear in the list of 
values, you are restricted to enabling access only to those applications that use 
the Profile window and Dashboard tabs:

For Dashboard Groups which are available in Oracle TeleService and Oracle 
TeleSales, you must select either:

■ Customer Dashboard

The Contact Center window in Oracle TeleService

■ E-Business Center
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The E-Business Center window in Oracle TeleSales.

4. For Customer Profile groups, which are available in Oracle TeleService and 
Oracle Depot Repair applications, you must select one of the following:

■ Critical Customer Management

The Override Customer Criticality window in Oracle TeleService.

■ Enter Service Request

The Service Request window of Oracle TeleService.

■ Depot Repair Orders

The Repair Order window in Oracle Depot Repair.

5. If you wish to restrict access to the customer information to agents with a 
particular Responsibility, then select the Responsibility using the Responsibility 
list of values (LOV).

Leaving this value blank enables agents of all responsibilities to access to 
customer information. 

You can map more than one Responsibility by creating multiple records.

6. Use the Customer Type drop-down list to restrict the type of profile and 
dashboard groups that appear in the Group and Dashboard Group LOVs:

■ Selecting Organization or Person restricts the selection to the profile and 
dashboard groups you have set up for that customer type.

■ Selecting All displays all dashboard and profile groups. 

7. Select a profile group, a dashboard group, or both you wish to enable using the 
Group (Profile Group) and Dashboard Group LOVs. 

8. Save your work.

 

4.1.14 Running the Customer Profile Engine
The Customer Profile Engine is a server side PL/SQL concurrent program. You 
must run the Customer Profile Engine after completing the customer profile setup 
process so that all the SQL statements defined during the setup are executed to 
generate the appropriate profile values. 
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If you wish to generate data for the contact-level profiles, then you must set the 
system profile Customer Care: Include Contact Profiles in Customer Profile Engine 
Batch Runs to Yes.

The Customer Profile Engine, when executed, performs the following operations in 
the sequence below:

■ Evaluates the results of all the effective profile variables.

■ Evaluates the results of all effective profile checks based on the profile variables.

■ Evaluates the results for all the customers, accounts, and contacts.

The Customer Profile Engine must be run to:

■ Retrieve profile values for new customers

■ Retrieve the latest profile values for all customers

■ Reflect changes made to the profile setup

■ Retrieve values for new profiles

The Customer Profile Engine can be run in two ways:

■ As a concurrent program (for more information on running concurrent 
programs, refer to the Oracle System Administator’s Guide).

■ When agents click the Refresh button available in the Profile section or the 
Dashboard tab of the Contact Center or the E-Business Center in Oracle 
TeleSales. This manual method fetches the latest data for the displayed 
customer.

The parameters for running Customer Profile Engine are: 

■ Party Name

■ Group Name

 

4.1.15 Setting Automatic Refresh of Profiles on the Dashboard
You can have the application automatically recalculate the customer profile values 
for a customer whenever the agent displays a customer record by setting the profile 
option Customer Care: Permit the Dashboard to be Refreshed Automatically to Yes. 
If the profile option is set to No, the profile values are updated only when the agent 
clicks the Refresh button. Use this procedure to set the profile option.
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To enable or disable the automatic refresh of customer profiles: 
1. Navigate to Others > Profile System Values 

2. Using the Query by Example method, display Customer Care: Permit the 
Dashboard to be Refreshed Automatically.

3. Set the profile to Yes to enable the functionality. Setting the value No disables 
the automatic refresh. 

4. Set the system profile Customer Care: Run the Profile Engine to process the 
profile checks for contacts at batch mode to Yes to enable the engine to calculate 
contact-specific profile checks.

4.2 Setting Up Relationship Plans
Relationship plans make it possible for your organization to deliver personalized 
and proactive customer service by alerting agents to customer needs. Whenever an 
agent is working on a customer record that meets the conditions you specify, the 
application can automatically display an alert message or launch a script that 
guides the agent through the interaction with the customer.

Relationship plans can trigger the alerts and scripts for agents working in the 
Contact Center and Service Request windows in Oracle TeleService and in the 
E-Business Center window for Oracle TeleSales.

For a general understanding of relationship plans see the following topics:

■ The About Relationship Plans on page 4-31 topic gives you a general overview 
of the relationship plan concepts. 

■ The Relationship Plans Components on page 4-32 section describes some of the 
modules you must set up to create relationship plans.

■ The Process on page 4-34 Overview gives you an overview of the major setup 
steps in the order you must carry them out. You can access the detailed 
instructions from each step.

The following topics give you the details for individual implementation steps. They 
include:

■ Defining Plan Groups on page 4-35

■ Defining an Action on page 4-36

■ Setting Up Messages and Scripts for Association with Relationship Plans on 
page 4-39
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■ Defining Messages on page 4-40

■ Generating Messages on page 4-42

■ Creating the Relationship Plan Itself on page 4-43

■ Creating a Condition for the Relationship Plan on page 4-46

■ Adding or Modifying Relationship Plan Condition Lines on page 4-49

■ Enabling Relationship Plans on page 4-50

■ Running the Relationship Plan Assignment Engine on page 4-51

■ Modifying Relationship Plan Lookups on page 4-52

4.2.1 About Relationship Plans
A relationship plan is a process which runs in the background periodically checking 
which customers meet one or more conditions you specify. Here are two examples:

■ Plan A

If a customer contract is to expire in five days, then alert the agent with a 
message.

■ Plan B

If a customer has ten or more open high-priority service requests, then check if 
the customer has orders of $1 million or more. 

For customers with orders above $1 million, launch a script that guides the 
agent in handling the customer call. 

For customers below that threshold, alert the agent with a message. 

Determining what action to take is a two-step process. The relationship plan first 
evaluates if a customer qualifies for the plan and then determines what action to 
take.

If your plan includes only one condition, then all customers that meet that condition 
qualify for the plan and the plan takes the action you specify. For Plan A, that 
means alerting agents for all the qualifying customers.

But a plan can take different actions for different subsets of the customers who 
qualify. Plan B first decides which customers qualify for the plan by checking which 
have ten or more high-priority open service requests.

The plan evaluates the qualifying customers using two more conditions and takes 
different actions for those customers who meet them: 
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■ If a customer has orders of less than $1 million, the plan displays an alert.

■ If a customer has orders of more than $1 million, the plan displays a script.

4.2.2    Relationship Plan Components
Relationship plan implementation involves many steps in multiple modules. You 
must create a mechanism to decide which customers belong to your plan, for 
example, and you must also create the actions, the messages, and the scripts, you 
wish the plan to display. The relationship plan itself (Setup > Relationship Plans > 
Define Relationship Plans) brings all the pieces together. 

This section highlights the different types of setups you need to complete. A later 
section gives a process overview of the actual setup steps themselves.

Monitoring the Database of Customers 
If you wish to assign your customers to relationship plans automatically, you must 
set up a way to monitor the database to see if any customers qualify. For Plan A this 
means finding customers with expiring contracts. For Plan B, finding customers 
with high-priority service requests. 

This involves setting up a Profile Check which retrieves and summarizes customer 
data based on the SQL query you enter. The Customer Profile Engine concurrent 
program refreshes this data at the periods you specify. See Setting up Customer 
Profiles on page 4-2.

Evaluating if Customers Qualify for the Plan
Now that you are collecting data on your customers, you must create the condition 
which evaluates the data tracked by the profile check and determines whether a 
specific customer qualifies for the relationship plan. Does the customer have more 
than one open high-priority service request? Does the customer have more than five 
expiring service contracts?

You enter the qualifying condition in the Relationship Plan itself. It is evaluated by 
the concurrent program Relationship Plan Assignment Engine. If any customers 
meet the condition, then they qualify for the plan. 

Setting Up the Actions the Plan will Take
A relationship plan can take different actions on subsets of the qualifying 
customers. Now that you have assigned customers to the plan, you are ready to 
determine what actions you wish the plan to take for which customers.
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You must define the actions and conditions separately. 

For Plan B, this means creating two conditions:

■ Condition B1: If a customer has orders of less than $1 million

■ Condition B2: If a customer has orders of more than $1 million

And two actions:

■ Action B1: Display alert.

■ Action B2: Display Script

Plan A does not need to evaluate any additional condition because it displays an 
alert for all customers who qualify, however, you must still create one because 
conditions are the only way to trigger an action:

■ Condition A1: <header information only>

You must also create the action for Plan A:

■ Action A1: Display alert message that contract is about to expire. 

Please note that the action setup uses a user interface provided by Oracle Contracts 
which includes additional functionality you do not need to use for relationship 
plans.

Setting Up the Messages or Scripts
You must also set up the alert messages and scripts you wish to display for the 
different actions your plan will take.

You set up the Messages in the Messages window under the Application Developer 
Responsibility and compile them by running the Generate Messages concurrent 
program. Messages are similar to the standard application messages used by all 
Oracle applications and are fully described in the Oracle Applications Developer's 
Guide.

You must create your scripts using Oracle Scripting as described in that applications 
documentation.

Hooking Up the Conditions to the Actions
When you create the conditions of your relationship plan, you cannot directly 
specify the alert messages and scripts the conditions are to launch. You must make 
this link indirectly by first defining an "Outcome" for each script and message. To 
create an Outcome, you define the script or message as a Process Definition of the 
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type Outcome and then use the name of this process definition to create the link 
with the condition that will trigger it.

   

4.2.3 Process Overview
Here is an outline of the steps required to implement Relationship plans:

1. Log into Oracle applications under the Customer Support Responsibility.

2. Set up a profile check that retrieve and summarize your customer data. You can 
use one of the profile checks you set up to display key customer information for 
agents as part of Customer Profile setup. If you do need to create a profile check 
specifically for relationship plans, then you must complete at least the following 
steps:

a. Navigate to Setup > Customer Management > Customer Profiles.

b. On the Profile Variables tab, define the variable you wish to use in your 
profile check. This is where you enter the SQL queries. You can use the 
same variable in multiple profile checks. See Defining Profile Check 
Variables on page 4-11.

c. On the Profile Checks tab, define the profile check itself. See Defining 
Profile Checks on page 4-17. 

3. Navigate to Setup > Relationship Plans > Events > Define Action and set up one 
action for every condition in the relationship plan. Every relationship plan must 
have at least one action. On the Basic tab, you must define all of the variables 
you want to use for your condition and every token that you wish to use in an 
alert message. See Defining an Actions on page 4-36 for details.

4. If you wish to have your relationship plan display an alert message, then you 
must:

a. Under the Application Developer Responsibility, navigate to Application> 
Messages.

b. Define all of your messages as described in Defining Messages on 
page 4-40. For displaying customer information, such as the customer 
name, in the text of the message you are limited to using only the tokens 
you have defined in the Action window in the previous step.

c. Generate the messages (Other > Requests > Run) by running the Generate 
Messages concurrent program. See Generating Messages on page 4-42.
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5. If you wish to have your relationship plan display a script, then prepare the 
script as described in Oracle Scripting documentation and note down its name. 
You can obtain this from the Name field of the Script Properties window in the 
script author’s file.

6. You have now created the action(s) your relationship plan will take, but you 
cannot hook them up to the relationship plan just yet. You must first create an 
intermediary called a Process Definition of type Outcome. It is this process 
definition or "Outcome" and not the action itself that you associate with the 
relationship plan conditions that launch them.

To create the outcome:

a. Switch to the Customer Support Responsibility and navigate to Setup > 
Relationship Plans > Events > Define Process Definition.

b. Create the outcomes according to the steps outlined in Setting Up Messages 
and Scripts for Association with Relationship Plans on page 4-39. 

7. If you wish to organize your relationship plans in categories, then navigate to 
Setup > Relationship Plans > Define Plan Groups and define these categories as 
described in Defining Plan Groups on page 4-35.

8. You are now ready to create the relationship plan itself which ties together all of 
the setups you have done so far. In this step you enter both the condition that 
determines which customers qualify for the plan and any other conditions 
which decide what action the plan will take. The setup is done in the New Plan 
window (Setup > Relationship Plans > Define Relationship Plans). See Creating 
the Relationship Plan Itself on page 4-43 and Creating a Condition for the 
Relationship on page 4-46 Plan for details.

9. Now you must enable your plan for any of the forms where you wish the 
actions to appear. Navigate to Setup > Relationship Plans > Enable Relationship 
Plans) and enable the forms as described in Enabling Relationship Plans on 
page 4-50. The options are: Contact Center, Service Request, and the E-Business 
Center from Oracle TeleSales. See.

10. As a last step, run the concurrent program Relationship Plan Assignment 
Engine to assign customers to your plan. See Running the Relationship Plan 
Assignment Engine on page 4-51.
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4.2.4 Defining Plan Groups
Use this procedure if you wish to create categories to organize your relationship 
plans into logical groups. Defining plan groups is optional.

Prerequisites
None

To define relationship plan groups:
1. Navigate to Setup > Relationship Plans > Define Plan Groups.

The Relationship Plans Group Lookup window appears.

2. In a new row, enter a value in the Code field.

3. Enter a value in the Meaning field.

4. Enter a value in the Description.

5. The Tag field is not used in Oracle TeleService.

6. Optionally enter dates in the From and To fields.

7. Save your plan group.
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4.2.5    Defining an Action
Use this procedure to define the action the application will take when the 
relationship plan applies to a particular customer. 

If you wish to display an alert message for agents as your action, then you must 
define any tokens you wish to use in the message text in the Element Name field of 
the Basic tab. For example, if you wish to include the customer’s name in the alert 
message, then you must enter CUST_PARTY_NAME.

If the action you are defining is triggered by evaluating a relationship plan 
condition, then you must also define the variable you will use for the condition. If 
your relationship plan contains a condition that will take this action based on the 
city where the customer is located, then in the Basic tab you must enter the variable 
CITY. 

If you wish to view the available list of variables/tokens to choose from, you can 
query up the action with the name Customer Care - Generic Action or refer 
to Appendix C, "Seed Data for Relationship Plans" of this guide. 

Prerequisites
None

To define an action:
1. Navigate to Setup > Relationship Plans > Events > Define Action.

The Action window appears.

Note: You must enter the same token name when you set up 
condition that will trigger this action. See Creating a Condition for 
the Relationship Plan on page 4-46.
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2. Enter a name for your action in the Name field.

3. Select Action Based from the Action Type drop-down list. Date Based is not 
supported.

4. Optionally enter a description of your action in the Description field.

5. Enter a unique name in the Correlation field. You can start the name with the 
prefix CSC_, for example, to indicate your action is related to Oracle Customer 
Care. 

6. Select the Enabled check box to make this action available for use.

7. Select the Allow Synchronous Outcomes check box to allow a real-time alert or 
script to pop up.

8. If your action displays an alert message, then in the Basic tab, enter any tokens 
you wish to use in your message:

a. In Element Name, enter a valid variable name. 

You can obtain the list of valid Contact Center header variable names by 
querying up the Customer Care - Generic Action or from 
Appendix B of this guide.

Note: You need not define any tokens for generic messages that 
apply to all customers.
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For example, if you wish to display the full name of the customer in the 
alert message, then enter CUST_PARTY_NAME. 

You must also enter the same value in two other places: in the text of the 
message when you define the message in the Messages window and in the 
Parameters window when defining the condition that uses this action.

b. You can enter the same value in the Name field as in the Element Name 
field.

c. Optionally, enter a description in the Description field.

d. Select a data type of CHAR, NUMBER, or DATE in the Data Type field.

e. Select a format mask, if appropriate.

9. If your action is triggered by a condition that evaluates a variable, then define 
the variable in the Basic tab in the same manner as the message tokens above.

10. Save your action.

4.2.6    Setting Up Messages and Scripts for Association with Relationship Plans
You can indicate which script or message your relationship plan is suppose to 
launch only indirectly by first creating what is called a Process Definition of type 
Outcome. It is the name of this process definition, or outcome, rather than the name 
of the message or script itself, that you will associate with the condition of your 
relationship plan. 

Prerequisites
■ You must create the action, message, and script first. 

■ For Scripts, you must know the name of the script. You can obtain this from the 
Name field of the Script Properties window. You can open this window from 
the script author’s file. 

■ For messages, you must know:

■ The value you entered in the Name field of the Messages window.

■ The value(s) you entered for the individual message tokens used by the 
message. (These were entered on the Basic tab of the Action window in the 
Element Name fields.)

To define process definitions of type outcome:
1. Navigate to Setup > Relationship Plans > Events > Define Process Definitions.
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The Process Definitions window opens.

2. In the Name field, enter the name of the script or message.

3. Optionally enter a description in the Description field.

4. Select Outcome from the Purpose drop-down list. This is the only permitted 
value.

5. From the Type drop-down box, select either Alert or Script. The other types are 
not supported.

6. Optionally enter comments in the Comments field.

7. If you are creating the outcome for a message, then in the Name fields of the 
Basic tab of the Parameters region, enter the same values you entered for 
Element Name fields on the Basic tab of the Action window. 

8. The Data Type field defaults to the data type of the Element Name.

9. Save your process definition. 

4.2.7    Defining Messages
Use this procedure to define the alert messages the agents will see. Messages are 
defined for use in displaying messages about customers in real-time alerts. 
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Prerequisites
None

To define messages:
1. Under the Application Developer Responsibility, navigate to Application > 

Messages. 

The Messages window opens.

2. Enter a name for your message in the Name field. You must enter this same 
name when you create a Process Definition. 

3. Select a language from the Language list of values (LOV).

4. Select Customer Care from the Application LOV.

Entry in the remaining fields, Number, Type, Maximum Length and 
Description, are optional.

5. In the Current Message Text field, enter the message that you wish to display as 
a real-time alert. 

If you wish to display the value of a token, for example, the customer name 
CUST_PARTY_NAME, then you must enter it preceded with an ampersand 
symbol, for example, &CUST_PARTY_NAME.
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You are restricted to using only the tokens that you have entered in the Element 
Name fields in the Action window. See Defining an Actions on page 4-36.

6. Save your message.

4.2.8    Generating Messages
Use this procedure to generate the messages you have created.

To generate messages:
1. Under the Application Developer Responsibility, navigate to Other > Requests 

> Run.

2. Select the Single Request radio button in the Submit a New Request window 
and click OK.

3. Select Generate Messages from the Name list of values.

4. In the Parameters window enter:

■ Language: US or another message language

■ Application: Customer Care

■ Mode: DB_TO_RUNTIME

5. Click OK to close the Parameters window.

6. Click Submit.
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7. Click No to submit another request.

8. You can view the status of your requests by navigating to View > Requests >All 
My Requests > Find

   

4.2.9 Creating the Relationship Plan Itself
Use this procedure to create the plan which ties all of the pieces of the relationship 
plan together. It is here you enter the condition that determines whether customers 
qualify for the plan and also the conditions that decide which action the plan will 
take. 

Oracle TeleService provides a predefined relationship plan, Expiring Contracts, 
which displays an alert when a customer has any contracts that will expire in the 
next 30 calendar days. This relationship plan uses the profile check called Expiring 
Contracts. Refer to Appendix B for more details about the predefined relationship 
plan. 

Prerequisites
You must have defined your actions, process definitions, messages, and scripts.

To define the plan itself:
1. Navigate to Setup > Relationship Plans > Define Relationship Plans.

New Plan window appears. (When you are modifying the plan the name of this 
window changes to Modify Plan, but the functionality is the same.)
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2. In the Plan Headers tab, enter a name for the plan in the Name field.

3. If you wish to group this relationship using relationship plan categories you 
have created, then select a group name from the Group Name list of values.

4. Optionally enter start and end dates for this relationship plan.

5. Unless you wish to create a plan for individual accounts rather than for 
customers, leave the Account Level check box unselected. An account 
relationship plan tracks customers who generate a significant amount of 
revenue in one account, for example.

6. All relationship plans are initially created from a template, so the Template 
radio button is selected by default in the Plan Type section. The Custom radio 
button can be used only from the Inquiry tab when you customize a 
relationship plan for one specific customer. 

7. Enter a description of the Relationship Plan in the Description field.

a. In the Plan Criteria section, you define the criteria to be used by the 
Relationship Plan Assignment Engine to decide which customers qualify 
for the plan:

b. Using the Profile Check list of values, select the profile check that 
summarizes the customer information you wish to evaluate. The profile 
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checks contain those seeded with the application as well as those you have 
defined. 

c. Select an operator from the Operator list of values. The choices are =, <, >, 
>=. <=, Between, and Not Between.

d. Enter the constant in the Low Value field. 

e. The high value is available only if you previously selected an operator 
value of Between or Not Between.

8. Save your relationship plan. 

You are now ready to specify the action(s) the relationship plan is to take and 
any additional conditions will trigger them.

9. Select the Plan Details tab.

Note: If you wish the relationship plan to display an alert message 
or script to agents for all customers who qualify, you must still 
create a new condition for each action you wish the plan to take. 
Conditions provide the only way to specify which actions the plan 
will take. If you wish all qualifying customers to trigger the action, 
you simply leave the expression tab blank.
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10. Click New Condition to create a new condition that will trigger one of the 
action as described in Creating a Condition for the Relationship Plan on 
page 4-46. 

4.2.10    Creating a Condition for the Relationship Plan
Use this procedure to create a condition for your relationship plan. Each 
relationship plan must have at least one condition attached to it.

Prerequisites
You must create the relationship plan itself before adding conditions.

To create a condition for a relationship plan:
1. Navigate to Setup > Relationship Plans > Define Relationship Plans.

2. Display the relationship plan where you wish to create a condition. 

3. Select the Plan Details tab.

4. Click New Condition 

The Condition window appears.
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5. Enter a name for the condition in the Name field.

6. Optionally enter effective dates, description and comments for your condition.

7. In the Condition Type region, select the Action radio button. The Date condition 
type is not supported in relationship plans.

8. Select an action from the Action list of values. The list of values contains actions 
that you previously defined. You must use a unique action for every 
relationship plan. 

9. Leave the Evaluate Only Once check box unselected unless you wish to 
evaluate your condition only once.
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10. In the Outcomes region, use the Outcomes LOV to select the outcome which 
represents the message or script you wish to display for customers matching 
this condition. 

A relationship plan can display a message, a script, or both.

Outcomes, are the intermediaries which permit you to associate scripts and 
messages with relationship plans. They are defined in the Process Definitions 
window as described in Registering Messages and Scripts for Use in 
Relationship Plans on page 4-39.

11. If the outcome is a message which displays the value of one or more tokens, 
such as the customer’s name, then you must re-enter the same message tokens: 

a. Click Parameters.

b. The Parameters window appears.

c. Select the token from the Action Attribute list of values.

Note: If you have defined more than one outcome for this 
condition, then the application displays a different window. In this 
case you must first:

■ Select the parameter you wish to define.

■ Right-click and select Populate selected rows in 
PARAMETERS from the pop-up menu.
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For example, if you are displaying the customer name in the body of the 
message then you must select CUST_PARTY_NAME in the Action Attribute.

d. Click OK to return to the Conditions window.

12.  If you wish to enter a condition which will trigger the action, then enter it in 
the Expression tab. You can use the parameters you have just mapped.

13. Save the condition.

4.2.11    Adding or Modifying Relationship Plan Conditions
Use this procedure to modify relationship plan conditions. You can add additional 
conditions to an existing plan or modify a condition already attached to your plan.

Prerequisites
You must define a relationship plan first.

To add or modify relationship plan conditions:
1. Navigate to Setup > Relationship Plans > Define Relationship Plans.

2. Display the Relationship Plan to which you want to add condition lines.

3. Select the Plan Details tab in the Modify Plan window.

Note: Most of the time you will want the value in the Parameter 
and Action Attributes fields will be the same. But you are permitted 
to assign different values to the token in your message provided 
they are of the same data type. For example, if you wish to display 
the customer name in the message, then you can map the full 
customer name, the first name, or the last name to that token using 
this window.
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4. Click Add Condition. 

5. Select a condition and click OK to attach it to the plan header.

6. If you wish to modify a condition line of a relationship plan, then:

a. Click Modify Condition in the Plan Details window.

b. Make the necessary changes to the condition line or outcome.

c. Save the modified condition line.

   

4.2.12 Enabling Relationship Plans in Application Modules
Follow this procedure to enable relationship plans in different application modules: 
in the Contact Center and the Service Request windows of Oracle TeleService and in 
the E-Business Center of Oracle TeleSales. 

Prerequisites
None
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To enable relationship plans:
1. Navigate to Setup > Relationship Plans > Enable Relationship Plans.

The Enable Relationship Plans - Setup window appears.

2. The Function list of values displays all forms, but you must select one of the 
three following forms:

■ CSCCCCRC for Contact Center 

■ CSXSRIXSR for Service Request 

■ AST_RC_ALL for E-Business Center 

3. Save your settings.

4.2.13    Running the Relationship Plan Assignment Engine
The Relationship Plan Assignment Engine is a server side PL/SQL concurrent 
program. You must run the Relationship Plan Assignment Engine after completing 
the relationship plan setup process so that all associations between customers and 
relationship plans are made. 

This concurrent program also runs automatically each time you run the Customer 
Profile Engine.

The Relationship Plan Assignment Engine performs the following operations:

Note: Please see the appendix, Enabling Relationship Plans, for 
additional information.
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■ Evaluates all customers that meet relationship plan criteria and associates the 
customers with the appropriate relationship plan.

■ Evaluates all customer that do not meet relationship plan criteria and 
disassociates the customer from the relationship plan.

■ Checks for all customers who have been manually assigned to relationship 
plans and ignores automatic association/disassociation rules for these 
customers.

The following parameters are available for running the Relationship Plan 
Assignment Engine:

■ Plan Name

■ Check Name

■ Party Name

■ Account Name

Each parameter provides a list of values from which to choose. If a value is entered 
in the Party Name parameter, the Account Name list of values contains only those 
values for the selected Party Name. If no Party Name is selected, the Account Name 
list of values displays all accounts.

You can initiate the Relationship Plan Assignment Engine in two ways: 

■ Run the concurrent program explicitly.

■ Let it run automatically whenever the customer profiles are updated by the 
Customer Profile Engine. 

Customer profiles can be updated by running the Customer Profile Engine as a 
concurrent program or by selecting the Refresh on the Dashboard tab.

4.2.14 Modifying Relationship Plan Lookups
The lookups described in this section make it possible for you to modify different 
lists of values for relationship plan setup.

■ Group Names for relationship plans

You can modify any of the meaning fields in the lookup described in the 
following table. It controls the list of values for the Group Name field.
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■ Group Names for relationship plans

You can modify any of the meaning fields in the lookup described in the 
following table. It controls the list of values for the Group Name field.

4.3 Setting Up Critical Customers
The application automatically flags a customer as critical whenever a customer 
meets conditions defined in a customer profile.

The predefined customer profile, called Critical Customer, flags a customer as 
critical if the customer has more than five open service requests. 

You can change the criteria by modifying the profile or by creating a new one 
altogether as described in the Setting Up Customer Profiles section. You must select 
any new profile to be used for criticality checking in the system profile Customer 
Care: Profile Check for Determining Customer Criticality. 

You can manually reset the criticality of a customer making a non-critical customer 
critical or vice versa and you can view the audit history of such manual over-rides.

4.4    Setting Up Quick Menu
Quick menu is based on seeded filters. Filters have a many to many relationship 
with AOL functions and are seeded in the Quick Menu tables. This section defines 
the association of the filter with its function in AOL. 

Lookup Type Meaning Lookup Code Meaning Level

CSC_PLAN_
GROUP

Relationship Plans 
Group

■ GROUP1

■ GROUP2

■ GROUP3

■ Plan Group1

■ Plan Group2

■ Plan Group3

User

Lookup Type Meaning Lookup Code Meaning Level

CSC_PLAN_
STATUS

Relationship Plans 
Status

■ APPLIED

■ DISABLED

■ ENABLED

■ MERGED

■ REMOVED

■ TRANSFERED

■ Applied

■ Disabled

■ Enabled

■ Merged

■ Removed

■ Transferred

User
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For the Customer Support Responsibility, the Quick Menu has already been setup. 
To familiarize yourself with the quick menu setup, perform the following steps:

■ Viewing System Profile Values

■ Verifying AOL Menu for Quick Menu

■ Configure the Quick Menu to meet your needs

4.4.1 Viewing System Profile Values

To view the profile values:
1. Open the System Profile Values window from the navigator.

2. Query on the system profile Customer Care: Start Menu in Quick Menu.

3. The default value is Quick Menu for Customer Support.

4.4.2 Verifying AOL Menu for Quick Menu

To verify an AOL menu for quick menu:
1. Using the Application Developer Responsibility, navigate to Application > 

Menu.

The Menus window appears.

2. Run a query to open the seeded menu CSX_CUSTOMER_SUPPORT_QM.

3. View the results of the query.

4. Close the window.

4.4.3 Configuring the Quick Menu
You can configure a different quick menu for each Responsibility by adding or 
deleting Quick-Menu-enabled forms. 

The seeded quick menu displays all quick-menu enabled forms:

■ Manage Critical Customer

■ Maintain Relationship Plans

■ Order Capture (Order Quoting - Forms)

■ View Customer Product
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■ Maintain Systems

■ Contact Center

■ Service Request

■ Depot Repair

The following item is not quick-menu enabled as it uses the HTML interface:

■ Search Knowledge Base

You can add any additional form function to the Quick Menu, even though the form 
function is not quick menu enabled. This allows you to quickly navigate to the 
form, but the variables in the original form are not passed to the form on the quick 
menu. Only quick menu enabled forms can accept variables from the original form.

4.5 Setting Up Wrap-up
Agents record their interactions with customers using the Call Wrap Up window. 
You can use this procedure to make the wrap up mandatory or optional and specify 
what information is recorded by default.

Prerequisites
Every interaction between an agent and a customer and each action an agent takes 
can have multiple outcomes, each outcome can have multiple results, and each 
result can have multiple reasons. 

You must set up the outcome, results, and reasons and their possible combinations 
by following the procedures described in the Oracle Customer Interaction History 
Implementation Guide.

To set up wrap up: 
1. Navigate to Others > Profile System Values.

2. If you wish to make wrap up mandatory for every agent interaction with the 
customer in the Contact Center, then set the system profile Customer Care: 
Make Call Wrap Up Mandatory in Contact Center to Yes. By default wrap up is 
optional and this profile is set to No.

3. If you wish to make wrap up mandatory for agent interactions in the Service 
Request window, then set Service: Make Call Wrap Up Mandatory in Service 
Request to Yes. A setting of No, makes entry optional.
Implementing Customer Care 4-53



Setting Up Party and Account Numbering
4. Set the system profile Default Interaction Wrap-Up Combination for Contact 
Center to the combination of outcome, result, and reason codes you wish to use 
by default for interactions. 

The list of values lists all of the Wrap Up combinations of outcome, result, and 
reason codes you have created. See the Wrap Up section of the Oracle Customer 
Interaction History Implementation Guide.

5. Set the system profile Customer Care: Default Value for Wrap-Up Activities to 
the combination of outcome, result, and reason codes you wish to use by 
default for each activity recorded by the agent.

4.6 Setting Up Party and Account Numbering
Party numbers and account numbers can be generated manually or automatically. 

To setup party and account numbering:
1. Set up automatic account numbering:

a. Select an Oracle Receivables Responsibility and navigate to System > 
System Options.

The System Options window appears.

b. Open the Trans and Customers tab.

c. Check the Automatic Customer Numbering check box if you want to 
generate customer account numbers automatically in Customer Care.

2. To enable automatic party number generation in Oracle TeleService, set the HZ: 
Generate Party Number system profile option to Yes.

4.7 Specify Global Address Formatting and Address Validation 
Agents can enter customer addresses in the formats appropriate for the country 
where the customer is located. For example, if a customer has a branch in Germany, 
agents enter the address in a format recommended by the Bundespost. For 

Note: Although this number is referred to as Customer Number 
in Oracle Receivables, this number is referred to as Account 
Number in Oracle TeleService.
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addresses in the United Kingdom, they enter the address in the format 
recommended by the Royal Mail.

There are six preset address formats that are available for your use:

■ Japan

■ Northern Europe

■ South America

■ Southern Europe

■ UK/Africa/Australia

■ United States of America

The different address formats are implemented in the application by using 
descriptive flexfields. Agents enter the country using a list of values and then enter 
the rest of the address in a flexfield window. 

Prerequisites
Understanding of descriptive flexfields

To set up global address formatting and address validation: 
1. Set up flexible addresses and address validation as described in the Flexible 

Address and the Address Validation sections of the Customers chapter of the 
Oracle Receivables User Guide. 

2. Set up the two following profile options:

■ Customer Care: Default Country for Contact Center

This profile option defaults the country in the Country field of an address 
on the Contact Center. The setting of this profile option is mandatory as 
there is no seeded default value.

■ Customer Care: Default Address Style for Contact Center

If there is no address style associated with the country, then the application 
uses the address style specified in this profile. By default this system profile 
is set to AS_DEFAULT (the Oracle Sales Default Address Style).

3. If you wish to create additional address styles then follow the instructions 
outlined in Setting Up Additional Address Styles on page 4-57.

4. Map the countries to address styles as described in Mapping Countries to 
Address Styles on page 4-60.
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5. Set up the Customer Care: Default Address Style for Contact Center system 
profile option to the address style you wish to use in case a user fails to enter a 
country for an address.

4.7.1 Setting Up Additional Address Styles
Use this procedure to create additional address styles or to modify existing ones.

Prerequisites
Familiarity with descriptive flexfields.

To set up additional address styles:
1. Log into Oracle applications under the Application Developer Responsibility.

2. Navigate to Flexfield > Descriptive > Segments.

The Descriptive Flexfield Segments window appears.

3. Search for Address in the Title field using the Query Enter / Query Run search 
method available from the View menu.

The Descriptive Flexfield Segments window lists the available address styles.

4. With the Freeze Flexfield Definition check box unselected, create a new record 
in the Context Field Values region.
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5. Enter the name of the style in the Code and Name fields.

6. Enter an optional description.

7. Click Segments.

The Segments Summary window appears.

8. Enter each element of your address style:

a. Enter a number that determines the order of the address element. The 
address elements appear in ascending order.

b. Enter the element Name and Window Prompt.

c. Select one of the available address components using the Column LOV.

d. Select the Displayed and Enabled check boxes.

9. Click Save.

10. Navigate to Application > Lookups > Application Object Library.

The Application Object Library Lookups window appears.

11. Search for ADDRESS_STYLE in the Type field using the Query Enter / Query 
Run search method available from the View menu.

The Application Object Library Lookups window lists the available address 
styles.
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12. Enter the code for your address style. The value you enter in the Code field 
must match the code you have entered in the Context Field Values.

13. Enter the wording the agents will see in the Meaning field. 

14. Enter an optional description.

15. Make sure the Enabled check box is selected.

16. Click Save.

4.7.2 Mapping Countries to Address Styles
You must make sure that each country you are doing business with is mapped to 
the appropriate address style. Use the following procedure to map address styles.

Steps
1. Under the Receivables Manager Responsibility, navigate to Setup> System > 

Countries.

The Countries and Territories window appears.

2. Search for the countries that you want to set up using the Query/Enter 
Query/Run method.

3. Use the Address Style List of Values (LOV) to select the address style for each 
country.

4. Click Save on the toolbar.
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4.8 Setting Up Custom Tabs on the Contact Center
Implementers can create two custom tabs in the Contact Center window by 
modifying the code for the Contact Center form and the associated library. 

The customization must be made on a view or a table which has a reference or 
intersection with HZ_PARTIES. The fields that can be displayed in the custom tabs 
will be based on this view or table.

The implementer must write public APIs to perform transactions against this table. 
Code for insert, update and delete must be built into these APIs after the necessary 
validations.

The form you create can be compiled and run stand-alone. There are no 
dependencies for running this form.

This topic covers:

■ Guidelines for Setting Up Custom Tabs on page 4-61

■ Parameters Passed from the Contact Center Header on page 4-62

■ Function Name for Custom Tabs on page 4-63

4.8.1 Guidelines for Setting Up Custom Tabs
These steps provide guidelines to help you with custom tab implementation.

Prerequisites
Knowledge of Oracle Forms development procedures and an understanding of 
Oracle TeleService code.

To set up the two custom tabs:
1. Customize the form using the following guidelines:

■ In the form CSCCUST1.fmb and/or CSCCUST2.fmb, create a data block 
with all the fields you wish to display in the custom tab. 

■ Code an On Insert trigger for the data block to insert data into the tables.

■ Code an On Update trigger for the data block to update data in the tables.

■ Code an On Delete trigger for the data block to delete data from the tables.

■ The fields in the data block must be placed on the tabbed canvas CC_MAIN_
TAB_CANVAS.CUSTOM1 and/or CC_MAIN_TAB_CANVAS.CUSTOM2.
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■ Any record groups and LOVs must be coded. 

■ In order to integrate this with the Contact Center, The data block, record 
groups, and LOVs for CSCCUST1.fmb must be dropped in the CUSTOM1_
OBJ_GRP object group. Those for CSCCUST2.fmb must be dropped in the 
CUSTOM1_OBJ_GRP2 object group.

2. Modify the library using the following guidelines:

■ You can use any of the following event handlers:

■ All the code to handle API calls can be put in the library CSCCUST1.pld 
and/or CSCCUST2.pld. 

3. Integrate the forms with the Contact Center:

a. Copy the forms CSCCUST1.fmb and/or CSCCUST2.fmb to the $AU_
TOP/forms/US directory in the patched environment.

b. Compile the corresponding library and copy CSCCUST1.pll and/or 
CSCCUST2.pll to the $AU_TOP/resource directory in the patched 
environment.

c. Run the adadmin utility to compile CSC forms and libraries so that the 
changes made to the custom form and library are reflected in the Contact 
Center.

4.8.2 Parameters Passed from the Contact Center Header
The following parameters are passed from the Contact Center form to the 
CSCCUST1 and CSCCUST2 forms:

Trigger Name Description

WHEN-NEW-FORM-INS
TANCE 

This trigger calls WHEN-NEW-FORM-INSTANCE of the custom 
form. Code is added to the custom library based on the 
requirements of the custom form. 

KEY-CLRFRM This trigger calls CLEAR_CTRL_FIELDS which clears the 
control field values populated by values from the header region.

WHEN-NEW-FORM-INS
TANCE

RESTART

WHEN-TAB-PAGE-CHA
NGED

These triggers call the POPULATE_CTRL_FIELDS procedure 
which populates the control fields from the header region.
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4.8.3 Function Name for Custom Tabs
The function name for CSCCUST1 is CSCSFCU1. For CSCCUST2, it is 
CSCSFCU2.These functions are added to the CSC_CONTACT_CENTER_MENU. You 
can use it to hide and show the custom tabs.

By default, the tabs are hidden so you must enable the function in the menu CSC_
CONTACT_CENTER_MENU.

4.9 Enabling E-Mail for the Contact Center 
E-mail functionality in the Contact Center is provided through the Oracle eMail 
Center. Please see Implementing Oracle eMail Center and E-Mail Templates on 
page 1-89 for further details.

Parameter Description

Customer_Header_blk.Cust_Party_Type Customer’s party type 

customer_header_blk.cust_account_number Customer’s account number

customer_header_blk.cust_cust_acct_id Customer’s account identification number

contact_header_blk.cont_per_party_id Identification number for the Contact’s 
party of Person

contact_header_blk.cont_relationship_id The identification number for the party 
relationship

contact_header_blk.cont_party_type Contact’s party type

Note: Please back up your custom forms and libraries before 
applying any future CSC patches for these files so they are not 
over-written in $AU_TOP/forms/US and $AU_TOP/. After the 
patch is applied successfully, you must copy the customized files 
back to these directories and run adadmin to generate CSC forms 
and libraries.

If Oracle supplies a bug fix in the future for the custom forms and 
libraries you modify, then you must copy your modifications from 
the backup to the newer version of the files.
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4.10 Setting Up Search Preferences
You can customize searches in the Contact Center by:

■ Setting Up Service Key Search Preferences on page 4-65

■ Limiting Searches to a Specific Country on page 4-65

■ Modify the List of Service Keys Used for Searches on page 4-66

■ Configuring Customer Search Window Defaults on page 4-66

4.10.1 Setting Up Service Key Search Preferences
Agents can display customer information in the Contact Center by entering any one 
of the following pieces of uniquely-identifying information, called service keys: 

■ Service Request Number

■ Instance Name

■ Order Number 

■ RMA Number

■ Invoice Number 

■ Contract Number

■ Serial Number 

■ Tag Number 

■ System 

■ Social Security Number

Agents can enter the service key either in the Contact Center header or the 
Customer Search window.

If the implementation includes an IVR system, the service key can also be entered 
directly by customers themselves.

The application displays customer contact information only for service request 
numbers. In this case, the contact displayed is the contact associated with the 
service request. If the contact for the service request is an internal employee, the 
application displays customer information only. 

You can specify:
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■ Which service key is the default for agent searches by setting the system profile 
Customer Care: Default Contact Center Service Key to any one of the ten 
service keys. This specifies which service key appears by default in the Search 
By drop-down list in the Contact Center header and Customer Search windows.

■ Which tab agents will see when they perform a service key search. 

You can specify which tab displays by default for each of the service keys by 
setting the profile options listed in the following table:

4.10.2 Limiting Searches to a Specific Country
You can limit all searches to customers in a specific country by setting the system 
profile Customer Care: Default Country for Filtering Records in the Contact Center 

Profile Name Description
Possible 
Settings Default Value

Customer Care: Default Tab for 
Service Request Number Service 
Key

Default tab to be displayed when the 
Service Key is a service request 
number

All tabs Service Request tab

Customer Care: Default Tab for 
Order Number Service Key

Default tab to be displayed when the 
Service Key is an order number

All tabs Orders tab

Customer Care: Default Tab for 
RMA Number Service Key

Default tab to be displayed when the 
Service Key is an RMA number

All tabs Service Request tab

Customer Care: Default Tab for 
Invoice Number Service Key

Default tab to be displayed when the 
Service Key is an Invoice number

All tabs Invoices tab

Customer Care: Default Tab for 
Contract Number Service Key

Default tab to be displayed when the 
Service Key is a Contract number

All tabs Contracts tab

Customer Care: Default Tab for 
Serial Number Service Key

Default tab to be displayed when the 
Service Key is a Serial number

All tabs Service Request tab

Customer Care: Default Tab for Tag 
Number Service Key

Default tab to be displayed when the 
Service Key is Tag number

All tabs Service Request tab

Customer Care: Default Tab for 
System Service Key

Default tab to be displayed when the 
Service Key is a System number

All tabs Service Request tab

Customer Care: Default Tab for 
Instance Name Service Key

Default tab to be displayed when the 
Service Key is an Instance Name

All tabs Install Base tab

Customer Care: Default Tab for 
Social Security Number Service 
Key

Default Contact Center tab displayed 
when the Service Key a user enters is 
a social security number

All tabs Dashboard tab
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to a country of your choice. By default, this profile is null. This means that searches 
are not restricted by country.

4.10.3 Modify the List of Service Keys Used for Searches
The following lookup makes it possible for you to modify the values in the Search 
By drop-down list agents use to select a service key for a search in the Contact 
Center.

4.10.4 Service Key Search Extensibility
You can extend the service key search using user hooks. The following steps 
provide guidelines to extend the service key search:

Extending the service key search:
1. Before enabling the service key user hook, verify that the CSC_Service_Key_

CUHK package body has been created.

2. Set the execute_flag column value to Y in the JTF_USER_HOOKS table for the 
Customer User Hook that should be enabled.

Lookup Type Meaning Lookup Code Meaning Level

CSC_CC_
DEFAULT_
SERVICE_KEY

Customer Care: 
Default Contact 
Center Service Key 
Lookup

■ CONTRACT_NUMBER

■ EXTERNAL_REFERENCE

■ INSTANCE_NAME

■ INVOICE_NUMBER

■ ORDER_NUMBER

■ RMA_NUMBER

■ SERIAL_NUMBER

■ SERVICE_REQUEST_
NUMBER

■ SSN

■ SYSTEM_NUMBER

■ Contract Number

■ Tag Number

■ Instance Name

■ Invoice Number

■ Order Number

■ RMA Number

■ Serial Number

■ Service Request Number

■ SSN

■ System

User

Note: After the Customer User Hook is enabled, the custom code 
written in CSC_Service_Key_CUHK package body is the only code 
executed. This means that none of the original product is executed 
after you enable the service key search customer user hook.
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The following script can be used to enable the Service Key search customer user 
hook:

    UPDATE jtf_user_hooks SET execute_flag = 'Y'
    WHERE pkg_name = 'CSC_SERVICE_KEY_CUHK'
    AND api_name = 'SERVICE_KEY_SEARCH_PRE'
    AND processing_type = 'B'
    AND user_hook_type = 'C'

4.10.5 Configuring Customer Search Window Defaults
You can modify the behavior of the Customer Search window in two ways:

■ Force agents to use the search window whenever they open the Contact Center

By setting the system profile Customer Care: Display Customer Search Window 
by Default to Yes, you can have the Customer Search window appear by default 
each time an agent launches the Contact Center, forcing the agent to search 
customer records before creating a new customer record.

■ Specify whether you wish to display the Basic or Advanced search tab of the 
Customer Search window by default. 

This is accomplished by setting the system profile Customer Care: Default Tab 
in Customer Search Window to the tab of your choice. By default, this profile is 
set to Basic.

4.11 Modifying the Behavior of Contact Center Tabs
You can modify the behavior of Contact Center tabs by:

■ Setting default values in key fields to speed up agent entry

■ Restricting access to tab functions or the entire tab itself

■ Modifying the lookups which determine what agents see in the lists of values

The topics in this section cover the modifications you can make in each of the 
seeded Contact Center tabs:

■ Dashboard on page 4-67

■ Interactions on page 4-69

■ Notes on page 4-69

■ Tasks on page 4-70
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■ Service Request on page 4-72

■ Contracts on page 4-73

■ Install Base on page 4-74

■ Invoices on page 4-74

■ Orders on page 4-75

■ Collateral on page 4-76

■ Addresses on page 4-76

■ Contact Points on page 4-77

■ Accounts on page 4-78

■ Party Information on page 4-79

■ Relationships on page 4-80

4.11.1 Modifying the Behavior of the Dashboard Tab
The Dashboard tab displays summaries of key information about customers, 
accounts, and contacts. Agents can drill down to the individual documents 
summarized on the tab. To gather the information displayed in this tab and enable 
the drill-downs, you must set up Customer Profiles as described Setting Up 
Customer Profiles on page 4-2. 

In addition, you can modify the behavior of the tab. You can:

■ Limit drill-downs

By default, agents are permitted to open multiple windows when they drill 
down to detailed customer information. You can restrict them to just one 
drill-down by setting the system profile Customer Care: Open Multiple 
Sessions for Dashboard Drilldown to No.

■ Permit automatic refresh of customer information

You can have the application refresh the customer information on the 
dashboard each time an agent displays a customer by setting the system profile 
Customer Care: Permit the Dashboard to be Refreshed Automatically to Yes. A 
setting of No, the default, requires the agent to click the Refresh button to 
update the display.

■ Specify if the tab displays customer or account information by default.
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Using the View By Account check box, agents specify whether they wish to 
display customer information for all accounts or for the account specified in the 
Account field of the Contact Center header. By default, the check box is not 
selected and the tab displays customer information for all accounts.

By setting the system profile Customer Care: Default Dashboard Display by 
Customer or Account to Account, the check box is selected by default and the 
dashboard summarizes only information about the account entered in the 
Contact Center header.

By default, this system profile is set to Party displaying summaries of all 
customer information. 

■ Restrict access to the tab and Refresh button by responsibility

You can specify which responsibilities can access the tab and button by 
mapping the functions listed in the following table according to the procedures 
described in Oracle Applications System Administrator’s Guide. The seeded 
Customer Support responsibility maps all of these functions.

4.11.2 Modifying the Behavior of the Interactions Tab
Agents use the Interactions tab to view the history of interactions with a customer. 
You can:

■ Specify the number of records the tab displays

This is accomplished by entering the number in the system profile Customer 
Care: Number of Interactions Displayed in Contact Center. By default this 
system profile is set to 12.

■ Restrict access to the tab or individual buttons by responsibility

You can specify which responsibilities can access the tab and buttons by 
mapping the functions listed in the following table according to the procedures 
described in Oracle Applications System Administrator’s Guide. The seeded 
Customer Support responsibility maps all of these functions.

Description Function

Access to the Dashboard tab CSCSFDSB

Access to the Dashboard tab Refresh button CSCSFRBU
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4.11.3 Modifying the Behavior of the Notes Tab and All Notes Window
You must set up notes as described in the Oracle Common Application Components 
Implementation Guide.

Agents can view notes either in the Notes tab or in the View All Party Notes Web 
browser page. The tab permits agents to view only one note at a time and to create 
new notes. The Web page displays all notes for the customer with no creation 
permitted.

For the Notes tab, you can:

■ Specify the default note Type for new notes.

This is accomplished by setting the system profile Customer Care: Default a 
Type for New Notes in the Notes Tab. By default, there is no default.

■ Specify the default note Status for new notes.

This is accomplished by setting the system profile Note: Default Note Status. By 
default, this profile is not set to any value. The default you enter affects not only 
new notes created in the Contact Center, but all notes in all applications.

■ Restrict access to the tab and the ability to create new notes by responsibility.

You can specify which responsibilities can access the tab and create new notes 
by mapping the functions listed in the following table according to the 
procedures described in Oracle Applications System Administrator’s Guide. The 
seeded Customer Support responsibility maps all of these functions.

For the View All Party Notes page, you can:

■ Include note details text in the list.

Description Function

Access to the Interactions tab CSCSFINT

Access the Account Interactions button CSCFAAB

Access to the All Interactions button CSCSFAIB

Description Function

Access to the Notes tab CSCSFWKB

Create Notes on the Notes tab CSCSFCNO
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Note details store additional text in a separate table from regular notes text and 
can only be entered in a separate Details window. Displaying this text is 
accomplished by setting the system profile Customer Care: Display Note 
Details in All Party Notes Page by Default to Yes. By default this profile is set to 
No.

■ Specify the number of records you wish to display at one time.

This is accomplished by setting the system profile Customer Care: Display Note 
Details in All Party Notes Page by Default to Yes. By default this profile is set to 
10.

■ Specify the maximum age of displayed notes.

You can specify in days how far back you want to display notes by making an 
entry in the Customer Care: Default Date Range for View All Party Notes Page. 
By default, this system profile is set to 30.

4.11.4 Modifying the Behavior of the Tasks Tab
You must set up tasks as described in the Oracle Common Application Components 
Implementation Guide.

You can specify different default values for agents creating new tasks on the tasks 
tab. You can set:

■ The default task Type for new tasks

This is accomplished by setting the system profile Task Manager: Default Task 
Type. The selection you make affects all tasks, not just those created in the 
Contact Center. The default value is Breakfast. 

■ The default task Priority

This is accomplished by setting the system profile Task Manager: Default Task 
Priority. The selection you make affects all tasks, not just those created in the 
Contact Center. The default value is: Medium.

■ The default task Status

This is accomplished by setting the system profile Task Manager: Default Task 
Status. The default setting is Open.

■ The default Assignee Type, either a group, team, or individual employee

This is accomplished by setting the system profile Customer Care: Default 
Assignee Type for New Customer Tasks. Tasks can be assigned either to an 
individual employee (Employee Resource), a group (Group Resource), or a 
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team (Team Resource). By default this profile is set to Employee Resource. An 
assignee is the individual or group responsible for carrying out the work. 

■ The Assignee responsible for completing the task

This is accomplished by setting Customer Care: Default Assignee for New 
Customer Tasks to an assignee of type you have specified in Customer Care: 
Default Assignee Type for New Customer Tasks.

■ The default type of owner assigned to customer-related tasks created on the 
Tasks tab

This is accomplished by setting the system profile Customer Care: Default 
Owner Type on the Contact Center Tasks Tab to the type of owner responsible 
for coordinating the completion of the task. 

Task ownership can be assigned either to an individual employee (Employee 
Resource), a group (Group Resource), or a team (Team Resource). The default 
setting is Group Resource. All three owner types are set up in the Resource 
Manager foundation module.

The Owner Type does not display in the tab but determines which resources 
appear in the list of potential task owners. This system profile does not affect 
service request tasks created on the Service Request tab.

■ The default task Owner for customer-related tasks

This is accomplished by setting the system profile Customer Care: Default Task 
Owner for New Customer Tasks to the resource of the type you have specified 
in the Customer Care: Default Owner Type for Contact Center Tasks. A task 
owner is the person or group responsible for coordinating the completion of the 
task.

■ Restrict access to the tab and individual tab functions by responsibility

You can specify which responsibilities can access the tab and individual tab 
functions by mapping the functions listed in the following table according to 
the procedures described in Oracle Applications System Administrator’s Guide. The 
seeded Customer Support responsibility maps all of these functions.

Description Function

Access to the Tasks tab CSCSFTSK

Create a task on the Tasks tab CSCSFCTK

Update a task on the Tasks tab CSCSFUTK
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4.11.5 Modifying the Behavior of the Service Request Tab
You can modify the behavior of the Contact Center Service Request tab by:

■ Specifying different default values for agents creating new service requests

This is accomplished by setting the system profiles describe in the following 
table. Because agents can create service requests on both on this tab and in the 
Service Request window, all settings you make here apply to both.

Access the Assignment Manager button next to the 
Owner and Assignee fields of the Tasks tab

CSCSFAMB

Access the Details button on the Tasks tab CSCSFATB

Access to the Add Notes button on the Tasks tab CSCSFANB

Access to the Use Template button on the Tasks tab CSCSFUTB

Access to the Launch Workflow button on the Tasks tab CSCSFLWF

Access to the More button on the Tasks tab CSCSFMBU

System Profile Description Default Setting

Service: Default Service 
Request Type 

Specifies the default value for service 
request Type

Customer 
Service Request

Service: Default Service 
Request Urgency

Specifies the default value for service 
request Urgency

High

Service: Default Service 
Request Severity

Specifies the default value for service 
request Severity

None

Service: Default Service 
Request Owner

Specifies the default value for service 
request Owner

None

Service: Default Service 
Request Status

Specifies the default value for service 
request Status.

Working

Service: Default Group 
Owner Type for Service 
Request

Specifies the default type of group for 
specifying a group owner. Available 
values are Group Resource and Team 
Resource. 

Group Resource

Description Function
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■ Restricting access to the tab and individual tab functions by responsibility.

You can specify which responsibilities can access the tab and individual tab 
functions by mapping the functions listed in the following table according to 
the procedures described in Oracle Applications System Administrator’s Guide. The 
seeded Customer Support Responsibility includes this mapping.

Service: Default Group 
Owner for Service 
Requests

Specifies the default value for the group 
service request owner displayed in the 
Group field. The owner must be of the 
type you specify in Service: Default 
Group Owner Type for Service Request.

None

Service: Group Owner 
Mandatory

A setting of Yes, makes entry in the 
Group field mandatory.

No

Service: Individual 
Owner Mandatory

A setting of Yes, makes entry of the 
Owner field mandatory

No

Description Function

Service Request Tab - Access Service Request Tab CS_HA_AXS_SR_TAB

Service Request Tab - Access Charges Button CS_HA_AXS_SRT_CHARGES_
BTN

Service Request Tab - Access Folder Button CS_HA_AXS_SR_TAB_FOLDER_
BTN

Service Request Tab - Access Knowledgebase 
Button

CS_HA_AXS_SRT_KB_BTN

Service Request Tab - Access Log Button CS_HA_AXS_SRT_LOG_BTN

Service Request Tab - Access Schedule Task 
Button

CS_HA_AXS_SRT_SCHL_TASK_
BTN

Service Request Tab - Access Service Request 
Details Button

CS_HA_AXS_SRT_DETAILS_BTN

Service Request Tab - Access View Task Button CS_HA_AXS_SRT_VIEW_TASK_
BTN

Service Request Tab - Create Service Request CS_HA_SR_TAB_INST_SR

Service Request Tab - Update Service Request CS_HA_SR_TAB_UPDT_SR

Service Request Tab - View Service Request CS_HA_SR_TAB_VIEW_SR

System Profile Description Default Setting
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■ Setting the system profile Service: Autoquery the grid in Service Request tab to 
display the service request history in the non-telephony mode. The default 
setting for this profile is No.

4.11.6 Implementing the Contracts Tab
You must implement Oracle Contracts according to the procedures described in the 
Oracle Service Contracts Concepts and Procedures.

In addition, you can:

■ Specify the date range for contracts displayed in the tab.

This is accomplished by setting OKS: Contact Center Date Range to the time 
period in days.

■ Restrict access to the tab by responsibility.

You can specify which responsibilities can access the tab by mapping the 
function CSCSFOKS according to the procedures described in Oracle 
Applications System Administrator’s Guide. The seeded Customer Support 
responsibility maps this function and permits access.

4.11.7 Restricting Access to the Install Base Tab
You can specify which responsibilities can access the tab by mapping the function 
CSCSFIB according to the procedures described in Oracle Applications System 
Administrator’s Guide. The seeded Customer Support responsibility maps this 
function and permits access.

The lookup described in the following table makes it possible for you to modify the 
Install Base tab search criteria.

Service Request Tab - Access Attributes Button CS_HA_AXS_SR_ATTR_BTN

Description Function
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4.11.8 Setting Up the Invoices Tab
To display Oracle Receivables invoices on the Invoices tab of the Contact Center, 
you must implement Oracle Receivables as specified in Oracle Receivables User 
Guide. If agents are to use the windows accessed from the tab, including Transaction 
Details, Adjustment Processing, Payment Processing, and Payment Details, you 
must also implement Oracle Collections according to Oracle Collections 
Implementation Guide.

In addition you can:

■ Specify the default time period in the From Date and To fields of the tab by 
setting the system profile Customer Care: Default Date Range for Invoices Tab.

You can set this profile at the system, site, responsibility, and user level. The 
default setting for this profile is 30. This means, that by default, the Invoices tab 
displays all invoices with transaction dates within the last thirty days.

■ Specify the default value for the Include Closed as selected by setting the 
system profile Customer Care: By Default Include Closed Invoices in Invoices 
Tab. The default setting for this profile Option is No.

■ Restrict access to the tab and its buttons by responsibility

You can specify which responsibilities can access the tab and buttons by 
mapping the functions listed in the following table according to the procedures 
described in Oracle Applications System Administrator’s Guide. The seeded 
Customer Support responsibility maps all of these functions.

Lookup Type Meaning Lookup Code Meaning Level

CSI_CC_FILTER_
CODES

Install Base Contact 
Center Filter Codes

■ CON 

■ INSN

■ INST

■ ORD

■ SRL

■ SYS

■ TAG 

■ Contract Number

■ Instance Name

■ Item Instance

■ Order Number

■ Serial Number

■ System

■ Tag Number

System

Description Function

Access to the Invoices tab CSCSFINV
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■ Modify the search criteria for invoices

The lookup described in the following table makes it possible for you to modify 
the Invoice tab search criteria.

4.11.9 Modifying the Behavior of the Orders Tab
To display orders on the Orders tab of the Contact Center, you must Implement 
Oracle Order Management as specified in the Oracle Order Management 
Implementation Manual. 

In addition, you can:

■ Specify the default time period in the From Date and To fields of the Orders tab 
by setting the system profile Customer Care: Default Date Range for Orders 
Tab.

You can set this profile at the System, Site, Responsibility, and User level. The 
default setting for this profile is 30. This means, that by default, the Order tab 
displays all orders created within the last thirty days.

■ Restrict access to the tab and its buttons by responsibility

You can specify which responsibilities can access the tab and buttons by 
mapping the functions listed in the following table according to the procedures 

Access to the Transaction Details button CSCSFTDB

Access Adjustment Processing button CSCSFAPB

Access Payment Processing button CSCSFPPB

Access Payment Details button CSCSFPDB

Lookup Type Meaning Lookup Code Meaning Level

CSC_CC_
INVOICE_
FILTERBY

Customer Care: 
Contact Center 
Invoice Tab Filter By

■ ACCOUNT_NUMBER

■ INVOICE_NUMBER

■ ORDER_NUMBER

■ PO_NUMBER

■ Account Number

■ Invoice Number

■ Order Number

■ PO Number 

User

Note: The addition of new search criteria is not supported.

Description Function
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described in Oracle Applications System Administrator’s Guide. The seeded 
Customer Support responsibility maps all of these functions.

■ Set the system profile OM: Sales Order Form Preference to launch the Order 
Management screen of choice. 

You can access the System Profile Options window from the System 
Administrator responsibility. Query the profile OM: Sales Order Form 
Preference and choose the appropriate selection from the list of values. You 
must save your changes. 

■ Set the Orders tab as the default when the order number is used for customer 
identification by ensuring the system profile Customer Care: Default Tab for 
Order Number Service Key is set to the Orders tab. The default setting for this 
profile is the Orders tab.

■ Modify the search criteria

The lookup described in the following table makes it possible for you to modify 
the Orders tab search criteria.

4.11.10 Enabling the Collateral Tab
To enable the Collateral tab of the Contact Center, which agents can use to send 
both physical and electronic collateral to customers and to view collateral history, 

Description Function

Access to the Orders tab CSCSFORD

Access to the New button CSCSNORB

Access to the Details button CSCSODEB

Lookup Type Meaning Lookup Code Meaning Level

CSC_CC_ORDERS_
FILTER_BY

Customer Care: 
Contact Center 
Orders Tab Filter By

■ ACCOUNT_NUMBER

■ ORDER_AMOUNT

■ ORDER_NUMBER

■ PRODUCT

■ Account Number

■ Order Amount

■ Order Number

■ Item

User

Note: The addition of new search criteria is not supported.
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you must implement Oracle One-to-One Fulfillment according to the Oracle 
One-to-One Fulfillment Implementation Guide and have the fulfilment server running.

You can:

■ Specify which responsibilities can access the tab

This is accomplished by mapping the function CSCSFCOL according to the 
procedures described in Oracle Applications System Administrator’s Guide. The 
seeded Customer Support Responsibility includes this mapping.

■ Improve the performance of collateral name searches

This is accomplished by requiring agents to enter a minimum number of 
characters. You can do so by setting the system profile OTS: Minimum Number 
of Characters for Lookup to the number of characters you require for the search. 
A larger number makes the search more specific and improves performance. By 
default, this system profile is set to 0.

4.11.11 Modifying the Behavior of the Addresses Tab
You can:

■ Restrict access to the tab and its buttons by responsibility

You can specify which responsibilities can access the tab and buttons by 
mapping the functions listed in the following table according to the procedures 
described in Oracle Applications System Administrator’s Guide. The seeded 
Customer Support responsibility maps and thus enables all of these functions.

■ Specify a default country for creating addresses and set up address formats for 
different countries. See Specifying Global Address Formatting and Address 
Validation on page 4-56.

Description Function

Access to the Addresses tab CSCSFADR

Create and update addresses on the Addresses tab CSCSFCAD

Access to the Identifying Address button on the 
Addresses tab. This button is used to create or change 
the customer’s identifying address.

CSCSFIAB

Access to the Site Contact Points button on the 
Addresses tab. This button makes it possible to enter 
addresses for customer sites.

CSCSFSCP
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■ Modify the lists of values displayed in different lists of values

You can modify the values displayed in list of values by modifying the lookups 
listed in the following table. Please refer to Oracle Account Receivables 
documentation for details.

4.11.12 Modifying the Behavior of the Contact Points Tab
You can:

■ Specify which responsibilities can access the tab and create new contact points.

This is accomplished by mapping the functions listed in the following table 
according to the procedures described in Oracle Applications System 
Administrator’s Guide. The seeded Customer Support responsibility maps and 
thus enables both functions.

■ Modify the lists of values displayed in different lists of values

You can modify the values displayed in list of values by modifying the lookups 
listed in the following table. Please refer to Oracle Account Receivables 
documentation for details.

Lookup Type Field Type

PARTY_SITE_USE_
CODE

Site Usage list of values Extensible

Description Function

Access to the Contact Points tab CSCSFCPT

The ability to create contact points in the Contact Points 
tab

CSCSFCCP

Lookup Type Field Type

COMMUNICATION_
TYPE

Type field list of values System

PHONE_LINE_TYPE Contact Method list of values Extensible
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4.11.13 Restricting Access to the Accounts Tab and Account Details Window
You can specify which responsibilities can access the tab and the Account Details 
window launched from it, by mapping the functions listed in the following table 
according to the procedures described in Oracle Applications System Administrator’s 
Guide. The seeded Customer Support responsibility maps and thus enables all 
functions on this tab.

4.11.14 Modifying the Behavior of the Party Information Tab and Its Functions
You can:

■ Specify which responsibilities can access the tab and its different functions

This is accomplished by mapping the functions listed in the following table 
according to the procedures described in Oracle Applications System 
Administrator’s Guide. The seeded Customer Support responsibility maps and 
thus enables all functions on this tab.

Description Function

Access to the Accounts tab CSCSFACT

The ability to create accounts on the Accounts tab CSCSFCAT

The ability to update account information in the 
Accounts tab

CSCSFUAT

Access to the Details button on the Accounts tab. This 
button launches the Customer Account Details window.

CSCSFADB

Access to the Credit tab of the Customer Account Details 
window. 

CSCSFCRD

Access to the Roles tab of the Customer Account Details 
window and the ability to create and update roles. 

CSCSFROL

Access to the Suspensions tab of the Customer Account 
Details window. 

CSCSFSUS

Access to the Sites tab of the Customer Account Details 
window.

CSCSFSIT

Access to the Relationships tab of the Customer Account 
Details window and the ability to create new 
relationships. 

CSCSFRTB

Access to the Customer Standard button on the Accounts 
Tab. This button launches the Customers - Standard 
window.

CSCSFCSN
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■ Modify the lists of values displayed in different lists of values

You can modify the values displayed in list of values by modifying the lookups 
listed in the following table. Please refer to Oracle Account Receivables 
documentation for details.

Description Function

Access to the Party Information tab CSCSFPTY

The ability to update customer information on the Party 
Information tab

CSCSFUPI

Access to the Details button on the Party Information tab CSCSFDBU

Access to the Contact Restrictions button on the Party 
Information tab

CSCSFCRB

Lookup Type Field Type

CONTACT_TYPE Contact Method field in the Contact 
Restrictions window. This window is 
available from the tab by clicking Contact 
Restrictions

Extensible

DEPARTMENT_TYPE Dept Code field used in the tab when the 
customer is an individual

User

MARITAL_STATUS Marital Status field used in the tab when 
the customer is an individual

User

YES/NO Residence Status field used in the tab 
when the customer is an individual

System

CODE_STATUS Status field System

SIC_CODE_TYPE SIC Code Type field for customers of 
type organization

Extensible

RESPONSIBILITY The Title field on the Person Details 
window available by clicking Details for 
a customer of type person

Extensible

INTEREST_TYPE Interest Type list of values in the Person 
Details and Organization Details 
windows.

User

HZ_PERSON_IDEN_
TYPE

Person Id Type list of values for customer 
of type person

Extensible
4-80 Oracle TeleService Implementation Guide



Modifying the Behavior of the Contact Center Header
4.11.15 Modifying the Behavior of the Relationships Tab
You can: 

■ Specify which responsibilities can access the tab and create relationships

This is accomplished by mapping the functions listed in the following table 
according to the procedures described in Oracle Applications System 
Administrator’s Guide. The seeded Customer Support responsibility maps and 
thus enables both functions.

■ Modify the lists of values displayed in different lists of values

You can modify the values displayed in list of values by modifying the lookups 
listed in the following table. Please refer to Oracle Account Receivables 
documentation for details.

4.12 Modifying the Behavior of the Contact Center Header
To modify the behavior of the Contact Center header, you can:

■ Prevent users or groups of users from modifying a customer name displayed in 
the Contact Center header

This is accomplished by setting the system profile HZ: Change Party Name to 
No. By default this system profile is set to Yes. You can set this profile at the site, 
application, or individual user level.

■ Select to view details of customer or contact information by default

Description Function

Access to the Relationships tab CSCSFREL

The ability to create relationships on the Relationships 
tab.

CSCSFCRE

Lookup Type Field Type

PARTY_RELATIONS_
TYPE

Sets up the list of relationships between 
individuals and organizations.

Extensible

CODE_STATUS Dept Code field used in the tab when the 
customer is an individual

System

RESPONSIBILITY Marital Status field used in the tab when 
the customer is an individual

Extensible
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By making a selection from the View Details For drop-down list, agents can 
specify whether they wish to view customer or customer contact information in 
the Contact Center tabs. 

However, the following tabs are limited to displaying details on customers only:

■ Interactions

■ Tasks

■ Contracts

■ Invoices

■ Orders 

■ Collateral

■ Accounts

You can specify the default setting of the View Details for drop-down list by 
setting the system profile Customer Care: Default View in Contact Center to 
either Customer or Contact. By default this profile is set to Customer.

■ Specify whether you wish to include inactive accounts in the list of accounts

The system profile Customer Care: Display Only Active Accounts in Contact 
Center determines whether inactive accounts are shown in the Acct Num field 
LOV of the Contact Center. A setting of Yes shows only active accounts. A 
setting of No includes inactive accounts as well. By default this system profile is 
set to Yes.

■ Specify whether you wish to display inactive customer records

The system profile Customer Care: Display Only Active Customers in Contact 
Center determines whether inactive customers are included in the Name LOV. 
A setting of Yes restricts the list to active parties. A setting of No includes 
inactive customers as well. By default this system profile is set to Yes.

■ Default the first customer account in the Acct Num field

Setting the system profile Customer Care: Default first account for a customer 
in Contact Center form to Yes defaults the first customer account record in the 
database in the Acct Num field of the Contact Center header. A setting of No 
leaves the field blank. By default, this system profile is set to Yes.

■ Specify the default country for filtering records in the Contact Center.
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Setting the system profile Customer Care: Restrict Searches to a Specific 
Country specifies whether customer searches in the Contact Center are limited 
by default to a specific country. The default profile is None.

■ Specify the default party type on Contact Center header.

Setting the system profile Customer Care: Default Customer Type on Contact 
Center, determines the default value for the Type field within the Customer 
region on the Contact Center header. The default profile is Organization.

■ Specify the default tab for Contact Center.

Setting the default value on the system profile Customer Care: Default Tab for 
Contact Center determines which tab defaults when opening the Contact 
Center form. The default profile is Dashboard.

■ Specify the default service key for searches

See Setting Up Service Key Search Preferences on page 4-64 for setup details.

■ Speed up customer searches by phone number by requiring agents to enter a 
minimum number of digits

The system profile Customer Care: Minimum Number of Characters for Phone 
Search specifies the minimum number of phone number digits agents must 
enter in the Phone field in the Contact Center header when they search for a 
customer using the phone number. This search matches the concatenated phone 
number, ignoring any spaces or other delimiters. Greater number of digits 
improve search performance. By default, no number is specified.

■ Specify the default title for contacts

Customer Care: Default Title for a Person defaults the title for the contact in the 
Contact region of the Contact Center header. There is no seeded default value.

■ Modify the wording of the View Details For drop-down list

The system lookup described in the following table makes it possible for you to 
modify the wording agents see in the View Details For drop-down list. meaning 
column.

■ Modify the values displayed in different lists of values

Lookup Type Meaning Lookup Code Meaning Level

CSC_CC_VIEW_BY Customer Care: View 
by's in Contact 
Center form

■ CONTACT

■ CUSTOMER

■ Contact

■ Customer

System
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You can modify the values displayed in a number of other fields by modifying 
the following Oracle Account Receivables lookups:

■ PARTY_TYPE

■ CONTACT_TITLE

■ PHONE_LINE_TYPE

■ CODE_STATUS

■ PARTY_RELATIONS_TYPE

■ SITE_USE_CODE

■ PARTY_SITE_USE_CODE

Please see Oracle Account Receivables documentation for details.

4.13 Enabling Telephony
To enable telephony in the Contact Center, you must implement Oracle Advanced 
Outbound and Oracle Advanced Inbound as described in the Oracle Advanced 
Outbound Implementation Guide, the Oracle Advanced Inbound Implementation Guide 
and the Oracle Interaction Blending Implementation Guide.

In addition, you can:

■ Improve the performance of automatic identification of customers via 
Automatic Number Identification (ANI)

This is accomplished by setting the system profile Customer Care: Use Exact 
Matches in ANI Searches to Yes. 

A Yes setting restricts the search to exact matches improving performance. 

A No setting permits the application to use an inexact match. This may be 
preferable in locations where multiple telephone codes may prevent exact 
matches, however.

■ Specify which responsibilities can access the SoftPhone icon in the toolbar

This is accomplished by mapping the function CSCSFSPB according to the 
procedures described in Oracle Applications System Administrator’s Guide. The 
seeded Customer Support Responsibility includes this mapping and thus 
enables the icon. The SoftPhone is used by agents for both inbound and 
outbound calls.
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■ Specify which responsibilities can access the Initiate Call button in the Contact 
Center header, Contact Points tab, and the Tools menu. 

This is accomplished by mapping the function CSCSFPBU according to the 
procedures described in Oracle Applications System Administrator’s Guide. 

4.14 Enabling Oracle Knowledge Management
To enable knowledge searches within the Contact Center you must implement the 
Oracle Knowledge Management service foundation module according to the 
procedures described in Oracle Knowledge Management Implementation Guide.

You can specify which responsibilities can:

■ Access the Knowledge Base Search icon in the toolbar, by mapping the function 
Access Knowledge Base Icon (CSCSKBIC) according to the procedures 
described in Oracle Applications System Administrator’s Guide. 

■ Access the Search Knowledge button within the Service Request tab, by 
mapping the function Service Request Tab - Access Knowledgebase Button (CS_
HA_AXS_SRT_KB_BTN), according to the procedures described in Oracle 
Applications System Administrator’s Guide. 

The seeded Customer Support Responsibility includes these mappings and thus 
enables the searches.

4.15 Enabling Oracle Scripting
You must create scripts and implement scripting according to the procedures 
described in Oracle Scripting Developer's Guide, Oracle Scripting Implementation Guide, 
and the Oracle Scripting User Guide.

In addition, the system profiles in the following table enable Oracle Scripting in the 
Contact Center and modify the performance of scripts.

Here is an explanation of the table’s columns: 

■ System Profile Name: The system profile name. An asterisk (*) next to a profile 
name indicates the profile is new in this release.

■ Description: A description

■ Level: A list of abbreviations representing the different levels at which the 
profile can be set:

* S: Site
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* A: Application

* R: Responsibility

* U: User

■ Default Setting and Level: The seeded default setting and the seeded level.

4.16 Specifying the Defaults for Overriding Customer Criticality
Agents use the Override Customer Criticality window to change the status of a 
customer to critical or to remove the customer from the critical list. You can: 

■ Specify the profile check used to determine if a customer is critical

You can do so by setting the system profile Customer Care: Profile Check for 
Determining Customer Criticality to the profile check you wish to use.

■ Modify the reasons agents give for the change they make

You can do this by updating the lookup described in the table below:

System Profile Name Description Level

Default 
Setting and 
Level

Customer Care: 
Automatically Launch a 
Script for Identified Callers

This profile defaults a script in the Oracle 
Scripting window used to launch a 
script.

S,A,R,U None

Default Level: S

CSC: Server Machine for 
Oracle Scripting

Name of the host computer where the 
scripting server resides.

S,A,R,U None

Default Level: S

CSC: Port for Oracle 
Scripting Application

Port for communicating with the 
scripting server.

S,A,R,U None

Default Level: S

CSC: SID of Oracle Scripting 
Database

The database used to support the 
scripting tool.

S,A,R,U None

CSC: Oracle Scripting Three 
Tier Installation

Specifies if the scripting server is a two- 
or three-tier installation.

S,A,R,U None

Lookup Type Meaning Lookup Code Meaning Level

CSC_CRITICUST_
OVERRIDE_
REASONS

Reasons to override 
Customer Criticality

■ CRUCIAL_
IMPLEMENTATION

■ DELICATE_SITUATION

■ Crucial Implementation

■ Delicate Situation 

User
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Implementing Charges

This group of topics describes the setup and configuration tasks required to 
successfully implement the Charges module of Oracle TeleService.

It covers:

■ Overview of Charges on page 5-1

■ Charges Setup Overview on page 5-3

■ Setting Up Business Processes, Service Activities, and Billing Types on page 5-6

■ Setting Up Oracle Install Base Transaction Subtypes on page 5-14

■ Setting Up Items in Oracle Inventory on page 5-20

■ Setting Up Labor Schedules for Pricing Labor on page 5-25

■ Setting Up Rules for Defaulting the Operating Unit on page 5-30

■ Creating Orders from Charges Across Operating Units on page 5-31

■ Modifying the Display of Charges on Customer Invoices on page 5-33

■ Setting Up System Profiles on page 5-34

■ Setting Up Remaining System Profiles on page 5-35

5.1 Overview of Charges
Charges is a component of the Oracle TeleService application that is used by many 
Oracle applications including Oracle Field Service and Oracle Depot Repair.

Typical business needs that Charges supports are as follows:

■ Create orders for shipments
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■ Create return orders (RMA)

■ Bill customers for any services provided to them

Charges has the following basic features and functions:

■ Create and view charge lines (shipments, returns, and billing)

■ Create and view estimated charge lines and convert them to actual charges

■ Roll up charge lines (labor, material, expenses) into a defined item (labor, 
material, and expenses) 

■ Associate charge lines with an existing order

■ Apply contract terms and conditions to charge lines. For example, discounts 
and labor pricing.

■ View coverage information for a contract

■ Submit charge lines to Oracle Order Management through Oracle Quoting

■ Achieve multi-currency compliance

5.1.1 Architecture of Charges
Charges windows remain based on the Oracle Forms technology stack. 

Charges integrates with the following Oracle applications:

■ Oracle Field Service

■ Oracle Depot Repair

■ Oracle Contracts

■ Oracle Quoting

■ Oracle Inventory

■ Oracle Install Base

■ Oracle Order Management
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The following diagram illustrates the architecture and data flow for Charges:

Charges integrates with Oracle Order Management for returns, shipments, and 
billing through APIs provided by Oracle Quoting. When you book an order 
(shipment or return), Oracle Quoting APIs pass the order to Oracle Order 
Management, an application that determines how the order is filled and shipped. 
Oracle Quoting APIs then give you a confirmation number that is displayed in the 
Charges window in the Line Number field. After the invoice cycle is complete, the 
invoice number and the invoice date are also displayed on the Order Status tabbed 
page of the Charges window in the Invoice Number and Invoice Date fields 
respectively. If an order line is split in Oracle Order Management, then Charges 
displays the status of the first line.

Oracle Service Contracts, Oracle Inventory, and Oracle Install Base integrate directly 
with Charges, whereas Oracle Field Service Debrief, Oracle Pricing, and Oracle 
Depot Repair communicate with Charges through Charges APIs. Oracle Pricing 
communicates with Charges through Oracle Quoting APIs.

5.2 Setup Overview
Use this procedure as an overview of the major steps required to set up the Charges 
module of Oracle TeleService. The details of each of the steps listed below are 
covered in the associated section of this chapter:
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Prerequisites:
You must have completed implementation of the following applications:

■ Oracle Order Management

■ Oracle Advanced Pricing

■ Oracle Service Contracts

■ Oracle Inventory

■ The following are optional:

■ Oracle Install Base 

■ Oracle Field Service

To set up Charges:
1. Set up or verify the setups of your inventory items. The application uses 

inventory items not only for tracking physical items but also for pricing labor 
and expenses. You set up labor items in Oracle Inventory and price them using 
price lists in Oracle Advanced Pricing. See Setting Up Items in Oracle Inventory 
on page 5-20.

2. Implement Oracle Order Management. For example, you must set up Line 
Types, Defaulting Rules, and Oracle Workflow processes assigned to the 
different line types and headers.

3. Set up labor schedules for pricing labor in Oracle Service Contracts and a 
default schedule for labor not covered by contract. See Setting Up Labor 
Schedules for Pricing Labor on page 5-25.

4. Set up any discounts for the labor items within Oracle Service Contracts. See 
Oracle Service Contracts Concepts and Procedures for details.

5. Set up the rules for defaulting the operating unit, the financial entity that is 
used for billing and receiving payments from the customer. See Setting Up 
Rules for Defaulting the Operating Unit on page 5-30.

6. Set up Business Processes, Service Activities, and Billing Types as described in 
Setting Up Business Processes, Service Activities, and Billing Types on page 5-6.

7. If you wish agents to ship or receive items tracked by Oracle Install Base, then 
you must set up the Install Base Transaction Subtypes. See Setting Up Install 
Base Transaction Subtypes on page 5-14.
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8. Optionally, you can modify the way charges are displayed on customer 
invoices. See Modifying the Display of Charges on Customer Invoices on 
page 5-33.

9. If you are using Oracle Field Service, you can automate the submission of 
charges to Oracle Order Management.
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5.3 Setting Up Business Processes, Service Activities, and Billing 
Types

This section explains how to set up the classification system your agents use to 
enter the labor, parts, and expenses that are processed, shipped, and billed through 
Oracle Order Management. 

This section covers:

■ Key Concepts on page 5-6

■ Process Overview on page 5-8

■ Setting Up Additional Service Billing Types on page 5-9

■ Associating Billing Types with Billing Categories on page 5-9

■ Setting Up Service Activities on page 5-10

■ Setting Up Business 

5.3.1 Key Concepts
To enter a charge line, an agent must select:

1. A business process

2. A service activity 

3. An inventory item

4. If the item the agent enters is a physical item tracked by Oracle Install Base then 
the agent may also be required to enter an instance number. For example, an 
agent entering a unit to be returned.

Business Process A business process provides a general classification of the work 
performed. Examples include depot repair, field service, and customer support. 
The business process is the first entry agents make on a charge line.

Service Activity Each business process is associated with a list of activities that 
can be performed as part of that process. 

For example, if the business process involves the shipment of a replacement 
piece of equipment to the customer, the return of the defective equipment, and 
the installation of the new piece of equipment at the customer site by a field 
service technician, then you may wish to set up three activities "Ship 
Replacement", "Return Defective Equipment", "Install Replacement Equipment". 
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You must classify each activity as either of type order or of type return. Order 
activities can be related to bill-only lines, or the shipment of items to customers. 
Return activities are used for recording customer returns of items they own.

In the above case the Ship Replacement and Install Replacement Equipment are 
activities of type order. The Return Defective Equipment is of type return. 

Service activities are reusable: you can associate one activity to multiple 
business processes.

The activity the agent selects determines which inventory items they can enter 
in the charge line. However, activities restrict the list of inventory items only 
indirectly through an inventory classification called a billing type. 

Billing Types Billing types are used to categorize items in inventory for use in 
service applications. For example, you associate the labor billing type with all of 
the different labor rates in inventory, and the material billing type with all of the 
parts and equipment in inventory that can be sold to customers.

By associating billing types with service activities you determine what items an 
agent can enter in a charge line for a given activity.

You can associate multiple billing types to a single service activity. For example, 
a repair activity may have billing types of material (the parts used in the repair), 
labor, and expenses (travel).

You may choose to associate the Ship Replacement activity from the above 
example, with two billing types: material (the new piece of equipment) and 
expense (shipping charges).

The Return Defective Equipment activity may just have one billing type: 
material (the equipment being returned).

The Install Replacement Equipment activity may be associated with three 
billing types: Material (for any additional parts needed by the field technician), 
labor (the labor involved in installing the new equipment), and expenses (any 
non-itemized costs). 

The application comes with several billing types defined for you, but you can 
add as many additional billing types as you like by modifying the lookup code 
MTL_SERVICE_BILLABLE_FLAG.

For an item to appear in the list of items in Charges, you must associate it with a 
billing type.
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Billing Categories If you have created any additional billing types, you must 
classify them as either material, labor, or an expense. The categorization, using 
Billing Categories, ensures it is processed correctly by Charges and other 
applications that use Charges, including Oracle Field Service. 

Business Processes, Service Activities, and Billing Types in Contracts Business 
processes, together with service activities and billing types, are used by Oracle 
Contracts to specify the level of coverage and discounts for a customer. A 
contract may cover different business processes differently. For example, a 
customer’s service-level agreement may provide free customer support over the 
phone, offer a 10 percent discount for in-house depot repairs, but charge the 
customer fully for field service visits.

5.3.2 Process Overview
This topic outlines the major steps you need to perform to set up the business 
processes, service activities, and billing types classification system.

To set up business processes, service activities, and billing types:
1. Several billing types are set up for you, but you can set up as many as you need 

following the procedure described in Setting Up Additional Service Billing 
Types on page 5-9.

2. You must classify any additional billing types you have created as material, 
labor, or expense by associating them with Billing Categories. See Associating 
Billing Types with Billing Categories on page 5-9.

3. Set up the service activities as described in Setting Up Service Activities on 
page 5-10. This involves:

a. Defining the service activities and associating each with all the billing types 
used for that activity. This restricts agent choices of inventory items to those 
associated with the billing types you associate here. 

b. To ensure that the items entered are processed through Oracle Order 
Management, you must associate each service activity and billing type pair 
with at least one operating unit and specify the header and line type for the 
order.

c. For any activity that involves the shipment or receipt of items tracked by 
Oracle Install Base, you must set up a corresponding Oracle Install Base 
transaction subtype according to the procedure described in Setting Up 
Install Base Transaction Subtypes on page 5-14. 
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4. Set up the business processes agents will use to classify work for the customer 
and associate them with appropriate activities. See Setting Up Business 
Processes on page 5-13.

5.3.3 Setting Up Additional Service Billing Types
Use this procedure to set up additional service billing types. You can create as many 
billing types as you need.

To set up additional service billing types:
1. Navigate to the Others > Service: Lookups.

2. Using the Query By Example method, display the lookup type MTL_SERVICE_
BILLABLE_FLAG.

3. Enter the additional billing types. The Meaning field is what appears in the lists 
of values.

4. Save your work.

5. You must now classify the billing types you have created into the three billing 
categories: Labor, Material, and Expense. See Associating Billing Types with 
Billing Categories on page 5-9.

5.3.4 Associating Billing Types with Billing Categories
Use this procedure to classify any billing types you have created as Labor, Material, 
or Expense. Only billing types associated with these billing categories are available 
for use in service applications.

To associate billing types with billing categories:
1. Navigate to Setup > Charges > Billing Type Attributes.

The Billing Type Attributes window appears.
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2. Enter the billing type using the Billing Type list of values (LOV).

3. Classify the billing type as either a Material, Expense, or Labor billing category 
using the Billing Category LOV.

4. It is not necessary for you to enter dates in the Start Date and End Date fields as 
this controls the availability of the billing type to category mapping and not the 
billing type itself. The start date is populated for you automatically.

5. Using the Rollup Item LOV you can specify a single item to appear on customer 
invoices as a substitute for all of the items classified by the billing type. For 
example, substituting the general term "Overtime" for multiple overtime labor 
rates. For an explanation of roll-up items, see Modifying the Display of Charges 
on Customer Invoices on page 5-33.

5.3.5 Setting Up Service Activities
Use this procedure to set up service activities that field-service, depot, and call 
center agents use to classify work performed on behalf of a customer.

To set up a service activity:
1. Navigate to Setup > Charges > Service Activities and Billing Types. 

Note: You must create separate activities of type order for Oracle 
Field Service (Debrief) and Oracle TeleService Charges module if a 
customer’s installed base is being updated. This is because Oracle 
Field Service and Oracle TeleService update the customer’s 
installed base separately. 
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The Service Activities and Billing Types window appears.

2. Click New in the toolbar.

3. Enter a name and an optional description in the Service Activity and 
Description fields.

4. Specify if this activity is related to an order or a return by making a selection 
with the Line Category LOV. This setting prevents a single service activity from 
being used for an order in one operating unit and a return in another.

5. If you plan to use this activity in Oracle Depot Repair, then select the Oracle 
Depot Repair Quantity update check box.

6. If this activity does not incur any charges to the customer, then select the No 
Charge check box. The item still appears on the customer invoice but with no 
charge. You are setting up the default value only. The agent can change it when 
they enter a charge.

7. If this activity is not billed to customers but has to be entered as a charge line by 
agents for costing purposes (for example, for tracking travel expenditures), then 
unselect the OM Interface check box. If this check box is unselected, then 
charges for it do not appear on the customer invoice.
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Leaving the check box selected (the default value) means the customer is billed 
for any charges for this activity. 

The setting you select is the default value only. The agent can change the status 
of this check box when they enter a charge.

8. Specify the billing types that can be used with the service activity. You can have 
multiple billing types for a single activity. For example, the replacement of a 
defective part may include material (the part itself), the labor required to install 
it, and expenses for shipping or travel. For each Billing type:

a. With the activity selected, place your cursor in the Billing Types region and 
click New in the toolbar.

b. Select the billing type using the Name LOV.

c. Optionally, you can control the availability of the billing type by entering 
dates in the Start Date and End Date fields.

9. For each activity and billing type pair, enter all of the operating units together 
with the Oracle Order Management order and line types. You may have 
multiple operating units if, for example, you have a central support center that 
is dispatching repair crews or parts from different locations (operating units):

a. Select the activity and one of the billing types you have associated to the 
activity in the previous step.

b. In the Order Management Header and Line types region, enter the 
operating unit, order type, and line type that will be used by Oracle Order 
Management to process the order. Repeat this step for each possible 
operating unit.

c. Repeat this procedure for each of the billing types associated with the 
activity.

10. If agents are going to be using the activity you have set up to enter items 
tracked by the Oracle Install Base, then you must set up the activity as an Oracle 

Note: The Operating Unit is an entity used by financial 
applications to create, process, and report on financial data. It is not 
the same as an Inventory Organization, an organization for which 
you track inventory transactions and balances, and/or an 
organization that manufactures or distributes products.
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Install Base transaction type. See Setting Up Install Base Transaction Subtypes 
on page 5-14.

5.3.6 Setting Up Business Processes
Use this procedure to define the business processes and the activities that belong to 
them. 

Prerequisites
You must set up service activities first.

To setup of service business processes:
1. Under the Customer Support Responsibility, navigate to Setup > Charges > 

Service Business Process.

The Service Business Process window appears.

2. Enter a name of the business process you wish to create in the Name field. The 
name is what agents will see in Charges.

3. Enter an optional description.

4. Specify one or more applications where you wish this business process to be 
visible by selecting the appropriate check boxes: Depot Repair (Oracle Depot 
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Repair), Field Service (Oracle Field Service), Service Request (Oracle 
TeleService).

5. In the Service Activities region, enter the activities you wish to associate with 
this business process. Optionally, you can enter start and end dates for activities 
if you wish to control their availability. 

6. Save your work by clicking Save in the toolbar.

5.4 Setting Up Oracle Install Base Transaction Subtypes
If you wish agents to ship or receive items tracked by Oracle Install Base, then you 
must set up the service activities associated with those items as Oracle Install Base 
Transaction Subtypes. 

Inventory items are associated with service activities indirectly through their billing 
types. You can find which activities need to be set up by looking at the billing type 
of an item and viewing all of the service activities associated with that billing type.

Prerequisites
You must create service activities before you can create them as install base 
transaction types. 

You must know whether the activities are of type return or order. Return activities 
are used by agents to record items to be shipped back by customers. Order activities 
are used to ship items out.

To set up Oracle Install Base transaction subtypes:
1. Navigate to Setup > Charges > Install Base Transaction Types.

The Transaction Sub Types window appears.
5-14 Oracle TeleService Implementation Guide



Setting Up Oracle Install Base Transaction Subtypes
2. Select the Service Type check box.

3. Select the service activity you would like to set up from the Name list of values.

4. If the activity you are setting up is of type return, used by agents to record 
return of parts from customers, then set up the Source Info region:

a. Select the Reference Rqd check box. 

b. If you wish to change ownership of the part, then select the Change Owner 
check box and select Internal from the Change Owner to drop-down 
box. This indicates the part is now owned by your organization.

c. If you want to update the status of the item in the customer’s installed base, 
then select a new status using the Status LOV. 

Note: Different types of activities require different setups in the 
Source and Non Source Info regions. For information on valid use 
case for these setups see Summaries of Setups for Valid Cases on 
page 5-17.
Implementing Charges 5-15



Setting Up Oracle Install Base Transaction Subtypes
d. If you wish to require agents to enter a date in the Return By date field in 
Charges then select the Return Reqd check box. The return by date is the 
date the return must be received.

5. If the service activity is of type order, used by agents to ship replacement parts 
to customers, then make entries in the Non Source Info region. You can either 
require agents to enter the instance of the part being replaced or you can choose 
to make the entry optional.

Making the entry optional is useful for enabling agent to ship replacement parts 
to a customer if the instance of the part being replaced is not known. For 
example, you may wish to ship a replacement computer board to a customer 
with ten computers without knowing which instance is being replaced. 

■ To make instance entry optional, leave the check box unselected and optionally 
populate the other fields. In this case agents will be permitted but not required 
to enter instance information for the customer item being replaced. 

■ If you wish to require agents to enter the instance information for the item 
being returned by the customer, then:

a. Select the Reference Rqd check box in the Non Source Info region. This 
check box requires agents to enter an instance or serial number for the item 
being replaced.

b. If you wish to record the change of ownership of the part, then select the 
Change Owner check box and select External from the Change Owner to 
drop-down box. This indicates the part is now owned by the customer.

c. If you want to update the status of the item in the customer’s installed base, 
then select a new status using the Status LOV. 

6. In the Source Transaction Types region:

a. Use the Application Name LOV to enter Oracle Order Management. This 
permits Oracle TeleService and Oracle Depot Repair users to use this 
subtype.

b. Select a valid source transaction type from the Transaction Name LOV. 
Source transactions types are used by Oracle Install Base and are set up 
according to procedures described in the Oracle Install Base Implementation 
Guide.

Note: The Parent info region is reserved for future use.
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c. Select the Update IB check box. This permits Order Management to update 
the customer’s installed base when an item is shipped or received.

d. Select the Default check box if you wish this subtype to be the default for 
Oracle Order Management.

7. Enter any other applications that you wish to permit to use this subtype. 
.

5.4.0.1 Summaries of Setups for Valid Cases
The use cases below summarize the valid cases and required setups for both order 
(shipping) and return activities.

When agents enter an item to be shipped or received from a customer, they must 
first select the business process and activity which restricts their choice of items to 
those valid for that activity. Agents enter the item by inventory item number using 
the Item list of values (LOV). 

If you set up the service activity as a transaction subtype, then the list of items 
includes all valid items for that activity regardless if they are tracked by the install 
base or not.

If you do not set up an activity as an Oracle Install Base transaction subtype, then 
the Item LOV excludes all items tracked by Oracle Install Base from this list.

For each item in inventory it is the Install Base Trackable check box on the Service 
tab of the Item Master window that determines if that item is tracked by Oracle 
Install Base.

Note: The Source Object field and the In Out check boxes are 
reserved for future use.

Note: You cannot have more than one application update the 
installed base at the same time. This means that you should create 
separate service activities and subtypes for Oracle Field Service and 
Charges. If you do want to use the same subtype for both, however, 
then you can permit only one application to make the update by 
selecting the Update IB check box for only one application.
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Case #1: Ship an item not tracked by Oracle Install Base
If the agent uses the activity to enter only items not tracked by the installed base, 
then you do not need to set up the Oracle Install Base transaction subtype for it.

If the subtype is not set up, then the Item list of values (LOV) excludes items 
tracked by Oracle Install Base for the service activity. 

Setup
■ The activity must be of type order.

■ Setup of transaction subtype not required

Case #2: Ship an item tracked by Oracle Install Base as a replacement 
for another tracked item (Require Instance Entry)
If you want agents to ship an installed-base tracked item to replace an existing item 
already in the customer’s installed base, then you must set up a transaction subtype 
for the activity. For example, shipping a computer board to replace another 
computer board both of which are tracked by the installed base.

To enter the order line, the agent enters the item by inventory number and then 
enters the instance number of the item that is being replaced.

The agent does not enter the instance number for the part to be shipped because the 
actual instance is selected when the order is picked. At that time the instance 
information is entered into Oracle Install Base. 

This case assumes that you do not care about the true disposition of the part being 
returned as the customer’s installed base instance for that part is updated at the 
time the replacement part is shipped, not after the part is received from the 
customer. 

Setup
■ The activity must be of type order

■ Setup of Transaction Subtype required

■ Leave the Source region blank.

■ In the Non Source region: 

■ Select the Reference Required check box.

■ Optionally select a new owner for the part being replaced

■ Optionally select the new status for the part being replaced
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Case #3: Ship a tracked item as a replacement when the replaced 
instance may not be known
This case is identical to Case #2 except that it does not require the agent to enter the 
instance number for the item being replaced. For example, an organization may 
ship a replacement mother board to fix problems with one of the computers a 
customer owns without necessarily knowing which instance is being fixed.

The agent enters the inventory number of the item to be shipped. Entry of the 
instance is optional. 

The new part is added to the installed base record at the time the replacement item 
is picked and shipped from within Oracle Order Management. The part being 
replaced remains unchanged if the agent did not enter instance information. 

Setup
■ The activity must be of type order

■ Setup of Transaction Subtype required

■ Leave the Source region blank.

■ In the Non-Source Info region, leave the Reference Reqd check box unselected. 
Optionally, populate the other fields. 

Case # 4: Return of a part not tracked by Oracle Install Base.
If agents use the activity to record that a customer is authorized to return a part not 
tracked by the install base, a disposable part such as a printer cartridge, for 
example, then you do not need to set up the activity as an Oracle Install Base 
transaction subtype.

The Item list of values (LOV) includes all of the inventory items not tracked by 
Oracle Install Base that are available for the service activity the agent has entered.

The Instance field is disabled. The Serial Number field is enabled but not required. 
This permits agents to record the return of serialized parts not in a customer’s 
installed base. 

Setup
■ Activity must be of type return

■ Setup of Transaction Subtype not required
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Case #5: Return of a part tracked by Oracle Install Base
This case handles an activity of type return of an item in a customer’s installed base.

To record a return, the agent must enter the item number of the part being returned 
using the Item LOV and then also enter its installed base instance number.

The customer’s installed base records are updated in Oracle Install Base after the 
part is received.

Setup
■ Activity must be of type return

■ Setup of Transaction Subtype required

■ Set up the Source Info region:

■ Select the Reference Req check box

■ Optionally select the Change Owner check box and select Internal from the 
Change Owner To drop-down list.

■ Optionally enter a new status for the returned part in the Status field.

■ Leave the Non-Source Info region blank.

5.5 Setting Up Items in Oracle Inventory
Use this procedure as a guideline for:

■ Verifying that existing items are set up correctly for service applications. For 
example, you must classify items by billing type on the Service tab of the Item 
Master window. 

■ Setting up new inventory items used for billing customers for services, for 
example, different labor overtime rates.

Prerequisites:
■ You must know the inventory organization for setting up your items. This is the 

organization selected in the system profile option Service: Validation Inventory 
Organization.

■ The billing type must be set up if you are not using one of the seeded billing 
types.
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To set up inventory items:
1. Navigate to Setup > Oracle Order Management > Items > Master Items.

The Organizations list of values window appears.

2. Select the Inventory organization in profile option ASO: Product Organization.

The Master Items window appears.

3. Follow the steps described in Oracle Inventory User Guide to set up your items or 
verify that existing items have been set up correctly. The following entries and 
settings are important for service applications:

■ Main Tab

* Enter item name and description in the Item and Description fields.

* Entries in the Unit of Measure region are used as the default units of 
measure in Charges.

■ Inventory Tab

* Inventory Item check box: Select for all items.

* Stockable check box: Select for tangible inventory items only. Leave 
unselected for labor and expense items.

* Transactable check box: Select for all items.

■ Order Management Tab

* Customer Orders Enabled check box: select for all items.

* Shippable check box: Select for physical items. Leave unselected for 
labor and expense items. 

4. Select the Service Tab.
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5. In the Service Region, make one or more of the following optional entries:

■ If you wish to make it possible for agents to create service requests for this 
item, then select Enabled from the Service Request drop-down list.

■ To make it possible to apply service contracts for this item, select the Enable 
Contract Coverage check box. You must also select Track in Installed Base 
check box before you can apply service contracts to it.

■ Select Enable Defect Tracking only if your organization uses Oracle Quality 
Online. 

■ Select Enable Provisioning if this item can be delivered through electronic 
fulfillment by the Oracle Service Fulfillment Manger (SFM).

6. In the Installed Base region, make one or more of the following optional entries:

■ Select the Track in Installed Base check box if you wish to track this item via 
Oracle Install Base. 

■ If you have selected the Track in Installed Base check box, then you can 
select the Create Fixed Asset check box to create a depreciable inventory 
asset used in Oracle Enterprise Install Base. See Oracle Enterprise Install 
Base documentation for more information.

7. In the Debrief and Charges region:

a. Select the Enable Service Billing check box.
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b. Use the Billing Type drop-down box to select a billing type for the item.

Selecting a billing type makes it possible for agents to enter the item in the 
Task Debrief (Oracle Field Service) and the Charges tab (Oracle TeleService). 
It also makes it possible for you to define discounts for the item in Oracle 
Service Contracts.

 

8. Leave the Service Contracts Region blank. This region is used for creating 
contracts as inventory items. Specifying a Billing Type for an inventory item 
means that the item can be covered by a contract. 

Guidelines
The tables below provide you with guidelines for Item Master setups for the three 
possible types of inventory items: parts, labor, and expenses.

Main Tab

Inventory Tab

Note: The Recovered Part Disposition drop-down box is reserved 
for future use by Oracle Spares Management.

Type of Inventory 
Item Name Unit of Measure

Part Entry Required Entry Required

Labor Entry Required Entry Required

Expense Entry Required Entry Required

Type of Inventory 
Item

Inventory Item 
check box

Stockable check 
box

Transactable 
check box

Part Selected Selected Selected

Labor Selected Unselected Selected

Expense Selected Unselected Selected
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Order Management Tab

Service Tab (Service Region)

Service Tab (Installed Base region)

Type of Inventory 
Item

Customer 
Orders Enabled 
check box

Shippable check 
box

Part Selected Selected

Labor Selected Unselected

Expense Selected Unselected

Type of Inventory 
Item

Service Request 
drop-down list 
selection

Enable Contract 
Coverage check 
box

Enable Defect 
Tracking check 
box

Part Enabled Selected Select only if your 
organization uses 
Oracle Quality 
Online.

Labor Enabled Unselected Unselected

Expense Enabled Unselected Unselected

Type of Inventory 
Item

Track in Install 
Base check box

Create Fixed 
Asset check box

Part Enable this check 
box if the item is 
to be tracked by 
Oracle Install 
Base. 

Select only if you 
selected the Install 
Base Tracking 
check box and the 
item is a 
depreciable asset in 
Oracle Enterprise 
Install Base.

Labor Unselected Unselected

Expenses Unselected Unselected
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Service Tab (Debrief and Charges region)

References
Oracle Inventory User’s Guide

5.6 Setting Up Labor Schedules for Pricing Labor
Labor schedules determine what your organization charges for labor at different 
times. There are two places where you can define labor schedules: in Oracle Service 
Contracts (optional) and in Charges (required).

You must set up the default labor schedule in Charges for each business process as 
described in this procedure only if your organization is charging customers for 
labor using the Debrief window in Oracle Field Service or Oracle Depot Repair. 

This setup is required because Debrief does not require agents to select the 
applicable labor item (the labor rate for the work performed). 

This topic covers:

■ How Charges Determines Labor Charges on page 5-25

■ Setting Up the Labor Schedule in Contracts on page 5-26

■ Setting Up the Default Labor Schedule on page 5-28

5.6.1 How Charges Determines Labor Charges
The application charges for Oracle Field Service labor in three steps:

1. Agents debrief labor in the Debrief window. Entry of the labor item (containing 
the applicable labor rate) is optional. 

2. If the labor item is not specified, the application determines it based on:

Type of Inventory 
Item

Enable Service 
Billing check box

Billing Type 
drop-down list

Part Selected Select a billing type

Labor Selected Select a billing type

Expense Selected Select a billing type
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a. The labor schedule from the service contract selected for the charge line. 
This schedule is entered in the Oracle Service Contracts’ Billing Rates 
window. See Setting Up the Labor Schedule in Contracts on page 5-26.

b. The default labor schedule you create using the procedure described in 
Setting Up the Default Labor Schedule on page 5-28.

If the agent has worked across multiple time periods specified in a labor 
schedule, then the application creates multiple charge lines.

Suppose, for example, you create a labor schedule with regular time 
between 8 a.m. and 4:59 p.m.; overtime to be between 5 p.m. and 7:59 p.m.; 
and double time after 8 p.m. If an agent reports they have worked between 
4 p.m. and 9 p.m., then the application creates three charge lines for the 
customer: one hour of regular time, three hours of overtime, and one hour 
of double time.

3. The application determines the price.

The price can be based on the price list alone or, if a contract is specified, in 
combination with a labor rate. A labor rate modifies or overrides the price list 
price: you can either specify a percent over or under the price list price or a flat 
currency amount which overrides the price list price. The labor rate pricing is 
available only when there is a contract specified for the charge line.

The concurrent program CSF: Update Debrief Lines creates the charge lines from 
debrief lines when a task assignment status is changed to Completed, Closed, 
Cancelled, Rejected, or On Hold. 

For charges lines entered directly in the service request and in Oracle Depot Repair, 
the application looks up the price directly as described in step 3 above. 

5.6.2 Setting Up the Contract Labor Schedule
If your organization uses Oracle Service Contracts together with Charges, then you 
can set up a labor schedule in each contract.

The steps below provide a guideline for entries important to Charges only. Refer to 
Oracle Service Contracts Concepts and Procedures for more details about this and other 
contracts-related setups.

Guidelines for setting up the labor schedule:
1. Under the Contracts Manager Responsibility, navigate to Launch Contracts.

2. If you wish to set up the labor schedule in a single contract, then: 
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a. Select the contract you wish to set up and display it in the Service Contracts 
Authoring window.

b. Select the Lines Tab.

c. Select the Effectivities subtab.

d. Select the service coverage item and click Edit Coverage in the Coverage 
Region.

The Service Contracts Coverage window appears.

e. Select the Billing Types subtab.

f. Select the Business Process and the Service Activity Billing Type pair you 
wish to set up. The Billing Type must have the Billing Category of Labor.

g. Click Billing Rates to display the Billing Rates window.

3. If you are setting up the labor schedule for a contract template, then navigate to 
the Billing Rates window following the instructions in Oracle Service Contracts 
Concepts and Procedures.

4. If you are pricing labor based on labor inventory items, then, on the Regular 
tab, set up the labor charges for different days and times as follows:

a. Enter the start and end time for the rate.

b. Select the days this rate is applicable using the check boxes for the days of 
the week. 

Note: Make sure the start and end times do not overlap.
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c. Select the labor item to be applied for this time period using the Labor Item 
LOV.

d. Leave the rest of the fields blank.

5. If you wish to use the labor rates in the contract to override or modify the price, 
then, on the Regular tab, set up the labor charges for different days and times as 
follows:

a. Enter the start and end time for each rate.

b. Select the days this rate is applicable using the check boxes for the days of 
the week. 

c. Select the labor Inventory item using the Labor Item LOV.

d. Use the Bill Rate LOV to enter the bill rate. The list of values is based on a 
lookup.

e. If you wish to specify a price for this rate, then enter the currency amount 
in the Flat Rate field and select a unit using the UOM LOV. Do not make 
any entries in the %Over List Price field. This price you enter here overrides 
the price list price for this contract.

f. If you wish to specify a discount or a surcharge for this rate, then enter a 
positive or a negative percentage in the %Over List Price field. A positive 
number increases the rate an agent enters. A negative number decreases the 
amount. Do not make any entries in the Flat Rate or UOM fields.

6. Repeat the entries you made on the Regular tab on the Holiday tab to set up the 
holiday rates.

7. Click OK to save and close the window when you are done.

5.6.3 Setting Up the Default Labor Schedule
Use this procedure to set up the labor schedule that is used by charges to supply a 
missing labor item when none is found in the customer contract or when there is no 
contract specified for the charge line. You must set up one default labor schedule for 
each business process.

Note: Make sure the start and end times do not overlap.
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To set up the time and material labor schedule for a business process:
1. Navigate to Setup > Charges > T&M Labor Schedule.

The Time & Material Labor Schedule window appears.

2. Use the Business Process LOV to select the service business process. 

3. Specify the different labor times and their pricing. For each, line:

a. Enter the start and end times.

b. Select the days the line is applicable using the check boxes for the days of 
the week. 

c. Select the labor item to be applied for this time period using the Labor Item 
LOV.

d. If you are using labor rates in your contracts, then select a billing rate using 
the Labor Rate LOV.

Note: Make sure that the start and end times of your entries do 
not overlap.
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4. Click Save in the toolbar.

5. Click Validate Setup to validate your entries.

If your entries do not overlap and the coverage is complete, then a check mark 
appears in the Validation Completed check box. 

5.7 Setting Up Rules for Defaulting the Operating Unit
When agents enter a charge line, the application automatically supplies a default 
operating unit based on the rules you set up in this procedure. The operating unit is 
the financial entity used for billing and receiving payments from the customer.

To set up the rules for defaulting the operating unit:
1. Navigate to Setup > Charges > Multi Org Setup 

The Service Request Multi Org Set Up window appears.

2. Enter the sequence in which you wish Charges to look for the value of the 
defaulted operating unit.

Note 1: Labor Rate in this window is the same field as the Bill 
Rate field in the Contracts’ Billing Rates window.

Note 2: You do not enter a currency rate (Flat Rate) or discount (% 
Over List Price) for the rate here, the application looks these up in a 
customer contract instead. Please see Oracle Service Contracts 
documentation for details.
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The application defaults the first operating unit it finds. For example, if you 
enter the sequence of 1, 2, 3, 4, then the application first looks for the operating 
unit in a valid contract. If there is no contract available, then it checks to see if 
the service request is for an Oracle Install Base item, and so on. 

3. Click Save on the toolbar to save your entries.

5.8 Creating Orders from Charges Across Operating Units
Many business processes cross operating unit boundaries, where there is a 
requirement for a function in one operating unit to create or update data in another 
operating unit.

If you would like to enable users to create orders in Order Management in an 
operating unit other than the one set in their MO: Operating Unit profile, you will 
need to set the context for the specific operating unit.

Setting up the Context for an Operating Unit
This setup is only required if your business requirement is to submit sales orders 
across organizations from Service Charges. 

Charges uses the HRMS Organization Extra Information Type (EIT) Descriptive Flex 
Fields to define the contexts (User_id, Resp_id, and Resp_appl_id) for each 
operating unit.

The following procedure looks at a company that has set the MO: Operating Unit 
profile to Vision Operations, USA, for the Customer Support,Vision USA 
responsibility. The company would like to create order lines in Vision Germany 
using the Customer Support, Vision USA responsibility.

Rule Name Description

Operating Unit of the 
Contract

If a contract is associated with the service request, then charges 
uses the operating unit of the contract.

Operating Unit of the 
Installed Base Product

If the service request concerns an Oracle Install Base item, then 
charges defaults the operating unit of the item.

Profile Option MO: 
Operating Unit of the 
Charge

Charges uses the operating unit selected in this profile.

Operating Unit Stamped 
on the Service Request

Charges uses the operating unit associated with the service 
request.
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The following procedure shows what the company will need to do in order to setup 
the operating unit, Vision Germany.

Prerequisites:
Before doing this setup you will need to identify the organizations as well as the 
associated user and responsibility for which you would like to submit orders from 
Charges.

To setup Context for the chosen Operating Unit:
1. Navigate to HRMS Manager Responsibility, Work Structures > Organization.

2. Open the Description form.

3. In the Find window, query the name of your organization.(for example, Vision 
Germany)

4. Scroll down to find the Operating Unit Organization Classification.

5. Choose the Others Button.

6. Select User Context Variables from the List.

7. Tab to populate the DFF user context variables window.

8. Choose Product Family Function as Service Charges.

9. From the list of values, select a appropriate Application User.

10. From the list of values, select the Responsibility (for example, Order 
Management Super User, Vision Germany). 

11. The Application is defaulted

12. Save your changes.

This setup should be repeated for all of the Operating Units that you plan to use.

Note : If you have more than one Business Group, change the 
responsibility associated with the other business group and 
continue defining your organization classification extra 
information.
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5.9 Modifying the Display of Charges on Customer Invoices
Normally the customer receives an invoice detailing all of the individual items 
agents have entered as charges. 

You can use this procedure to create an inventory item with a generic name, called a 
Rollup Item, to appear on customer invoices instead of the individual inventory 
items in a billing type. The roll-up item does not change what customers are 
charged, it affects only the name of the item printed on the invoice.

Suppose you have three different overtime labor items, Labor 1, Labor 2, Labor 3, all 
associated with the Labor billing type.

Normally, if the agent specifies the engineer worked for two hours at Labor 1 rate, 
three hours at the Labor 2 rate, and one hour at the Labor 3 rate, then the customer 
sees three items on the bill:

■ Labor 1: 2 hours

■ Labor 2: 3 hours

■ Labor 3: 1 hour

By setting up a new inventory item Overtime Labor with the Labor billing type, and 
creating a roll-up item using the procedure below, the customer bill substitutes 
Overtime Labor for each of the lines:

■ Overtime Labor: 2 hours

■ Overtime Labor: 3 hours

■ Overtime Labor: 1 hour

Prerequisites
You must know the correct inventory organization 

Note 1: The roll-up item you create does not summarize line items 
on an invoice. It only substitutes the generic roll-up item name for 
the item names for that billing type.

Note 2: You can use roll-up items for physical items but not for 
items that are shipped to or received from customers through 
Oracle Order Management. 
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To set up an inventory item to modify the display of charges in customer 
invoices:
1. Navigate to Setup > Oracle Order Management > Items > Master Items and set 

up the replacement items you wish to appear on the customer invoice. See 
Setting Up Inventory Items on page 5-20.

2. Navigate to Setup > Charges > Billing Type Attributes.

The Billing Type Attributes window appears.

3. Use the Billing Type list of values (LOV) to select the billing type for the 
inventory items you wish to summarize.

4. Select the inventory item you wish to use as the roll-up item using the Rollup 
Item LOV.

5. Save your work.

5.10 Setting Up System Profiles
Use this general procedure to set up any of the Charges profiles.

To set up system profiles:
1. Navigate to Others > Profile System Values.

The Find System Profile Values window appears.

2. In the Profile field, enter the search criteria. For example, Service%charges%.

3. Click Find.
5-34 Oracle TeleService Implementation Guide



Setting Up Remaining System Profiles
The profiles matching your search criteria appear in the System Profile Values 
window.

5.11 Setting Up Remaining System Profiles
Set up remaining Charges system profiles to control a different types of Charges 
behavior. This includes:

■ Preventing Accidental Overrides of Charges Price Modifications on page 5-35 

■ Setting Up the Default Sort Order on the Charges Tab on page 5-35

■ Defaulting the Service Request Business Process on page 5-36

■ Specifying the LOV Type for Price List on page 5-36

5.11.1 Preventing Accidental Overrides of Charges Price Modifications
Agents using Oracle Order Management’s Sales Order Line Items Pricing Tab can 
accidentally override prices entered in Charges when they select the Calculate Price 
check box. This causes prices to be recalculated for orders in the Entered state and 
overrides the prices entered in Charges by applying the modifiers associated with 
the price list.

To prevent this accidental price modifications:
1. Create a manual pricing modifier according to the procedures described in 

Oracle Order Management User’s Guide.

2. Set the system profile Service: Manual Modifier to a modifier you have set up.

5.11.2 Setting Up the Default Sort Order on the Charges Tab
Agents can decide how to sort the charges displayed in the tab by making a 
selection from the Sort By drop-down list. You can set up the default value by 
setting the system profile Charges Default Sort Order to any one of the following:

■ Billing Type

■ Charge Line Source

■ Charge Line Status

■ Charge Line Type

■ Creation Date
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Setting Up Remaining System Profiles
■ Order Number

■ Service Activity Code

By default, this system profile is set to Creation Date.

5.11.3 Defaulting the Service Request Business Process
Charges automatically defaults the business process from the service request 
into the charges lines when the system profile Service: Charges - Default Service 
Business Process from SR is set to Yes, the default seeded value. If you set this 
profile to No, the agent must always enter the business process manually.

5.11.4 Specifying the LOV Type for Price List
If your organization uses a large number of price lists, you can select to use the 
long list of values format by setting the system profile Service: Charges - Use 
Long List LOV for Price List to Yes. This forces agents to enter search criteria 
before displaying the list of values and thus improves performance. A setting of 
No, the seeded default, displays the short list of values format.
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Automating Submission of Field Service

Charges

This group of topics explains how to set up the application to automatically submit 
Oracle Field Service debrief charges to Oracle Order Management and bill 
customers. It covers:

■ Overview of Automatic Charges Submission  on page 6-1

■ What You Can Modify on page 6-3

■ Setting Up Rules to Restrict Automatic Submission on page 6-3

■ Setting Up Automatic Submission on page 6-7

6.1 Overview of Automatic Charges Submission
You can set up the application to automatically submit to Oracle Order 
Management any Oracle Field Service charges agents have entered in the Oracle 
Field Service Debrief window. 

There are two types of charge lines that can be created as a result of the Oracle Field 
Service debrief: 

■ In Progress: Debrief lines belonging to task assignment that are in one of five 
statuses: Completed, Closed, Cancelled, Rejected, or On Hold.

■ Actual: Debrief lines belonging to task assignments not in any of the above five 
statuses.

The automatic submission process submits only charge lines of type Actual and 
only those resulting from Oracle Field Service Debrief.
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Overview of Automatic Charges Submission
These are lines created when an engineer creates a debrief line in the Debrief 
window and changes its Assignment Status to one of the five statuses: Completed, 
Closed, Cancelled, Rejected, or On Hold. 

The automatic submission to Oracle Order Management is accomplished by 
running the Charges Autosubmission Concurrent Program.

The process does not submit:

■ Estimates and pending charges (lines of type Estimate or In Progress)

■ Charges entered in Oracle Depot Repair debrief

■ Charges agents entered directly in the Charges tab of the Service Request 
Window

■ Charge lines with errors

The submission process can fail if Oracle Order Management requires 
additional information not supplied by Charges, such as the entry of a sales 
person associated with the order, for example. 

Agents can view any error messages provided by Oracle Order Management by 
clicking the Charge Line Status Details button in the Charges tab.

Agents can see if the line has been submitted by checking the Status field in the 
Charges tab of the Service Request window. The following table lists and describes 
the possible statuses:

Charge Line Status Description

New All charge lines start with this status including estimates and 
those in progress.

Submitted The charge line has been successfully submitted either by the 
automatic submission concurrent program or by an agent 
clicking the Submit button or from Oracle Depot Repair.

For Review The charge line has violated one of the restrictions rules set up 
during implementation. For example, you can set up a rule that 
bars the automatic submission of charges that are more than ten 
percent from the original estimate price. Agents can review lines 
of this type and submit them manually.

Failed Automatic submission has failed because Oracle Order 
Management requires additional information. Agents must 
view the error message, supply the missing information, and 
submit the line manually.
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6.2 What You Can Modify
There are several ways you can modify the automatic submission process. You can:

■ Restrict charges from being automatically submitted and billed to customers.

You can set up one or more rules that bar charges from being submitted 
automatically. For example, you can prevent the application from automatically 
submitting charges to specific customers, or prevent any charges from being 
submitted if they exceed the estimated price by more than ten percent. See 
Setting Up Rules to Restrict Automatic Submission on page 6-3.

■ Determine if you want Oracle Order Management to bill the customer 
automatically or if agents will have to book the order in Oracle Order 
Management.

Setting the system profile option Service: Charges Book Order Automatically to 
Yes creates orders with a status of Booked. The default setting of No keeps the 
orders in the Entered status.

■ Specify at what stage you want to automatically submit charges

By setting the system profile Service: Charges Auto Submit Mode, you can have 
charges submitted individually any time charges are created, wait until all of 
the tasks are closed, or until the service request has been set to a final status.

■ Determine the frequency with which charges are submitted by specifying the 
frequency of the concurrent program runs.

6.3 Setting Up Rules to Restrict Automatic Submission
This group of topics explains how you can set up rules that restrict which charges 
are submitted automatically.

Restriction Rules  on page 6-3 describes the available rules. The other topics provide 
the procedures for setting them up:

■ Adding a Restriction Rule on page 6-5

■ Updating a Restriction Rule on page 6-6

6.3.1 Restriction Rules
This topic describes the different rules you can use to restrict the automatic 
submission of charges.
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Setting Up Rules to Restrict Automatic Submission
By default, the application includes one rule: the application does not submit charge 
lines if an agent has modified their pricing. (You can turn this rule off by entering an 
end date.)

The following table lists and describes the available restriction rules:

6.3.2 Displaying Current Restriction Rules
Use this procedure to set up rules that restrict the automatic submissions of charge 
lines.

To display current restriction rules:
1. Navigate to Setup > Charges > Autosubmit Restrictions.

Rule Description

Actuals Exceed 
Estimates

Limits automatic submission if the total service request charges fall 
within a percentage above the total estimated charges. You can 
specify only one rule of this type.

The rule calculates the percentage based on the following formula

(Total Actuals + Total In Progress - Total 
Estimates)/Total Estimates * 100

If the service request contains charges in multiple currencies, each 
currency is evaluated separately.

Bill to Customer Does not submit the charge line if the customer you specify is to be 
billed for the service. This restriction is based on the Bill To party. You 
can create multiple rules of this type to exclude specific customers 
from automatic billing.

Charge Line 
Amount

Each charge line must be below (or above depending on the operator 
you select) the amount you specify. The rule considers only the 
charge lines for the currency you specify as it does not perform any 
currency conversions. You can create multiple rules of this type, one 
for each currency.

Exclude Manually 
Overridden Charges

By default, the application does not submit charge lines modified by 
agents. You have the option of turning this rule off by entering an end 
date. 

Service Request 
Type

Prevents charges belonging to service requests of a particular type 
from being automatically submitted. You can create multiple rules of 
this type.

Total Service 
Request Charges

Total charges for the service request must be below (or above 
depending on the operator you select) the currency amount you 
specify. You can create only one rule of this type per currency.
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Setting Up Rules to Restrict Automatic Submission
A browser window displays the Autosubmit Restrictions page listing the 
current restriction rules.

2. If you wish to add a rule, then select the rule type from the Create Restriction 
drop-down list and click Go. For details see Adding a Restriction Rule on 
page 6-5.

3. If you wish to update a rule, then click Update to the right of the rule. For 
details, see Updating a Restriction Rule on page 6-6.

6.3.3 Adding a Restriction Rule
Use this procedure to add a restriction rule.

To add a restriction rule:
1. Display the Autosubmit Restriction page. 

2. Select the rule type from the Create Restriction drop-down list and click Go.

The application displays a different entry page depending on the rule you wish 
to add. The table below explains the different entries you can make depending 
on the rule you have selected:
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Setting Up Rules to Restrict Automatic Submission
3. Click Apply.

The new rule appears in the Autosubmit Restrictions page.

6.3.4 Updating a Restriction Rule
Use this procedure to update an automatic submission restriction rule.

To update a restriction rule:
1. Display the Autosubmit Restriction page. 

2. Click Update to the right of the rule.

The application displays a different entry page depending on the rule you wish 
to update. The table below explains the different entries you can make 
depending on the rule you have selected:

Rule What you enter:

Actuals Exceed 
Estimates

Enter a percentage (without the percent sign) in the Value(%) 
field.

Bill to Customer Enter the customer in the Value field using the list of values. 

Charge Line Amount 1. Enter the operator using the Condition drop-down list

2. Enter the amount.

3. Select the Currency using the list of values.

Exclude Manually 
Overridden Charges

You can turn this rule off by entering an end date.

Service Request Type Enter the Service Request Type in the Value field using the list 
of values.

Total Service Request 
Charges

1. Enter the operator using the Condition drop-down list

2. Enter the amount.

3. Select the Currency using the list of values.

Rule What you can update:

Actuals Exceed 
Estimates

■ Enter a new percentage (without the percent sign) in the 
Value(%) field 

■ Disable the rule by entering an end date.
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3. Click Apply.

You are returned to the Autosubmit Restrictions page.

6.4 Setting Up Automatic Submission
Use this procedure to set up the automatic submission of Oracle Field Service 
charges entered by agents in debrief to Oracle Order Management.

To set up the automatic submission of charges:
1. Set up any restrictions for submitting charges. See Setting Up Rules to Restrict 

Automatic Submission on page 6-3.

2. Navigate to Setup > Others > Profile System Values and set the following 
system profiles at the site level:

■ Service: Charges Book Order Automatically

Set to Yes if you wish to automatically create orders in Oracle Order 
Management with a status of Booked. 

Bill to Customer ■ Enter a different customer 

■ Disable the rule by entering an end date. 

Charge Line Amount ■ Enter a different operator using the Condition 
drop-down list

■ Modify the amount.

■ Select a different Currency using the list of values.

Exclude Manually 
Overridden Charges

Turn this rule on and off by entering or removing dates.

Service Request Type ■ Enter a different Service Request Type in the Value field 
using the list of values.

■ End-date the rule.

Total Service Request 
Charges

■ Enter a different operator using the Condition 
drop-down list

■ Modify the amount.

■ Select a different Currency using the list of values.

■ End-date the rule.

Rule What you can update:
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Setting Up Automatic Submission
The default setting of No keeps the orders in the Entered status. The order 
must be booked before the customer is billed.

■ Service: Charges Autosubmit Mode

This system profile determines at what stage the charges are submitted. You 
can set this profile to:

* When All Tasks Final

This mode submits charges when all of the tasks have reached a status 
designated as Closed. If the automatic submission process fails for any 
charge line associated with the service request, none of the lines are 
submitted.

* When Service Request Final

Submits charges when the service request is set to a status designated 
as Final. If the automatic submission process fails for any charge line 
associated with the service request, none of the lines are submitted.

* As Available

Charges are submitted after the Oracle Field Service concurrent pro-
gram creates them from debrief. If any line encounters errors, all subse-
quent charge lines for that service request are not submitted.

3. Run the Charges Autosubmission Concurrent Program with the frequency you 
desire. To run the program, navigate to Setup > Others > Submit Requests.
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Integrating Relationship Plans in Other

Applications

This appendix details the necessary steps involved in integrating any application 
within the Oracle E-Business Suite to the relationship plans functionality offered by 
Oracle TeleService. Integration can be achieved by coding one or more of the 
following form level triggers in the integration form:

■ On Insert

■ On Update

■ Custom1

■ Custom2

A.1 Overview of Integrating Relationship Plans
Modules within the CRM application need to be integrated with each other to 
ensure smooth flow of data and business logic through out the application. The 
relationship plans module within Customer Care allows organizations to set up 
plans that they can offer to their customers and ensure a constantly growing 
customer base.

The relationship plans module is a busy point of integration, because of the very 
fact that almost every other module within CRM needs to have a consistent view of 
all the existing plans in the application. To help in this integration process, the 
relationship plans module facilitates an "ENABLE PLAN" form, which enables 
other modules to integrate with relationship plans.
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Technical Overview
A.2 Technical Overview

A.2.1 Forms Used:
CSCUTILS.fmb - Setup Form and Outcomes Window

A.2.2 Tables Used:
CSC_PLAN_ENABLE_SETUP

OKC_PROCESS_DEFS_V

A.2.3 List of Packages and Procedures:
PACKAGE CSC_PLAN_OUTCOMES
PROCEDURE GET_OUTCOMES (    
p_FUNCTION_ID                                NUMBER,
p_TRIGGER_EVENT                              VARCHAR2,
p_PARTY_ID                                   NUMBER,
p_CUST_ACCOUNT_ID                            NUMBER,
p_END_USER_TYPE                              VARCHAR2 := NULL
p_APPLICATION_SHORT_NAME                     VARCHAR2,
p_MSG_TBL                                    OKC_AQ_PVT.MSG_TAB_TYP)

Description of Parameters:
■ P_FUNCTION_ID - The integrating form function id from table FND_FORM_

FUNCTIONS

■ P_TRIGGER_EVENT - The triggering event that calls the outcomes. The allowed 
values are INSERT, UPDATE, CUSTOM1, and CUSTOM2.

■ P_PARTY_ID - Party Id from HZ_PARTIES.

■ P_CUST_ACCOUNT_ID - Customer account Id from HZ_CUST_ACCOUNTS_ALL

■ p_END_USER_TYPE - The end user type. AGENT or CUSTOMER

■ P_APPLICATION_SHORT_NAME - The short name of the application from FND_
APPLICATION.

■ P_MSG_TBL - The msg_tbl has the following structure:

a. ELEMENT_NAME       VARCHAR2(4000)

b. ELEMENT_VALUE      VARCHAR2(4000)
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Steps to Enable Modules in Relationship Plans
The element name is the name of the action attribute element name. The 
element value is the actual value of the element name.

A.3 Prerequisites
1. Relationship Plans have to be defined and attached to the specific customer.

2. Actions, Conditions, and Outcomes have to be defined using the Events 
screens.

A.4 Steps to Enable Modules in Relationship Plans
1. Register the integrating module form with the relationship plan’s setup form.

2. Attach library CSCUTILS.pll (from $CSC_TOP/resource) in the integrating 
form.

3. Subclass relationship_plans_outcomes and enable_relationship_plans object 
groups from the CSCUTILS.fmb form (from $CSC_TOP/forms/US).

4. Call CSC_PLAN_OUTCOMES.GET_OUTCOMES procedure from all of the above 
mentioned form level triggers. The outcomes are fired only for triggers that are 
enabled in the setup form.

5. Add the following code to the APP_CUSTOM package body in the integrating 
form:

if (wnd=’OUTCOMES’) then
cscutils_app_custom.close_windo(’OUTCOMES’);
--move focus to required block/field. for eg:
GO_BLOCK(’target block’);
end if;

6. User defined triggers, Custom1 and Custom2 have to be explicitly executed 
from the required integration point. Following is an example: 

execute_trigger(’CUSTOM1’);
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Functionality of the Setup Form - CSCUTILS
A.5 Functionality of the Setup Form - CSCUTILS

A.5.1 Enable Relationship Plans - Setup Window:
To enable a module for relationship plans, the module should register its form 
functions with the relationship plans registering table called CSC_PLAN_ENABLE_
SETUP. This can be done via the Enable Relationship Plans - Setup form.

The Function column specifies the integrating form function name.

The Application column specifies the application the form function belongs to.

The integrating module has four form level triggers which can be coded to achieve 
integration with the relationship plans module. They are:

1. On Insert

2. On Update

3. Custom1

4. Custom2

By checking one or more of these triggers, the enable plan APIs can be executed 
from the integrating module. 

A.5.2 Outcomes Window
Outcomes of a plan can be of two types - synchronous and asynchronous. 
Asynchronous outcomes are those that are fired immediately but the resulting 
outcomes are processed in the background. Synchronous outcomes are those which 
are fired immediately and the results are shown in the outcomes window. The user 
can then select or deselect the outcomes and execute them.

Outcome Name is the name of the outcome.

Outcome Type is the name of the outcome type, such as Alert or Script.

Description is the description of the outcome, such as the alert text for alerts.

The Execute button executes the outcome.

The Cancel button closes the Outcome window.
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Limitations
A.5.3 Defining an Alert
1. Create a message with the alert text as the message text. This is the same as 

defining an error message.

2. Define the outcome in the Process Definition screen. Use the same message 
name defined in step 1 for the outcome name.

3. Define the parameters for the outcomes. Use the same message token names 
defined step 1 as the parameter names.

4. For more information about defining outcomes, refer to Events documentation.

A.6 Limitations
Defining a plan which has only one outcome to be fired raises no issues. The 
outcome is fired and the control passes on normally to the next logical step. If there 
are two or more outcomes to be fired, the control passes to the ’OUTCOMES’ block 
which lists the different outcomes and the user can select which of the outcomes are 
to be executed. This raises a potential error situation if the enable relationship plans 
triggers are called from triggers that do no allow restricted procedures to be part of 
their code. This is due to the fact that there is a ’GO_BLOCK’ statement executed in 
the GET_OUTCOMES program unit when transferring control to the OUTCOMES 
block to display the various outcomes. 

You must make sure that the form functions integrating with the Relationship Plans 
module takes into account the above situation and performs the right code calls. A 
workaround for the above scenario would be to create a timer and then execute the 
Enable Relationship plan trigger from the ’WHEN-TIME-EXPIRED’ trigger.
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Frequently Asked Questions About Setting

Up Relationship Plans

What does Plan Type mean? 
Relationship Plans can be of two types: 

■ Template Plan - These types of plans can be associated to any customer. 

■ Customized Plan - This type of plan is created only for specific customers. 

Can a customized plan be created when the Define Relationship Plan 
responsibility is invoked? 
No, a customized plan can be created only when a plan already exists and is 
associated to a group of customers. This plan can then be customized for a specific 
subgroup of those customers. When a plan is customized, a new plan in created in 
the application. 

What is the Account Level check box in the Define Plan form? 
Plans can be associated to customers at two levels. 

■ Party Level, in which case this check box is left unchecked. Party Level plans 
can be associated to customers only at party level.This means the plan is 
associated to all the customer accounts as well. 

■ Account Level, in which case this check box is checked. Account Level plans 
can be associated to customers only at account level. This means the plan is 
associated to a specific account of the customer and not to all the accounts. 

What is the Group Name field in the Define Plan form? 
Plans can be grouped together to form a logical set of plans. This group of plans can 
then be associated to customers and the customer gets the benefits and outcomes of 
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all the plans in the group. This functionality is not yet implemented in the current 
release. 

Sometimes the Low Value and High Value values cannot be modified. 
Why is this? 
These fields define the Relationship Plan header criteria. For example, consider the 
following Plan definition: 

Open Service Requests  > 5 

This plan will be associated to customers who have more than five open service 
requests. Assume that Customer A has eight open service requests. If you try to 
modify the plan criteria so the high value is 10 instead of 5, this will not be allowed 
because Customer A, who has eight open service requests is already associated to 
the plan and would not satisfy the new plan criteria. 

This update is allowed in the following scenarios: 

■ The plan is not associated to any customers. 

■ The new plan criteria does not violate any of the existing customer-plan 
associations. 

The Relationship Plan is setup and the customer is associated to the 
plan, but the plan does not execute. 
Relationship Plans are currently integrated with the Contact Center and Service 
Request forms. No other form can execute plans. If the plan is failing to execute 
from these two forms, check the following: 

Navigate to Customer Support > Setup > Relationship Plans > Enable Relationship 
Plans and verify if the following entries exist and that the Custom1 check box is 
checked: 

Function                Application 

CSCCCCRC           Customer Care

CSXSRISR              Oracle Service  

How do I set up Relationship Plans to pop up an alert? 
In this example, we are creating a new message called RV30 and specifying the 
message text that needs to pop up in the alert window. 

1. Navigation Path: Application Developer > Messages 
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2. Define an action called RV30 with the following attributes: 

■ Action Type = Action Based 

■ Correlation = CUSTOMER_RV30 

■ Check the Enabled and Allow Synchronous Outcomes check boxes. 

■ Name = CUSTOMER NAME 

■ Element = CUST_NAME

■ Navigation Path: Customer Support > Setup > Relationship Plans > Events 
> Define Actions 

3. Define a Process Definition (Outcome) called RV30 with the following attributes 
using this navigation path:

Customer Support: Setup > Relationship Plans > Events > Define Process 
Definition 

■ Purpose = "OUTCOME" 

■ Type    = "ALERT" 

■ Name    = "CUST_NAME" 

The process definition name should be the same as the message name).

4. Define a relationship plan called RV30. The plan header criteria is 'Open Service 
Request > 10'. The navigation path is Customer Support: Setup > Relationship 
Plans > Define Relationship Plans 

5. In the Plan Details tab, create a new condition called RV30 using the action 
called RV30 and outcome RV30. 

6. Click Parameters. In the Parameters window, right click and select 'Populate 
selected rows in parameters'. Invoke the list of values to populate the value for 
the Action Attribute field. 

7. Attach the plan to the customer. In the Relationship Plans Search Screen, search 
for the customer to which the plan is to be attached. 

8. Click OK to invoke the Plans Summary window. 

9. Click Add/Remove to invokes the Add/Remove Plans window. This window 
displays all the plans the customer can be associated to. Select RV30 to add the 
plan called RV30 to the customer. 

10. Open the Contact Center window and query the Customer. The Plan's alert 
message should pop up. 
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What manuals are available that describe Relationship Plans? 
■ Oracle TeleService Implementation Guide

■ Oracle TeleService User Guide 

■ Oracle Service Contracts Concepts and Procedures

Why do extra outcomes sometime fire?
The same action is being used in multiple conditions.
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Seed Data for Relationship Plans

The Expiring Contracts relationship plan is included with this release. This 
relationship plan is designed to display an alert when an agent views a record of a 
customer who has one or more contracts that will expire in the next 30 days. 

This appendix describes the following:

■ Relationship Plan Header

■ Condition Header

■ Condition Type

■ Outcome

■ Parameter

■ Outcome Header

■ Outcome Argument

■ Message Definition

■ Profile Definition

■ Action Header

■ Action Attributes

Note: Do not modify seed data. Seed data is provided for you to 
use as delivered. If you want to make modifications, please make a 
copy and modify your copy. 
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Relationship Plan Header
■ Plan Name - Expiring Contracts

■ Plan Type - Template

■ Description - Plans that display an alert when querying a customer who has one 
or more contracts that will expire in the next 30 days

■ Profile Check - Expiring Contracts

■ Operator - >

■ Low Value - 0

Condition Header
■ Condition Name - Customer Care - Condition for Expired Contracts.

■ Description - Seeded condition for Relationship Plans.

Condition Type
Action - Customer Care - Generic Action

Outcome
CSC_EXPIRING_CONTRACTS

Parameter
■ Parameter - CUST_PARTY_NAME

■ Description - Name of the customer who has one or more contracts that will 
expire in the next 30 days.

■ Data Type - CHAR

■ Action Attribute - CUST_PARTY_NAME

Outcome Header (Process Definition)
■ Name -  CSC_EXPIRING_CONTRACTS

■ Application - Oracle Customer Care

■ Description - Outcome that will be fired when a customer has one or more 
contracts that will expire within the next 30 days. An alert message will pop up 
warning the agent about this.

■ Purpose - Outcome
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■ Type - Alert

■ Comments - Outcome for a relationship plan that fires when a customer has one 
or more contracts that will expire in the next 30 days.

Outcome Argument
■ Name - CUST_PARTY_NAME

■ Data Type - Char

■ Description - Name of the customer who has one or more contracts that will 
expire in the next 30 days.

Message Definition
Message Name - CSC_EXPIRING_CONTRACTS

Message Tokens - CUST_PARTY_NAME

Message Description - Message used as an outcome in a Relationship Plan that fires 
when a customer has one or more contracts that will expire in the next 30 days.

Message Text - Customer &CUST_PARTY_NAME has one or more contracts that 
will expire in the next 30 days.

Profile Definition
Block:

■ Name - Expiring Contracts

■ Code - EXPIRINGCONTRACTS

■ Description - Number of contracts that will expire in the next 30 days.

■ Application - Oracle Customer Care

■ Select - count(*)

■ From - OKS_ENT_HEADERS_V A

■ Where -   (a.party_id =:party_id and:cust_account_id is null) and a.end_date_
active <= sysdate + 30

Check

■ Name - Expiring Contracts

■ Code - EXPIRINGCONTRACTS
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■ Description - Number of contracts that will expire in the next 30 days.

■ Application - Oracle Customer Care

■ Type - Variable

■ Variable - Expiring Contracts

Action Header
Action Name - Customer Care - Generic Action

Action Type - Action Based

Description - Customer Care generic action that has all the attributes from the 
contact center header region as well as some from SR, that can be used as additional 
condition or as arguments to an outcome.

Correlation - CUSTOMER_CARE_ACTION

Application - Oracle Customer Care

Enable - Yes

Counter Action - No

Allow Synchronous Outcomes - Yes

Action Attributes
The following is a list of the Action Attribute Name, Element Name, Description 
and Data Type for the attributes provided with the seeded Action named Customer 
Care - Generic Action.

■ Customer Party Id, CUST_PARTY_ID, Customer Party Id, NUMBER

■ Customer Party Number, CUST_PARTY_NUMBER, Customer Party Number, 
CHAR

■ Customer Name, CUST_PARTY_NAME, Customer Party Name, CHAR

■ Customer Type, CUST_PARTY_TYPE, Customer Party Type, CHAR

■ Customer Status, CUST_PARTY_STATUS, Customer Party Status, CHAR

■ Customer Account Id, CUST_ACCOUNT_ID, Customer account Id, NUMBER

■ Contact Party Id, CONT_PARTY_ID, Contact Party Id, NUMBER

■ Contact Party Number, CONT_PARTY_NUMBER, Contact Party Number, 
CHAR
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■ Contact First Name, CONT_FIRST_NAME, Contact First Name, CHAR

■ Contact Last Name, CONT_LAST_NAME, Contact Last Name, CHAR

■ Area Code, AREA_CODE, Area Code, CHAR

■ Phone Number, PHONE_NUMBER, Phone Number, CHAR

■ Extension, EXTENSION, Extension, CHAR

■ E-mail Address, EMAIL, E-mail Address, CHAR

■ Address, ADDRESS, Address, CHAR

■ City, CITY, City, CHAR

■ State, STATE, State, CHAR

■ Postal Code, POSTAL_CODE, Postal Code, CHAR

■ Province, PROVINCE, Province, CHAR

■ Country, COUNTRY, Country, CHAR

■ Caller Type, CALLER_PARTY_TYPE, Caller Type, CHAR

■ Caller Status, CALLER_PARTY_STATUS, Caller Status, CHAR

■ Category Code, CATEGORY_CODE, Category Code, CHAR

■ Country Code, COUNTRY_CODE, Country Code, CHAR

■ Contact Relation, CONTACT_RELATION, Contact Relation, CHAR

■ Contract Id, CONTRACT_ID, Contract Id, NUMBER

■ Contract Line Id, CONTRACT_LINE_ID, Contract Line Id, NUMBER

■ Critical Overidden Flag, CRIT_OVERRIDE_FLAG, Critical Overidden Flag, 
CHAR

■ Relation Meaning, RELATION_MEANING, Relationship code meaning, CHAR

■ Account Number, ACCOUNT_NUMBER, Account Number, CHAR

■ Contract Number, CONTRACT_NUMBER, Contract Number, NUMBER

■ Contract Line Number, CONTRACT_LINE_NUMBER, Contract Line Number, 
NUMBER
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                                                         Service Request Lookup C
D

Service Request Lookup Codes

This appendix lists the lookup types and codes for the Service Request modules of 
Oracle TeleService. The following table lists lookups for service requests:
-

Lookup Type Lookup Code
User 
Extensible Meaning Description

CSY_PERIODS - N Period Types Used in 
Embedded Analytics

Period Types Used in 
Embedded Analytics

- LAST_30_DAYS - Last 30 Days -

- LAST_365_DAYS - Last 365 Days -

- LAST_7_DAYS - Last 7 Days -

- LAST_90_DAYS - Last 90 Days -

- TODAY - Today -

CSY_PROMPTS - N Prompts used in 
service core 
embedded analytic 
components

Prompts used in service 
core embedded analytic 
components

- ALL - All -

- CRIT_CUST_SR - Critical Customer 
Requests

-

- DAYS - days -

- HOURS - hours -

- MINS - mins -

- MTT_RSLV - Mean Time to 
Resolve

-

odes D-1



- MTT_RSPND - Mean Time to 
Respond

-

- PERCENT - % -

- PROB_CODE - Problem Code -

- PROD_CODE - Item Code -

- RESL_CODE - Resolution Code -

- SEV_1_SR - Severity 1 Requests -

- SR_IN_JEOPARDY - In Jeopardy Requests -

- SR_RSLTN_QLTY - Request Resolution 
Quality

-

- SR_RSLVD_PER_
AGT

- Request Resolved Per 
Agent

-

CS_BILLING_
CATEGORY

- N Service Billing 
Category

Billing Category for 
Billing Types

- E - Expense Expense

- L - Labor Labor

- M - Material Material

CS_CHG_LINE_
STATUS

- N Service Charges Line 
Status

List of Service Charges 
Line Statuses

- FOR_REVIEW - For Review For Review

- IN_ERROR - Failed Failed

- NEW - New New

- SUBMITTED - Submitted Submitted

CS_CHG_LINE_
TYPE

- N Service Charge Line 
Type

List of Service Charge 
Line Types

- ACTUAL - Actual Actual

- ESTIMATE - Estimate Estimate

- IN_PROGRESS - In Progress In Progress

CS_CHG_SORT_
ORDER

- N Service Charge Sort 
Order

List of columns that can 
be used to sort charge 
lines for UI

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- BILLING_TYPE - Billing Type Billing Type

- CHARGE_LINE_
SOURCE

- Charge Line Source Charge Line Source

- CHARGE_LINE_
TYPE

- Charge Line Type Charge Line Type

- CREATION_DATE - Creation Date Creation Date

- LINE_STATUS - Charge Line Status Charge Line Status

- ORDER_NUMBER - Order Number Order Number

- TRANSACTION_
TYPE

- Service Activity Code Service Activity Code

CS_CREDIT_CARD_
TYPES

- Y Credit Card Types List of Credit Card Types

- AMEX Amex American Express

- DINERS Diners Diners Club

- DISCOVER Discover Discover

- ENROUTE Enroute En route

- JCB JCB JCB

- MASTERCARD Master Card Master Card

- VISA Visa Visa Card

CS_FILTER_
OPTIONS                                                                     

- N Search Filter Criteria List of Filter Criteria 
used on setup UIs

- ACTIVE - Active Active

- ALL - All All

- PLANNED - Planned Planned

CS_MULTI_ORG_
RULE

- N Service Request Multi 
Org Rule

List of Service Request 
Multi Org Rule

- RULE_CONTRACT - Operating Unit of the 
Contract

Operating unit of the 
contract

- RULE_INSTALLED_
BASE

- Operating Unit of the 
Installed base 
product

Operating Unit of the 
Installed base product

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- RULE_PROFILE - Profile Option MO: 
Operating Unit

Profile Option MO: 
Operating Unit

- RULE_SR - Operating Unit 
Stamped on the 
Service Request

Operating unit stamped 
on the service request

CS_PRODUCT_
FAMILY_FUNCTION

- N Product Family 
Function

Product Family Function

- SERVICE_CHARGES - Service Charges Product Family Function                                                                           

CS_RESP_ACCESS_
TYPE

- N Service 
Responsibility Access 
Level

List of Service 
Responsibility Access 
Levels

- ALL - All Request Types All Request Types

- LIST - Select Request Type Select Request Type

CS_RESP_
BUSINESS_USAGE

- N Service 
Responsibility 
Business Usage

List of Business Usages 
which can be associated 
to a Service 
Responsibility

- AGENT - Service Provider Service Provider

- SELF_SERVICE - Self Service User Self Service User

CS_SECURITY_TYPE - N Service Security 
Level

List of Service Security 
Levels

- CUSTOM - Custom Security Custom Security

- NONE - No Security No Security

- STANDARD - Standard Security Standard Security

CS_SR_
ASSIGNMENT_
LEVEL

- N Service Request 
Assignment Level

List of Service Request 
Assignment Levels

- GROUP - Group Group Resource                             

- INDIVIDUAL - Individual Individual Resource              

CS_SR_AUDIT_
FIELDS

- N All Audit fields List of audit columns 
displayed on the Service 
Request Audit UI.

- ACCOUNT_ID - Account Account

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- ACTUAL_
RESOLUTION_
DATE

Resolved On Resolved On

- ALL - All All

- BILL_TO_
ACCOUNT_ID

- Bill To Account 
Number

Bill To Account Number

- BILL_TO_
CONTACT_ID

- Bill to Contact Bill to Contact

- BILL_TO_PARTY_ID - Bill To Party Bill To Party

- BILL_TO_SITE_ID - Bill To Site Bill To Site

- CATEGORY_SET_ID - Category Set Category Set

- CLOSE_DATE - Close Date Close Date

- COMM_PREF_
CODE

- Communication 
Preference

Communication 
Preference

- CONTRACT_ID - Contract Contract

- CONTRACT_
NUMBER

- Contract Number Contract Number

- CONTRACT_
SERVICE_ID

- Contract Line 
Description

Contract Line 
Description

- COVERAGE_TYPE - Coverage Coverage

- CP_COMPONENT_
ID

- Component Component

- CP_COMPONENT_
VERSION_ID

- Component Version Component Version

- CP_REVISION_ID - Revision Revision

- CP_
SUBCOMPONENT_
ID

- Sub Component Sub Component

- CP_
SUBCOMPONENT_
VERSION_ID

- Sub Component 
Version

Sub Component Version

- CURRENT_SERIAL_
NUMBER

- Serial Serial

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- CUST_PREF_LANG - Customer Preferred 
Language

Customer Preferred 
Language

- CUSTOMER_
EMAIL_ID

- Customer Email Customer Email

- CUSTOMER_
PHONE_ID

- Customer Phone Customer Phone

- CUSTOMER_PO_
NUMBER

- PO Num PO Num

- CUSTOMER_
PRODUCT_ID

- Item Instance Item Instance

- CUSTOMER_
TICKET_NUMBER

- Ticket Number Ticket Number

- DATABASE - Database Database

- DB_VERSION - Database Version Database Version

- ERROR_CODE - Error Code Error Code

- EXPECTED_
RESOLUTION_
DATE

- Expected Resolution 
Date

Expected Resolution 
Date

- EXTERNAL_
REFERENCE

- Tag Tag

- GROUP_ID - Group Name Group Name

- GROUP_TYPE - Group Type Group Type

- INC_RESPONDED_
BY_DATE

- Responded On Responded On

- INCIDENT_
ADDRESS

- Address Address

- INCIDENT_
ADDRESS_STYLE

- Address Style Address Style

- INCIDENT_
ADDRESS2

- Address 2 Address 2

- INCIDENT_
ADDRESS3

- Address 3 Address 3

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- INCIDENT_
ADDRESS4

- Address 4 Address 4

- INCIDENT_CITY - City City

- INCIDENT_
COUNTRY

- Country Country

- INCIDENT_
COUNTY

- County County

- INCIDENT_CROSS_
STREET

- Cross Street Cross Street

- INCIDENT_
DIRECTION_
QUALIF

- Direction Qualifier Direction Qualifier

- INCIDENT_
DISTANCE_QUAL_
UOM

- Distance UOM Distance UOM

- INCIDENT_
DISTANCE_QUALIF

- Distance Qualifier Distance Qualifier

- INCIDENT_FLOOR - Floor Floor

- INCIDENT_HOUSE_
NUMBER

- House Number House Number

- INCIDENT_LOC_
DESCRIPTION

- Location Description Location Description

- INCIDENT_LOC_
DIRECTION

- Location Direction Location Direction

- INCIDENT_
LOCATION_ID

- Incident Address Incident Address

- INCIDENT_
OCCURED_DATE

- Incident Occurred 
Date

Incident Occurred Date

- INCIDENT_
OWNER_ID

- Owner Owner

- INCIDENT_PO_
BOX_NUMBER

- PO Box PO Box

- INCIDENT_POINT_
OF_INTEREST

- Point Of Interest Point Of Interest

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- INCIDENT_
POSITION

- Position Position

- INCIDENT_
POSTAL_CODE

- Postal Code Postal Code

- INCIDENT_
POSTAL_PLUS4_
CODE

- Postal Code + 4 Postal Code + 4

- INCIDENT_
PROVINCE

- Province Province

- INCIDENT_
RESOLVED_DATE

- Resolution On Resolution On

- INCIDENT_
SEVERITY_ID

- Severity Severity

- INCIDENT_STATE - State State

- INCIDENT_
STATUS_ID

- Status Status

- INCIDENT_STREET - Street Street

- INCIDENT_
STREET_NUMBER

- Street Number Street Number

- INCIDENT_
STREET_SUFFIX

- Street Suffix Street Suffix

- INCIDENT_SUITE - Suite Suite

- INCIDENT_TYPE_
ID

- Type Type

- INCIDENT_
URGENCY_ID

- Urgency Urgency

- INSTALL_SITE_ID - Installed At Address Installed At Address

- INV_COMPONENT_
ID

- Inventory 
Component

Inventory Component

- INV_COMPONENT_
VERSION

- Inventory 
Component Version

Inventory Component 
Version

- INV_ITEM_
REVISION

- Inventory Item 
Revision

Inventory Item Revision

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- INV_
SUBCOMPONENT_
ID

- Inventory Sub 
Component

Inventory Sub 
Component

- INV_
SUBCOMPONENT_
VERSION

- Inventory Sub 
Component Version

Inventory Sub 
Component Version

- LAST_UPDATE_
CHANNEL

- Last Update Channel Last Update Channel

- OBLIGATION_DATE - Obligation Date Obligation Date

- OPERATING_
SYSTEM

- Operating System Operating System

- OPERATING_
SYTEM_VERSION

- Operating System 
Version

Operating System 
Version

- ORG_ID - Organisation Organisation

- ORIG_SYSTEM_
REFERENCE

- Original System 
Reference

Original System 
Reference

- ORIGINAL_ORDER_
NUMBER

- Order Number Order Number

- PLATFORM_ID - Platform Platform

- PLATFORM_
VERSION_ID

- Platform Version Platform Version

- PROBLEM_CODE - Problem Problem

- PROJECT_NUMBER - Project Project

- PUBLISH_FLAG - Publish Publish

- PURCHASE_
ORDER_NUM

- Sales PO Number Sales PO Number

- QA_COLLECTION_
ID

- QA Collection Plan QA Collection Plan

- RESOLUTION_
CODE

- Resolution Code Resolution Code

- RESOURCE_TYPE - Resource Type Resource Type

- SHIP_TO_
ACCOUNT_ID

- Ship To Account 
Number

Ship To Account 
Number

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- SHIP_TO_
CONTACT_ID

- Ship to Contact Ship to Contact

- SHIP_TO_PARTY_ID - Ship To Party Ship To Party

- SHIP_TO_SITE_ID - Ship To Address Ship To Address

- SITE_ID - Site Site

- SR_CREATION_
CHANNEL

- Channel Channel

- SYSTEM_ID - System System

- TERRITORY_ID - Territory Territory

- TIER - Tier Tier

- TIER_VERSION - Tier Version Tier Version

- TIME_ZONE_ID - Time Zone Time Zone

CS_SR_AUTO_
CLOSURE_VALUES

- N Lookup Type which 
defines values for SR 
auto-closure state

Lookup Type which 
defines values for SR 
auto-closure state

- CS_SR_NONE - No SR validate and 
auto-closure feature is 
turned off                                                                    

- CS_SR_VALIDATE_
AND_CLOSE

- Yes SR validate and 
auto-closure is turned on                                                              

CS_SR_CALLER_
TYPE

- N Service Request 
Caller Types

List of service request 
caller types

- CALLER_EMP - Employee Employee

- ORGANIZATION - Organization Organization

- PERSON - Person Person

CS_SR_CHILD_
ENTITY_CODE

- N Service Request Child 
Entities

List of Service Request 
Child Entities

- SR_CONTACT_
POINT

- Service Request 
Contact Point

Service Request Contact 
Point

- SR_ESCALATION - Service Request 
Escalation

Service Request 
Escalation

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- SR_HEADER - Service Request 
Header

Service Request Header

- SR_LINK - Service Request Link Service Request Link

- SR_NOTE - Service Request Note Service Request Note

- SR_SOLUTION_
LINK

- Service Request 
Solution Link

Service Request Solution 
Link

- SR_TASK - Service Request Task Service Request Task

CS_SR_CONTACT_
TYPE

- N Valid Contact Types 
for creating a Service 
Request

Valid Contact Types for 
creating a Service 
Request

- EMPLOYEE - Employee Employee

- PARTY_
RELATIONSHIP

- Customer Customer

- PERSON - Person Person

CS_SR_CREATION_
CHANNEL

- Y Service Request 
Creation Channels

Creation channels for a 
service request

- AGENT - Agent Create a Service Request 
by Agent

- AUTOMATIC - Automatic Automatic

- EMAIL - Email Create a service request 
via Email

- FAX - Fax Create a service request 
via a Fax

- PHONE - Phone Create a service request 
via Phone

- WALKIN - Walk-In Create a service request 
via Walk-in

- WEB - Web Create a service request 
via Web

CS_SR_DEFAULT_
TAB

- N Service Request 
Default Tab

List of tab pages 
available on Service 
Request UI

- ADDRESSES - Addresses Tab for Addresses

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- CHARGES - Charges Tab for Charges

- CONTACTS - Contacts Tab for Contacts

- CONTACTS_AND_
ADDRESSES

- Contact and 
Addresses

Tab for Contact and 
Addresses

- CSXCUST1 - First Custom Tab First Custom Tab

- CSXCUST2 - Second Custom Tab Second Custom Tab

- INTERACTIONS - Interactions Tab for Interactions

- LOG - Log Tab for Log

- MAINTENANCE_
REQUESTS

- Maintenance 
Requests

Tab for Maintenance 
Requests

- PRODUCT_
COVERAGE

- Subject Tab for Subject

- RELATED_
DOCUMENTS

- Related Objects Tab for Related Objects

- SERVICE_HISTORY - Service History Tab for Service History

- TASKS - Tasks Tab for Tasks

- WORKBENCH - Workbench Tab for Workbench

- WORKORDERS - Workorders Tab for Workorders

CS_SR_DIRECTIONS - Y CS_SR_DIRECTIONS Distance Qualifier Unit 
of Measure while 
entering non-postal 
components for 
incident_Address

- E - East East

- N - North North

- NE - North East North East

- NW - North West North West

- S - South South

- SE - South East South East

- SW - South West South West

- W - West West

Lookup Type Lookup Code
User 
Extensible Meaning Description
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CS_SR_DISTANCE_
UOM

- Y CS_SR_DISTANCE_
UOM

Distance Unit of 
Measure

- KM - Kilometers Kilometers

- METER - Meters Meters

- MILE - Miles Miles

- YARD - Yards Yards

CS_SR_DUPLICATE_
REASON_CODE

- N Service: Duplicate 
Check found Reason 
Code

List of duplicate reason 
codes.These are used to 
display messages when 
duplicate Service 
Requests are found by 
the duplicate check 
process.

- CS_CUST_PROD_
EA_ADDR_MCH

- Customer, Item, and 
Address are matched

Customer, Item, and 
Incident Address are 
matched                                                        

- CS_CUST_PROD_
EA_EA_ADDR_
MCH

- Customer, Item, 
Attributes, and 
Incident Address are 
matched

Customer, Item, 
Extended Attributes 
Incident Address are 
matched         

- CS_CUST_PROD_
EA_MCH

- Customer, Item and 
Attributes are 
matched                                       

Customer, Item, and 
Extended Attributes are 
matched                                                 

- CS_CUST_PROD_
SER_EA_ADD_MCH

- Customer, Item, 
Serial Number, and 
Incident Address are 
matched           

Customer, Item, Serial 
Number, and Incident 
Address are matched           

- CS_CUST_PROD_
SER_EA_EA_ADD_
MCH

- Customer, Item, 
Serial Number, 
Attributes, and 
Address matched                                                                

Customer, Item, Serial 
Number, Extended 
Attributes, and Incident 
Address are matched                                                                

- CS_CUST_PROD_
SER_EA_MCH

- Customer, Item, 
Serial Number, and 
Attributes are 
matched                

Customer, Item, Serial 
Number, and Extended 
Attributes are matched                

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- CS_CUST_PROD_
SERIAL_MCH

- Customer, Item, and 
Serial Number are 
matched                                     

Customer, Item, and 
Serial Number are 
matched                                     

- CS_EA_EA_ADDR_
MCH

- Attributes and 
Address are matched

Extended Attributes and 
Incident Address are 
matched        

- CS_EA_EA_MCH - Attributes are 
matched                                                                                                                               

Extended Attributes are 
matched                                                                                                                        

- CS_EA_INCIDENT_
ADDR_MCH

- Address is matched Incident Address is 
matched                                                       

- CS_INSTANCE_EA_
EA_ADDR_MCH

- Instance, Attributes, 
and Address are 
matched   

Instance Extended 
Attributes and Incident 
Address are matched             

- CS_INSTANCE_EA_
INC_ADDR_MCH

- Instance and Address 
are matched

Instance and Incident 
Address are matched                                    

- CS_INSTANCE_EA_
MCH

- Instance and 
Attributes are 
matched 

Instance and Extended 
Attributes are matched                                                

- CS_INSTANCE_
MCH

- Instance is matched Instance is matched                                                                               

- CS_INSTANCE_OR_
CUST_PROD_MCH

- Customer and Item 
are matched

Customer and Item are 
matched                                           

- CS_ORIGINAL_OF_
DUP_SR

- The original of the 
Duplicate 

The original of the 
Duplicate       

CS_SR_DUP_
CRITERIA

- N Service: Service 
Requests Duplicate 
Criteria

List of criteria used in 
Service Requests 
Duplicate check

- CS_DUP_CRIT_EA_
ADDR

- Extended Attributes 
and Incident Address

Extended Attributes and 
Incident Address

- CS_DUP_CRIT_
INST_CUST_PROD

- Item Instance/ 
Customer and Item 

Item Instance/ 
Customer and Item 

- CS_DUP_CRIT_
INST_CUST_PROD_
SER

- Item Instance/ 
Customer Item Serial 
Number

Item Instance/ 
Customer Item Serial 
Number

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- CS_DUP_CRIT_
WITH_SERIAL

- All with Serial 
Number

All with Serial Number

- CS_DUP_CRIT_
WITHNO_SERIAL

- All without Serial 
Number

All without Serial 
Number

CS_SR_ENTITY_
ACTIVITY_CODE

- N Service Request Child 
Entity Activities

List of Service Request 
Child Entity Activities

- C - Created Created

- D - Deleted Deleted

- U - Updated Updated

CS_SR_FILTERBY_
SRTAB

- N Service request tab 
filter by list

Service request tab filter 
by list

- ACCOUNT_
NUMBER

- Account Number Account Number

- CONTRACT_
NUMBER

- Contract Number Contract Number

- EXTERNAL_
REFERENCE

- Tag Number Tag Number

- INCIDENT_
ADDRESS

- Incident Address Incident Address

- PRODUCT - Item Name Item Name

- RMA_NUMBER - RMA Number RMA Number

- SERIAL_NUMBER - Serial Number Serial Number

- SERVICE_
REQUEST_NUMBER

- Service Request 
Number

Service Request Number

CS_SR_GRANT_
TYPE

- N Service Request grant 
types

List of Service Request 
grant types.

- N - All web enabled 
Service Request 
Types

All web enabled Service 
Request Types

- Y - Only Service Request 
Types mapped to 
User's Responsibility

Only Service Request 
Types mapped to User's 
Responsibility

Lookup Type Lookup Code
User 
Extensible Meaning Description
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CS_SR_
INTERACTION_
LOGGING

- N Service: Interaction 
Logging

Service: Interaction 
Logging

- AUTO_INT_LOG - Log Interactions 
automatically

Log Interactions 
automatically

- MANUAL_INT_
LOG

- Log Interactions 
manually

Log Interactions manual

- NO_INT_LOG - Do not log 
Interactions

Do not log Interactions

CS_SR_LOCATION_
TYPE_CODE

- N Service Request 
Location Types

Service Request Location 
Types

- HZ_LOCATIONS - HZ Location The location is defined 
in HZ_LOCATIONS 
table.                                                                                                  

- HZ_PARTY_SITES - Party Site The location is defined 
in HZ_CUST_SITE_
USES_ALL table.                

CS_SR_LOG_
CHECK_BOX

- N Service: Log tab 
default check box

List of check boxes 
displayed on the Service 
Request Log window. 

- ACTIVITY - Activity Records Activity Records

- ALL - All Records All Records

- AUDIT - Audit Records Audit Records

- NOTE - Notes Records Notes Records

- SOLN - KB Solution Records KB Solution Records

- TASK - Task Records Task Records

CS_SR_PRODUCT_
RELATION_TYPE

- N Service: Item, Item 
Category, None 
selection

List of values used for 
the Item radio groups on 
setup UIs.

- NONE - None None

- PRODUCT_
CATEGORY

- Item Category Item Category

- PRODUCT_P - Item Item

Lookup Type Lookup Code
User 
Extensible Meaning Description
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CS_SR_SERV_REQ_
ENABLED_TYPE

- N Used to determine if 
an item can have a 
Service Request 
logged for it.

Used to determine if an 
item can have a Service 
Request logged for it.

- D - Disabled Disabled

- E - Enabled Enabled

- I - Inactive Inactive

CS_SR_SOURCE_
PROGRAMS

- Y Service Request 
Source Program 
Codes

List of program codes 
which creates or updates  
Service Requests

- ACCOUNT_MERGE - Account Merge Account Merge Program

- AHL_
NONROUTINE

- Service Request for a 
Non-Routine job

Service Request for a 
Non-Routine job

- AHL_ROUTINE - Service Request for a 
routine job

Service Request for a 
routine job

- BIV_SR_UPDATE - Service Intelligence Service Intelligence

- CSCCCQSR.SCR - Seeded Script Script (Seeded Script 
from SR/CSC)

- CSD_REPAIR_
ORDER_FORM

- Depot Repair - Repair 
Order form

Depot Repair - Repair 
Order form

- CSL_LAPTOP - Field Service / 
Laptop

Field Service / Laptop

- CSM_UPSYNC_
WRAPPER

- CSM Upward 
Synchronization 
Wrapper Package

CSM upward 
synchronization 
wrapper package

- CSXSRISR - Teleservice-Service 
Request Form

Teleservice-Service 
Request Form

- CSXSRTAB - Teleservice Service 
Request Tab

Teleservice Service 
Request Tab

- CSZSRC - Service Online: 
Create call from 
CszIncidentEO

Service Online: Create 
call from CszIncidentEO

- CSZSRU - Service Online: 
Update call from 
CszIncidentEO

Service Online: Update 
call from CszIncidentEO

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- EMAILCENTER - eMail Center eMail Center

- EVENT_
SUBSCRIPTION

- Event Subscription Event Subscription

- ISUPPORTSRUI - iSupport Service 
Request UI

iSupport Service Request 
UI

- OKS_CT_EVENTS_
WFA

- Service Contract 
Events API

Service Contract Events 
API

- PARTY_MERGE - Party Merge Party Merge Program

- PMCON - Preventive 
Maintenance - 
Concurrent Request

Preventive maintenance 
- concurrent request

- SRAMCONC - Service 
Auto-assignment 
concurrent program

Service Auto-assignment 
concurrent program

- SUPPORT.WF - Workflow for 
Customer Support

Workflow for Customer 
Support

- UNKNOWN - Source Program Code 
not specified

Source Program Code 
not specified

- XNSSRISR - Service for Comms Service for Comms

CS_SR_STATUS_
CLASS

- N Service Request 
Status Classification

Service Request Status 
Classification

- WAIT_ON_
CUSTOMER

- Waiting on Customer Waiting on Customer

- WAIT_ON_EXT_
GROUP

- Waiting on External 
Group

Waiting on External 
Group

- WAIT_ON_INT_
GROUP

- Waiting on Internal 
Group

Waiting on Internal 
Group

- WAIT_ON_
SUPPORT

- Waiting on Support Waiting on Support

CS_SR_STATUS_
CONDITIONS

- N Status Change Event 
Conditions

List of status change 
conditions

- STATUS_
CHANGED_FROM

- Status Changed From Status Changed From

Lookup Type Lookup Code
User 
Extensible Meaning Description
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- STATUS_
CHANGED_TO

- Status Changed To Status changed to

CS_SR_TGT_
SEARCH_RULES

- N Task Template Search 
Rule Codes

List of Search rules used 
in finding the Task 
Template for auto task 
generation feature.

- C - Product Category Rule to Search by 
Product Category 

- CP - Product Category 
Problem Code

Rule to Search by 
Product Category and 
Problem Code                                                  

- I - Product Rule to Search by 
Product                    

- IP - Product Problem 
Code

Rule to Search by 
Product and Problem 
Code                                                                   

- P - Problem Code Rule to Search by 
Problem Code                  

- T - Service Request Type Rule to Search by 
Service Request Type                                                                          

- TC - Service Request Type 
Product Category

Rule to Search by 
Service Request Type 
and Product Category                                  

- TCP - Service Request Type 
Product Category 
Problem Code

Rule to Search by 
Service Request Type 
Product Category and 
Problem Code     

- TI - Service Request Type 
Product

Rule to Search by 
Service Request Type 
and Product                                                    

- TIP - Service Request Type 
Product Problem 
Code

Rule to Search by 
Service Request Type 
Product and Problem 
Code              

- TP - Service Request Type 
Problem Code

Rule to Search by 
Service Request Type 
and Problem Code                                          

Lookup Type Lookup Code
User 
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CS_SR_UPDATED_
FIELDS

- N Update Fields of 
Service Request

List of updated 
attributes used in 
notification messages

- CS_SR_SEVERITY - Severity Severity

- CS_SR_STATUS - Status Status

- CS_SR_SUMMARY - Summary Summary

- CS_SR_TYPE - Type Type

- CS_SR_URGENCY - Urgency Urgency

CS_SR_UWQ_
GROUP_LABEL

- Y Service: SR UWQ 
Group Label

Service: SR UWQ Group 
Label

- GROUP_LABEL - Groups Groups

- MY_GROUP_LABEL - My Groups My Groups

CS_SR_UWQ_MY_
LABEL

- N Service: SR UWQ My 
Label

Service: SR UWQ My 
Label

- MY_LABEL - My Service Request My Service Request

CS_SR_UWQ_
TEAM_LABEL

- N Service: SR UWQ 
Team label

Service: SR UWQ Team 
label

- MY_TEAM_LABEL - My Teams My Teams

- TEAM_LABEL - Teams Teams

CS_SR_VIEW_
CHOICES

- N Possible viewing 
choices

3 possible viewing 
choices will be seeded in 
this lookup

- ACTIVE - Active Active Mapping Rules                            

- ALL - All All mapping Rules                                                 

- PLANNED - Planned Planned Mapping Rules   

Lookup Type Lookup Code
User 
Extensible Meaning Description
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Service Security Seeded Data

This appendix lists seeded data for Oracle TeleService. You can enable or disable 
elements of the Oracle TeleService application including tabs, buttons, menus, and 
regions by mapping the functions listed in this appendix to responsibilities. You can 
use the seeded data security information as a guide to creating custom security.
 

E.1 Seeded Functions
 This group of topics lists the functions you can map to responsibilities using 
procedures described in Oracle Applications System Administrator’s Guide. It lists 
functions for:

■ Contact Center

■ Service Request Functions

E.1.1 Contact Center Functions
This table lists the Contact Center functions you can map to responsibilities:

Note: Do not modify seed data. Seed data is provided for you to 
use as delivered. If you want to make modifications, please make a 
copy and modify your copy. 

Description Function
Affected Tab or 
Window

Access to the Create Customer button CSCSFNCT Contact Center 
header
 Data E-1



Seeded Functions
Access to the Create Contact button CSCSFNCO Contact Center 
header

Ability to create a customer in Create Contact window CSCSFCCC Create Contact 
window

Access to the Edit Customer button CSCSFECT Contact Center 
header

Access to the Edit Contact button CSCSFECO Contact Center 
header

Access to the Dashboard tab* CSCSFDSB Contact Center 
Dashboard tab

Access to the Dashboard tab Refresh button CSCSFRBU Contact Center 
Dashboard tab

Access to the Party Information tab CSCSFPTY Contact Center 
Party Information 
tab

The ability to update customer information on the Party 
Information tab

CSCSFUPI Contact Center 
Party Information 
tab

Access to the Details button on the Party Information tab CSCSFDBU Contact Center 
Party Information 
tab

Access to the Contact Restrictions button on the Party 
Information tab

CSCSFCRB Contact Center 
Party Information 
tab

Access to the Relationships tab CSCSFREL Contact Center 
Relationships tab

The ability to create and update relationships on the 
Relationships tab.

CSCSFCRE Contact Center 
Relationships tab

Access to the Accounts tab CSCSFACT Contact Center 
Accounts tab

The ability to create accounts on the Accounts tab CSCSFCAT Contact Center 
Accounts tab

The ability to update account information in the 
Accounts tab

CSCSFUAT Contact Center 
Accounts tab

Description Function
Affected Tab or 
Window
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Seeded Functions
Access to the Details button on the Accounts tab. This 
button launches the Customer Account Details window.

CSCSFADB Contact Center 
Accounts tab

Access to the Credit tab of the Customer Account Details 
window. 

CSCSFCRD Contact Center 
Accounts tab

Account Details 
Window

Access to the Roles tab of the Customer Account Details 
window and the ability to create and update roles. 

CSCSFROL Contact Center 
Accounts tab

Account Details 
Window

Access to the Suspensions tab of the Customer Account 
Details window.

CSCSFSUS Contact Center 
Accounts tab

Account Details 
Window

Access to the Sites tab of the Customer Account Details 
window and the ability to create and update sites.

CSCSFSIT Contact Center 
Accounts tab

Account Details 
Window

Access to the Relationships tab of the Customer Account 
Details window and the ability to create new 
relationships.

CSCSFRTB Contact Center 
Accounts tab

Account Details 
Window

Access to the Customer Standard button on the Accounts 
Tab. This button launches the Customers - Standard 
window.

CSCSFCSN Contact Center 
Accounts tab

Access to the Addresses tab CSCSFADR Contact Center 
Addresses tab

Create and update addresses on the Addresses tab CSCSFCAD Contact Center 
Addresses tab

Access to the Identifying Address button on the 
Addresses tab. This button is used to create or change 
the customer’s identifying address.

CSCSFIAB Contact Center 
Addresses tab

Description Function
Affected Tab or 
Window
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Seeded Functions
Access to the Site Contact Points button on the 
Addresses tab. This button makes it possible to enter 
addresses for customer sites.

CSCSFSCP Contact Center 
Addresses tab

Access to the Contact Points tab CSCSFCPT Contact Center 
Contact Points tab

The ability to create and update contact points in the 
Contact Points tab

CSCSFCCP Contact Center 
Contact Points tab

Access to the Interactions tab CSCSFINT Contact Center 
Interactions tab

Access the Account Interactions button on the 
Interactions tab

CSCFAAB Contact Center 
Interactions tab

Access to the All Interactions button in the Interactions 
tab

CSCSFAIB Contact Center 
Interactions tab

Access to the Service Request tab CSCSFSR Contact Center 
Service Request 
tab

Access to the Notes tab CSCSFWKB Contact Center 
Notes tab

Create and update Notes on the Notes tab CSCSFCNO Contact Center 
Notes tab

Access to the Tasks tab CSCSFTSK Contact Center 
Tasks tab

Create a task on the Tasks tab CSCSFCTK Contact Center 
Tasks tab

Update a task on the Tasks tab CSCSFUTK Contact Center 
Tasks tab

Access the Assignment Manager button next to the 
Owner and Assignee fields of the Tasks tab

CSCSFAMB Contact Center 
Tasks tab

Access the Details button on the Tasks tab CSCSFATB Contact Center 
Tasks tab

Access to the Add Notes button on the Tasks tab CSCSFANB Contact Center 
Tasks tab

Access to the Use Template button on the Tasks tab CSCSFUTB Contact Center 
Tasks tab

Description Function
Affected Tab or 
Window
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Access to the Launch Workflow button on the Tasks tab CSCSFLWF Contact Center 
Tasks tab

Access to the More button on the Tasks tab CSCSFMBU Contact Center 
Tasks tab

Access to the Orders tab CSCSFORD Contact Center 
Orders tab

Access to the New button on the Orders tab of the 
Contact Center

CSCSNORB Contact Center 
Orders tab

Access to the Details button on the Orders tab CSCSODEB Contact Center 
Orders tab

Access to the Invoices tab CSCSFINV Contact Center 
Invoices tab

Access to the Transaction Details button CSCSFTDB Contact Center 
Invoices tab

Access to the Adjustment Processing button CSCSFAPB Contact Center 
Invoices tab

Access to the Payment Processing button CSCSFPPB Contact Center 
Invoices tab

Access to the Payment Details button CSCSFPDB Contact Center 
Invoices tab

Access to the Contracts tab CSCSFOKS Contact Center 
Contracts tab

Access to the Install Base tab CSCSFIB Contact Center 
Install Base tab

Access to the Collateral tab CSCSFCOL Contact Center 
Collateral Tab

Access to the Universal Work Queue icon in the toolbar 
and the corresponding menu selection

CSCSFUWQ Toolbar

Access to the Soft Phone icon in the toolbar and the 
corresponding menu selection

CSCSFSPB Toolbar

Access to the Quick Menu icon in the toolbar and the 
corresponding menu selection

CSCSFQMB Toolbar

Access to the Script icon in the toolbar and the 
corresponding menu selection

CSCSFSCB Toolbar

Description Function
Affected Tab or 
Window
                                                                   Service Security Seeded Data E-5



Seeded Functions
E.1.2 Service Request Functions
The following table lists the service-request-related functions:

Access to the Call Information icon in the toolbar and the 
corresponding menu selection

CSCSFCIB Toolbar

Access to the Call Wrap Up icon in the toolbar and the 
corresponding menu selection

CSCSFCWU Toolbar

Access to the Open Email Compose Window icon in the 
Toolbar, the Contact Center header, and the Contact 
Points tab. This also controls access to the corresponding 
menu selection.

CSCSFECW Contact Center 
header and tabs

Access to the Knowledge Base icon in the toolbar and the 
corresponding menu selection

CSCSKBIC Toolbar

Access to the Initiate Call button in the Contact Center 
header and Contact Points tab. This button is located 
next to the Phone field.

CSCSFPBU Contact Center 
header

Description Function
Affected Tab or 
Window

Create Service Request CS_HA_INST_SERVICE_REQUEST Service Request 
Creation

Update Service Requests CS_HA_UPDT_SERVICE_REQUEST Service Request 
Update

Access the Find Instance button CS_HA_AXS_FIND_PRD_BTN Service Request 
header

Access to the Find Icon CS_HA_AXS_FIND_ICON Service Request 
header

Access to the Subject tab CS_HA_AXS_PRD_COV_TAB Subject tab

Access Instance Configuration button 
on the Subject tab

CS_HA_AXS_PRD_CONFIG_BTN Subject tab

Access to the Workbench tab CS_HA_AXS_WORKBENCH_TAB Workbench tab

Access to the Search Knowledge 
button

CS_HA_AXS_KB_UI Workbench tab

Description Function
Affected Tab or 
Window
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Ability to create notes CS_HA_ADD_NOTES Workbench tab

Ability to update notes CS_HA_UPDT_NOTES Workbench tab

Access to the Note Detail button CS_HA_AXS_NOTE_DETAIL_BTN Workbench tab

Access to the Log and Notes button CS_HA_AXS_VIEW_LOG_BTN Workbench tab

Access Log Tab CS_HA_AXS_LOG_TAB

Access to the Contacts/Addresses tab CS_HA_AXS_CONTACTS_TAB Contacts/Addres
ses tab

Create Contact and Contact Point CS_HA_INST_CONTACTS

Update Contact and Contact Point CS_HA_UPDT_CONTACTS

Access Address Tab CS_HA_AXS_ADDRESS_TAB

Access Tasks Tab CS_HA_AXS_TASK_TAB

Create Tasks CS_HA_INST_TASK

Update Task CS_HA_UPDT_TASK

Access Use Template Button CS_HA_AXS_USE_TEMPLATE_BTN

Access Launch Workflow Button CS_HA_AXS_LAUNCH_WF_BTN

Access Task Details UI CS_HA_AXS_TASK_DETAIL_BTN

Access Interactions Tab CS_HA_AXS_INTERACTION_TAB

Access Related Documents Tab CS_HA_AXS_REL_DOCS_TAB

Create Related Document CS_HA_INST_REL_DOCS

Update Related Document & Access 
Delete Link button

CS_HA_UPDT_REL_DOCS

Access Service History Tab CS_HA_AXS_SRV_HIST_TAB

Access Customer Profile CS_HA_AXS_CUSTOMER_
PROFILE_BTN

Access Customer Update UI CS_HA_AXS_CUSTOMER_BTN

Access AM UI CS_HA_AXS_AM_BTNS

Access UWQ Buttons (Call Info, Call 
Wrap Up, End Call, Agent on Break 
Buttons)

CS_HA_AXS_UWQ_BTNS

Description Function
Affected Tab or 
Window
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Create Interactions and Activities CS_HA_INST_INTERACTION_ACT

Access Folder Button CS_HA_AXS_FOLDER_BTN

Access Attachments CS_HA_AXS_ATTACHMENT_UI

Access Translation CS_HA_AXS_TRANSALATION

Access Fulfillment Special Menu Item CS_HA_AXS_FULFILMENT_SM

Access Quick Menu Special Menu 
Item

CS_HA_AXS_QUICKMENU_SM

Access Notes Special Menu Item CS_HA_AXS_NOTES_SM

Access Launch Service Request 
Workflow Special Menu Item

CS_HA_AXS_LAUNCH_SRWF_SM

Access Abort Service Request 
Workflow Special Menu Item

CS_HA_AXS_ABORT_SRWF_SM

Access Service Request Escalation 
Special Menu Item

CS_HA_AXS_SR_ESCALATE_SM

Access Task Escalation Special Menu 
Item

CS_HA_AXS_TASK_ESCALATE_SM

Access Send Message Special Menu 
Item

CS_HA_AXS_SEND_MESSAGE_SM

Access View Message Special Menu 
Item

CS_HA_AXS_VIEW_MESSAGE_SM

Access Copy Service Request Special 
Menu Item

CS_HA_AXS_COPY_SR_SM

Access Counters Special Menu Item CS_HA_AXS_COUNTER_SM

Create Charges CS_HA_INST_CHRG

Update Charges CS_HA_UPDT_CHRG

Access Service Request Audit Special 
Menu Item

CS_HA_AXS_SR_AUDIT_SM

Access Scripting Special Menu Item CS_HA_AXS_SCRIPTING_SM

Access Outbound Email Special Menu 
Item

CS_HA_AXS_OUTBOUND_EMAIL_
SM

Access Print Request Special Menu 
Item

CS_HA_AXS_PRINT_REQUEST_SM

Description Function
Affected Tab or 
Window
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E.2 Standard Service Security Seed Data
This section lists the seed data for the standard service security that comes with 
your application. You can use it as a guide for creating your own custom security.

E.2.1 Objects
The following table lists the objects used by standard service security:

E.2.2 Object Functions (Form Functions)
The following table lists and describes the seeded functions.

Access Create Defect Special Menu 
Item

CS_HA_AXS_CREATE_DEFECT_SM

Access Create Enhancement Special 
Menu Item

CS_HA_AXS_CREATE_ENHANCE_
SM

Access Web Availability Special Menu 
Item

CS_HA_AXS_WEB_ACT_SM

Object Name Description

CS_SERVICE_REQUEST Service Request

CS_SR_TYPE Service Request Type

JTF_RESOURCE Resources

Function Name Related Object Description

CS_INCIDENTS_B_SEC CS_SERVICE_REQUEST Update service requests 

CS_SR_TYPE_SELECT_SEC CS_SR_TYPE Select Service Request 
Types

CS_JTF_RESOURCE_SELECT_SEC JTF_RESOURCE Select Service Request 
Type

CS_SR_ACCESS_RESP_SEC JTF_RESOURCE Assign service request 
resource

Description Function
Affected Tab or 
Window
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E.2.3 Object Roles (FND Menus)
The following table lists and describes the seeded object roles. These are the service 
related menus.

E.2.4 Object Role Functions (FND Menu Entries)
The following table lists and describes the seeded object role functions. 

E.2.5 Object Instance Sets for Restricted Access
The following table lists and describes the seeded object instance sets used by the 
application when normal security is turned on. 

CS_SR_ACCESS_RESP_SEC CS_SERVICE_REQUEST Service request security 
for Oracle Telephony 
Manager

Object Role (Menu_Name) Description

CS_SR_VIEW_UPDATE View and update service requests

CS_SR_TYPE_SELECT Select Service Request Types

CS_RESOURCE_ASSIGN Assign service request resources

CS_SR_ACCESS_RESP Security request security for Oracle Telephony 
Manager

Object Role (Menu_
Name in FND_MENUS)

Object Function (Function_
name in FND_FORM_
FUNCTIONS) Purpose

CS_SR_VIEW_UPDATE CS_INCIDENTS_B_SEC Secures CS_SERVICE_
REQUEST object in queries

CS_SR_TYPE_SELECT CS_SR_TYPE_SELECT_SEC To Secure CS_SR_TYPE in base 
queries in service security

CS_RESOURCE_
ASSIGN 

CS_JTF_RESOURCE_
SELECT_SEC

For validating SR owner as 
resource.

CS_SR_ACCESS_RESP CS_SR_ACCESS_RESP_SEC Validates Oracle Telephony 
Manager access to service 
requests.

Function Name Related Object Description
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Object Instance 
Set Name Predicate Description

CS_SR_SRTYPE_
SEC

EXISTS(SELECT '1'FROM cs_sr_type_
mapping csmap
WHERE csmap.incident_type_id =  cs_
sr_access_resp_sec.incident_type_id 
AND  csmap.responsibility_id =  
sys_context( 'FND', 'RESP_ID')AND  
csmap.application_id =  sys_
context( 'FND', 'RESP_APPL_ID')AND  
trunc(sysdate) between 
trunc(nvl(csmap.start_date, 
sysdate)) AND trunc(nvl(csmap.end_
date,sysdate))  )

Restricts service 
request access by 
Service Request Type

CS_SRTYPE_SEC "AND  EXISTS(SELECT '1'FROM cs_sr_
type_mapping csmapWHERE 
csmap.incident_type_id =  cs_
incident_types_b_sec.incident_type_
id   AND  csmap.responsibility_id = 
sys_context( 'CS_SR_SECURITY', 
'RESP_ID')AND  csmap.application_id 
=  sys_context( 'CS_SR_SECURITY', 
'APPL_ID')  AND  trunc(sysdate) 
between trunc(nvl(csmap.start_date, 
sysdate)) AND                                         
trunc(nvl(csmap.end_date,sysdate)) 
)"

Restricts availability 
of Service Request 
Types
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E.2.6 Object Instance Sets for Unrestricted Access
The following table lists and describes the seeded object instance sets used by the 
application when normal security is turned off and permits unrestricted access. 

CS_RESOURCE_
SEC

EXISTS           (SELECT '1' from 
FND_USER_RESP_GROUPS   ur,     cs_
sr_type_mapping  csmap             
WHERE   cs_jtf_rs_resource_extns_
sec.user_id  =  ur.user_id
AND ur.responsibility_id =  
csmap.Responsibility_id
AND ur. responsibility application_
id =  csmap.application_id
AND csmap.business_usage = 'AGENT'
AND csmap.incident_type_id  = sys_
context( 'CS_SR_SECURITY', 'SRTYPE_
ID')
AND trunc(sysdate) between 
trunc(nvl(ur.start_date,sysdate))
AND  trunc(sysdate) between 
trunc(nvl(csmap.start_date, 
sysdate)) 
AND                                        
trunc(nvl(csmap.end_date,sysdate))  
) OR (cs_jtf_rs_resource_extns_
sec.user_id is NULL)

Restricts the 
assignment of 
resources to service 
requests

CS_SR_ACCESS_
RESP_SEC

"AND EXISTS           (SELECT '1' 
from cs_sr_type_mapping csmap             
WHERE   csmap.incident_type_id  =  
cs_incidents_b_sec.incident_type_id   
AND     csmap.responsibility_id =  
sys_context( 'CS_SR_SECURITY', 
'RESP_ID')AND csmap.application_id 
= sys_context( 'CS_SR_SECURITY', 
'APPL_ID')  AND  trunc(sysdate) 
between trunc(nvl(csmap.start_date, 
sysdate)) AND                                        
trunc(nvl(csmap.end_date,sysdate))  
)"

Restricts access to 
service requests by 
Service Request Type 
and responsibility

Object Instance 
Set Name Predicate Description
E-12 OracleTeleService Implementation Guide                              



Standard Service Security Seed Data
E.2.7 Grants
The following table lists all of the seeded grants. All seeded grants are set with the 
grantee of GLOBAL.

Object Instance 
Set Name Predicate Description

CS_SR_SRTYPE_
NO_SEC

"1=1" Permits unrestricted service 
request access by Service Request 
Type

CS_SRTYPE_NO_
SEC

"1=1" Permits unrestricted availability 
of Service Request Types

CS_RESOURCE_
NO_SEC

"1=1" Permits unrestricted assignment 
of resources to service requests

CS_SR_ACCESS_
RESP_NO_SEC

"1=1" Permits unrestricted access to 
Service Request Types by 
responsibility

Description Object Type Object Role Instance Set 

Restricts access by 
Service Request Type

CS_SERVICE_REQUEST CS_SR_ VIEW_UPDATE CS_SR_SRTYPE_SEC

Permits access to all 
Service Request Types 
when security is turned 
off.

CS_SERVICE_REQIEST CS_SR_ VIEW_UPDATE CS_SR_SRTYPE_NO_SEC

Restricts service request 
access by Service 
Request Type and 
specific responsibility

CS_SERVICE_REQUEST CS_SR_ ACCESS_RESP CS_SR_ACCESS_RESP_
SEC

Permits access to all 
Service Request Types 
by responsibility when 
security is turned off.

CS_SERVICE_REQIEST CS_SR_ ACCESS_RESP CS_SR_ACCESS_RESP_
NO_SEC

Secures the Service 
Request Type list of 
values (LOV) 

CS_SR_TYPE CS_SR_TYPE_SELECT CS_ SRTYPE_SEC

Permits access to all 
Service Request Types in 
the LOV when security 
is turned off

CS_SR_TYPE CS_SR_TYPE_SELECT CS_SRTYPE_NO_SEC
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Restricts resources that 
can be assigned to 
service requests and 
service request tasks by 
Service Request Type.

JTF_TASK_RESOURCE CS_RESOURCE_ASSIGN CS_RESOURCE_SEC

Permits assignment of 
all resources to service 
requests and service 
request tasks when 
security is turned off

JTF_TASK_RESOURCE CS_RESOURCE_ASSIGN CS_RESOURCE_NO_SEC

Description Object Type Object Role Instance Set 
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System Profiles

This appendix lists the system profiles for the Service Request and Customer Care 
modules of Oracle TeleService.

F.1 Oracle TeleService System Profiles
The following table lists the system profiles for Oracle TeleService in alphabetical 
order. Here is an explanation of the table’s columns: 

■ System Profile Name: The system profile name. An asterisk (*) next to a profile 
name indicates the profile is new in this release.

■ Description: A description

■ Level: A list of abbreviations representing the different levels at which the 
profile can be set:

* S: Site

* A: Application

* R: Responsibility

* U: User

■ Default Setting and Level: The seeded default setting and the seeded level.

■ Affects: The affected window or application module with references to the 
appropriate section of the guide where the profile is discussed.

Information not available is entered as Not Available.

Null settings for default values are described as None.
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System Profile Name Description Levels

Default 
Setting and 
Level Affects

Charge: Default Price List Charges uses the price list you enter in 
this profile as the default price list when 
creating a new charge line with no 
contract or a contract with no associated 
no price list.

S,A,R,U None Charges

CSC: Oracle Scripting Three 
Tier Installation

Specifies if the scripting server is a two- 
or three-tier installation.

S,A,R,U None Scripting in Contact 
Center

CSC: Port for Oracle 
Scripting Application

Port for communicating with the 
scripting server.

S,A,R,U None

Default Level: S

Scripting in Contact 
Center

CSC: Server Machine for 
Oracle Scripting

Name of the host machine where the 
scripting server resides.

S,A,R,U None

Default Level: S

Scripting in Contact 
Center

CSC: SID of Oracle Scripting 
Database

The database used to support the 
scripting tool.

S,A,R,U None Scripting in Contact 
Center

CSY: Last Program Run Date This system profile is reserved for future 
use.

It is used to specify the date of the last 
run of the Service Analytics concurrent 
program.           

This profile option gives the date time 
value when either of these concurrent 
programs are run - KPI summary: 
Incremental Data LoadSet or KPI 
Summary: Initial Data Load Set'

S - -

CSY: Service Request Group 
Filter

This system profile is reserved for future 
use.

Used in Embedded Analytic KPI for 
Group Parameter Value. Enter the group 
associated with the given user or enter 
ALL for all groups.

S 1

Level: S

-

Customer Care: 
Automatically Create an 
Account for a New 
Customer

Setting this profile to Yes, selects the 
Create Account check box in the Create 
Customer window by default and thus 
creates an account for a new customer. A 
No setting leaves the check box 
unselected and does not create the 
account.

S,A,R,U No

Default level: S

Create Customer
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Customer Care: 
Automatically Launch a 
Script for Identified Callers

When the application identifies a caller 
via Automatic Number Identification 
(ANI), you can automatically display a 
script for the agent to follow. Set this 
profile to the Oracle Scripting script you 
wish the application to display in the 
Contact Center.

S,A,R,U None

Default Level: S

Scripting in Contact 
Center

Customer Care: By Default 
Include Closed Invoices in 
Invoices Tab*

Sets the default value of the Include 
Closed check box in the Contact Center 
Invoices tab. A Yes setting selects the 
check box and includes closed invoices 
among those displayed in the tab. A No 
setting, the default, leaves the check box 
unselected and excludes closed invoices.

S,A,R,U No

Default level: S

Contact Center 
Invoices tab

Customer Care: Default a 
Type for New Notes in the 
Notes Tab

Specifies a default note Type for notes 
entered on the Notes tab of the Contact 
Center

S,A,R,U None Contact Center 
Notes tab

Customer Care: Default 
Address Style for Contact 
Center

If there is no address style associated 
with the customer’s country, then the 
application uses the address style 
specified in this profile. By default this 
system profile is set to Oracle Sales 
Default Address Style (AS_DEFAULT).

S,A,R,U Oracle Sales 
Default 
Address Style

Default level: S

Contact Center

See Specify Global 
Address Formatting 
and Address 
Validation on 
page 4-54.

Customer Care: Default 
Address Style for Contact 
Center

Service application support multiple 
address format for different countries. 
This profile specifies the default address 
style if no style exists for a particular 
country. 

S,A,R,U Oracle Sales 
Default 
Address Style

Default Level: S

Contact Center 
address format

See Specify Global 
Address Formatting 
and Address 
Validation on 
page 4-54.

Customer Care: Default 
Assignee for New Customer 
Tasks

Defaults the assignee for a new task in 
the Assignee field of the Contact Center 
Tasks tab.

S,A,R,U None Tasks

Contact Center 
Tasks tab

Customer Care: Default 
Assignee Type for New 
Customer Tasks

Default assignee type in the Assignee 
Type field of the Contact Center Tasks 
tab. Tasks can be assigned either to an 
individual employee, a group, or a team. 
Available choices are:

■ Employee Resource

■ Group Resource

■ Team Resource

S,A,R,U Employee 
Resource

Default level: S

Tasks tab of the 
Contact Center

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Customer Care: Default 
Category for Outbound 
E-mail from Contact Center

If you wish to restrict the use of eMail 
Center templates by Oracle Marketing 
Encyclopedia System (MES) product 
categories, then set this profile to any of 
the existing categories.

S,A,R,U None Contact Center 
E-mail integration

See Implementing 
Oracle eMail Center 
and E-Mail 
Templates on 
page 1-90

Customer Care: Default 
Contact Center Service Key*

Defaults the type of service key in the 
Search By drop-down list in the Contact 
Center header. The service key is a 
unique identifier that can be used to 
quickly identify a customer in the 
Contact Center. Possible service keys and 
setting for this profile are:

■ Service Request Number

■ Instance Name

■ Order Number

■ RMA Number

■ Invoice Number

■ Contract Number

■ Serial Number

■ Tag Number

■ System

■ SSN (Social Security Number)

S,A,R,U Service Request 
Number

Default level: S

Contact Center 
header 

Customer Care: Default 
Country for Addresses 
Created in Contact Center

The default country for a new address 
entered in the Contact Center.

S,A,R,U None Contact Center 
header

Customer Care: Default 
Customer Type

This profile option sets the default value 
in the Caller Type field in the Contact 
Center Customer region.

S,A,R,U Organization

Default level: S

Contact Center

Customer Care: Default 
Dashboard Display by 
Customer or Account 

Determines whether the Contact Center 
Dashboard tab displays account or 
customer information by default. 

■ A setting of Party displays 
customer information. 

■ A setting of Account displays 
information for the account. The 
View By Account check box is 
selected.

S,A,R,U Party

Default level: S

Contact Center 
Dashboard tab

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Customer Care: Default Date 
Range for Invoices Tab

Specifies the default time period in the 
From Date and To fields of the Invoices 
tab in the Contact Center.

S,A,R,U 30

Default level: S

Invoices tab of the 
Contact Center

See Setting Up the 
Invoices Tab on 
page 4-74.

Customer Care: Default Date 
Range for Orders Tab

Specifies the default time period in the 
From Date and To fields of the Orders 
tab in the Contact Center.

S,A,R,U 30

Default level: S

Modifying the 
Behavior of the 
Orders Tab on 
page 4-75

Customer Care: Default Date 
Range for View All Party 
Notes Page

Agents can display a list of notes for a 
customer in a Web browser page by 
clicking on the All Notes button in the 
Notes tab of the Contact Center. You can 
set this profile to specify the maximum 
age of notes displayed on the page. 

S,A,R,U 30

Default level: S

Notes

View All Party 
Notes Web page 

Customer Care: Default 
Number of Records 
Displayed in View All Party 
Notes Page 

Agents can display a list of notes for a 
customer in a Web browser page by 
clicking on the All Notes button in the 
Notes tab of the Contact Center. You can 
set this profile to specify the number of 
notes to display on the page. 

S,A,R,U 10

Default level: S

Notes

View All Party 
Notes Web page 

Customer Care: Default 
Outcome for Interactions

This legacy system profile is not used in 
this release.

S,A,R,U Request 
Processed

Call Wrap-up

Customer Care: Default 
Owner Type for Contact 
Center Tasks

This profile option provides a default 
value for the Owner Type when creating 
a customer-related task in the Tasks tab. 
The Owner Type does not display in the 
tab but determines which resources 
appear in the list of potential task 
owners. This system profile does not 
affect service request tasks.

Valid values: Employee Resource, Group 
Resource, and Team Resource

All three owner types are set up in the 
Resource Manager foundation module.

S,A,R,U Group Resource

Default level: S

Contact Center 
Tasks tab

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Customer Care: Default 
Phone Type 

Defaults the phone type in the Type 
drop-down list for contacts created in the 
Create Contact window.

Options are:

■ Fax

■ Mobile

■ Pager

■ Telephone

■ Voice Mail

■ Telephone/Fax

S,A,R,U Telephone

Default Level: S

Create Contact 
window in Contact 
Center

Customer Care: Default 
Relationship 

This profile option sets the default value 
in the Relationship field of the Caller 
Information window.

S,A Employee of

Default level: S

None

Customer Care: Default Site Default Site Usage for new addresses in 
the Contact Center.

S,A,R,U None Contact Center 
Address tab

Customer Care: Default Tab 
for Contact Center

This profile option sets the default tab 
displayed when the Contact Center form 
is opened.

S,A,R,U Dashboard

Default level: S

Contact Center tabs

Customer Care: Default Tab 
for Contract Number Service 
Key*

Default Contact Center tab displayed 
when the Service Key a user enters is a 
contract number.

S,A,R,U Contracts tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

Customer Care: Default Tab 
for Instance Name Service 
Key*

Default Contact Center tab displayed 
when the Service Key a user enters is an 
instance name.

S,A,R,U Install Base tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

Customer Care: Default Tab 
for Invoice Number Service 
Key*

Default Contact Center tab displayed 
when the Service Key a user enters is an 
invoice number.

S,A,R,U Invoices tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

Customer Care: Default Tab 
for Order Number Service 
Key*

Default Contact Center tab displayed 
when the Service Key a user enters is an 
order number.

S,A,R,U Orders tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Customer Care: Default Tab 
for RMA Number Service 
Key*

Default Contact Center tab displayed 
when the Service Key a user enters is an 
RMA number.

S,A,R,U Service Request 
tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

Customer Care: Default Tab 
for Serial Number Service 
Key*

Default Contact Center tab displayed 
when the Service Key a user enters is a 
product serial number.

S,A,R,U Service Request 
tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

Customer Care: Default Tab 
for Service Request Number 
Service Key*

Default Contact Center tab displayed 
when the Service Key a user enters is a 
service request number.

S,A,R,U Service Request 
tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

Customer Care: Default Tab 
for Social security number 
Service Key*

Default Contact Center tab displayed 
when the Service Key a user enters is a 
social security number.

S,A,R,U Dashboard tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

Customer Care: Default Tab 
for System Service Key*

Default Contact Center tab displayed 
when the Service Key a user enters is an 
Oracle Install Base System name.

S,A,R,U Service Request 
tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

Customer Care: Default Tab 
for Tag Number Service Key*

Default Contact Center tab displayed 
when the Service Key a user enters is an 
Oracle Install Base Tag number.

S,A,R,U Install Base tab

Default level: S

Contact Center tabs

See Setting Up 
Service Key Search 
Preferences on 
page 4-62

Customer Care: Default Tab 
in Customer Search Window

Determines which tab is selected when 
an agent opens the Customer Search 
window. The options are: Basic Search 
and Advanced Search.

S,A,R,U Basic Search

Default level: S

Customer Search 
window in the 
Contact Center

Customer Care: Default Task 
Owner for New Customer 
Tasks

Specifies the default Task Owner for new 
customer-related tasks created in the 
Contact Center Tasks tab. This profile 
does not default an owner in 
service-request-related tasks.

S,A,R,U None Tasks

Contact Center 
Tasks tab

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Customer Care: Default 
Template for Outbound from 
Contact Center 

Set this profile to the e-mail template you 
wish agents to use as a default for 
creating E-mails. There is no seeded 
template available, so you must create 
your own.

S,A,R,U None Contact Center 
E-mail integration

See Implementing 
Oracle eMail Center 
and E-Mail 
Templates on 
page 1-90

Customer Care: Default the 
First Customer Account in 
Contact Center Header

A setting of Yes defaults the first account 
in the Acct Num field of the Contact 
Center header. A setting of No leaves the 
field blank.

S,A,R,U Party

Default level: S

Contact Center 
header

Customer Care: Default Title 
for a Person

Defaults the title for the contact in the 
Contact region of the Contact Center 
header.

S,A,R,U None Contact Center 
header

Customer Care: Default 
Value for Wrap-Up Activities 

Use this system profile to select the 
default combination of outcome, result, 
and reason codes for activities agents 
record in the Call Wrap Up window. The 
codes themselves and their combinations 
are created in Interaction History 
administration Web pages.

S,A,R,U Contact

Default level: S

Call Wrap Up 
window

See Setting Up 
Wrap-up  on 
page 4-53

Customer Care: Default 
Value for Wrap-up 
Interactions

Use this system profile to select the 
default combination of outcome, result, 
and reason codes that appear in the Call 
Wrap Up window. The codes themselves 
and their combinations are created in 
Interaction History administration Web 
pages.

S,A,R,U Contact

Default level: S

Call Wrap Up 
window

See Setting Up 
Wrap-up  on 
page 4-53

Customer Care: Default 
View in Contact Center

Default selection for the View Details for 
drop-down list in the Contact Center 
header. Options are: Customer or 
Contact.

S,A,R,U Customer

Default level: S

Contact Center 
header

Customer Care: Display 
Customer Search Window by 
Default

Setting this profile to Yes automatically 
displays the Customer Search window 
when an agent navigates to the Contact 
Center window. This forces an agent to 
perform a search of existing customers.

S,A,R,U No

Default level: S

Call Wrap Up 
window

See Setting Up 
Wrap-up  on 
page 4-53

Customer Care: Display 
Note Details in All Party 
Notes Page by Default

Agents can display a list of notes for a 
customer in a Web browser page by 
clicking on the All Notes button in the 
Notes tab of the Contact Center. Setting 
this profile to Yes displays the note 
details along with the note itself. 

S,A,R,U Yes

Default level: S

Notes

View All Party 
Notes Web page 

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Customer Care: Display 
Only Active Accounts in 
Contact Center

Determines whether inactive accounts 
are shown in the Acct Num field LOV of 
the Contact Center. A setting of Yes 
shows only active accounts. A setting of 
No includes inactive accounts as well. 

S,A,R,U Yes

Default level: S

Contact Center 
header

Customer Care: Display 
Only Active Customers in 
Contact Center

Determines whether inactive customers 
are shown in the Name LOV. A setting of 
Yes restricts the list to active customers. 
A setting of No includes inactive 
customers as well. 

S,A,R,U Yes

Default level: S

Contact Center 
header

Customer Care: Enable 
Outbound E-mail from 
Contact Center

This profile option enables the e-mail 
icons on the application’s tool bar. 

A setting of Yes, the default, enables the 
icons and permits users to send e-mails. 
A setting of No, disables the icons and 
functionality. 

S,A,R,U Yes

Default Level: S

Contact Center 
E-mail integration

See Implementing 
Oracle eMail Center 
and E-Mail 
Templates on 
page 1-90

Customer Care: Include 
Contact Profiles in Customer 
Profile Engine Batch Runs

Setting this profile to Yes generates data 
for contact-level profiles you have set up 
when you run the Customer Profile 
Engine concurrent program. A setting of 
No, the default, leaves out these profiles.

S,A,R,U No

Default level: S

Contact Center 
Dashboard tab 

Customer Profile 
Engine concurrent 
program

See Running the 
Customer Profile 
Engine on page 4-26.

Customer Care: Make Call 
Wrap Up Mandatory in 
Contact Center*

Setting this profile to Yes makes entries 
in the Call Wrap Up window mandatory 
when agents end an interaction with a 
customer in the Contact Center. A setting 
of No makes entries optional.

S,A,R,U Yes

Default level: S

Interaction Wrap Up

See Setting Up 
Wrap-up on 
page 4-53.

Customer Care: Minimum 
Number of Characters for 
Phone Search

Specifies the minimum number of phone 
number digits agents must enter in the 
Phone field in the Contact Center header 
when they search for a customer using 
the phone number. This search matches 
the concatenated phone number, 
ignoring any spaces or other delimiters. 
Greater number of digits improve search 
performance. By default, there are no 
restrictions.

S,A,R,U None Contact Center 
header phone 
number searches

Customer Care: Number of 
Interactions Displayed in 
Contact Center

Sets the number of interactions 
displayed in the Contact Center 
Interactions tab.

S,A,R,U 12

Default level: S

Contact Center 
Interactions tab

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Customer Care: Open 
Multiple Sessions for 
Dashboard Drilldown

Setting this profile to Yes makes it 
possible for agents to open multiple 
windows as they drill down on 
information in the Dashboard tab. A 
setting of No limits agents to drilling 
down on just one item at a time.

S,A,R,U Yes

Default level: S

Contact Center 
Dashboard tab

Customer Care: Permit SSN 
Create and Update*

Setting this profile to Yes permits agents 
to create and update social security 
numbers in the Contact Center.

S,A,R,U Yes

Default level: S

Contact Center 
header

Customer Care: Permit the 
Dashboard to be Refreshed 
Automatically

Setting this profile to Yes makes the 
application refresh the customer 
information on the dashboard each time 
an agent displays a customer A setting of 
No requires the agent to click the Refresh 
button to update the display.

S,A,R,U No

Default level: S

Contact Center 
Dashboard tab data 
refresh rate

See Overview of 
Customer Profile 
Setup  on page 4-6.

Customer Care: Profile 
Check for Determining 
Customer Criticality

This profile option specifies the Profile 
Check the application uses to determine 
criticality of customers.

S,A,R,U Critical 
Customers

Default level: S

Dashboard tab of the 
Contact Center

Customer Care: Restrict 
Searches to a Specific 
Country

Specifies whether customer searches in 
the Contact Center are limited by default 
to a specific country. For example, setting 
this profile to France, restricts customer 
searches to only French customers. 
Agents are free to modify the default 
country or search all countries by 
deleting the entry in the Country field.

S,A,R,U None Contact Center 
header, Customer 
Search window 

Customer Care: Start Contact 
Center Interactions 
Automatically

Setting this system profile to Yes 
automatically starts logging an 
interaction when a customer is displayed 
in the Contact Center. 

A setting of No requires the agent to 
click the Start Interaction icon on the tool 
bar. 

If you wish to set this profile option to 
Yes, then you must set Customer Care: 
Log Interaction in Contact Center to Yes.

S,A,R,U No

Default level: S

Interactions

Customer Care: Start Menu 
in Quick Menu

Default Quick Menu menu. The Quick 
Menu provides access to predefined 
application windows.

S,A,R,U Quickmenu for 
Customer 
Support

Default Level: S

Quick Menu

See Setting Up 
Quick Menu on 
page 4-51.

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Customer Care: Turn On 
Interaction Logging in 
Contact Center

This system profile enables the logging 
of customer interactions in the Contact 
Center.

A setting of Yes, the default, enables 
interactions. 

A setting of No, disables the logging of 
interactions. 

S,A,R,U Yes

Default level: S

Interactions

Customer Care: Turn On 
Logging of Task Activities

Turns on logging of interaction activities 
for tasks. Possible values are Yes or No.

S,A,R,U Yes

Default level: S

Tasks

Customer Care: Unit of 
Measure Class for Time in 
Customer Tasks

Identifies time as the unit of measure. Do 
not modify the setting of this system 
profile.

S,A Time

Default level: S

Tasks

Contact Center 
Tasks tab

Customer Care: Use Exact 
Matches in ANI Searches

This system profile is used to modify the 
search for a customer using customer 
phone number, ANI (Automatic Number 
Identification). A Yes setting restricts the 
search to exact matches improving 
performance. A No setting permits the 
application to use an inexact match. 

S,A,R,U No

Default level: S

Telephony

HZ: Change Party Name Controls an agent’s ability to modify an 
existing customer name in the Contact 
Center header. A setting of Yes enables 
edits. A setting of No prevents edits.

S,A,R,U Yes

Default Level: S

Contact Center 
header

IEU: Distribute: Service 
Request Task: Work Source

Activates pull assignment for tasks in the 
Oracle Universal Work Queue.

S,A,R,U No

Default Level: S

Service Request 

See Automating the 
Closure of Service 
Requests on 
page 1-97.

IEU: Distribute: Service 
Request: Work Source

Activates pull assignment for service 
requests in the Oracle Universal Work 
Queue.

S,A,R,U No

Default Level: S

Service Request 

See Automating the 
Closure of Service 
Requests on 
page 1-97.

Notes: Default Note Status Defines the default note Status for notes 
entered in the Notes Tab of Contact 
Center and in all other applications 
where notes are used.

S,A,R,U None Contact Center 
Notes tab

OKS: Contact Center Date 
Range*

This system profile lets you specify the 
time period in days for displaying 
contracts in the Contracts tab of the 
Contact Center.

S,A,R,U None Contracts

Contact Center 
Contracts tab

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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OTS: Minimum Number of 
Characters for Lookup

Specifies the number of characters agents 
must type in when they wish to search 
for a piece of collateral by name on the 
Collateral tab of the Contact Center. A 
larger number makes the search more 
specific and improves performance.

S,A,R,U 0

Default level: S

Collateral

Contact Center 
Collateral tab

Service: Allow Charge 
Operating Unit Update

This profile determines whether agents 
can update the operating unit in charge 
lines.

Valid values: Yes, No

S,A,R,U No

Default Level: S

Charges

Service: Auto Closure of 
Service Request

Set this profile to Yes to turn on 
automatic assignment of service request 
ownership (both upward and downward 
propagation). By default this profile is 
set to No and automatic assignment is 
disabled.

S No

Default Level: S

Service Requests

See Automating the 
Closure of Service 
Requests on 
page 1-97.

Service: Auto Generate Tasks 
on SR Create

Use this profile to select between the two 
methods of automatic task generation.

If you wish to automatically generate 
tasks based on service request type, 
problem code, and item mappings, then 
set this system profile to Task Template 
Mapping.

If you wish to generate tasks based on 
additional service request attributes, 
then select Task Type Attribute 
Configuration.

S,A,R None

Default Level: R

Service Requests

See Understanding 
Automatic Task 
Generation on 
page 3-1.

Service: Auto Launch Web 
Workflow

This profile enables the automatic 
launching of Oracle Workflow processes 
for service requests customers create on 
their Oracle iSupport Web portal. 

You must associate the Workflow process 
to be launched with the Service Request 
Type.

A setting of Yes, enables the automatic 
launching 

A setting of No, prevents any associated 
Workflow processes from being 
launched.

S,A,R,U No

Default Level: S

Service Request 
Workflow Processes

See Setting Up 
Service Request 
Types on page 1-15.

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Service: Auto Launch 
Workflow

A setting of Yes, enables the automatic 
launching of Oracle Workflow processes 
you associate with Service Request 
Types. 

A setting of No, prevents any associated 
Workflow processes from being 
launched.

S,A,R,U No

Default Level: S

Service Request 
Workflow Processes

See Setting Up 
Service Request 
Types on page 1-15.

Service: Auto Query service 
request history in the Service 
Request tab

This profile determines whether an agent 
sees a list of existing service requests for 
a customer on the Service Request tab of 
the Contact Center. This profile affects 
what the agent sees only the first time 
the agent selects the tab for a specific 
customer.

If set to Yes, this profile displays all 
current service requests for the customer.

If set to No, the tab does not display any 
customer service requests.

Both settings permit the creation and 
updates of service requests.

S,A,R,U No

Level: S

Contact Center 
Service Request tab.

Service: Charges - Default 
Business Process from SR

When you set this system profile to Yes, 
Charges automatically defaults the 
business process from the service request 
into the charges lines 

If you set this profile to No, the agent 
must always enter the business process 
manually.

S,A,R,U Yes Charges

Service: Charges - Use Long 
List LOV for Price List

Setting this profile to Yes, forces agents 
to enter search criteria before displaying 
the list of values for price lists and thus 
improves performance for organizations 
with large numbers of price lists. 

A setting of No, the seeded default, 
displays the short list of values format.

S,A,R,U No Charges 

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Service: Charges Autosubmit 
Mode

This system profile determines at what 
stage the charges are submitted. You can 
set this profile to:

■ When All Tasks Final

This mode submits charges when 
all of the tasks have reached a status 
designated as Closed. If the 
automatic submission process fails 
for any charge line associated with 
the service request, none of the lines 
are submitted.

■ When Service Request Final

Submits charges when the service 
request is set to a status designated 
as Final. If the automatic 
submission process fails for any 
charge line associated with the 
service request, none of the lines are 
submitted.

■ As Available

Charges are submitted after the 
Oracle Field Service concurrent 
program creates them from debrief. 
If any line encounters errors, all 
subsequent charge lines for that 
service request are not submitted.

S,A,R,U When All Tasks 
Final

Level: S

Charges

Service: Charges Book Order 
Automatically

Set this system profile to Yes if you wish 
to automatically create orders in Oracle 
Order Management with a status of 
Booked. 

The default setting of No keeps the 
orders in the Entered status. The order 
must be booked before the customer is 
billed.

S,A,R,U No

Level: S

Charges

Service: Charges Default 
Conversion Type

This system profile specifies the default 
conversion type for converting the 
transactional currency from Service 
Debrief to the billing currency that is 
used in Charges. This is used only for 
expense lines. 

Possible values: Corporate, EMU Fixed, 
Spot, and User.

S,A,R,U Corporate

Level: S

Charges

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Service: Charges Default Sort 
Order

Agents can decide how to sort the 
charges displayed in the tab by making a 
selection from the Sort By drop-down 
list. You can set up the default value to 
any one of the following:

■ Billing Type

■ Charge Line Source

■ Charge Line Status

■ Charge Line Type

■ Creation Date

■ Order Number

■ Service Activity Code

S,A,R,U Creation Date

Level: S

Charges

Service: Collapse or Expand 
Service History

This profile is reserved for future use. - - -

Service: CS to CSI Continue 
Migration With Errors

This profile is used for upgrades. Please 
see installation and upgrade 
documentation for details.

- - -

Service: CS to CSI Migrate 
Customer Products Audit 
Data

This profile is used for upgrades. Please 
see installation and upgrade 
documentation for details.

- - -

Service: CS to CSI Migrate 
Party Audit Data

This profile is used for upgrades. Please 
see installation and upgrade 
documentation for details.

- - -

Service: CS to CSI Migrate 
Systems All Audit Data

This profile is used for upgrades. Please 
see installation and upgrade 
documentation for details.

- - -

Service: CS to CSI Migration 
Stage

This profile is used for upgrades. Please 
see installation and upgrade 
documentation for details.

- - -

Service: Day Unit of Measure Identifies a day as the unit of measure. 
Do not modify the setting of this system 
profile.

S,A Day

Default level: S

Tasks

Contact Center 
Tasks tab

Service: Default Address 
Style                      

Specifies the default address style for 
addresses created from the Service 
Request window.

S,A,R,U None Service Request

System Profile Name Description Levels

Default 
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Service: Default Assignee 
type on the Service Request 
Tasks tab

Provides the default value for the 
Assignee Type field when creating a 
Service Request task.

Valid values: Employee Resource, Group 
Resource, Team Resource

S,A,R,U None Service Request

Tasks tab

Service: Default Channel* Defaults the value of the Channel 
drop-down list in the Service Request 
header.

Available values are: Phone, Email, Fax, 
Web, and Walk-in.

S,A,R,U Phone

Level: S

Service Request 
header

Service: Default Contact By This profile is reserved for future use. - - -

Service: Default Contact 
Type

Specifies the default value for the contact 
type for service request creation in the 
Service Request window. This profile 
applies to service request contacts, not to 
customer contacts.

Possible values are:

■ Customer: an organization

■ Employee: an employee of your 
organization

■ Person: a consumer

S,A,R,U Customer Service Request 
header

Service: Default Coverage for 
SLA

This profile specifies the contracts 
template used for defaulting response 
and resolution times into service 
requests that do not have an applicable 
contract.

S,A,R,U None Service Request 

See Setting Up 
Default Response 
and Resolution 
Times on page 1-96.

Service: Default Customer 
Name

Defaults a customer name in a new 
service request created in the Service 
Request window. You can set this profile 
to any customer name. This profile does 
not affect service requests created in the 
Contact Center.

S,A,R,U None Service Request 
header

Service: Default date range 
for SR Tab

Specifies the default time period in the 
From Date and To fields of the Service 
Request tab in the Contact Center. Enter 
the number of days.

S,A,R,U None Contact Center

System Profile Name Description Levels

Default 
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Service: Default Email 
Template

This profile defaults an e-mail template 
for agents who create e-mails in the 
Service Request window. Set this profile 
to a default e-mail template you have 
created.

S,A,R,U None E-mail in Service 
Request window

See Implementing 
Oracle eMail Center 
and E-Mail 
Templates on 
page 1-90.

Service: Default Group 
Owner for Service Requests

This profile value sets the default value 
of the Service Request group owner.

Valid values: Any resource belonging to 
the Group Owner Type selected.

S,A,R,U None Service Request

Service: Default Group 
Owner Type for Service 
Request

This profile value sets the default value 
of the Group Owner Type in a service 
request.

Valid values: Group Resource, Team

S,A,R,U Group Resource Service Request

Service: Default Incident 
Address Format

Determines the format of the incident 
address entered in a service request. You 
can have the agent enter the incident 
address either as text or by selecting the 
address from the list of existing 
addresses in the database.

Valid values: 

■ Free Format Incident Address

■ Validated Incident Address

S None Entry of incident 
address in the 
service request

Service: Default Item 
Category Set

This profile specifies the item category 
set that can be used for service requests 
and restricts the Category field of the 
Service Request header to categories in 
that set.

S,A,R,U None Service Request

System Profile Name Description Levels

Default 
Setting and 
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Service: Default Log tab 
Check Box

This profile determines which check box 
in the Log window is selected by default. 
The log window is available by clicking 
the Log and Notes button on the 
Workbench tab of the Service Request 
window. The check boxes determine 
what information the window displays. 
The choices are:

■ All

■ Audit

■ Notes

■ Knowledge

■ Activity 

■ Task

S,A,R,U None Service Request 

Log window

Service: Default New Note 
Type in Workbench Tab

This profile sets the default note type 
which appears in the Type field of the 
Workbench tab of the Service Request 
window.

S,A,R,U None Service Request

Workbench tab

Service: Default note type for 
agent comments

Specifies the default note type for service 
requests.

S,A,R,U None Service Request

Workbench tab

Service: Default Owner type 
on the Service Request Tasks 
tab

This profile sets the default Owner Type 
in the Service Request Tasks tab.

S,A,R,U None Service Request 
tasks

Service: Default Party Type Sets the default Customer Type 
drop-down list value on the Service 
Request window header.

S,A,R,U None Service Request 
window header

Service: Default Platform 
Category Set

This profile controls whether the 
Platform field displays within the 
Subject tab. The list of values for the 
Platform field will show all categories for 
the category set defined within this 
profile.

If there is no value set, the Platform field 
is disabled. 

Note: The Platform field is hidden out of 
the box.

S,A,R,U None Service Request

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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Service: Default Service 
Request Owner

Sets the default for the Owner field of a 
service request. The value can be any 
resource of type specified in the system 
profile Service: Default Service Request 
Owner Type. This profile applies to 
service requests created in both the 
Service Request window and tab.

S,A,R,U None Service Requests

Service: Default Service 
Request Owner Type

Sets the default type of owner for the 
Owner field during service request 
creation. This profile applies to service 
requests created in both the Service 
Request window and tab.

Valid values include:

■ Employee Resource

■ Other Resource

■ Partner Resource

■ Party Resource

■ Supplier Contact

■ To Be Hired

S,A,R,U Employee 
Resource

Service Requests

Service: Default Service 
Request Severity

The default value in the Severity field for 
the creation of new service requests.

S,A,R,U None Service Requests

Service: Default Service 
Request Status

Use this system profile to specify the 
default value of the Status field during 
service request creation.

S,A Working

Level: S

Service Requests

Service: Default Service 
Request Type

Use this system profile to specify the 
default value of the Type field during 
service request creation.

S,A Customer 
Service Request

Service Request

Service: Default Service 
Request Urgency

Use this system profile to specify the 
default value of the Urgency field during 
service request creation.

S,A Customer 
Service Request

Service Request

Service: Default System 
Resource

This system profile specifies the dummy 
employee source for logging interactions 
in Oracle iSupport. This is required 
because interactions require an employee 
name, but Oracle iSupport service 
requests are logged by customers 
themselves. 

S None Oracle iSupport

Interactions

System Profile Name Description Levels
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Service: Default Task 
Assignee on the Service 
Request Tasks tab

This system profile defaults a resource in 
the Assignee field of a service request 
task. The list of resources is restricted to 
the type you selected in Service: Default 
Assignee Type on the Service Request 
Tasks Tab.

S,A,R,U None Service Request

Tasks

Service: Default Task Owner 
on the Service Request Tasks 
tab

This system profile defaults a task owner 
in new service request tasks. The owner 
is of the type you specify in Default 
Owner type on the Service Request Tasks 
tab.                             

S,A,R,U None Service Request

Tasks

Service: Default value for 
restrict closure flag on 
service request task tab

This profile specifies the default setting 
of the Restrict Closure check box on the 
Tasks tab of the Service Request. Agents 
can select this check box to prevent 
closure of the service request when the 
task is not in a closed status.

Setting this profile to Yes selects the 
check box. A setting of No, leaves the 
check box unselected.

S,A,R,U - Service Request 
Tasks

Service: Enable Context 
Search

Setting this profile to Yes enables text 
search in service requests. 

S,A - Service Request 
Summary and Notes

Service: Enable Create 
Contact

When set to Yes, this profile enables the 
Create Contact icon in the Service 
Request window header as well as the 
Contact/Address tab, and makes it 
possible for agents to create new 
customer contacts. When set to No, the 
icon is disabled agents are barred from 
crating contacts from this icon.

S,A,R,U No Service Request 
window header

Service: Enable defaulting 
CC field in Email header 
while sending an email in 
Service Request form

Setting this profile to Yes, copies service 
request contacts in the CC fields of 
e-mails sent from within the Service 
Request.

S,A,R,U No Service Request

E-mail

Service: Enable Edit Contact When set to Yes, this profile makes it 
possible for agents to update existing 
customer contacts by using the Create 
Contact window which agents can 
launch via the Create Contact icon in the 
Service Request window header as well 
as the Contact/Address tab. 

When set to No, the icon is disabled 
agents are barred from updating contacts 
from this icon.

S,A,R,U No Service Request 

System Profile Name Description Levels
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Service: Enable Outbound 
Email in Service Request

A setting of Yes, enables agents to send 
e-mails from the Service Request 
window.

S,A,R,U E-mail from Service 
Requests

Service: Enable Outbound 
Telephony in Service Request

A setting of Yes, enables outbound 
telephony from service requests.

S,A,R,U Outbound 
Telephony from 
Service Request 
window

Service: Enable Service 
Request-UWQ Workitem 
Integration

Setting the profile to Yes makes it 
possible for agents to use the Request 
Work and Next Work buttons to receive 
work from the Oracle Universal Work 
Queue. Work can include both service 
requests and service request tasks

S No

Level: S

Service Requests 
Automatic 
Assignment

See Chapter 2, 
"Implementing 
Service Request and 
Task Assignment".

Service: Enable Warning 
Messages for Impacted Tasks 
on Service Request Update*

You can set up service requests to 
automatically generate tasks whenever 
an agent creates a service request. Which 
tasks get created can be based on the 
problem code, item, and service request 
type agents enter.

Because the tasks are generated only at 
service request creation, an agent who 
changes any of these fields later may 
have to manually change these tasks to 
make them appropriate to the new 
purpose of the service request.

Setting this profile to Yes, warns agents 
that they may need to make the manual 
changes. A setting of No, does not send 
the warning.

S,A,R,U - Service Request 
tasks

Service: Field Service 
Transaction Organization

Oracle Field Service profile. Please see 
that product’s documentation for details.

S,A,R,U - -

Service: Field Service 
Transaction Type

Oracle Field Service profile. Please see 
that product’s documentation for details.

S,A,R,U - -

System Profile Name Description Levels
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Service: FORMS - Automatic 
Assignment of Owner

Enables automated assignment of service 
request ownership (both push and

pull) each time a service agent creates a 
request using Oracle TeleService.

The available options are:

■ Yes

Triggers automated assignment 

■ No (the default setting)

Use this setting if you do not want 
to automatically assign request 
ownership each time an agent 
creates the request. You can run the 
concurrent program Automatic 
Assignment of Resource for Service 
Request take care of the automatic 
assignment instead.

S No Service Request 
ownership 
assignment.

See Setting Up 
Automated 
Assignment on 
page 2-16.

Service: Group Owner 
Mandatory

Makes agent entry in the Group Owner 
field of the Service Request mandatory.

If you wish to use automatic assignment 
to assign the Group Owner, then leave 
this profile set to No. Automatic 
assignment requires agents to leave the 
owner field blank, this means that setting 
this profile to Yes, limits automatic 
assignment only to those individuals 
within the group an agent enters.

S,A,R,U No

Level: S

Service Requests

Service: Hide Contracts 
Region

Setting this system profile to Yes hides 
the Contracts information region of the 
Subject tab in the Service Request 
window.

S,A,R,U - Service Request

Subject tab

Service: History Display 
Order

This system profile is reserved for future 
functionality.

- - -

Service: Hour Unit of 
Measure

Identifies the hour as a unit of measure. S - -

System Profile Name Description Levels
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Service: HTML - Automatic 
Assignment of Owner

If you have implemented Oracle 
iSupport, then you can use this option to 
enable automated assignment of service 
request ownership each time a customer 
creates a service request on the Web.

The available options are:

■ Yes

Triggers automated assignment 

■ No (the default setting)

Use this setting if you do not want 
to automatically assign request 
ownership each time a customer 
creates a request. You can run the 
concurrent program Automatic 
Assignment of Resource for Service 
Request take care of the automatic 
assignment instead.

S No Service Request 
ownership 
assignment.

See Setting Up 
Automated 
Assignment on 
page 2-16.

Service: Individual Owner 
Mandatory

A setting of Yes, requires agents to enter 
an individual owner in the Owner field 
of the Service Request header when 
creating a service request.

If you wish to use automatic assignment 
to assign the owner, then leave this 
profile set to No. Automatic assignment 
requires agents to leave the owner field 
blank. This means that setting this profile 
to Yes effectively prevents automatic 
assignment.

S,A,R,U No

Level: S

Service Request

System Profile Name Description Levels
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Service: Interaction Logging 
Mode

Determines if interactions are logged 
automatically in the Service Request 
window. 

Possible setting are:

■ Automatic 

Interaction history starts recording 
an interaction when agents update 
any field in the service request. 
Interactions are automatically 
ended when the Service Request 
window is closed or another 
customer queried.

■ Manual

Agents have to click the Start 
Interaction and End Interaction 
icons in the toolbar.

■ No Interaction

This setting disables the 
interactions icons in the toolbar.

This profile does not apply to the Service 
Request tab which records only one 
activity for each service request and 
associates it with the existing Customer 
Care interaction.

S,A,R,U Automatic

Level: S

Service Requests

Service: Inventory Validation 
Organization

Use this profile to specify the inventory 
organization for the items against which 
service requests can be created. This 
setting restricts service requests only to 
items from that organization. Valid 
values are all inventory organizations.

S,A,R,U None

Level: S

Service Requests

Service: Item Flexfield Use this system profile to select the 
Oracle Inventory Key Flexfield structure 
you wish to use when displaying items 
from inventory. 

The recommended value is MSTK.

You must set this profile even if you are 
not using Oracle Inventory.

Valid values: Any Oracle Inventory key 
flexfield defined for table MTL_
SYSTEM_ITEMS_B. 

S,A None Service Request

System Profile Name Description Levels
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Service: Jeopardy: Reaction 
Date Buffer (in Days)

Reserved for future release.

Specifies the number of days before a 
service request is considered in jeopardy 
when your organization fails to respond 
by the date specified in the Respond By 
field.

S,A,R,U - Service Request

Service: Jeopardy: Resolution 
Date Buffer

Reserved for future release.

Specifies the number of days before a 
service request is considered in jeopardy 
when your organization fails to resolve 
the customer issue by the date specified 
in the Resolve By field.

S,A,R,U - Service Request

Service: Jeopardy: Resolution 
Date Buffer (in Days

Reserved for future release. - -

Service: Jeopardy: Response 
Date Buffer

Reserved for future release. - -

Service: Jeopardy: Task 
Calendar End Date - Effort 
Buffer

Reserved for future release. - -

Service: Jeopardy: Task 
Calendar Start Date Buffer

Reserved for future release. - -

Service: Make Call Wrap Up 
Mandatory in Service 
Request

Setting this system profile to Yes requires 
agents to make entries in the Call Wrap 
Up window when completing 
interactions with customers in the 
Service Request window. A setting of 
No, makes entry optional.

S,A,R,U - Service Request 

Call Wrap Up 
window

See Setting Up 
Wrap-up on 
page 4-53

Service: Make Contact 
Mandatory

Setting this system profile to Yes requires 
agents to enter a service request contact 
when creating a service request. A 
setting of No makes entry optional.

S,A,R,U - Service Request

Service: Make Group or 
Individual Owner 
Mandatory

Setting this profile to Yes makes entry of 
the service request owner mandatory 
when creating a service request. A 
setting of No makes assignment 
mandatory.

S,A,R,U No -

System Profile Name Description Levels
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Service: Manual Modifier Agents using Oracle Order 
Management’s Sales Order Line Items 
Pricing Tab can accidentally override 
prices entered in Charges when they 
select the Calculate Price check box. This 
causes prices to be recalculated for 
orders in the Entered state and overrides 
the prices entered in Charges by 
applying the modifiers associated with 
the price list. Set this system profile to a 
dummy manual modifier you have set 
up to prevent this behavior.

- None Charges

Service: Migration 
Organization for Employee 
Service Requests

Organization to which all the pre-11.5.6 
Service Requests created for caller_type 
'Employee' is migrated                      

S,A,R,U - Service Request

Service: Navigate to Contact 
Center or Telesales

This profile determines which window 
displays when agents clicks the Contact 
Center /eBusiness Center icon in the 
Service Request toolbar. This icon 
includes an image of an arrow.

Valid Values: Contact Center or 
eBusiness Center

S,A,R,U Contact Center

Level: S

Service Request 
toolbar

Service: Note Type for Task 
Generation Failure

You can use this profile to specify the 
note type for error messages generated 
by the application when automatic 
creation of tasks fails.

S,A,R,U None Error messages 
generated by tasks

Service: Publish Flag Update 
Allowed

Setting this system profile to Yes, permits 
agents to select the Publish check box on 
a service request, thus making the 
request available for customers to view 
via Oracle iSupport.

S,A,R,U Service Request

Service: Quantity used to 
compute Task planned end 
date.

This profile is used to compute the 
planned end date based on the planned 
start date for a task associated to the 
service request. The unit of measure is 
day.                                           

S,A,R,U None

Level: A

Service Request

Service: Renewal Default 
Order Type

Default order type for Renewal 
operation of Transact Service front_end 
form                                                          

S, A - Service Request

System Profile Name Description Levels
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Service: Restrict Installed 
Base for location validation

Specifies whether the Oracle Install Base 
item is restricted to addresses associated 
with the customer who owns the product 
or can have any address in the database. 
Possible values: HZ_LOCATIONS (all 
addresses) and HZ_PARTY_SITES 
(customer addresses). 

S - Service Request 
header

Service: Restrict Installed 
Base list by Account

Setting this system profile to Yes, 
restricts the items in the Instance list of 
values to items belonging to the account 
specified in the service request. A setting 
of No, lists all items for the customer.

S,A,R,U - Service Request

Service: Rows Displayed in 
History

Reserved for future use. - - -

Service: Service Request 
Auto Close Status

This profile is used to specify the status 
you wish to apply for a service request 
that has been closed automatically

S,A,R None Service Request

Service: Service Request 
Creation Item List filter

Reserved for future use. - - -

Service: Service Request 
Default Tab

This profile is used to default the tab 
selected when an agent creates a service 
request in the Service Request window. 

Valid values: 

■ Addresses

■ Charges

■ Contact and Addresses

■ Contacts

■ First Custom Tab

■ Interactions

■ Log

■ Maintenance Requests

■ Related Objects

■ Second Custom Tab

■ Service History

■ Subject

■ Tasks

■ Workbench

■ Workorders

S,A,R,U Workbench Service Request

System Profile Name Description Levels
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Service: Service Request 
Default Tab for Update

This profile is used to default the tab 
selected when an agent displays a 
service request in the Service Request 
window. 

Valid values: 

■ Addresses

■ Charges

■ Contact and Addresses

■ Contacts

■ First Custom Tab

■ Interactions

■ Log

■ Maintenance Requests

■ Related Objects

■ Second Custom Tab

■ Service History

■ Subject

■ Tasks

■ Workbench

■ Workorders

S,A,R,U Workbench Service Request

Service: Service Request 
Duplicate Time Frame

Set this system profile to the time 
duration you wish the application to use 
for duplicate checking when a service 
request is created. The time duration is 
dependent on the unit of time you 
choose in Service: Service Request 
Duplicate Time Frame UOM.

S,A,R,U 30

Level: R

Service Requests

See Setting Up 
Automatic Duplicate 
Checking for Service 
Requests on 
page 1-58

Service: Service Request 
Duplicate Time Frame UOM 

Use this system profile to set the unit of 
time you wish to use for duplicate 
checking. 

S,A,R,U Day

Level: R

Service Requests

See Setting Up 
Automatic Duplicate 
Checking for Service 
Requests on 
page 1-58
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Service: Service Request First 
Tab

This profile sets the tab displayed when 
an agent opens the Service Request 
window to create a new request.

Valid values: 

■ Addresses

■ Charges

■ Contact and Addresses

■ Contacts

■ First Custom Tab

■ Interactions

■ Log

■ Maintenance Requests

■ Related Objects

■ Second Custom Tab

■ Service History

■ Subject

■ Tasks

■ Workbench

■ Workorders

S,A,R,U Workbench

Level: S

Service Request 
window

Service: Service Request 
Owner Auto Assignment 
Level

This profile determines the level of 
autoassignment for service requests. A 
setting of Individual assigns ownership 
to a group and to an individual. A 
setting of Group assigns ownership to a 
group only.

S,A,R Individual

Level: S

Service Request 
ownership 
assignment.

See Setting Up 
Automated 
Assignment on 
page 2-16.

Service: Service Request Task 
Owner Auto Assignment 
Level

This profile determines the type of 
owner assigned to a service request task. 
A setting of Individual assigns 
ownership to an individual resource. A 
setting of Group assigns ownership to a 
group.

S,A,R Individual

Level: S

Service Request Task 
Ownership 
Assignment.

See Setting Up 
Automated 
Assignment on 
page 2-16
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Service: Service Request Task 
Tab Owner Field Optional

A setting of Yes makes the Task Owner 
field optional. When an agent does not 
make an entry, this automatically 
triggers the task assignment 
functionality (both pull and push 
models) at the time the task is saved. The 
application automatically assigns the 
owner.

S,A,R,U Yes Service Request Task 
Ownership 
Assignment.

See Setting Up 
Automated 
Assignment on 
page 2-16

Service: SR UWQ Group 
Label

Makes it possible to substitute a different 
word for Group in the different 
Universal Work Queue categories. 

S,A,R,U None Universal Work 
Queue

Service: SR UWQ My Label Makes it possible to substitute a different 
word for My in the different Universal 
Work Queue categories. 

S,A,R,U None Universal Work 
Queue

Service: SR UWQ Team 
Label

Makes it possible to substitute a different 
word for Team in the different Universal 
Work Queue categories. 

S,A,R,U None Universal Work 
Queue

Service: Subject Prefix for 
Outbound Email in Service 
Request

Setting this profile to Yes causes the 
application to populate the Subject line 
of the e-mail to be populated with the 
problem summary from the service 
request. The application defaults the 
subject line only when agents launch the 
compose window from the Service 
Request window.

Setting this profile to No leaves the 
subject line blank.

S,A,R,U - E-mail sent 
regarding service 
requests

See Implementing 
Oracle eMail Center 
and E-Mail 
Templates on 
page 1-90.

Service: System Generated 
Service Request Number

This profile determines if the service 
request number is entered by the agent 
or system-generated.

A setting of Yes, generates the number 
automatically. 

A setting of No, forces the agent to enter 
it manually.

- - Service Request

Service: Task Auto Close 
Status 

This system profile determines the status 
of tasks automatically closed by the 
application with the downward 
propagation method.

S,A,R None Service Requests

See Automating the 
Closure of Service 
Requests on 
page 1-97

Service: Time Span for Notes Sets the number of days for displaying 
service request notes.

S,A,R,U -
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Service: UPG Bill to Country 
Code

This profile is used for upgrades. See 
upgrade and installation documentation 
for details.

S,A,R,U - -

Service: UPG Default 
Employee for Interactions

This profile is used for upgrades. See 
upgrade and installation documentation 
for details.

This system profile is used for upgrading 
Interactions from version 3i to 11i. The 
employee you enter used as the default 
resource whenever employee_id column 
is null in 3i.

S,A,R,U - -

Service: UPG Install Country 
Code

This profile is used for upgrades. See 
upgrade and installation documentation 
for details.

S,A,R,U - -

Service: UPG Ship to 
Country Code

This profile is used for upgrades. See 
upgrade and installation documentation 
for details.

S,A,R,U - -

Service: Upgrade Batchsize This profile is used for upgrades. See 
upgrade and installation documentation 
for details.

S,A,R,U - -

Service: Use Business Process 
ID in Service Request Auto 
Assignment

This profile value indicates whether to 
use Business Process ID in the automatic 
assignment of a service request.

A setting of Yes limits the search for 
preferred resources to those associated 
with the Customer Support business 
process

A setting of No returns all preferred 
resources as possible service request 
owners.

S,A,R - Service Request 
Ownership 
Assignment.

See Setting Up 
Automated 
Assignment on 
page 2-16

Service: Use Business Process 
ID in Service Request Task 
Auto Assignment

This profile value indicates whether to 
use Business Process ID in the automatic 
assignment of a service request tasks.

A setting of Yes limits the search for 
preferred resources to those associated 
with the Customer Support business 
process

A setting of No returns all preferred 
resources as possible task owners.

S,A,R - Service Request Task 
Ownership 
Assignment

See Setting Up 
Automated 
Assignment on 
page 2-16
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Service: Use List of values 
for Order Number       

Agents can restrict Oracle Install Base 
searches to a specific order by entering 
the order in the Order field of the Search 
Installed Base window. 

Setting this profile to Yes, includes all 
orders of the customer in the list of 
values. 

A setting of No, makes the entry free 
text. 

S,A,R,U - -

Service: User Currency Code User currency for multi-currency 
conversions.

S,A,R,U US Dollar

Level: S

Charges

Service: Valid Bill/Ship To 
Relationship Types

Reserved for future use. - - -

Service: Valid Incident 
Address

Reserved for future use. - - -

Service: Validate and Auto 
Close on Service Request 
Closure

Set this profile to Yes, to enable 
downward propagation method of 
service request closure. 

S No

Level: S

Service Requests

See Automating the 
Closure of Service 
Requests on 
page 1-97.

Service: Visual Attribute for 
Setting Color for SR Number 
if SR is Escalated

This system profile assigns a color to the 
Service Request Number field when the 
Service Request is escalated.

Valid values: Dark Blue, Dark Green, 
Dark Red, Light Blue, Light Green, Light 
Red, Medium Blue, Medium Yellow, 
Medium Green, Medium Red

S,A,R,U  Light Red -

Service: Workflow 
Administrator

This profile specifies the employee 
resource who is to received notifications 
from any failed Oracle Workflow process 
within Oracle TeleService.

S,A,R,U None Workflow

Services: Check for Duplicate 
Service Requests

A setting of Yes, turn on duplicate 
checking. A setting of No disables it.

S,A,R,U No

Level: S

Service Requests

See Setting Up 
Automatic Duplicate 
Checking for Service 
Requests on 
page 1-58
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Services: Check for Similar 
Service Requests

This profile turns on potential duplicate 
checking based on Item Instance or Serial 
Number.

When this profile is set to Yes, an agent 
selecting an Instance in a service request 
receives a list of all service requests for 
that same instance that may be potential 
duplicates. 

A setting of No, disables this 
functionality.

S,A,R,U No

Level: S

Service Requests

See Setting Up 
Duplicate Checking 
by Item Instance or 
Serial Number on 
page 1-64

System Profile Name Description Levels

Default 
Setting and 
Level Affects
                                                                   System Profiles F-33



Oracle TeleService System Profiles
Services: Service Request 
Duplicate Criteria

Use this system profile to select the type 
of duplicate check you wish to use. 

If you wish to enable duplicate checking 
by customer and item alone, then select 
one of the following:

■ Item Instance/Customer, Item, 
Serial Number

Select this setting if your 
organization uses serial numbers 
when logging service requests 
against items. 

The application checks duplicates 
on either the instance or the 
combination of customer, item, and 
serial number. 

■ Item Instance/ Customer and Item

Select this option if you do not use 
serial numbers for logging service 
requests against items. The 
application checks for duplicates on 
either instance or a combination of 
customer and item. 

■ Extended Attributes and Incident 
Address

Select this option if you wish to 
enable duplicate checking based on 
extended attributes and the incident 
address alone.

If you wish to enable duplicate checking 
using both types of check, then select one 
of the two following options:

■ All with Serial Number

Performs both type of duplicate 
checks with the serial number.

■ All without Serial Number

Performs both type of duplicate 
checks without the serial number.

To enable your selection you must set 
Services: Check for Duplicate Service 
Requests to Yes. 

S,A,R,U Service Requests

See Setting Up 
Automatic Duplicate 
Checking for Service 
Requests on 
page 1-58.

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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F.2 Obsolete System Profiles
The following table lists system profiles obsoleted in this release.

Task Manager: Default 
Priority

Specifies the default value of the Priority 
field for new tasks created in the Tasks 
tab of the Contact Center. This default 
also applies to tasks in all applications.

S,A,R,U Medium

Default level: S

Tasks

Task Manager: Default Task 
Status

Specifies the default value of the Status 
field for new tasks created in the Tasks 
tab of the Contact Center. This default 
also applies to tasks in all applications.

S,A,R,U Open

Default level: S

Tasks

Task Manager: Default Task 
Type

Specifies the default value for the Type 
field for new tasks created in the Tasks 
tab of the Contact Center. This default 
also applies to tasks in all applications.

S,A,R,U Breakfast

Default level: S

Tasks

System Profile Name Description Levels

Default 
Setting and 
Level Affects

Customer Care: Default 
Outcome for Interactions

This legacy system profile is not used in 
this release.

S,A,R,U Request 
Processed

Call Wrap-up

Customer Care: Default 
Reason for Interactions

This legacy system profile is not used in 
this release.

S,A,R,U Already Gave

Default level: S

Call Wrap-up

Customer Care: Default 
Result for Interactions

This legacy system profile is not used in 
this release.

S,A,R,U Sale

Default level: S

Call Wrap-up

Customer Care: Service 
Request form Check

This legacy system profile determines 
whether the application opens the 
Service Request form or the Comms 
Service Request form.

- - Service Request

System Profile Name Description Levels

Default 
Setting and 
Level Affects
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